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第 1 章 
虚拟样机技术与 MotionView & MotionSolve 
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序    一 
Altair 公司于 1985 年从工程咨询起家，在 1989 年发布了 HyperMesh 软件，并很快在汽

车业得到广泛认同，从此激发了 Altair 在软件上投入的热情。1994 年，Altair 推出了

OptiStruct 模块，当年即获得《工业周刊》（Industry Week）年度技术奖。随后的几年，Altair
通过收购和开发，扩展了一系列模块，并于 1999 年整合成 HyperWorks 软件包。在 2006 年

收购 RADIOSS 软件后，Altair 终于在结构仿真和优化方面形成了完整的产品系列。 
2012 是 Altair 进入中国的第 11 个年头，在这 11 年中，在 Altair 中国同仁的不懈努力

下，Altair 中国业务有了长足的发展，HyperWorks 用户群也逐渐壮大。为此，2007 年开始，

我们每年举办 HyperWorks 技术大会（HTC）暨 Altair 用户年会。在会上，不仅有大会主题

发言，还有大量的用户论文交流。2007 年，上海的第一届 HTC 大会就收到了 70 多篇论文，

大部分是关于 HyperMesh 的应用。2008 年，在北京的第二届 HTC 大会上开始有一些制造仿

真技术（HyperXtrude/HyperForm）方面的论文。2009～2010 年，在上海的第三、四届 HTC
大会上论文数都超过了 120 篇，内容涵盖的行业更广，应用的模块更多，涌现了大量的有限

元求解、多体动力学仿真（MotionSolve）、优化设计及二次开发的成功案例。  
Altair 早些年的成功基本上得益于好的产品以及技术人员的口口相传。Altair 的业务模式

也为 HyperWorks 的普及提供了强有力的支持，使得高端 CAE 的进入门槛大大降低。随着业

务的飞速发展，要求使用 HyperWorks 的技术人员也越来越多，大家迫切希望有一些更好的

教程，能帮助他们更快地上手、更系统地学习、更深入地应用。在这样的背景下，我们组织

编写了 HyperWorks 进阶教程系列：《HyperMesh & HyperView 应用技巧与高级实例》、

《OptiStruct & HyperStudy 理论基础与工程应用》、《RADIOSS 理论基础与工程应用》，以满足

广大 CAE 工程师及爱好者的要求，并帮助高校学子更快掌握 HyperWorks 的软件应用。 
无论您是新入行，还是已在这一行工作多年，您一定会为 CAE 工具的多样化伤透脑

筋。HyperWorks 在高端 CAE 技术上提供了一站式解决方案，不仅使系统精简，同时又可同

其他系统共享 CAE 模型，更进一步将目前的主流 CAE 求解器集成在统一的环境上，组成一

个高效的产品研发平台，从而将创新、成本、效率有机结合起来，构造最有效的产品创新设

计平台解决方案。Altair“以用户的成功衡量我们的业绩”的服务理念、不断创新的技术和

业务模式、全球工程咨询经验的导入，会助您更上一层楼！ 
 

戚国焕 
Altair 大中华区总经理 
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序    二 
随着现代科技的发展，人类对各种机械系统性能的要求越来越高，这就要求对机械系统

性能进行动态设计。传统的手工设计模式在设计效率、设计准确性、设计成本等方面已无法

满足现代机械系统的要求。 
多体系统动力学理论与计算机技术的迅速发展，使得复杂机械系统动力学动态设计与分

析成为可能，并由此出现了一系列优秀的多体系统动力学专用和通用软件，极大地推动了现

代机械工业技术的发展。通过动力学设计者与计算机“对话”来进行多体动力学设计与分

析，就像使用“傻瓜”相机自动选择曝光时间和快门等参数来自动拍摄一样。由美国 Altair
公司于 21 世纪初开发的 MotionView & MotionSolve 软件就是新一代多体系统动力学通用软

件中具有代表性的一款。 
MotionView & MotionSolve 软件因其强大的数字、图表、动画前处理和后处理功能，基

于多体系统动力学理论的多体系统运动学和动力学快速计算求解器，多种可拓展使用范围的

辅助软件接口，简洁友好的可视化用户界面，便于用户二次开发的完全开放式的程序架构等

鲜明特点，在竞争激烈的动力学软件国际市场上占有了重要地位，受到广泛欢迎。 
王亚斌博士与我在多体系统动力学应用领域合作研究近 10 年，他有深厚的多体系统动力学

理论基础和丰富的MotionView & MotionSolve 软件应用经验。通过与 Altair 公司合作，王亚斌博

士与合作者编著的本书全面系统地介绍了 MotionView & MotionSolve 软件的建模、求解、结果

分析方法以及在机械产品动力学设计中的应用实例，是一部重要的 MotionView & MotionSolve
使用指南，具有很好的可读性和实用性，对学习和使用 MotionView & MotionSolve 大有帮助。 

我相信，该书的出版，对推广应用 MotionView & MotionSolve 软件和促进我国多体系统

动力学研究与应用以及虚拟样机技术的发展具有重要的促进作用，对开发我国具有自主知识

产权的多体系统动力学通用软件具有重要借鉴作用。 
 

芮筱亭     
南京理工大学力学首席教授 
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前    言 
在日益激烈的市场竞争下，一个企业的兴衰很大程度上取决于是否拥有高效的产品研发

能力。作为一种提高产品研发效率的有效工具，计算机仿真早已被应用到各个行业。通过仿

真驱动设计理念，将仿真技术融入产品设计的全过程，特别是产品概念设计阶段，不但为产

品设计提供指导，加速研发过程，还可以激发灵感，实现产品创新。 
本书以美国 Altair 公司的机械系统动力学分析软件 MotionView & MotionSolve 为平台，

从基础入门开始，由浅入深地引导读者通过具体操作过程来掌握 MotionView & MotionSolve
软件建模、求解与结果分析的方法，详细阐述了虚拟样机技术在机械产品设计与分析中的应

用。全书共分 10 章：第 1 章简要介绍了虚拟样机技术、多体系统动力学及仿真软件 MotionView 
& MotionSolve；第 2 章详细介绍了 MotionView 的基础知识；第 3 章通过实例介绍了应用

MotionView & MotionSolve 软件建立机构虚拟样机模型、求解以及结果后处理的基本过程；

第 4 章介绍了应用 MotionView & MotionSolve 进行刚柔耦合多体系统建模与仿真的基本功

能；第 5 章对 MotionView 的模型语言 MDL 进行了介绍；第 6 章介绍了后处理工具 HyperView 
& HyperGraph 的使用方法；第 7 章介绍了 MotionView 中传感器以及仿真脚本的基本用法，

并通过实例说明机械系统序列仿真的实现过程；第 8 章介绍了应用 MotionSolve 联合系统优

化求解器 HyperStudy 和结构优化求解器 OptiStruct 进行机构优化设计的基本方法；第 9 章介

绍了 MotionView & MotionSolve 机械控制联合仿真功能，讲解了控制系统建模工具以及使用

方法，并通过实例说明了 MotionSolve 自身以及联合 Simulink 进行机械控制系统联合仿真的

基本过程；第 10 章主要介绍了耐久性分析向导 Durability Director 的使用方法。附录部分提

供了 MotionSolve 常用函数说明以及软件使用过程中遇到的常见问题与解答。 
本书的第 1 章、第 2 章、第 4 章、第 8 章、附录由李修峰编写，第 5 章、第 7 章、第 9

章、第 10 章由王亚斌编写，第 3 章、第 6 章由王晨编写。全书由李修峰统稿。 
在本书的编写过程中，得到了 Altair 中国公司的大力支持，市场及合作伙伴总监钱纯女

士为本书的选题与出版提供了帮助和指导；高级技术经理洪清泉先生在百忙之中对本书进行

了审查并提出了宝贵的修改意见；北方区技术支持经理王钰栋先生对本书的框架给予了建

议。北京理工大学的刘明杰教授和李晓峰老师在本书的编写过程中给予了指导，贾静波和王

茹同学为本书实例的校对做了大量细致的工作。在此，一并致以最诚挚的谢意。 
由于作者水平有限，加之时间仓促，虽经多次校对，书中疏漏和不足之处在所难免，敬

请专家和读者批评指正。 
 

编  者 
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第 1章     

 虚拟样机技术与 MotionView & 

 MotionSolve 
本章首先介绍了虚拟样机技术的定义、分类、特点及其应用，然后阐述了多体系统动力学

分析的发展历程及研究方法，最后讲解了多体动力学仿真软件 MotionView & MotionSolve 的功

能与特点以及进行虚拟样机设计的一般过程。通过本章的学习可以对虚拟样机技术及多体系统

动力学分析与仿真技术的内容及发展有较深入的了解，对 MotionView & MotionSolve 的应用范

围有基本的认识，便于以后对具体内容的学习和掌握。 

本章重点知识 
 
 

1.1  虚拟样机技术 

1.2  多体系统动力学 

1.3  MotionView & MotionSolve 简介 

1.4  应用 MotionView & MotionSolve 软件进行虚拟样机设计的一般过程 

1.5  小结 
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1.1  虚拟样机技术 

在产品开发过程中，时间始终是一个重要因素。为了提高产品竞争优势或市场份额，企

业需要不断开发高质量、高性能、个性化的产品。然而，传统的产品设计过程，要经过图样

设计、样机制造、测试改进、定型生产等步骤。为了使产品满足设计要求，往往要多次制造

样机，反复测试，不但延长了产品推向市场的时间，而且浪费了大量的人力物力。虚拟样机

技术的出现为改变这一现状提供了可能。通过仿真驱动设计理念，在产品设计初期，即概念

设计阶段开始引入仿真技术，合理定义和约束设计空间，有效预测产品在真实工作状态下的

性能并及早发现设计中存在的问题，将大大缩短研发周期。同时，应用仿真技术还可以深入

研究设计变量对产品性能的影响，帮助设计决策以获得最佳的产品性能，并实现产品创新。

图 1-1 对比了传统产品开发与虚拟产品开发流程之间的差异。 

 
图 1-1  传统产品开发与虚拟产品开发流程比较 

1. 1.1  虚拟样机技术定义 

虚拟样机技术（Virtual Prototyping，VP）是指在产品设计开发过程中，将分散的零部件

设计和分析技术（指在某一系统中零部件的 CAD 和 FEA 技术）融合在一起，在计算机上建

造出产品的整体模型，并针对该产品在投入使用后的各种工况进行仿真分析，预测产品的整

体性能，进而改进产品设计，提高产品性能的一种新技术。 
虚拟样机技术是基于计算机技术的一个新概念技术，到目前为止还没有一个统一的定

义，有学者对集中代表性的论述进行了以下归纳： 
（1）虚拟样机技术就是在建立第一台物理样机之前，设计师利用计算机技术建立机械系

统的数学模型，进行仿真分析并从图形方式显示该系统在真实工程条件下的各种特性，从而

进行修改并得到最优设计方案的技术。 
（2）虚拟样机是一种计算机模型，它能够反映实际产品的特性，包括外观、空间关系以

及运动学和动力学特性。借助于这项技术，设计师可以在计算机上建立机械系统模型，伴之以

三维可视化处理，模拟在真实环境下系统的运动和动力特性并根据仿真结果精简和优化系统。 
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（3）虚拟样机技术利用虚拟环境在可视化方面的优势以及可交互式探索虚拟物体功能，

对产品进行几何、功能、制造等许多方面交互的建模与分析。它在 CAD 模型的基础上，把

虚拟技术与仿真方法相结合，为产品的研发提供了一个全新的设计方法。 

1. 1.2  虚拟样机分类 

虚拟样机按照实现功能的不同可分为结构虚拟样机、功能虚拟样机和结构与功能虚拟样机。 
1）结构虚拟样机主要用来评价产品的外观、形状和装配。新产品设计首先表现出来的

就是产品的外观形状是否符合要求；其次，零部件能否按要求顺利安装，能否满足配合要

求，这些都是在产品的虚拟样机中得到检验和评价的。 
2）功能虚拟样机主要用于验证产品的工作原理，如机构运动学仿真和动力学仿真。新产

品在满足了外观形状的要求以后，就要检验产品整体上是否符合基于物理学的功能原理。这一

过程往往要求能实时仿真，但基于物理学功能分析，计算量很大，与实时性要求经常冲突。 
3）结构与功能虚拟样机主要用来综合检查新产品试制或生产过程中潜在的各种问题。

这是将结构虚拟样机和功能虚拟样机结合在一起的一种完备型的虚拟样机。它将结构检验目

标和功能检验目标有机结合在一起，提供全方位的产品组装测试和检验评价，实现真正意义

上的虚拟样机系统。这种完备型虚拟样机是目前虚拟样机领域研究的主要方向。 

1. 1.3  虚拟样机技术特点 

与传统的基于物理样机的设计研发方法相比，虚拟样机技术具有以下特点： 
（1）新的研发模式。 
传统的研发方法是一个串行过程，而虚拟样机技术真正地实现了系统角度的产品优化。

它基于并行工程使产品在概念设计阶段就可以迅速地分析、比较多种设计方案，确定影响性

能的敏感参数，并通过可视化技术设计产品、预测产品在真实工况下的特征以及所具有的响

应，直至获得最优的工作性能。 
（2）更低的研发成本、更短的研发周期、更高的产品质量。 
通过计算机技术建立产品的数字化模型，可以完成无数次物理样机无法进行的虚拟试验，

从而无需制造及试验物理样机就可获得最优方案，不但减少了物理样机的数量，而且缩短了

研发周期、提高了产品质量。 
（3）实现动态联盟的重要手段。 
动态联盟的概念：为了适应快速变化的全球市场，克服单个企业资源的局限性，出现了

在一定时间内，通过 Internet 临时缔结的一种虚拟企业。为实现并行设计和制造，参盟企业

之间产品信息的交流显得尤为重要。而虚拟样机是一种数字化模型，通过网络输送产品信

息，具有传递快速、反馈及时的特点，进而使动态联盟的活动具有高度的并行性。 
 

1. 1.4  虚拟样机技术应用 

虚拟样机技术应用的目的是尽可能逼真地虚拟产品的物理原型，因此虚拟样机研究具有
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鲜明的领域特色。当前国际上对虚拟样机技术的研究主要集中在以下 4 个方向： 
第一种是面向虚拟现实的虚拟样机，强调数字模型在感观特性方面与实际产品的一致

性，可以通过数据手套、头盔等对虚拟原型进行实际操作，验证原型外在特性和内部功能及

性能等，主要应用在消费类电子、通信产品及医学等领域，如芬兰的 VTT 实验室研究的手

机虚拟原型。 
第二种是面向行为、结构仿真的虚拟样机，或称为机械系统仿真，强调数字模型在行为

及结构方面与实际产品的一致性，主要是利用虚拟原型仿真产品的几何和运动特性，通过原

型可视化进行产品外形设计、布局设计、可达性设计、运动和动力学仿真、装配仿真等，主

要应用于机械设计领域。典型的应用是机械系统仿真软件 MotionView & MotionSolve。 
第三种是面向并行工程的虚拟样机，强调从概念、设计、分析到可制造性等阶段连续的

计算机仿真，目的是减少设计反复，缩短产品研制周期，降低成本，主要应用在航空航天、

船舶等领域。有代表性的实例是 Boeing 公司 Boeing 777 客机和西克斯基飞机公司的科曼奇

武装直升机研制，采用虚拟原型技术后，前者比起以往的飞机设计，减少了 94%的花费，减

少了 93%的设计更改；后者减少了 11 590 小时飞行测试时间，节约经费总计 673 000 000 美

元，获得了巨大的经济效益。 
第四种是面向国防工业虚拟采办的虚拟样机，强调虚拟原型在虚拟环境中功能与实际产

品的一致性。例如，美国国防部联合建模和仿真系统（简称 J-MASS）体现了对新型武器系

统研制进行全寿命周期管理的思想，是协同虚拟样机技术在虚拟采办领域的一个典型应用。 

1.2  多体系统动力学 

虚拟样机技术是一门多学科综合的技术，它的核心部分是多体系统运动学与动力学建模

理论及其技术实现。多体系统是指由多个物体通过运动副连接组成的复杂机械系统。多体系

统动力学的根本目的是应用计算机技术进行复杂机械系统的动力学分析与仿真。它是在经典

力学基础上产生的新学科分支，在经典刚体系统动力学上的基础上，经历了多刚体系统动力

学和计算多体系统动力学两个发展阶段，目前已趋于成熟。 
对于由多个刚体组成的复杂系统，理论上可以采用经典力学的方法，即以牛顿-欧拉方

法为代表的矢量力学方法和以拉格朗日方程为代表的分析力学方法。这些方法对于单刚体或

者少数几个刚体组成的系统是可行的，但随着刚体数目的增加，方程复杂度成倍增长，寻求

其解析解往往是不可能的。后来随着计算机数值计算方法的出现，面向具体问题的数值方法

成为求解复杂问题的一条可行道路，即针对具体的多刚体问题列出其数学方程，再编制数值

计算程序进行求解。但是，对于每一个具体问题都要编制相应的程序进行求解，虽然可以得

到合理的结果，但是这个过程是非常繁琐的，于是寻求一种适合计算机操作的程式化的建模

和求解方法就变得非常迫切了。20 世纪 60 年代初期，在航天领域和机械领域，分别展开了

对于多刚体系统动力学的研究，并且形成了不同派别的研究方法。 
最具代表性的方法是罗伯逊-维登伯格（Roberson-Wittenburg）方法、凯恩（Kane）方法

和变分方法。 
罗伯逊与维登伯格于 1966 年提出一种研究多刚体系统动力学的普遍性方法，简称为 R/W

方法。该方法的主要特点是利用图论的概念描述多刚体系统的结构特征，使各种不同结构的系



第 1 章 
虚拟样机技术与 MotionView & MotionSolve 

 5 

统能用统一的数学模型来描述；以邻接刚体之间的相对位移作为广义坐标，导出适合于任意多

刚体系统的普遍形式动力学方程；引入增广体概念赋予动力学方程的系统以明确的物理意义且

使方程的形式简洁。由此得到的系统动力学方程是一组精确的非线性运动微分方程，在运动学

研究中还给出了各种有意义的运动量的表达式。R/W 方法以十分优美的风格处理了树结构多

刚体系统，对于非树系统，通过铰切割或刚体分割方法将非树系统转变成树系统进行处理。 
凯恩方法是建立一般多自由度离散系统动力学方程的一种普遍方法，其特点是以伪速度

作为独立变量描述系统的运动，兼有矢量力学和分析力学的特点，既适用于完整系统，也适

用于非完整系统。建立的动力学中不出现理想约束反力，也不必计算动能等动力学函数及其

导数，推导计算规范化，所得结果是一阶微分方程，便于计算机计算。 
变分方法使用高斯最小拘束来研究多刚体动力学问题。变分的力学原理并不直接描述机

械运动的客观规律，而是把真实发生的运动和可能发生的运动加以比较，在相同条件下所发

生的很多可能运动中找出真实运动所应满足的条件。因此该方法不需要建立系统的动力学方

程，而是以加速度为变量，根据拘束这个泛函的极值条件，直接利用系统在每个时刻的坐标

和速度值解出真实加速度，从而确定系统的运动规律。该方法的主要特点是可以利用各种有

效的数学规划方法寻求泛函极值，对于带控制的多刚体系统，动力学分析可以与系统的优化

结合进行。不论是树形的系统，还是非树形的系统，都可用同样的方法处理。 
这几种方法构成了早期多刚体系统动力学的主要内容，借助计算机数值分析技术，可以

解决由多个物体组成的复杂机械系统动力学分析问题。但是，相对于成熟的结构有限元分

析，多体系统动力学在建模与求解方面的自动化程度相差甚远。为此，美国的 Chace 和

Haug 于 20 世纪 80 年代提出了适宜于计算机自动建模与求解的多刚体系统笛卡儿建模方

法，并确立了“计算多体系统动力学”这门新的学科。 
计算多体系统动力学是指用计算机数值手段来研究复杂机械系统的静力学分析、运动学

分析、动力学分析以及控制系统分析的理论和方法。其具体任务如下： 
（1）建立复杂机械系统运动学和动力学程式化的数学模型，开发实现这个数学模型的软

件系统，用户只需输入描述系统的最基本数据，借助计算机就能自动进行程式化处理。 
（2）开发和实现有效的处理数学模型的计算方法与数值积分方法，自动得到运动学规律

和动力学响应。 
（3）实现有效的数据后处理，采用动画显示、图表或其他方式提供数据处理结果。 
计算多体系统动力学的产生极大地改变了传统机构动力学分析的面貌，使工程师从繁琐

的手工计算中解放了出来，只需根据实际系统建立合适的模型，就可由计算机自动求解，并获

得所需的结果。对于原来不可能求解或求解极为困难的大型复杂问题，都可利用计算机的强大

计算功能顺利求解。同时，多体系统动力学分析软件还为其他工程辅助设计或分析软件提供了

强大的接口功能，并与它们紧密联系在一起，形成了完整的计算机辅助工程（CAE）技术。 

1.3  MotionView & MotionSolve 简介 

国外的虚拟样机技术已走向商业化，目前比较有影响力的软件有美国机械动力学公司

（Mechanical Dynamics Inc，MDI。现已并入 MSC 公司）的 ADAMS（Automatic Dynamic 
Analysis of Mechanical System）机械系统自动动力学分析软件、比利时的 LMS 公司的
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Virtual.Lab Motion（其前身为 DADS）、德国航天局的 SIMPACK、美国 Altair 公司的

MotionView & MotionSolve 以及韩国的 Recurdyn 等。 
MotionView & MotionSolve 软件是美国 Altair 公司研发的新一代多体动力学软件。该软

件完全集成在 HyperWorks 平台中，为用户提供了强大的多体动力学前后处理、求解与优化

功能。MotionView 是一个通用的多体动力学仿真前处理器和可视化工具，采用完全开放的

程序架构，可以实现高度流程化、自动化的客户定制。MotionView 具有简洁友好的界面，

高效的建模语言（MDL），同时也是第一款支持多求解器的多体动力学前处理器，可以将模

型直接输出成 ADAMS、DADS、ABAQUS 和 NASTRAN 等多种求解格式文件，或直接由

MotionSolve 求解。MotionSolve 求解器是基于新一代的点辅助坐标系原理（Point-Auxilary-
Coordinate System）的多体动力学求解器，具有计算速度快、计算过程及结果稳定的特点，

适用范围广泛，可以处理机械系统动力学、车辆动力学、隔振、控制系统设计、针对耐久性

分析的载荷预期和稳健性仿真等多方面的问题，还可以对零自由度的机械系统和具有复杂非

线性应变的模型进行仿真。应用 MotionView & MotionSolve 可以建立任意复杂机械系统虚拟

样机，完成产品相关性能分析。 
具体来说，MotionView 和 MotionSolve 具有以下特征及优势： 

1.高效的前、后处理 

（1）MotionView 支持多种格式的数据文件输入/输出。输入文件包括如 Pro/E、CATIA、

UG、SolidWorks、step、iges 等主流的 CAD 格式模型，RADIOSS、Optistruct、NASTRAN、

ABAQUS、Dyna 等 FEA 格式模型以及试验数据文件等，创建完毕的模型可以提交 MotionSolve、
ADAMS、DADS、ABAQUS 和 NASTRAN 等求解器求解，广泛的模型的接口便于不同部门

之间的交流以及仿真平台建设。 
（2）MotionView 强大的图形处理功能支持任意复杂程度模型的创建，灵活的模型树功

能加上独有的可重用子系统功能使得模型管理非常便捷。模型树工具根据对象类型将当前会

话中的所有对象进行分类，便于对象查看与编辑，特别适用于大规模多体系统的前处理。会

话中任何现有模型在定义连接关系后都可以存储为子系统，子系统可以灵活调用和编辑，并

且通过子系统中的不同选项可以实现不同零部件系统的任意切换，实现系列产品的统一建模

和仿真。MotionView 模型树与复杂模型建模，如图 1-2 所示。 

 
图 1-2  MotionView 模型树与复杂模型建模 
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（3）MotionView 支持丰富的模型元素，如点、线、刚性体、柔性体等对象，平动副、转动副

等基本约束，点-曲面、点-曲线、曲线-曲线、齿轮副等高级约束以及包括用户定义的代数变量、

微分方程、线性和非线性空间描述以及传递函数等可以用来构建非机械零件的非机械元素。 
（4）MotionView 可定制行业模板，为企业开发专门仿真流程，极大提高新型产品研发

效率。MotionView 车辆动力学分析模板，如图 1-3 所示。 

 

图 1-3  MotionView 车辆动力学分析模板 

（5）MotionView 后处理采用多页面多窗口界面，可以通过流程自动化达到仿真结果处

理的一致性和标准化，支持在单个窗口中载入和叠加多个动画或曲线，从而方便比较不同设

计方案的分析结果。可以构造复杂的数学表达式，对工程数据进行解析和构图，并可采用交

互方式进行曲线标注、坐标轴、图例、图标和脚注的编辑。此外，通过内嵌的文本和数值处

理器可以创建高级注释。 

2.杰出的求解器 

（1）MotionSolve 支持五大类不同的解决方案，以保证工程师能够完整地分析模型。 
静态仿真可以用于获得静态的平衡系统状态和载荷。准静态仿真可以用于分析惯性力可

以忽略，而载荷变化非常缓慢的情况。运动学仿真可以用于预测零自由度系统的内力和运动

情况。MotionSolve 可以自动化且智能地删除任何系统中的冗余约束。动力学仿真则应用于

惯性力和阻尼力很重要且无法被忽略的情况。MotionSolve 提供了多种积分器来处理不同的

问题，并为用户提供了高级的积分器控制选项来调节计算性能和精度。MotionSolve 的动力

学解决方案支持刚柔耦合系统的分析。MotionSolve 还提供了两类线性化解决方案，在任何

一个操作点对非线性模型进行线性化。随后对线性化的模型计算特征值获取系统固有频率和

模态振型。MotionSolve 还允许用户定义模型输入和输出来计算系统状态矩阵，用于高级控

制系统设计。齿轮系统接触模拟如图 1-4 所示。复杂系统动力学分析如图 1-5 所示。 
（2）MotionSolve 支持刚柔耦合仿真分析。 
随着机械系统的设计日益复杂，机构运动过程中构件的变形对系统性能的影响越来越突

出，为此迫切需要一种考察构件变形影响的机构运动仿真技术。MotionSolve 刚柔耦合仿真

技术就能够实现这样的要求，应用模态综合技术（包括 Craig-Bampton 和 Craig-Chang 方
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法）描述柔性体，允许柔性体发生大的总体运动，在运动过程中可以根据模态振型和状态计

算构件的变形，求解后可在后处理中查看构件应力应变，进行结构强度验证。刚柔耦合分析

示例，如图 1-6 所示。 

              
                图 1-4  齿轮系统接触模拟         图 1-5  复杂系统动力学分析 

 
图 1-6  刚柔耦合分析示例 

3.强大的联合仿真能力 

（1）MotionView & MotionSolve 支持疲劳仿真分析。 
为考察构件在循环工况下的疲劳问题，MotionView 提供了完整的疲劳仿真分析流程。

整个流程可以 Altair HyperWorks 仿真平台中完成，也可以将多体系统仿真结果输出为 FES、
DAC 和 RPC 等格式，供疲劳分析软件使用。MotionView & MotionSolve 疲劳仿真分析流程

如图 1-7 所示。 

 

图 1-7  MotionView & MotionSolve 疲劳仿真分析流程 
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（2）MotionView & MotionSolve 支持机电联合仿真分析。 
MotionView 支持 MATLAB 和 DSHPlus 软件的联合仿真功能，其中 DSHPlus 软件可直

接使用 Altair 软件许可系统启动，用户无需额外增加费用就可以实现机、电、液或气等的联

合仿真，如图 1-8 所示。 

 

图 1-8  MotionSolve 联合 DSHPlus 进行机、电、液或气一体化仿真 

（3）MotionView & MotionSolve 支持机构优化分析。 
MotionView & MotionSolve 联合 HyperStudy 可以实现系统级的优化，如机械系统运动轨

迹、结构形状、零件尺寸等试验设计研究、优化分析等。联合 OptiStruct 可以进行零件级的优

化，使用 Altair 独有的等效静态载荷技术（ESL）进行诸如拓扑优化、形状优化、尺寸优化

等，实现零件形状、重量最优化。应用等效静态载荷技术进行结构拓扑优化，如图 1-9 所示。 

 

图 1-9  应用等效静态载荷技术进行结构拓扑优化 

MotionView & MotionSolve 软件作为新一代的多体动力学分析软件，为用户提供了方便、

易用、开放、全面的多体动力学分析平台。应用 MotionView & MotionSolve 软件可帮助企业

在方案制定阶段既对产品的多体动力学性能进行预测和分析，又能在方案设计阶段减少产品

设计缺陷，减少物理样机的实验次数，从而实现产品性能、周期和成本三者的有效平衡。目

前，对于 MotionView & MotionSolve 的使用，已经使众多机械制造企业从中获益。 
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1.4  应用MotionView & MotionSolve 软件进行虚拟样机设计的一般过程 

应用 MotionView & MotionSolve 软件进行虚拟样机设计的一般流程如图 1-10 所示。 

 

图 1-10   应用 MotionView & MotionSolve 软件进行虚拟样机设计的一般流程 

1.创建模型 

复杂机械系统模型主要由构件、约束、力等要素组成。 
（1）构件。构件分为刚性构件和柔性构件。刚性构件是几何形体在任何时候都不会发生

变形的物体，有质量属性和惯性属性。刚体的一种特殊形式是点质量体，仅有质量属性，没

有惯性属性。柔性构件是几何形体可发生改变的物体。 
（2）约束。约束分为运动学约束与驱动约束两种。运动学约束指将不同的部件连接在一

起的模型元素，如各种铰、齿轮约束、凸轮约束以及耦合副等。驱动约束规定了构件间相对

位置与时间的关系，如转动驱动、平动驱动。 
（3）力。分为作用力（力或力矩）、柔性连接力（衬套、场力、弹簧阻尼器、梁等）、特

殊力（重力）以及接触力四种。 
MotionView 中创建构件可以通过以下两种方式： 
1）根据构件的物理属性来创建。部件分为刚性部件和柔性体部件，对于刚体构件，

MotionView 通过定义刚体的质量、质心位置及转动惯量等信息创建物体，并使用基本几何

构造工具创建刚体所对应的外形；对于柔性体，可使用 MotionView Flextools 工具创建。 
2）导入三维造型软件建立的模型。在导入过程中，用户可以选择是否根据图形自动计
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算物体的质量、质心位置及转动惯量等信息。 

2.测试模型 

在创建模型之后或在创建模型的任何时刻，都可以进行仿真以测试模型。Altair 新一代

的基于点辅助坐标系的多体动力学求解器 MotionSolve 提供的运动学分析、动力学分析、静

态/准静态分析以及线性分析功能，可处理机械系统动力学、车辆动力学、隔振、控制系统

设计、针对耐久性分析的载荷预期和稳健性仿真等多方面的问题。应用 MotionView，可定

义测量感兴趣的信息，如构件上某个点的位移、速度、加速度、所受的力等。求解结束后，

可在后处理工具 HyperView 中查看机械系统运动历程动画，在 HyperGraph 中查看仿真结果

曲线。 

3.验证模型 

将物理试验获得的测试数据输入到 HyperGraph 中与 MotionSolve 求解获得的仿真数据进

行比较，可验证模型的正确性。另外，可将试验视频导入 MediaView 中，通过 HyperView 动

画同步功能与仿真获得的机构运动历程动画对比，可以更直观地验证仿真模型的正确性。 

4.细化模型 

在进行完最初的仿真以确定模型的最基本运动之后，可根据机械系统的实际工作状态，

细化模型。例如，考虑运动副间隙摩擦力的影响、考虑细长杆的柔性变形、定义完整的控制

系统、使用接触约束定义构件间的相对关系等。 

5.优化设计 

获得合理的仿真模型后，可测试初始设计方案是否达到设计要求。对于没有满足设计要

求的方案或已满足设计要求需要进行优化的方案，HyperWorks 为用户提供了两种优化流程：

MotionSolve 联合 HyperStudy 进行多体系统级优化与 MotionSolve 联合 OptiStruct 进行多体系

统零件级优化。系统级优化可实现机械系统运动轨迹、结构形状、零件尺寸等试验设计研究

（DOE）、优化分析等，而零件级优化应用 Altair 独有的等效静态载荷技术可实现结构在运动状

态下的拓扑优化、形貌优化、自由尺寸优化、尺寸优化、形状优化和自由形状优化。 

6.客户定制 

针对某个系列产品开发，企业用户可以考虑创建分析向导，通过定义模型库、分析工况

库以及分析结果输出模板等，可以快速完成产品改型设计方案的虚拟测试。另外，

MotionView 基于 TCL 语言的命令行界面可以实现所有面板的操作功能，实现对操作对象的

控制。利用 Altair Process Manager 可将 TCL 与 MDL 语言组合起来，创建标准的流程界面，

将产品完整的虚拟样机设计流程固化下来，从而实现流程的标准化和自动化。 

1.5  小结 

通过对虚拟样机技术、多体动力学及分析软件 MotionView & MotionSolve 简介的讲解，

读者应对虚拟样机技术及机械系统动力学分析仿真技术的内容及发展有了较深入的了解，对

应用 MotionView & MotionSolve 进行虚拟样机设计的基本流程有了一定的认识。接下来将开

始学习如何使用 MotionView & MotionSolve。 
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第 2章     

 MotionView 基本知识 

MotionView 是一款通用多体系统动力学分析前处理器，除了提供强大的多体系统建模功能

外，还集成了仿真、优化分析功能，其创建的多体系统模型不但可以提交 Altair 自有求解器

MotionSolve 求解，也可供第三方求解器使用。通过本章的学习，可以对 MotionView 的主要功

能及操作步骤有一定的了解。 

本章重点知识 
 
 

2.1  MotionView 入门 

2.2  文件管理 

2.3  模型显示控制 

2.4  窗口布局及页面控制 

2.5  单位设置 

2.6  重力设置 

2.7  建模工具 

2.8  偏好设置 

2.9  初识 MotionView 界面 

2.10  小结 
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2.1  MotionView 入门 

2. 1.1  启动 MotionView 

在 Windows 操作系统上打开 MotionView 软件可通过以下任一种方式： 
●  选择“开始”→“所有程序”→Altair HyperWorks→MotionView 命令。 
●  单击桌面上的 MotionView 快捷方式图标。 
在 UNIX 操作系统上打开 MotionView 软件可以通过以下步骤： 
1）打开操作系统终端程序。 
2）输入 MotionView 软件的完整路径并按<Enter>键。 

2. 1.2  MotionView 工作界面 

MotionView 工作界面如图 2-1 所示。 

 

图 2-1  MotionView 工作界面 

（1）标题栏（Title Bar）：位于界面顶端，显示当前软件的版本信息。 
（2）图形区（Graphics area）：显示模型的区域，可以显示刚体模型、柔性体模型、XY

曲线图以及结果图等。 
（3）工具栏（Toolbar）：位于图形区的上下边缘，应用这些按钮可快速进入常用功能面板。 
（4）菜单栏（Menu Bar）：将功能按组分类，包含 MotionView 的所有命令。 
（5）主菜单（Main menu）：显示了该页面菜单下的所有可用功能。 
（6）命令窗口（Command window）：支持 TCL 命令输入和执行，通过 View 菜单设置显

模型浏览树 

命令窗口

主菜单 

图形区
工具栏 

菜单栏

状态栏 

标题栏
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示（默认不显示）。 
（7）状态栏（Status bar）：显示当前操作状态。 

2.2  文件管理 

2. 2.1  模型打开与保存 

多体系统模型文件由 MDL（Model Definition Language）描述。这些模型文件可由

MotionView 的 File 菜单或标准工具栏中的 Open Model 和 Save Model 按钮打开和保存。 

1.打开模型文件 

（1）通过下述方式选择和打开多体系统模型文件。 
从 File 菜单中选择 Open→Model（见图 2-2）或单击标准工具栏中的Open Model 按钮 。 

 
图 2-2  从 File 菜单中选择 Model 

注意：如果当前工具栏中未显示 Open Model 按钮，可在 View 菜单中选择 Toolbars→
HyperWorks→Standard，此时将弹出标准工具栏，如图 2-3 所示。 

（2）在弹出的 Open Model 对话框中，选择希望打开的 mdl 文件并单击 Open 按钮，如

图 2-4 所示。 

    
           图 2-3  激活工具栏                            图 2-4  打开 MDL 文件 
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此时，模型将载入到当前 MotionView 图形区。 

2.保存模型 

（1）从 File 菜单中选择 Save→Model 命令（见图 2-5）或单击标准工具栏上的 Save Model
按钮 。 

 
图 2-5  从 File 菜单中选择 Model 

（2）在 Save As Model 对话框中指定待保存的文件名称并单击 Save 按钮，如图 2-6 所

示。 

 
图 2-6  Save As Model 对话框 

此时，模型将以指定名称保存至指定目录下。 

3.另存模型 

（1）从 File 菜单中选择 Save As→Model 命令。 
（2）在 Save As Model 对话框中指定待保存文件名称并单击 Save 按钮。 
此时，模型将以指定名称另存文件。 
注意：模型打开和保存操作中，都存在 Model 和 Session 选项。Session 选项表示打开或

保存整个会话，会话中可能仅包含一个模型，也有可能是多个应用程序的多个模型；而

Model 选项则是仅打开或保存当前界面中的模型。 

2. 2.2  模型输入/输出 

MotionView 模型输入/输出功能可读入和导出模型向导库模型、MDL 数据文件或由前两
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种文件合并得到的 MDL 文件。 

1.模型输入 

从模型向导库中读入模型时，MDL 文件应满足下述要求： 
●  该文件应是一个输出（Export）的 MDL 文件，而不是保存的（Save）MDL 文件。 
●  该文件在*BeginWizardSelections 数据块中应包含向导选择信息。 
●  该文件的系统选择信息必须与模型向导文件指定的子系统变量名一致。 
模型输入过程如下： 
（1）从 File 菜单中选择 Import→Model 命令（见图 2-7）或单击标准工具栏中的 Import 

Model 按钮 。 

 

图 2-7  从 File 菜单中选择 Model 

（2）在 Import Model 对话框中，通过 Selectfile 按钮 选择相应的 MDL 文件，如图 2-8
所示。 

 

图 2-8  Import Model 对话框 

此时，MotionView 将验证该文件的合法性，并自动打开或关闭相关功能选项。 
选择合适的输入选项（Import Options）。 
●  Data and wizard selections：根据模型向导库创建模型，当前 MotionView 会话中已有

MDL 模型将被删除。 
●  Data only：根据新模型数据替换 MotionView 会话中已有 MDL 模型数据。模型输入

前，MotionView 需载入相关的模型以保证该功能的正常使用。 
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●  Wizard selections only：根据模型向导库创建模型，当前 MotionView 会话中已有

MDL 模型将被删除。 
（3）单击 Import 按钮。 

2.模型输出 

模型输出应满足以下条件： 
●  当前 MotionView 会话中包含模型数据。 
●  如果使用模型向导输出模型，该模型必须来自于模型向导库（应用 Import Model 功

能或 Model→Assembly Wizard 创建的模型）。 
模型输出过程如下： 
（1）从File 菜单中选择Export→Model 命令（见图 2-9）或单击标准工具栏中的Export Model

按钮 。 

 
图 2-9  从 File 菜单中选择 Model 

（2）在 Export Model 对话框中，通过 Selectfile 按钮 指定模型输出的路径及名称，如

图 2-10 所示。 

 

图 2-10  Export Model 对话框 

此时，MotionView 将检查指定信息的合法性，并自动打开或关闭相关功能选项。 
选择合适的输出选项（Export Options）。 
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●  Data and wizard selections：输出模型向导库选择信息以及相关的数据信息。 
●  Data only：仅输出模型的数据信息。 
●  Wizard selections only：仅输出模型向导库选择信息。 
（3）单击 Export 按钮，输出模型。 

3.从求解器接口输入模型 

目前 MotionView 定义了 ADAMS 求解器接口。使用该功能输入模型时，当前 MotionView
会话中的模型将被清除，并根据输入数据创建新模型。 

（1）从 File 菜单中选择 Import→Solver Deck 命令（见图 2-11）或单击标准工具栏上的

“从求解器接口输入”按钮 。 

 

图 2-11  从 File 菜单中选择 Solver Deck 

（2）在 Import Solver Deck 对话框中，通过 Selectfile 按钮 选择希望输入的 ADAMS
（*.adm）文件，如图 2-12 所示。 

 

图 2-12  Import Solver Deck 对话框 

若选中 Load standard include 复选框，则将自动加载 MDL 模型标准库文件。 
（3）单击 Import 按钮，此时 ADAMS 文件将被输入。 

4.从求解器接口输出模型 

（1）从 File 菜单中选择 Export→Solver Deck 命令（见图 2-13）或单击标准工具栏上的

“从求解器接口输出”按钮 。 
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图 2-13  从 File 菜单中选择 Solver Deck 

注：后续对话框将根据所选求解器不同而不同。 
（2）在 Export Solver Deck 对话框中，通过 Selectfile 按钮 指定模型输出路径及名称，

如图 2-14 所示。 

 

图 2-14  Export Solver Deck 对话框（MotionSolve 求解器） 

选择合适的输出选项（Export Options），如图 2-15 所示。 

 

图 2-15  Export Solver Deck 对话框（ADAMS 求解器） 
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●  Analysis：选择希望输出的分析工况。该选项在模型含有多种分析工况时有效。 
●  Write MDL animation file （.maf）：创建压缩的 MDL 文件，仅用于 HyperView。 
●  Export .mtx paths as：可以选择 MTX 文件的输出路径为绝对路径还是相对路径。

MTX 文件是求解器接口在输出包含柔性体的模型时输出的矩阵文件。 
（3）单击 Export 按钮，输出模型。 
模型输入/输出应注意的内容如下： 
1）对于 ADAMS ADM 文件，模型输入后，MotionView 将其转换成 MDL 模型。如果

ADAMS 模型中某些对象没有相应的 MDL 对象匹配，则这些对象将在 Templex template 中

描述。由 ADAMS 模型创建的 MDL 文件没有等级关系。在默认情况下，MotionView 为

ADAMS 模型的每个对象创建 MDL 对象，因此这种 MDL 模型比一般的 MDL 模型会多出多

个几何点（Point）和标记点（Marker）。 
2）如果 ADAMS 模型含有用户子程序，传递给用户子程序的参数需要手动修改，因为模型

转换时模型将重新编号。类似地，如果将模型输出到其他求解器，Templex template 的内容需要

根据目标求解器重新编写。Templex template 中存储的模型拓扑关系语句也需要特别注意。使用

ADAMS 求解器接口时，Templex template 将用于保存 MDL 不支持的 ADAMS 对象。 
3）输入 ADAMS 模型时，用户可以选择是否保留 MDL 标准库。如果选择保留，包含

在 std_inc 文件中的设置将自动输入到当前模型中。在默认情况下，ADAMS 模型中包含单位

制和重力设置，标准库不需要输入。MotionView 将根据 ADAMS 模型中单位制的定义自动

修改 MDL 模型单位制，而重力的设置将加载到 Templex template 中。如果输入了 MDL 标准

库，将有可能在 ADAMS 模型输出时重复定义单位制和重力。 
4）如果 MotionView 进行模型保存时没有选择 Embed standard include，并且在后续该模

型输入时没有激活 Load standard include 功能，那么 MotionView 将弹出警告窗口，提醒用户

没有单位制和重力定义。 

2.3  模型显示控制 

2. 3.1  项目浏览树 

项目浏览树（或称模型浏览树）位于 MotionView 界面标签区域（见图 2-16），支持

MotionView 模型的全局查看并提供对象显示和编辑控制功能。项目浏览树中包含两种文件

夹：系统文件夹 和对象文件夹 。系统文件夹包含对象文件夹和子系统文件夹。对象文

件夹则包含特定的对象类型，如弹簧、铰链等。 
项目浏览树可由 View 菜单的 Browsers→MotionView→Project 命令打开或关闭。对勾符

号表示在标签区域激活项目浏览树。 
注：项目浏览树可放在 MotionView 右侧标签区域。 
项目浏览树有以下特点： 
●  当前 MotionView 会话中所有系统和对象全部列于树中。 
●  相同类型的对象将保存在同一个对象文件夹中。 
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图 2-16  项目浏览树 

●  文件夹可以展开或关闭以控制文件夹内容的显示或隐藏。 
●  在某些情况下，对象的颜色和显示类型也出现在项目浏览树中。  
●  快捷菜单（Context Sensitive Menu）提供了系统/对象文件夹快速展开/关闭、新建对

象、剪切和粘贴对象文件夹以及模型信息查看等功能。 

1.快捷菜单说明 

在项目浏览树中右键单击文件夹或对象将弹出快捷菜单，如图 2-17 所示。该菜单功能

列表取决于当前所选的对象，只有与所选对象相关的功能才会出现。在项目浏览树的空白位

置右键单击弹出的编辑菜单将作用到整个模型。 

 

图 2-17  项目浏览树快捷菜单 
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●  Expand All Children：打开所有子文件夹，将该文件夹下的各级对象全部展开。 
●  Collapse All Children：关闭所有子文件夹，只显示有所选系统文件夹名称。 
●  Save All：打开 Save Model As 对话框。 
●  Save Only：打开 Save Model As 对话框。 
●  Save As：打开 Save Model As 对话框。 
●  Activate：激活已失效的对象。 
●  Deactivate：失效所选对象。 
●  AddEntity：新建对象，弹出的对话框名称取决于所选对象的类型，如 Add Body or 

BodyPair。 
●  Add System/Analysis：新建系统，该系统可来自于当前 MotionView 会话、MDL 文件

或关联对象。 
●  Add Reference Entity：新建对象，如几何点、体、向量、标记点、曲线、图形、曲

面、变形曲线或变形曲面。 
●  Add Constraint：添加约束，如基本副、高级副、耦合副、齿轮或驱动约束。 
●  Add Force Entity：添加力对象，如场力、衬套、弹簧阻尼、梁、多段梁、力或接触。 
●  Add Control Entity：添加控制对象，如传感器、结果输出、控制模板、数据库、求解

变量、求解序列、求解字符串、控制输入/输出或差分方程。 
●  Add General MDL Entity：添加基本的 MDL 对象，如结果输出、控制模板或数据库。 
●  Add System：添加系统，如空白系统、文件输入的系统或取代当前系统。 
●  Rename：系统/对象重命名。 
●  Delete：删除所选对象。 
●  Cut：剪切所选对象。 
●  Paste：在项目浏览树范围内粘贴已剪切的对象。 
●  Show/Hide ID、Show/Hide Color、Show/Hide Mesh：显示或隐藏所选对象的编号、颜

色、网格显示信息。 
●  Data Summary：显示所选系统/对象数据列表。 

2.视图控制 

下列选项控制项目浏览树中显示对象的范围。 
●  View all types：显示当前 MotionView 会话中所有对象类型。 
●  View selected type：仅显示当前激活的对象类型。 

3.对象生效/失效控制 

MotionView 中的对象有两种状态：生效状态和失效状态。在求解过程中，MotionSolve
使用分析模型中所有处于活动状态的对象，忽略所有失效状态的对象。例如，用铰连接的两

个构件，如果对铰进行失效处理，则两个构件之间没有铰约束限制。在默认情况下，所有对

象都处于生效状态。对象的生效和失效功能，在模型仿真调试时非常有用。 

4.对象选择 

项目浏览树提供了强大便捷的系统/对象查询、编辑功能。在项目浏览树中单击某个
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系统或对象时，该系统或对象将在图形区高亮显示，并且主菜单区域将进入该对象的编

辑面板。 
（1）在项目浏览树中选择对象。 
●  在项目浏览树中选择某对象，该对象在图形区高亮显示。 
●  使用<Ctrl>键配合鼠标左键，在项目浏览树或图形区选择多个对象。 
●  使用<Shift>键配合鼠标左键，在项目浏览树中选择多个对象。 
●  在项目浏览树中右键单击某对象，该对象在图形区高亮显示同时弹出快捷菜单。 
（2）在图形区选择对象。单击工具栏中的对象建模图标，然后在图形区单击对象，此

时主面板进入该对象的编辑面板，同时打开项目浏览树中相应对象的文件夹，并高亮显示

该对象。 

5.显示控制 

项目浏览树的显示控制按钮（ID、Colors 和 Mesh/Shade）可以控制图形区对象的显示

属性。 
（1）编号（ID） 
编号列表显示了每个对象的编号，这些编号不可修改。在项目浏览树中新建的对象编号

只有在模型检查（Tools→Check Model）后才会加载。 
（2）颜色（Colors） 
系统和对象可被单独赋色。应用项目浏览树可以设定对象的颜色（也可在图形对象属性

面板设定）。已指定的对象颜色将在颜色列表中显示出来。在当前颜色按钮上单击鼠标右

键，选择 Change Color 命令，然后在弹出的 Colors/Materials 对话框中选择新颜色，单击 OK
按钮即可改变对象的颜色。 

（3）网格/渲染（Mesh/Shade） 
对象有多种显示状态，当前显示状态取决于其单元和几何模型的显示形式。右键单击

Mesh 列表中的按钮，选择 Change Mesh Style 命令，然后在弹出的 Mesh/Shade 对话框中选择

新的显示形式即可修改对象的显示状态。 
1）Mesh：控制对象以网格线 、特征线 、边界线 或无线 形式显示。单击图形按

钮选择相应的显示方式。 
2）Shaded：控制对象以渲染模式 或线框模式 显示。 
3）Opaque：控制对象以透明或不透明显示。 
●  单击 ，设置对象不透明显示。 
●  单击 ，设置对象以指定材料的颜色显示。 
●  单击 ，设置对象透明显示。 

2. 3.2  视角控制 

模型视角控制可通过标准视图（Standard Views）工具栏、三维视图控制（3D View 
Controls）工具栏以及鼠标实现。 

（1）标准视图工具栏，如图 2-18 所示。 
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图 2-18  标准视图工具栏 

标准视图工具栏的按钮名称及功能，如表 2-1 所示。 

表 2-1  标准视图工具栏的按钮名称及功能 

按    钮 按 钮 名 称 功    能 

 Fit Model 设置图形区模型最大化 

 Previous View 返回上一视图 

 XY Top Plane View 设置 XY 平面上视图 

 XY Bottom Plane View 设置 XY 平面底视图 

 XZ Left Plane View 设置 XZ 平面左视图 

 XZ Right Plane View 设置 XZ 平面右视图 

 YZ Rear Plane View 设置 YZ 平面后视图 

 YZ Front Plane View 设置 YZ 平面前视图 

 Isometric View 设置轴向视图 

 Reverse View 设置翻转视图 

 User Views 定义保存用户视图 

（2）三维视图工具栏，如图 2-19 所示。 

 

图 2-19  三维视图工具栏 

三维视图工具栏的按钮名称及功能，如表 2-2 所示。 

表 2-2  三维视图工具栏的按钮名称及功能 

按    钮 按 钮 名 称 功    能 

 Zoom 局部放大模型 

 Circle/Dynamic Zoom 全局放缩模型 

 Dynamic Rotate/Spin 动态旋转模型 

 Pan 平移模型 

 Rotate Left/Right 左右旋转模型 

 Rotate Up/Down 上下旋转模型 

 Rotate lockwise/counterclockwise 正时针/逆时针旋转模型 

（3）鼠标操作。 
鼠标控制是视角控制的推荐操作方法。配合键盘上的<Ctrl>键，鼠标可实现旋转、放
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缩和平移等操作。 
鼠标控制具体说明如表 2-3 所示。 

表 2-3  鼠标控制具体说明 

按    钮 鼠标操作，配合<Ctrl>键 功    能 

拖动 旋转 

单击模型 改变旋转中心  

单击图形区 将旋转中心恢复到图形区中心 

拖动 放缩模型 
 

单击 图形区模型最大化 

 拖动 平移 

2. 3.3  图形对象显示控制 

图形对象属性（Graphic Entity Attributes）面板提供了图形对象的显示控制功能，可实现

诸如图形渲染或线框显示、变更颜色、网格线显示等操作。该面板由对象列表树、对象属性控

制区和调色板 3 个部分构成。单击工具栏中的图形对象属性按钮 即可进入该面板，如图 2-20
所示。 

 

图 2-20  图形对象属性面板 

（1）对象列表树。 
对象列表树将显示模型中所有图形对象。在默认情况下，该目录指定为图形（Graphic），

单击左侧三角符号可以切换目录的类型。图形对象将根据所选的目录类型组织分类，如图 2-21
所示。 

 

图 2-21  对象列表树 

面板按钮功能如下。 
●  All：选择列表中的所有对象。 
●  None：取消选择列表中的所有对象。 



MotionView & MotionSolve 
应用技巧与实例分析 

 26 

●  Flip：反选当前选择的对象。 
●  Clear：清除列表内容。 
MotionView 图形对象是对模型的虚拟显示。图形对象分为基本图形（如圆台、锥体、

球体等）和用户自定义图形两种。修改图形对象属性时，首先需要从对象列表树或图形区选

择图形对象，所有的属性操作仅对选中的对象有效。 
对象列表树中的对象支持单选和多选。在对象类型菜单中指定一个对象类型后，只有与该

类型相关的图形的对象才能被选中。例如，对象类型菜单选择为 Body，只有与 Body 有关的图

形才能被选中。在图形区单击某个图形对象时，该对象高亮显示，同时显示在对象列表树中。 
（2）对象显示控制选项。 
1）Auto apply：从图形区或对象列表树中选择图形对象后，自动应用指定的显示控制设置。

每次鼠标操作只进行一次属性更改。单击Auto apply 左侧的复选框可以激活或取消该功能。 
2）Display：控制所选对象的显示或隐藏。 
3）ID：控制所选对象编号的显示或隐藏。 
4）Use In Fit：控制图形对象最大化显示。 
5）Mesh mode：控制对象以网格线 、特征线 、边界线 或无线 形式显示。单击

图形按钮选择相应的显示方式。 
6）Shaded：控制对象以渲染模式 或线框模式 显示。 
7）Opaque：控制对象以透明或不透明显示。 
●  单击 ，设置对象不透明显示。 
●  单击 ，设置对象以指定材料的颜色显示。 
●  单击 ，设置对象透明显示。 
8）Implicit Graphics：激活 Implicit Graphics Setting 对话框。该对话框提供了对象显示控

制功能，如对象的显示或隐藏、对象大小（相对于整体模型还是图形区）及对象颜色等。 
9）Color：设置图形对象颜色。调色板含有 64 种颜色，单击某个颜色，图形对象立即

变为该颜色。 
10）Material：提供了更精确的图形颜色显示。该选项仅用于控制图形对象的颜色和光

学敏感性。调整材料的光学性能，能使图形对象的显示更加逼真。 
11）Property：显示所选材料的光学性能。 
12）Add：新增一种材料属性。 
13）Delete：删除一种材料属性（只有用户自定义材料属性才可删除）。 

2.4  窗口布局及页面控制 

MotionView 窗口布局及页面控制由 PageControls 工具栏设定，如图 2-22 所示。表 2-4
列出了各按钮的功能。 

 
图 2-22  PageControls 工具栏 
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表 2-4  PageControls 工具栏各按钮的功能 

按    钮 按 钮 名 称 功    能 

 Previous Page 显示前一页面 

 Next Page 显示后一页面 

 Add Page 在当前会话中增加一个页面，并使之为当前页面 

 Delete Page 删除当前页面，并使其后一页面为当前页面 

 Window Layout 设定当前页面中窗口布局形式 

/  Expand/Reduce 
将某窗口扩展至全屏或将某扩展窗口还原到原始大小。两个按钮共

享一个图标位置，单击 ，窗口扩展至全屏，同时该按钮变为  

 Left Only 将当前活动窗口模型与所选窗口模型交换 

/  Window Synchronization 设置窗口同步 

2.5  单位设置 

MotionView 提供了 6 个基本的度量单位：长度（Lnegth）、质量（Mass）、时间（Time）、
力（Force）、角度（Angle）、频率（Frequency），如表 2-5 所示。 

表 2-5  MotionView 度量单位 

量    纲 可使用的度量单位 

长度（Length） Millimeter，Centimeter，Meter，Kilometer，Inch，Foot，Mile 

质量（Mass） Milligram，Gram，Kilogram，Megagram，Pound_mass，Kpound_mass，Ounce_mass，Slug 

时间（Time） Millisecond，Second，Minute，Hour 

力（Force） Newton，Knewton，Milligram_force，Kilogram_force，Dyne，ounce_force，Pound_force， 

角度（Angle） Radius，Degree 

频率（Frequency） Hertz 

展开项目浏览树的 Form 文件夹，单击 Units 项目，将进入单位设置面板，如图 2-23 所

示。建模时，可根据模型需要，指定合适的度量单位。 

 
图 2-23  单位设置面板 

2.6  重力设置 

在默认情况下，MotionView 定义 1G（9810mm/s2
）的-Z 向重力加速度。根据模型需

要，用户可以修改重力加速度的大小和方向，也可控制其开闭。展开项目浏览树的 Form 文

件夹，单击 Gravity 项目，即可将进入重力加速度设置面板，如图 2-24 所示。修改时注意当

前使用的单位制。 
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图 2-24  重力加速度设置面板 

2.7  建模工具 

2. 7.1  模型转换工具 

MotionView CAD 接口调用 HyperMesh CAD 输入引擎。MotionView 支持多种类型的 CAD
和 FE 模型的导入。模型输入时，MotionView 在后台启动 HyperMesh，输入 CAD 模型并保存

到各个组件集中，然后对输入的 CAD 模型进行网格划分并输出到一个特定的可由 MotionView
显示的 H3D 图形文件中。模型在输入 MotionView 时，每个组件将视为一个体（body）。该体

的质量和转动惯量属性可由 MotionView 计算，也可根据实际模型自行输入。该输入工具能够

启动 HyperMesh，进行交互式的网格划分或选择节点输出为 MotionView 几何点。 
接下来将描述 MotionView CAD 接口的基本用法。 
从 Tools 菜单中选择 Import CAD or FE，弹出 Import CAD or FE 对话框，如图 2-25 所示。 
Import CAD or FE 对话框包含下述选项和功能。 
（1）输入选项（Import Options）。 
1）Import CAD or Finite Element Model With Mass and Inertias：输入 CAD 或 FE 模型时

计算体的质量和转动惯量信息。 
2）Import CAD or Finite Element Model Only：仅输入图形。 
●  Do not import into currently active window（save to output file only）：后台转换 CAD

模型至 H3D 格式图形文件，转换后的文件不输入到当前 MotionView 窗口中。 
●  Create one graphic per CAD component：为每个体创建一个单独的 H3D 格式图形文

件，否则所有体的图形均存储在一个 H3D 文件中。 
（2）输入/输出文件（Input/Output Filenames）。 
1）Input File：指定待转换的 CAD 或 FE 文件。使用下拉按钮选择相应的文件格式。 
2）Output Graphic File：指定包含图形信息的 H3D 文件名称。 
（3）MDL 选项（MDL Options）。 
1）Place data in System：将生成的 MDL 数据放置于一个特定的系统中。 
2）Place data in new system：将生成的 MDL 数据放置于一个新系统中。 
3）Point Varname Prefirx、Body Varname Prefirx or Graphic Varname Prefix：指定待创建的几

何点、体和图形变量名的前缀。 
4）Import free points if available：模型中的自由几何点将被输入为 MDL 几何点。 
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图 2-25  Import CAD or FE 对话框 

（4）曲面网格划分选项（Meshing Options for Surface Data）。 
1）Allow HyperMesh to specify mesh options：该选项允许 HyperMesh 使用默认的设置划

分网格。 
2）Launch HyperMesh to create MDL points：使用一个特定的宏命令启动 HyperMesh，在

此期间可以选择并转换有限元模型中的节点为 MDL 几何点。 
3）Interactive mesh（launches HyperMesh）：启动 HyperMesh 并自动载入模型文件，进

行交互式网格划分，通过专门的宏命令创建 MDL 几何点。 
（5）定位参考点（Locator Points）。 
None/Coordinates/Node Ids：指定 H3D 图形文件中几何模型的定位参考点。在 MDL 模

型输入过程中，这 3 个几何点可与 MDL 几何点进行匹配。用户可以根据这 3 个几何点进行

模型的定位和放缩，对于 HyperMesh 文件，节点编号等同于几何点坐标信息。 
注： 
1）Import CAD/FE with Mass/Inertia 选项支持CATIA、HyperMesh、Optistruct、NASTRAN、

Pro/E 和 STEP 文件格式。 
2）Import CAD/FEonly 选项支持 Abaqus、ACIS、Ansys、DXF、Ideas、IGES/IGS、

JT、LS-Dyna、Madymo、Marc、Pamcrash2G、Parasolid、PDGS、Permas、RADIOSS、
SolidWorks、UG、VDAFS 文件格式。 
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3）如果在Meshing Options for Surface Data 处选中 Interactive Mesh （launches HyperMesh）
单选按钮，将启动 HyperMesh 并自动载入模型文件。如图 2-26 所示，HyperMesh 左侧浏览

器区域的 Utility 标签包含了控制 MotionView 模型输入的多种工具，如自动划分模型所有

面、选择节点输出为 MDL 几何点等。同时，用户可以使用 HyperMesh 的其他通用功能，如

几何模型编辑，网格划分或组件整理等。所有操作完毕后，使用 Utility Browser 下的 Save 
and Quit 工具保存模型并返回到 MotionView 中。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

图 2-26  HyperMesh 交互式网格划分 

4）如果选中 Import CAD or Finite Element Model With Mass and Inertias 单选按钮，在模

型输入过程中将弹出如图 2-27 所示的对话框。该对话框列出了各个体的体积与质量信息，

并提供了输入文件单位制的设定选项，用于获得正确的质量和转动惯量信息。单击 OK 按

钮，即可完成 CAD 或 FE 模型的转换。 

 
图 2-27  模型导入时质量计算验证窗口 
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5）一些 CAD 格式模型（如 CATIA 和 UG）需要额外的 CAD 接口许可证和模型库设置。 
6）密度设定仅用于模型输入过程。输入转换完毕，这些属性将无法改变，体的体积信

息也不可用。 
7）有限元模型的质量/转动惯量信息和质心位置与网格模型的粗糙程度有很大关系。 
8）网格模型仅用于刚性体的图形显示，网格质量不作要求。 
9）该接口适用于中等规模的 CAD 模型（约 100 个组件），超大的 CAD 装配体模型输

入可能存在内存不足的问题。 

2. 7.2  几何建模工具 

MotionView 提供了丰富的几何建模工具，表 2-6 描述了工具栏中各几何建模按钮的基

本功能。单击 View 菜单中的 Toolbars→MotionView 命令，可以控制工具栏的打开或隐藏。

工具栏可以浮动，用户可以根据需要指定它的位置。 

表 2-6  几何建模工具按钮及说明 

鼠标操作执行功能 
按    钮 

单    击 右    击 

 进入 Point 面板 创建几何点 

 进入 Body 面板 创建几何体 

 进入 Vector 面板 创建矢量 

 进入 Marker 面板 创建标记点 

 进入 Curve 面板 创建曲线 

 进入 Graphic 面板 创建图形 

 进入 Surface 面板 创建曲面 

 进入 deformable Curve 面板 创建变形曲线 

 进入 deformable Surface 面板 创建变形曲面 

几何建模面板还可以通过下拉菜单及项目浏览树打开，如图 2-28 所示。 

 
                                      a）                              b） 

图 2-28  几何建模面板打开方式 

a） 下拉菜单  b） 项目浏览树 
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（1）几何点（Point）。 
几何点是创建几何体或其他对象的基础。创建几何体或其他对象时，选择参数化的几何

点，可实现系统的参数化设计。Point 面板可用来新建几何点或修改几何点坐标，如图 2-29
所示。每个几何点包括 X、Y、Z 三个坐标。在属性（Properties）标签中，实数或数学表达式

均可作为点坐标输入。在这里，几何点可以单独创建也可以成对创建。 

 
图 2-29  几何点面板 

在默认情况下，几何点对以 XZ 平面为对称面且左侧几何点为主点。在几何点对中，只

有主点可以编辑，编辑后的数据将自动更新到右侧几何点。单击 Left 和 Right 标签可以进行

左右几何点的坐标切换。属性标签里的 Symmetric properties 复选框用于打开或关闭几何点对

称属性。如果关闭对称属性，则左右几何点均可独立编辑。如果希望打开对称属性，则要求

选择主点。Get coordinates from node 按钮可根据某个点坐标定义几何点。 
几何点可在几何点面板逐个创建也可以在数据表（DataSummary）的几何点标签中批量

编辑。单击几何点面板上的 Data Summary 按钮 可直接进入数据表的几何点标签，

如图 2-30 所示。 

 
图 2-30  几何点数据表 

测量标签（Measure）可以测量模型中两点间的距离。测量时，在 Select first/Point 和

Select second/Point 中分别选择第一个几何点和第二个几何点，X、Y、Z 区域将显示上述两

个几何点在 X、Y、Z 轴的距离分量。MAG 为两几何点的距离值，如图 2-31 所示。 

 
图 2-31  几何点面板测量标签 
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应用几何点面板添加几何点可以通过下述步骤实现： 
1）在项目浏览树中选择待创建几何点的系统。在系统或几何点文件夹处右键单击选择

Add Reference Entity→Point，或从 Model 下拉菜单中选择 Reference Entity→Point，或在工具

栏中右键单击几何点按钮 ，进入 Add Point or Point Pair 对话框。 
2）指定几何点名称，该名称可在后续操作中更改。 
3）指定几何点变量名，该变量名在后续操作中不可更改。 
4）如果创建单几何点，则选择 Single；如果创建几何点对，则选择 Pair。 
5）单击 OK 按钮。 
此时几何点添加到指定系统中，默认几何点坐标为（0，0，0）。 
此外，还有以下两种几何点创建方式： 
1）编辑 MDL 文件。 
① MotionView 中几何点可由*Point（ ）和*SetPoint（ ）描述。打开 MDL 文件参照图 2-32

所示第 17 行和第 18 行的语句添加几何点。 

 
图 2-32  MDL 文件示例 

② 添加几何点如下： 

*Point（ p_1， "Point 1" ） 
*SetPoint（ p_1，             10， 10， 0 ） 

③ 保存并关闭 MDL 文件。 
④ 打开 MotionView，将该 MDL 文件载入。 
⑤ 在项目浏览树中单击 Point 1，此时主面板将自动进入几何点面板并显示该点坐标。 
2）使用几何点批处理创建脚本。 
① 打开 chap03 目录中的 point_data.csv 文件，编辑几何点数据文件。 
② 根据该表输入待创建的几何点坐标。 
③ 保存并关闭该文件。 
④ 从 View 下拉菜单中单击 Command window 进入命令窗口。 
⑤ 如图 2-33 所示，在命令窗口中右击鼠标选择 File→Load File 命令，并在弹出的 Source 

File 对话框中选择 chap03 目录中的 Point_Import.tcl 文件。 
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图 2-33  加载几何点批处理创建脚本 

⑥ 在弹出的几何点数据文件浏览窗口中，选择编辑好的几何点数据文件（CSV 文件）。 
⑦ 此时 MotionView 将自动加载几何点数据文件中的几何点信息。 
（2）几何体（Body）。 
MotionView 可创建刚性体、柔性体、点质量以及大地 4 种类型的几何体。其中大地没

有质量和速度，自由度为零，且任何时候都保持静止。大地定义了全局坐标系的位置，是所

有构件位移、速度及加速度的惯性参考系。 
应用体面板可以创建刚性体或柔性体，如图 2-34 所示。MotionView 中的体由质心处

（CM marker）的质量属性和相对惯性坐标系（IM marker）的转动惯量属性构成。刚性体具

有 6 个自由度。 

 
图 2-34  Body 面板 

刚性体创建可通过以下步骤完成： 
1）在项目浏览树中选择文件夹（Model|System|Assembly|Analysis），右击鼠标选择 Add 

Reference Entity→Body（见图 2-35）或在工具栏中单击 Body 按钮 ，此时弹出 Add Body 
or BodyPair 对话框，如图 2-36 所示。 

            
             图 2-35  项目浏览树选项                  图 2-36  Add Body or BodyPair 对话框 
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2）指定体标题和变量名，该变量名不能与体所从属的文件夹重名。 
3）选择体类型，Single 用于定义一个体，Pair 用于定义一个体对。 
4）单击 Apply 按钮再次添加体，此时 MotionView 根据当前对话框中的设置添加体，然

后重新打开该对话框。 
5）单击 OK 按钮，MotionView 根据当前对话框中的设置添加体。 
6）单击 Cancel 按钮，取消当前设置并关闭对话框。 
MotionView 中的刚性体输出到 MotionSolve 求解器时使用<Body_Rigid/>描述，输出到

ADAMS 时使用 PART 描述。 
通过以下步骤可以编辑体的属性： 
1）单击工具栏中的 Body 按钮 ，在图形区单击与待编辑体相关联的图形，即可进入该

体的编辑面板。另外，在项目浏览树中单击待编辑的体也可进入该体的编辑面板。 
2）属性（Properties）标签可修改体质量和转动惯量信息（Ixx， Iyy， Izz， Ixy， Ixz， Iyz）或

替换刚体为柔性体。柔性体相关定义请参阅第 4 章。 
3）质心（CM coordinates）标签用于定义体的质心坐标。 
4）惯性坐标系（inertia coordsys）标签用于定义惯量信息所参考的坐标系。如果未指定

该坐标系，MotionView 将使用质心坐标系作为惯量坐标系。 
5）体坐标系（Body coordsys）标签用于定义体局部参考坐标系。 
6）初始条件（Initial Conditions）标签用于定义体初始条件。面板中选项前的单选按钮

用于打开/关闭初始条件。体对初始条件的对称性由属性标签中的 Symmetric properties 选项

控制。 
以下是对柔性与点质量体的介绍： 
1）柔性体（Deformable Bodies）。 
MotionView 支持柔性体创建。求解器不同，柔性体类型也不同。例如，MotionSolve 或

ADAMS 使用等效意义的柔性体，而 Abaqus 则使用传统的有限元模型。MotionSolve 或

ADAMS 支持的柔性体是通过模态综合法创建的。它是使用一系列模态和节点（或称界面

点）来描述完整的有限元模型。关于柔性体的介绍请参考本书第 4 章。 
MotionView 中的柔性体在输出到 MotionSolve 求解器时使用< Body_Flexible/>描述，输

出到 ADAMS 时使用 FLEX_BODY 描述。 
2）点质量体（Point Mass Body）。 
点质量体是刚性体的特殊形式，该类型的体仅具有 3 个轴向的平移自由度。其创建过程

与一般体类似。 
MotionView 中的点质量体输出到 MotionSolve 求解器时使用<Body_Point/>描述，输出到

ADAMS 时使用 POINT_MASS 描述。 
（3）向量（Vector） 
Vectors 面板用于创建和编辑向量，如图 2-37 所示。在 MotionView 中，向量可为铰、

衬套、梁、拉簧等对象提供导向作用。向量由属性（Properties）标签定义，仅提供方向信息

而无确定的空间位置。 
在向量面板中单击 DataSummary 按钮 可直接进入 Data Summary 对话框中

的向量列表，如图 2-38 所示。在这里可以批量编辑向量属性。 
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图 2-37  向量面板 

 

图 2-38  Data Summary 对话框 

（4）标记点（Marker）。 
Marker 面板用于创建和编辑标记点，如图 2-39 所示。标记点关联在体上，作为加载或

输出设置的参考坐标系。创建标记点时需要指定与其相关联的体、标记点的原点以及指向。 

 

图 2-39  标记点面板 

在面板中，Body 用于指定标记点所关联的体，Point 用于定义标记点的原点。标记点的指

向有 3 种定义方式：Orient one axis、Orient two axes和Orient by angles。Orient one axis方法通过

使用几何点或向量定义标记点的一个轴，MotionView 自动计算另外两轴指向。该方法用于定

义轴对称对象的方向。Orient two axes方法通过几何点或向量的组合来定义标记点的两个轴指

向，MotionView 自动计算第三轴指向。Orient by angles方法通过指定相对模型中其他坐标系的

欧拉角来定义标记点的方向。选中 Floating Marker 复选框，将取消标记点方向的定义。 
对于刚性体，系统会在其质心位置自动创建一个质心标记点。该标记点随刚体一起运

动，用于表征刚体在全局坐标系中的位置与方向。通过质心标记点可以计算出刚体上其他标

记点在全局坐标系中的位置与方向。在 MotionView 中，质心标记点记做 Marker CM，而其

他标记点记做 Marker。标记点的 idstring 可以用于信息输出。例如，若要输出刚体位移信
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息，则可在 Output 面板上定义`DX（{b_0.cm.idstring}）`。 
（5）曲线（Curve）。 
Curve 面板可进行曲线的创建和编辑，如图 2-40 所示。在 MotionView 中，曲线用于捕

捉非线性属性或为高副提供约束路径。曲线的 x 和 y 轴数据的来源有 3 种方式：文件、数学

表达式和数值列表。例如，某条曲线的 x 轴数据可由文件来定义，而 y 轴可由与 x 相关的数

学表达式定义。 

 

图 2-40  Curve 面板 

Curve 面板创建的曲线可以输出成 Excel、ADAMS Spline、Columns、Altair Binary、XY 
Data、DAC、X Graph、RPC、Summary、Excel Europe 等格式文件。 

注：在 MotionView 数学表达式中，曲线分量的使用需要参考曲线变量名，即 varname.x
或 varname.y，如 crv_o.x。而在 HyperGraph 中，可以直接编写曲线所从属的窗口进行调用，

如 p1w1c1.x。 
接下来以正弦曲线为例，说明基于数学表达式方法的曲线创建过程。 
1）右键单击工具栏中的 Curve 按钮 。 
2）使用默认的标题与变量名，单击 OK 按钮，进入 Curve 面板。 
3）在属性（Properties）标签中选择 2D Cartesian，创建二维曲线。 
4）选中 x 单选按钮，将数据来源设置为 Math，并在其后的文本框中输入{0：6.28：0.01}。

此表达式意为从 0 开始，以 0.01 为步长增长到 6.28。 
5）选中 y 单选按钮，将数据来源设置为Math，并在其后的文本框中输入{sin （0：6.28：0.01）}。

此表达式意以 x 为自变量，进行正弦函数计算。 
6）退出文本框，MotionView 的 Templex 功能将自动计算 x、y 的数值，如图 2-41 所示。 

 

图 2-41  正弦曲线创建面板 

7）单击 Show Curve 按钮，可预览曲线形状，如图 2-42 所示。 
8）单击 Export Curve 按钮可输出曲线。 
（6） 图形（Graphic）。 
Graphic 面板（见图 2-43）可创建三维图形对象，该对象用于图形区的模型显示，也可

用于后处理中的模型动画显示。 
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图 2-42  曲线预览窗口 

 

图 2-43  Graphic 面板 

图形面板支持由文件导入的复杂图形对象（.H3D 格式）以及使用 MotionView 创建的箱

体、球体、圆柱体、轮廓、管道、轮胎、弹簧、图形系统、变形曲面、变形曲线以及曲面等

图形对象，如图 2-44 所示。 

 
                          a）                                                  b） 

图 2-44  MotionView 图形示例 

a） MotionView 自建图形  b） 外部导入图形 

图形创建时需要指定与其相关联的体，该操作可通过图形面板的连接（Connectivity）标

签完成。对于从文件导入的模型可使用位置（Location）标签调整模型的位姿及缩放比例。

属性（Properties）标签用于定义自建模型的相关参数。可视化（Visualization）标签用于设

定图形文件的显示状态。 
接下来以圆柱体为例说明 MotionView 图形的创建过程。 
1）右键单击工具栏中的 Graphic 按钮 。 
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2）使用默认的标题与变量名，选择图形类型为 Cylinder，单击 OK 按钮，进入 Graphic
面板。 

3）在 Connectivity 标签中双击 Body 按钮，在弹出的 Select a body 对话框中选择 Ground。 
4）双击 Origin 处的 Point 按钮，在弹出的 Select a Point 对话框中选择 Global Origin。 
5）将 Direction 设置为 Vector，双击 Vector 按钮，在弹出的 Select a Vector 对话框中选择

Global X。 
6）进入 Properties 标签，指定 Length 为 10，其他使用默认

参数。 
7）单击工具栏适合缩放工具 ，此时图形区如图 2-45 所示。 
此时，创建了一个从属于大地、长度为 10、端面半径为 10 的

圆柱体图形。 
（7）曲面（Surface）。 
Surface 面板用于创建和编辑曲面对象，如图 2-46 所示。在

MotionView 中，曲面对象主要为几何点到曲面、曲线到曲面和曲面

到曲面高副提供参数化的曲面。对于 MotionSolve 求解器，曲面可

由用户自定义程序描述；对于 ADAMS，曲面可由用户自定义程序定义，也可以参考 Parasolid
对象定义。 

 

图 2-46  Surfaces 面板 

曲面创建可通过以下步骤实现： 
1）从项目浏览树中选择待创建的曲面从属的系统。 
2）在系统文件夹处右击鼠标，选择 Add Reference Entity→Surface，或从 Model 下拉菜

单中选择 Reference Entity→Surface，或单击工具栏中的 Surface 按钮 。此时，将弹出 Add 
Surface 对话框。 

3）指定待创建的曲面名称，该名称可在后续操作中更改。 
4）指定待创建的曲面变量名，该名称在后续操作中不可更改。 
5）单击 Apply 按钮，根据上述参数创建曲面，然后重新打开 Add Surface 对话框。 
6）单击 OK 按钮，根据上述参数创建曲面并关闭 Add Surface 对话框。 
7）单击 Cancel，取消曲面创建操作。 
（8）变形曲线（Deformable Curve）。 
Deformable Curve 面板用于创建和编辑变形曲线对象，如图 2-47 所示。在 MotionView

中，变形曲线为高副提供必需的曲线对象。变形曲线可以连接一个或多个体，并且在仿真过

程中可以变形。 

 

图 2-45  圆柱体 
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图 2-47  变形曲线面板 

构建变形曲线的几何点可以是标记点，也可以是与体关联的几何点。单击 Add 按钮可

增加数据行。如果数据较多，则可以单击“扩展”按钮 ，打开 Deformable Curve table 对

话框进行查看或编辑。 
对于变形曲线的端点类型，MotionView 提供了 NATURAL、PARABOLIC、PERIODIC

和 CANTILEVER 四种端点二阶导数连续性假定。 
曲线创建可通过以下步骤实现： 
1）右键单击Point 按钮，创建 9 个几何点，标题为Point 0～Point 8，坐标值如图 2-48 所示。 

 
图 2-48  几何点坐标 

2）右键单击 Marker 按钮，创建 9 个标记点，均以大地为 Parent，Origin 分别为 Point 
0～Point 8。 

3）右键单击 Deformable Curve 按钮，使用默认的标题与变量名，单击 OK 按钮，进入

Deformable Curve 面板。 
4）单击 Add 按钮，添加 8 个 Marker 项目。 
5）双击 Marker 按钮，分别选择上述创建的 9 个标记点。 
6）此时，创建了一条变形曲线，如图 2-49 所示。 

 

图 2-49  变形曲线 
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（9）变形曲面（Deformable Surface）。 
Deformable Surface 面板用于创建和编辑变形曲面对象，如图 2-50 所示。在 MotionView

中，变形曲面主要为几何点到变形曲面副和几何点到变形曲面接触约束提供可变形的曲面对

象。描述变形曲面的几何点可来自多个体。 

 

图 2-50  变形曲面面板 

构建变形曲面的点可以使标记点，也可以是与体关联的几何点。单击 Add Row 和 Add 
Column 按钮可分别增加数据行和数据列。如果数据较多，则可以单击“扩展”按钮 ，打

开 Deformable Curve table 对话框进行查看或编辑操作。 
对于变形曲面的端点类型，MotionView 提供了 NATURAL、PARABOLIC、PERIODIC

和 CANTILEVER 四种端点二阶导数连续性假定。 
曲面创建可通过以下步骤实现： 
1）右键单击 Point 按钮，创建 12 个几何点，标题为 Point 0～Point 11，坐标值如图 2-51

所示。 

 

图 2-51  几何点坐标 

2）右键单击 Marker 按钮，创建 12 个标记点，均以大地为 Parent，Origin 分别为 Point 
0～Point 11。 

3）右键单击 Deformable Surface 按钮，使用默认的标题与变量名，单击 OK 按钮，进入

Deformable Surface 面板。 
4）单击 Add Row 按钮 3 次，添加 3 行。 
5）单击 Add Column 按钮 4 次，添加 4 列。 
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6）双击第一个 Marker 按钮，选择上述创建的 Marker 0。 
7）按照先列后行的原则，指定 Marker。 
8）单击面板右侧的“扩展”按钮 ，弹出 Deformable Surface Data 对话框，如图 2-52

所示。 

 

图 2-52  Deformable Surface Data 对话框 

9）此时，创建了一个变形曲面，如图 2-53 所示。 

 

图 2-53  变形曲面 

2. 7.3  约束建模工具 

一个系统通常是由多个构件组成的，各个构件之间通常存在约束关系，即一个构件限制

另一个构件的运动。两个构件间的这种约束关系，通常称为运动副或铰。MotionView 提供

了多种约束关系，主要分为以下 4 类。 
（1）基本约束。 
基本约束是一种抽象的运动副，通过基本约束的组合可以得到更复杂的约束。基本约束

可以组合成常用的铰约束，如平行约束与点重合约束可以组合成旋转铰。基本约束在特定的

场合有特殊用途。例如，一个系统完全使用铰约束定义，往往会造成过约束，此时可以使用

一定量的基本约束来替代铰，避免过约束。MotionView 提供的基本约束有点线约束

（Inline）、点面约束（Inplane）、方向约束（Orientation）、平行约束（Parallel Axes）、垂直约

束（Perpendicular）等。 
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（2）铰约束。 
MotionView 提供的球铰有铰（Ball）、旋转铰（Revolute）、平移铰（Translational）、固

定铰（Fixed）、虎克铰（Hooke）、万向节（Universal）、常速度铰（Constant Velocity）、圆柱

铰（Cylindrical）、齿轮铰（Gear）等。 
（3）高副约束。 
高副相对低副而言，是一种点接触约束，即限制一个构件上的一个点在另一个构件上的

一条曲线或曲面上移动，不能分离。这里的曲线可以是平面曲线或空间曲线，可以封闭也可

以开放，可以是固定曲线也可以是变形曲线；曲面可以是刚性曲面或变形曲面。MotionView
提供的高副约束有曲线-曲线约束（Curve To Curve）、点-曲线约束（Point To Curve）、点-曲

面（Point To Surface）、曲线-曲面（Curve To Surface）、曲面-曲面（Surface To Surface）、
点-变形曲线（Point To DeformableCurve）、点-变形曲面（Point To DeformableSurface）等。 

（4）驱动约束。 
驱动也是一种约束，这种约束是时间的函数。按驱动加在对象类型上分有点驱动（施加

在 Marker 上）和铰驱动（施加在铰上）；按驱动特点区分有平移驱动和旋转驱动。 
MotionView 提供了便捷的约束建模工具，表 2-7 描述了工具栏中各约束建模按钮的基

本功能。 

表 2-7  约束建模按钮 

鼠标操作执行功能 
按    钮 

单    击 右    击 

 进入 Joint 面板 创建铰约束 

 进入 Motion 面板 创建驱动约束 

 进入 Coupler 面板 创建耦合副 

 进入 Gear 面板 创建齿轮副 

 进入 Advanced Joint 面板 创建高副 

约束建模面板还可通过下拉菜单及项目浏览树打开，如图 2-54 所示。 

 
                                         a）                            b） 

图 2-54  约束建模面板打开方式 

a） 下拉菜单  b） 项目浏览树 
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表 2-8 列出了不同类型约束的约束关系。 

表 2-8  MotionView 约束副的约束关系 

约    束 示  意  图 约 束 关 系 

点线约束（Inline）  
约束第一个构件的一点在第二个构件上的某个方

向运动，限制两个构件间的两个平动自由度，剩下

1 个平动自由度及 3 个旋转自由度 

点面约束（Inplane）  
约束第一个构件的一点只能在第二个构件的某个

平面内运动，限制两个构件间的 1 个平面自由度，

剩下两个平动自由度和 3 个旋转自由度 

方向约束（Orientation）  
约束第一个构件只能相对第二个构件平动而不能

转动，限制两个构件间的 3 个旋转自由度，剩下 3
个平动自由度 

平行约束（Parallel Axes）  
约束第一个构件的某个方向与第二个构件的某个

方向始终平行，限制两个构件间的两个旋转自由

度，剩下 3 个平动自由度和 1 个旋转自由度 

垂直约束（Perpendicular）  
约束第一个构件的某个方向始终垂直于第二个构

件的某个方向，限制两个构件间的 1 个旋转自由

度，剩下 3 个平动自由度和两个旋转自由度 

平面铰（Planar）  
约束一个构件只能在另一个构件的某个平面内运

动，限制两个构件间的 1 个平动自由度和两个旋转

自由度，剩下两个平动自由度和 1 个旋转自由度 

球铰（Ball）  约束两个构件只能旋转不能移动，限制两个构件

3 个平动自由度，剩下 3 个旋转自由度 

常速度铰（Constant Velocity） 
约束两个构件在两个方向上的旋转速度相等，限

制两个构件间 3 个平动自由度和 1 个旋转自由度，

剩下两个旋转自由度 

螺旋铰（Screw）  

约束两个构件间两个平动自由度和两个旋转自由

度，剩下 1 个平动自由度和 1 个旋转自由度，且这

两个自由度间满足一定的关系，即两个构件相对旋

转 360°时，平移一个螺距的距离 
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（续） 

约    束 示  意  图 约 束 关 系 

固定铰（Fixed）  
将两个物体固定在一起，两个构件间没有相对位

移，限制两个构件间 3 个平动自由度和 3 个旋转自

由度 

旋转铰（Revolute）  
约束两个构件在某点处绕旋转轴相对旋转，限制

两个构件间 3 个平动自由度和两个旋转自由度，剩

下 1 个旋转自由度 

平移铰（Translational）  
约束两个构件只能够沿轴线平动，限制两个构件

的两个平动自由度和 3 个旋转自由度，剩下 1 个平

动自由度 

万向节（Universal）  约束两个构件间 3 个平动自由度和 1 个旋转自由

度，剩下两个旋转自由度 

下面介绍铰的创建和驱动的创建： 
（1）铰的创建。 
Joint 面板用于创建和编辑铰对象，如图 2-55 所示。MotionView 中铰分为刚性铰（Non-

compliant joints）和柔性铰（Compliant Joints）两类。 
刚性铰指一般铰约束，仅具有该类型铰特定的自由度。对于刚性铰，铰面板包含连接

（Connectivity）和初始条件（Initial Conditions）两个标签。连接标签用于定义铰的连接对

象、位置及指向等参数，初始条件标签用于定义铰的运动初始条件，如初位移、初速等。 

 
图 2-55  铰面板 

柔性铰与衬套类似，具有 6 个自由度。使用该类型铰连接的物体间的相对运动取决于柔

性铰的刚度和阻尼系数。使用连接标签中的 Allow compliance 选项可将刚性铰转换为柔性

铰。柔性铰面板上除了连接和初始条件标签外，还包括平动刚度系数（Trans Stiffness）、转

动刚度系数（Rot Stiffness）、平动阻尼系数（Trans Damping）、转动阻尼系数（Rot Damping）
和预载（Preload）标签。另外，连接面板上的 Symmetric properties 选项可用来定义对称的铰

约束，User-defined 选项支持用户自定义程序定义的非线性刚度系数和阻尼系数。 
创建了铰后，铰关联的两个构件上将分别固定一个标记点，第一个构件的标记点称为 I-
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Marker，第二个构件上的标记点称为 J-Marker。这两个标记点用于建立铰的约束方程，通过

这两个标记点可以计算两个构件间的相对位移、速度、加速度以及作用在两个构件上的约束

反力和力矩。 
接下来以旋转副为例说明铰的创建过程，假定

会话中已创建四杆构件，如图 2-56 所示。 
1）右键单击工具栏中的 Joint 按钮 ，在弹出

的 Add Joint or JointPair 对话框中使用默认的标题与

变量名，选择铰类型为 Revolute Joint。 
2）单击 OK 按钮，进入 Joint 面板。 
3）单击 Body1 按钮，在图形区选择 bar1。 
4）单击 Body2 按钮，在图形区单击坐标系，

选择 Ground Body。 
5）在 Origin 处单击 Point 按钮，选择图形区 bar1 1 几何点。 
6）在 Alignment axis 处指定铰约束方向类型为 Vector，在图形区选择坐标系 Z 轴。Joint

面板如图 2-57 所示。创建的旋转铰如图 2-58 所示。 

 
图 2-57  Joint 面板（Revolute Joint） 

 
图 2-58  四杆构件与旋转铰 

（2）驱动的创建。 
Motion 面板用于驱动约束的创建和编辑，如图 2-59 所示。 

 
图 2-59   Motion 面板 

 

图 2-56  四杆构件 
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MotionView 支持铰驱动与标记点驱动两种类型的驱动。指定铰约束后，MotionView 会

自动辨别施加线驱动（线位移、线速度或线加速度）还是角驱动（角位移、角速度或角加速

度）。如果使用标记点驱动，则需指定驱动作用的标记点。由于标记点均从属于几何体，因

此标记点驱动也就是间接驱动几何体。属性标签可以指定驱动的大小，MotionView 支持恒

值、曲线和表达式 3 种定义方式。 
注：进行位移驱动时，建议写成`Value*time`的表达式形式。如果使用 Value 的恒值形

式，则求解器会将此当做一个强制约束而报错。 

2. 7.4  载荷建模工具 

MotionView 提供了以下 4 种类型的力。 
作用力：定义在零件上的外载荷。力创建时需要指明力类型是力还是转矩。与驱动约束

类似，力的大小支持恒值、曲线和表达式 3 种定义方式。 
柔性连接力：根据两个构件间产生的相对位移和相对速度，产生一对与相对位移成正比

的力或力矩，以及与相对速度成正比的阻尼力，这种力或力矩与位移的方向相反，阻尼力与速

度方向相反，它们起到阻碍两构件相对运动的作用。MotionView 使用衬套、场力、弹簧阻尼

器、梁等对象描述柔性连接力，这些对象在工作时只考虑作用力和力矩，而忽略对象的质量。 
特殊力：如重力等。 
接触力：系统运动时，零件相互接触产生的作用力。 

1.作用力的创建 

Force 面板用于力的创建与编辑，如图 2-60 所示。这里力可以分为为作用力（action-only）
和作用力与反作用力对（action-reaction）两种类型。作用力指施加的力仅作用在指定物体上，而

作用力与反作用力对则对指定的物体 1 和物体 2 施加等值反向的力。根据力所产生的效果可分为

力（Translational）、力矩（Rotational）、力与力矩（TtansRotational）、直线力（Line Of Action 
Translational）和力矩对（Single Comp Rotational）5 种类型。其中，直线力指所施加的力仅在指

定连接物体的作用点连线方向起作用，力矩对在指定轴线上为两个物体施加等值反向力矩，它们

仅在施加作用力与反作用力对时有效。此外，用户可使用VFORCE 对象自定义力。 

 
图 2-60  Force 面板 

2.柔性连接力的创建 

表 2-9 描述了柔性连接力的功能。 
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表 2-9  柔性连接力的功能 

柔性连接力 按    钮 功    能 

衬套  根据两构件间的相对位移与相对速度分别产生弹性力与阻尼力，同时可施

加预载（6 个分量，3 个弹性力和 3 个阻尼力） 

场力  定义了两个构件间的六分量作用力（3 个弹性力和 3 个阻尼力） 

弹簧阻尼器  在两构件间产生一对与相对位移（角度）和相对速度（角速度）成正比的

作用力（力矩） 

梁 /  
定义无质量、等截面、直线梁，根据 Timoshenko 梁理论计算出两构件间

的作用力。梁局部坐标系 x 轴沿着两构件间的标记点连线，该连线也假定为

梁未变形中线。这里，梁仅支持小转动（转动角度小于 10°） 

（1）衬套的创建 
Bushing 面板用于衬套的创建与编辑，如图 2-61 所示。衬套可等效为一个六分量的弹

簧阻尼器，弹性力可通过指定的刚度矩阵与构件间相对位移的乘积获得，阻尼力可由指定

的阻尼矩阵与构件间相对速度的乘积获得。此外，还可定义预载。式（2-1）为衬套力的计

算公式。 

 

图 2-61  Bushing 面板 
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 （2-1） 
式中，x、y、z 分别为第一构件上的 I 标记点相对第二构件上的 J 标记点的 3 个轴向线位

移； xθ 、 yθ 、 zθ 分别为 I 标记点相对 J 标记点的 3 个轴向角位移； x&、 y& 、 z&分别为 I 标记

点相对 J 标记点的 3 个轴向线速度； xw 、 yw 、 zw 分别为 I 标记点相对 J 标记点的 3 个轴向

角速度； 0xf 、 0yf 、 0zf 和 0xt 、 0yt 、 0zt 是预载。 
注： 

1）式中角位移的单位为 rad。 
2）在 3 个转角中，至少有两个转角的角位移小于 10°。 
3）衬套为线性力单元。如果定义非线性力单元，则推荐使用场力。 
4）衬套单元中刚度矩阵和阻尼矩阵均为对角矩阵，因此不包括不同轴向的耦合作用。

如果考虑这种耦合作用，则推荐使用场力。 
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5）衬套可应用于刚体、柔体及点质量构件间的连接。 
6）衬套力方向约定：I、J 标记点相离时，弹性力为正；I 标记点相对 J 标记点为逆时针

旋转时，阻尼力为正。 
（2）场力的创建。 
Field 面板用于场力的创建与编辑，如图 2-62 所示。场力只能是构件间标记点距离与时

间的函数，这里支持线性和非线性力的定义，非线性力需调用 FIESUB 用户子程序定义。

式（2-2）力场力的计算公式。 

 

图 2-62  Field 面板 
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 （2-2） 
式中，x、y、z 分别为第一构件上的 I 标记点相对第二构件上的 J 标记点的 3 个轴向线位

移； xθ 、 yθ 、 zθ 分别为 I 标记点相对 J 标记点的 3 个轴向角位移； x&、 y&、 z&分别为 I 标记

点相对 J 标记点的 3 个轴向线速度； xw 、 yw 、 zw 分别为 I 标记点相对 J 标记点的 3 个轴向

角速度； 0xf 、 0yf 、 0zf 和 0xt 、 0yt 、 0zt 是预载； xl 、 yl 、 zl 、 rxl 、 ryl 、 rzl 分别是初始线位

移和初始角位移。 
注： 
1）I 标记点为作用力加载点，J 标记点为反作用力加载点。 
2）力和力矩表达式（或用户子程序）需要连续可导，以保证数值计算顺利进行。 
3）如果无法获得解析的偏导数，可使用有限差分方式计算。使用解析的偏导数往往获

得更精确的结果且求解效率高，因而推荐使用。 
4）场力可应用于刚体、柔体及点质量构件间的连接。 



MotionView & MotionSolve 
应用技巧与实例分析 

 50 

5）场力常用于模拟非线性衬套、不严格遵守 Euler-Bernoulli 或 Timoshenko 梁理论以及

曲线或变截面梁单元。 
（3）弹簧阻尼器的创建。 
Spring Damper 面板用于弹簧阻尼器的创建与编辑，如图 2-63 所示。弹簧阻尼器作用在

有一定距离的两个构件上，选择第一构件为作用构件，第二个构件为反作用构件，根据它们

之间的相对位移与相对速度计算构件间的作用力，计算公式见式（2-3）。 

 

图 2-63  Spring Damper 面板 

                            0 0= （ ）f k l l cl + f− − − &  （2-3） 

式中， k 为弹簧刚度系数； l 为构件间的相对（角）位移； 0l 为初始（角）位移； c 为阻尼

系数； l&为构件间的相对（角）速度； 0f 为预载。 
注： 
1）作用力方向约定：斥力或（角）位移增加时力为正。其中角位移按照 J 标记点相对 I

标记点的 x 轴逆时针旋转测量。 
2）对于拉伸弹簧，初始长度不允许为零。 
（4）梁的创建。 
Beam 面板和 Polybeam 用于梁的创建与编辑，如图 2-64 和图 2-65 所示。梁连接能计算

12 个作用力，分别是轴向力 S1 和 S7；剪切力 S2、S3 和 S8、S9；弯矩 S5、S6 和 S11、S12 以及

扭矩 S4和 S10，如图 2-66 所示。实际模型中可将一个构件分为几段，每段使用梁连接，即多

段梁（Polybeam）。 

 

图 2-64  Beam 面板 

 

图 2-65  Polybeam 面板 
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图 2-66  梁示意图 

式（2-4）为场力的计算公式。 
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式中，E 为弹性模量，G 为切变模量；A 为梁横截面积；cratio 为阻尼比； xxI 、 yyI 、 zzI 分

别为绕 x 轴、y 轴和 z 轴的惯性矩； syA 、 szA 分别为 y 方向和 z 方向的剪切变形系数；ν 为

泊松比；l 为梁初始长度。 
注： 

1）J 标记点的 x 轴定义了梁的中性线，y 轴和 z 轴分别代表了横截面的惯性主轴方向。 
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2）梁未变形时，I 标记点方向与 J 标记点相同，只是沿 x 轴偏移了梁的长度。 
3）梁使用时，I、J 标记点间的角位移应小于 10°。 
4）力方向约定：斥力为正。I 标记点相对 J 标记点逆时针旋转时，力矩为正。 
5）梁是线性力单元。如果定义非线性力关系，则推荐使用场力。 
6）此处不能模拟非均质、曲线段或变截面梁。不等截面梁可由一组梁单元模拟，每段

梁具有不同的截面属性。 
7）对于较小跨深比的梁（ zr >0.3L 或 yr >0.3L）来说，剪切应力将导致较大的变形并主导弯

矩的作用。梁单元中 syA 和 szA 用于控制剪切变形。表 2-10 列出了典型截面的剪切系数值。 

表 2-10  典型截面的剪切系数值 

截面 syA 或 szA  

圆形 1.2 

矩形 1.111（10/9） 

薄壁空心圆截面 2.0 

3.接触力的创建 

在多体动力学分析领域，接触是一类非常广泛的零部件间相互作用方式。Contact 面板

通过物体的外部曲面来定义物体之间的接触力，如图 2-67 所示。MotionView 支持刚体-刚

体接触和点-变形曲面接触两种接触类型。 

 

图 2-67  Contact 面板 

刚体-刚体接触约束中可选择 Impact 接触算法或 Possion 接触算法。在 Impact 接触算法

中，接触力使用 Impact 函数计算。Impact 函数见式（2-5）。 
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 （2-5） 
式中，x 为独立变量，如使用 I 标记点相对 J 标记点在 RM 参考系下的 Z 轴线位移作为独立

变量； x&为独立变量相对时间的导数； 1x 为独立变量的下限值，当 x 小于 1x 时，Impact 返回

正值；k 为接触面材料刚度，一般来说，刚度值越大，积分求解越困难；e 表示接触力指数

定义了接触面的力-变形特性，对于刚性弹簧，该指数大于 1.0，对于软性弹簧，该指数小于
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1.0，接触力指数为恒正值；cmax 为最大接触阻尼系数，非负；d 表示是阻尼最大时刻的接触

物体间的穿透深度，该值恒正。 
在 Possion 接触算法中，弹力根据赫兹接触理论计算，阻尼力由阻尼系数与相对运动速

度决定。计算公式见式（2-6）。 

                         

contact spring damping
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damping spring

2 2
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 （2-6） 

式中，k 为惩罚系数，可以看做接触刚度；z 为穿透深度；COR 为恢复系数，可以看做阻尼，

是指接触物体相对分离速度与相对接近速度之比，该系数取 1 时表示为完全弹性碰撞，取 0 时

表示为完全塑性碰撞。对于静态和准静态工况，s=0；其他工况 s= STEP（vapproach， - 
normal_tran_vel ， -1， normal_tran_vel， 1），其中 vapproach 为接触点的相对速度。 

在 Possion 接触模型中，太大的惩罚系数可能导致数值积分困难，太小的惩罚系数可能

造成过量穿透。合理调整两个参数，可获得稳定且精确的结果。 
如果上述两种接触模型不适合实际模型，用户可以考虑自定义子程序。CNFSUB 可用于

自定义法向力，摩擦力可根据式（2-7）模拟成一个粘性力。 

                      2

（ ） /（ ）

（ ） （3.0 2.0 ）
t s d s

t s d s

d V V V V

F d dμ μ μ

= − −⎧⎪
⎨
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式中， tV 是当前接触点的滑动速度； sμ 为静摩擦系数； dμ 为动摩擦系数； sV 是 sμ 达到最大

静摩擦系数时接触点的过渡滑动速度； dV 是 dμ 达到最大动摩擦系数时的接触点滑动速度；

tF 为计算的摩擦力，该力方向与滑动速度相反。如果摩擦力模型不能满足使用要求，则可以

考虑使用摩擦自定义子程序 CFFSUB。 
点-变形曲面接触用于模拟半径为 r 的球体与变形曲面之间的接触力，这里球体与变形

曲面分别属于两个不同的体。应用这种建模方式可以进行柔性体-柔性体或柔性体-刚性体间

的接触模拟。 
注：MotionView 中图形可通过两种方式定义：一种是 MotionSolve 基本图形，如圆柱

体、箱体、椭球体等，在求解过程中 MotionSolve 会自动对其进行网格划分；另一种是由

CAD 软件创建，输入到 MotionView 中的图形。图形输入过程中，会自动调用 HyperMesh 进

行网格划分并将细化的几何模型输出到 MotionSolve XML 文件中。应用 HyperMesh 交互式

网格划分功能可以控制几何模型的网格质量，进而提高接触力的计算精度。 

2. 7.5  数据输入文本框 

MotionView 文本框支持以下 3 种数据输入方式： 
●  常数值（Constant values）。 
●  数学表达式（Mathematical Expressions）。 
●  模板表达式（Template Expressions）。 
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大多数文本使用常数值形式，可以使用标准浮点型数据、整数型数据或科学计数型数

据。数据输入后，MotionView 将自动转换数据的格式。 
（1）数学表达式。 
编写数学表达式时，可以调用对象属性。数学表达式类似 Execl 表格公式，按<Enter>

键后，文本框会自动计算表达式数值。数学表达式示例如下： 
●  （p_1.x + p_2.x） / 2。 
●  b_powertrain.mass * 1.5。 
●  b_uca.l.cm.origin.z + ds_params.wb.value。 
应用.符号可调用对象属性，上述示例中使用了以下对象属性： 
p_1.x：几何点 p_1 的 x 坐标值。 
p_2.x：几何点 p_2 的 x 坐标值。 
b_powertrain.mass：几何体 b_powertrain 的质量值。 
b_uca.cm.origin.z：几何体 b_uca 质心标记点原点的 z 坐标值。 
ds_params.wb.value：数据库参数 ds_params 变量 wb 的值。 
如果调用其他系统的对象属性，则需要在属性名称前加入系统名称。系统名称与其属性

使用.符号连接。例如，model.sys_front.p_1.x 表示 model 模型 sys_front 子系统中 p_1 点的 x
坐标值。sys_plane.sys_wing.sys_flap.j_hinge.body1.mass 表示 sys_plane 模型 sys_wing 系统

sys_flap 子系统中 j_hinge 铰连接的体 body1 的质量。 
用户可以使用表达式编辑器（expression builder）创建数学表达式。 
通过以下步骤还可以查看对象或系统的变量名： 
1）从 MotionView 工具栏或 Model 下拉菜单中选择一个面板。 
2）选择一个对象或系统。 
3）单击“文本编辑器”按钮 。 
此时将弹出信息对话框，显示了当前对象或系统的变量名。 
（2）模板表达式。 
应用模板表达式可以调用由指定求解器符号定义的对象属性。模板表达式是一个放在

单引号内包含模板语句的字符串。当模板表达式输出到 ADAMS 时，MotionView 应用

Templex 工具将其保存到一个文件中。模板表达式支持 ADAMS 表达式的直接调用。

ADAMS 函数通常定义为某些属性（如时间、两点距离等）的函数，这些函数可在求解过

程中变化。在 ADAMS 求解器输入文件中，ADAMS 通过对象编号来调用对象属性。

MotionView 读入 ADAMS 模型文件时将保留对象和属性的变量名，增加了 ADAMS 函数

的可读性。MotionView 变量名应用时需要放在大括号内（{}）。典型的 ADAMS 函数示例

如下： 
●  `-AZ（{j_st_wheel.i.id， %d}，{j_st_wheel.j.id， %d}）*RTOD` 
●  `IF（DZ（{frc_bmp.i.l.id，%d}，{mrk_disp.l.id，%d}，{mrk_disp.l.id，%d}）：{cr（）}，0，0，DZ（{frc_b

mp.i.l.id，%d}，{mrk_disp.l.id，%d}，{mrk_disp.l.id，%d}））` 
ADAMS 中铰、衬套、弹簧或力对象属性的定义常常需要标记点位移和速度值。表 2-11

描述了位移和速度测量用到的函数。 
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表 2-11  位移和速度函数 

线  位  移 角  位  移 线  速  度 角  速  度 

DX（I， J， R） AX（I， R） VX（I， J， R） WX（I， J， R） 

DY（I， J， R） AY（I， R） VY（I， J， R） WY（I， J， R） 

DZ（I， J， R） AZ（I， R） VZ（I， J， R） WZ（I， J， R） 

DM（I， J）  VR（I， J）  

在表 2-11 中，I 和 J 为测量中使用的标记点编号，R 为参考标记点编号。 
应用这些函数可以创建下面所示的模板表达式： 

`-DX（{bsh_lca_frnt.l.i.id}，{bsh_lca_frnt.l.j.id}，{bsh_lca_frnt.l.j.id}` 

MotionView 为铰、弹簧、衬套和力元对象的位移和速度测量提供了简洁的表达式。这

些表达式在输出 ADAMS 求解文件.adm 时将自动按照 ADAMS 表达式语法进行扩展。例

如，下面两个表达式代表同一个含义。 
ADAMS DX 函数 `DX（{bsh_lca_frnt.l.i.id}，{bsh_lca_frnt.l.j.id}，{bsh_lca_frnt.l.j.id}` 
MotionView .DX 属性 `{bsh_lca_frnt.l.DX}` 
当 MotionView 将衬套、铰、弹簧简洁表达式扩展至 ADAMS 完整表达式时，自动使用

对象的 J 标记点作为参考标记点（或称 R 标记点）。而对于力元，MotionView 会指定参考标

记点。 

2. 7.6  表达式编辑器 

应用表达式编辑器可快速编辑表达式，无需输入大量的字符或记忆公式。表达式编辑过

程中可以调用对象属性。单击文本框，单击 F（x）按钮 即可进入图 2-68 所示的表达式编辑

器窗口。 

 

图 2-68  表达式编辑器窗口 
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表达式编辑器包含以下 3 个部分。 
●  上部：文本框用于显示表达式。在文本框内单击，光标位置可以直接输入字符。

如果输入的表达式长于文本框，则会自动换行。对于大型的表达式，可以拖动文

本框右侧的滑动条进行查看。另外，文本框支持字符串的剪切、复制、粘贴和删

除操作。Font 按钮用于控制表达式的字体属性，Apply 按钮确认表达式更改，

Undo 按钮用于取消上一次的 Apply 操作，激活 Evaluated 选项将计算文本框中表

达式的数值。 
●  中部：提供对象属性和求解器函数。 
●  底部：数码盘以及常用函数列表。 
编辑完毕，单击 OK 按钮应用该表达式并退出表达式编辑器对话框，单击 Close 按钮退

出表达式编辑器对话框。 
（1）对象属性（Properties）。 
对象属性标签提供了对象的属性列表。在列表中选定对象属性，然后单击 Add 按钮即

可将该属性插入到文本框的表达式，例如，使用车辆左前轮轮心点 x 坐标，可通过以下操作

实现。 
1）激活对象属性标签。 
2）在模型树中寻找前轮所从属的子系统 Frnt SLA susp（1 pc. LCA）。 
3）打开 Points 文件夹，展开轮心点 Wheel CG。车辆对称建模，因此会有左右两个轮心。 
4）打开左轮心点，并找到#x 项，此时在对象属性标签下将显示该选项的变量名及数值。 
5）单击 Add 按钮，即可将该变量插入到文本框的表达式中，如图 2-69 所示。 

 

图 2-69  对象属性应用 
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（2）运动（Motion）。 
运动标签提供了位移、速度、加速度函数，如图 2-70 所示。单击某个函数按钮，即可

将该函数插入到文本框的表达式中。 

 

图 2-70  运动标签 

例如，测量物体质心在全局坐标系中 x 轴方向的位移，可通过以下操作实现。 
1）激活运动标签，单击 DX 按钮，此时文本框显示如图 2-71 所示（光标位于大括号内）。 

 

图 2-71  表达式编辑器文本框 

2）激活对象属性标签，在模型树中找到待测量物体的质心标记点。 
3）选择 idstring 并单击 Add 按钮，此时文本框显示如图 2-72 所示。 

 

图 2-72  编辑表达式 
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4）激活 Evaluated 选项，可检查该表达式是否正确。新建模型，MotionView 还未给对

象分配编号，此时检查结果为“DX（）”。单击 Tools→Check model 检查模型后，MotionView
将为各对象分配编号，此时再使用 Evaluated 功能即可得到“DX（30102020）”。 

注： 
1）表达式需要用点号（`）括起来。该点号正确的输入方法是英文输入法下的 键。 
2）DX 函数的标准格式为 DX（I， J， R），其中 I 表示待计算的标记点编号，J 表示位移计

算时相对标记点编号，R 表示参考坐标系。J 和 R 可以省略，省略时表示计算 I 标记点在全

局坐标系下 x 轴的绝对位移。基于标准格式的表达式如下： 

`DX（{b_0.cm.idstring}，{Global_Frame.idstring}，{Global_Frame.idstring}）` 

（3）力元（Force）。 
力元标签提供了力、转矩和约束函数，如图 2-73 所示。单击某个函数按钮，即可将该

函数插入到文本框的表达式中。 

 

图 2-73  力元标签 

例如，测量某约束副的约束反力，可通过以下操作实现。 
1）激活力元标签，单击 JOINT 按钮，此时文本框显示如图 2-74 所示（光标位于第一

个大括号内）。 

 

图 2-74  表达式编辑器文本框 

2）激活对象属性标签，从模型树中选择待测量的约束副编号变量填入第一项，如图 2-75
所示。 

3）在表达式第二项中输入 0。0 表示输出 I 标记点的约束反力；1 表示输出 J 标记点的

约束反力。 
4）在表达式第三项中输入 1。1 表示输出约束反力的合值；2、3、4 分别表示输出约束

反力在 x、y、z 轴方向上的分量；5 表示输出约束转矩的合值；6、7、8 分别表示输出约束

转矩在 x、y、z 轴方向上的分量。 
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图 2-75  编辑表达式 

5）在表达式最后一项中输入 0。0 表示输出值的参考坐标系为全局坐标系。最终的表达

式如图 2-76 所示。 

 

图 2-76  完整表达式 

（4）通用函数（General）。 
如图 2-77 所示，通用函数标签提供了丰富的函数功能，单击某个函数按钮，即可将该

函数插入到文本框的表达式中。 

 

图 2-77  通用函数标签 
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下面介绍一些常用的函数，对于其他函数，可参看本书附录 A。 
DX：调用格式为 DX（I，J，K），表示标记点 I 相对于标记点 J 的 X 轴上的投影或分

量。其中 K 是可选项，若未指定，则使用全局坐标系，如图 2-78 所示。与 DX 函数类似的

函数是 DM、DY 和 DZ。 
AX：调用格式为 AX（I，J），表示标记点 I 相对于标记点 J 的 X 轴旋转的角度。其中 J

是可选项，若未指定，则使用全局坐标系。计算 AX 时，将 I 的 Y 轴相对 J 的 Y 轴逆时针旋

转，得到的角度即是 AX，如图 2-79 所示。 

      

                 图 2-78  DX 函数示意图                  图 2-79  AX 函数示意图 

FX：该函数格式为 FX（I， J， K），表示返回自 I 作用于 J 的合力在 K 的 X 轴向上的分量。

其中 K 是可选项，如果未指定，则使用全局坐标系。与 FX 类似的函数有 FM、FY、FZ、
TM、TX、TY 和 TZ。 

STEP：该函数格式为 0 0 1 1STEP（ ， ， ， ，y ）x x y x ，表示用一个三次多项式构造一个阶跃函数。

其中，x 为独立变量， 0x 为起始点， 0y 为起始点处的函数值， 1x 为终止点， 1y 为终止点处

的函数值。STEP 的数学表达式见式（2-8） 

          

0 0
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0 1 0 0 1

1 01 0

1 1

 （ ）
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≥

 （2-8） 

STEP 函数示意图如图 2-80 所示，与其类似的函数是 STEP5。该函数使用五次多项式构

造阶跃函数。 
VARVAL：该函数格式为 VARVAL（Variable），用于

获取状态变量的值，通常用在与状态变量有关的操作

中，如控制系统中。 
AKISPL：该函数格式为 AKISPL（First Independent 

Variable，Second Independent Variable，Spline，Derivative 
Order）。它使用 Akima 插值方法对样条线型数据进行微分

计算，并返回一个样条线型数据。其中，First Independent 
Variable 为第一个独立变量，Second Independent Variable 为第二个独立变量，两者共同组成

了一个曲面，第二个独立变量是可选的。Spline Name 是样条线型数据，Derivative Order 为

微分阶次，可取 0，1 和 2，分别表示不微分、一次微分和二次微分。与 AKISPL 类似的函数

还有 CURVE 和 CUBSPL，CURVE 使用 B 样条线（B-Spline）插值方法对曲线型数据进行微

 

图 2-80  STEP 函数示意图 
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分计算，CUBSPL 使用三次样条线型（Cubic Spline）插值方法进行微分计算。 
SHF：该函数格式为SHF 0（x，x ，A，w， ， y）ϕ ，是一种简谐函数。其中，x 为独立变量，任何

有效的表达式均可用做独立变量，如使用 I 标记点相对 J 标记点在坐标系 K 下的 Z 轴向位移

作为独立变量 x=DZ（I，J，K）； 0x 为独立变量的偏置量；A 为简谐函数幅值；w 为简谐函数频

率，默认使用弧度每单位独立变量进行度量，如果使用角度，则在其数值后加 D；ϕ 为相位

差，默认使用弧度进行度量，如果使用角度，则在其后数值加 D；y 为简谐函数的均值。

SHF 的数学表达式为 0SHF （ （ ） ）= Asin w x x + y− − ϕ 。 
IF：该函数是一个判断函数，其格式为 IF（EXPR1： EXPR2， EXPR3， EXPR4）。如果

EXPR1<0，则返回 EXPR2 的值；如果 EXPR1=0，则返回 EXPR3 的值；如果 EXPR1>0，则

返回 EXPR4 的值。 
RTOD：该函数是一个将弧度转换为角度数值的乘积系数，等于 180/π。与其对应的函

数 DTOR 是一个将角度转换为弧度数值的乘积系数，等于π/180。 
TIME 类似于状态变量，返回当前的仿真时间，可在函数中用做独立变量。 

2. 7.7  宏菜单 

MotionView 的宏菜单（Macros）提供了几何点创建、角度测量、查询连接对象、创建

变形曲面参考标记点以及接触约束编辑功能。 
（1）几何点创建（Create Points Between Points）。 
几何点创建工具提供了多种几何点创建功能，如图 2-81 所示。 

 

图 2-81  几何点创建工具面板 

1）Create points equally spaced along a vector（沿指定向量均布创建几何点）。 
① Define vector using points（根据点定义向量）。 
●  Select first point（选择第一个点）：单击 Point/Node 按钮选择第一个点。 
●  Select second point（选择第二个点）：单击 Point/Node 按钮选择第二个点。 
●  Place data in（新建点位置）：单击 System 按钮选择新建点从属的系统。 
●  Number of points（点个数）：指定待创建的点个数。 
●  Points varname prefix（点变量名前缀）：指定待创建点变量名前缀。 
●  Points label prefix（点名称前缀）：指定待创建点名称的前缀。 
② Define vector using base point and vector（根据点和向量定义向量）。 
●  Select Point（选择点）：单击 Point/Node 按钮选择点。 
●  Select Vector（选择向量）：单击 Vector 按钮选择向量。 
●  Place data in（新建点位置）：单击 System 按钮选择新建点从属的系统。 
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●  Distance between points（点间距）：指定待创建点的间距。 
●  Number of points（点个数）：指定待创建点的个数。 
●  Points varname prefix（点变量名前缀）：指定待创建点变量名前缀。 
●  Points label prefix（点名称前缀）：指定待创建点名称前缀。 
2）Create points equally spaced along a curve（沿指定曲线均布创建几何点）。 
●  Number of points 点个数：指定待创建的点个数。 
●  Points varname prefix（点变量名前缀）：指定待创建点变量名前缀。 
●  Points label prefix（点名称前缀）：指定待创建点名称前缀。 
●  Points for curve fit（曲线拟合）：指定用于拟合曲线的点数量，最少为 4 个。 
●  Point/Node collectors（选择器）：单击 Point/Node 按钮选择用于曲线拟合的点。选择

点的数量应与 Points for curve fit 中的一致。 
3）Create point at center of a circle（在圆弧中心处创建几何点）。 
●  Select first point（选择第一个点）：单击 Point/Node 按钮选择第一个点。 
●  Select second point（选择第二个点）：单击 Point/Node 按钮选择第二个点。 
●  Select third point（选择第三个点）：单击 Point/Node 按钮选择第三个点。 
●  Place data in（新建点位置）：单击 System 按钮选择新建点从属的系统。 
●  Points varname prefix（点变量名前缀）：指定待创建点变量名前缀。 
●  Points label prefix（点名称前缀）：指定待创建点名称前缀。 
●  Keep values as Parametric equations：默认情况下，新建点由原始点的参数化定义而

来。激活该选项，在点创建后，点坐标依然保持参数化定义。 
●  Create Points：运行宏程序创建几何点。 
（2）角度测量（Calculate Angles）。 
角度测量工具提供了几何点之间空间或平面角度的测量功能，如图 2-82 所示。 

 

图 2-82  角度测量工具 

●  Select first point（选择第一个点）：单击 Point 按钮选择第一个点。 
●  Select vertex（选择顶点）：单击 Point 按钮选择顶点。 
●  Select third point（选择第三个点）：单击 Point 按钮选择第三个点。 
●  Select reference marker（选择参考标记点）：单击 Marker 按钮定义参考坐标系。 
●  Absolute angle（绝对角度）：三点之间的空间角度。 
●  XY In Reference：所测角度在指定参考坐标系的 XY 平面的角度投影。 
●  YZ In Reference：所测角度在指定参考坐标系的 YZ 平面的角度投影。 
●  XZ In Reference：所测角度在指定参考坐标系的 XZ 平面的角度投影。 
●  XY Global：所测角度在整体坐标系的 XY 平面的角度投影。 



第 2 章 
MotionView 基本知识 

 63 

●  YZ Global：所测角度在整体坐标系的 YZ 平面的角度投影。 
●  XZ Global：所测角度在整体坐标系的 XZ 平面的角度投影。 
（3）查询连接对象（Find Connected Entities） 
查询连接对象工具可查询与所选对象（体、铰或衬套单元）相连接的对象，如图 2-83

所示。相连接的对象将列于面板右侧的文本框内且高亮显示在图形区。 

 

图 2-83  查询连接对象面板 

●  Find entities connected to：指定查询的连接对象类型为体（Body）、铰（Joint）或衬套

（Bushing）。 
●  Select entity：指定被查询的对象。 
●  Undo：取消最后一步操作。 
●  Redo：重做最后一步操作。 
●  Reset：返回默认设置。 
注：单击列于文本框的对象将直接进入该对象面板 。 
（4）创建变形曲面参考标记点（Create Markers For Deformable Surface）。 
创建变形曲面参考标记点工具可快速创建用于定义变形曲面的参考标记点矩阵，如图 2-84

所示。 

 
图 2-84  创建变形曲面参考标记点 

●  Select the body：选择待创建标记点所从属的体。 
●  Select the FEM file：应用文件浏览器选择有限元文件。该工具将在有限元模型的各个

节点位置创建标记点，使用的有限元模型每行节点的数量必须一致。 
●  Maximum number of marker rows：允许创建的标记点最大行数。 
●  Maximum number of marker columns：允许创建的标记点最大列数。 
●  Generate：创建标记点。 
（5）接触约束编辑器（Contact Properties Editor）。 
接触约束编辑器可进行接触约束的修改，如图 2-85 所示。 
●  Impact：列出当前系统中所有 Impact 类型的接触约束。 
●  Stiffness：材料刚度系数。 
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图 2-85  接触约束编辑器 

●  Exponent：力指数，非负。 
●  Damping：阻尼系数。 
●  Penetration depth：穿透深度。 
●  ：单击这两个按钮可以转换接触算法类型。在列表中选择某个接触约束，然

后单击鼠标转换该接触的算法类型。多个接触可通过鼠标配合<Shift>+<Ctrl>
键选择。 

●  Friction：接触约束的摩擦力参数。 
●  Calculation options：控制接触约束是否考虑摩擦力的影响。 
●  MU Static：静摩擦系数。 
●  MU Dynamic：动摩擦系数。 
●  Stiction transition velocity：当接触点相对滑动速度逐渐减少时，摩擦系数从 MU 

Dynamic 变化到 MU Static。当滑动速度等于 Stiction transition velocity 时，摩擦系数

等于 MU Static。 
●  Friction transition velocity：当接触点相对滑动速度逐渐增大时，摩擦系数从 MU 

Static 变化到 MU Dynamic。当滑动速度等于 Stiction transition velocity 时，摩擦系数

等于 MU Dynamic。 
●  Poisson：列出当前系统中所有 Poisson 类型的接触约束。 
●  Penalty：惩罚系数。 
●  Resitution_coeff：恢复系数，反映接触过程中的能量损失。 
●  Help：显示"Force Contacts"相关内容的在线帮助。 
●  Close：关闭对话框。 

2.8  偏好设置 

MotionView 的选项对话框（Options）为用户提供了多种偏好设置功能。该对话框可通

过单击 Tools→Options 命令调用。 
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（1）外观（Appearance）。 
外观标签提供了图形区背景色、前景色、网格线等修改功能，如图 2-86 所示。 

 

图 2-86  Options 对话框外观标签 

① Colors：修改下述对象的颜色。单击调色板，选择新颜色并单击 OK 按钮即可完成颜

色更改。 
●  Mesh lines：更改网格线颜色。 
●  Global X axis/Global Y axis/ Global Z axis：更改全局坐标系轴线颜色。 
●  Foreground：更改前景色（如全局坐标系的轴线标志颜色）。 
●  Background 1：更改图形区第一背景色，默认为蓝色。截图输出时，自动使用白色

背景。 
●  Background 2：更改图形区第二背景色，默认为灰色。 
●  Parametric field background：更改所有参数化定义文本框颜色。 
② Background gradient：设置图形区背景色变换梯度 
③ Show：显示控制。 
●  Global axes：在默认情况下，全局坐标系显示在图形区左下角。取消选中该选项可以

隐藏全局坐标系。 
●  Model Title：在默认情况下，模型名称显示在图形区上端。取消选中该选项可以隐藏

模型名称。 
④ Image capture：抓图功能。 
Reverse video：截图时，更改背景色为白色，文本颜色为黑色。 
（2）可视化（Visualization）。 
可视化标签用于设置模型放缩倍数，默认为 1.2 倍。  
（3）光线（Lighting）。 
光线标签用于设置图形区的光照角度、光泽度等。激活 Preview 选项，可在图形区实时
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更新设置变化。 
●  Direction：通过水平和竖直滚动条调整光线角度。 
●  Specular：定义图形对象的光泽度。 
（4）鼠标（Mouse）。 
鼠标标签用于定制鼠标操作的按键与功能。 
（5）模型检查（Check Model）。 
模型检查标签用于设置模型检查时的输出信息。在默认情况下，Error Message 和

Warning Messages 自动输出，因此这两项不可用。 
（6）路径管理（Path Management）。 
路径管理标签用于设置模型的路径保存方式。 
●  Convert all to absolute：将所有文件（特别是曲线、图形和柔性体等对象）路径转换

为绝对路径。 
●  Convert all to relative：将所有文件（特别是曲线、图形和柔性体等对象）路径转换为

相对路径。 

2.9  初识 MotionView 界面 

本练习将学习以下内容： 

●  MotionView 用户界面功能。 
●  MotionView 文件的载入与保存。 
●  对象编辑与选择。 
●  鼠标控制与视图控制。 
●  MotionView 窗口布局调整与应用程序调用。 
MotionView 作为多体系统动力学分析模型的前处理器，构建在 HyperWorks Desktop 平

台上。同时，该平台还提供了一个交互式的、便捷的环境，可进行多体系统动力学分析或有

限元分析结果可视化、数据后处理。 
表 2-12 描述了 HyperWorks Desktop 平台支持的数据类型以及文件打开与保存功能。 

表 2-12  HyperWorks Desktop 平台支持的数据以及文件打开与保存功能 

文 件 类 型 扩  展  名 应 用 程 序 打 开 功 能 保 存 功 能 

会话脚本 .mvw Any 菜单栏 菜单栏 

报告模板 .tpl Any 工具栏 菜单栏 

MDL 模型 .mdl MotionView 工具栏 工具栏 

动画 .gra、.res、 h3d、.flx、.mrf HyperView 工具栏 工具栏 

曲线 .req、.mrf、.abf、.plt、.res （ADAMS） HyperGraph 工具栏 无 

模板脚本及文本文件 .tpl、.txt TextView 工具栏 工具栏 
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练习开始前，复制 chap02 目录下的 soliton.mdl 文件到工作文件夹中。 

载入和保存 MDL 模型文件 

MotionView 模型文件只能在 MotionView 应用程序下打开。任何试图在动画或曲线窗口

打开的操作，软件都将产生错误信息。 
（1）启动 MotionView。 
●  Window：单击菜单开始→程序→Altair HyperWorks→MotionView。 
●  Linux：在 open terminal 中激活 ～hw_install/altair/scripts/mview，这里～hw_install 为

软件的安装目录。 
（2）在标准工具栏中单击 Open Model 按钮 ，或从 File 菜单中选择 Open→Model 命令。 
（3）在弹出的 Open Model 对话框中选择工作文件夹下的模型文件 soliton.mdl。 
（4）单击 Open 按钮，载入模型，如图 2-87 所示。 

 
图 2-87  MotionView 窗口与 Pendulum 模型 

（5）从 File 菜单中选择 Save As→Model 命令，弹出 Save As Model 对话框，如图 2-88
所示。 

 
图 2-88  Save As Model 对话框 

注：单击标准工具栏上的 Save Model 按钮 ，可将当前模型以原有名称保存在工作路径

 STEP 
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中。如果该模型是新建模型，则软件将提示用户指定模型名称。 
（6）选择工作路径并在 File name 文本框中输入模型名称为 model.mdl。 
（7）单击 Save 按钮，保存模型。 

使用项目浏览器 

（1）在用户界面左侧的项目浏览器中展开 Pendulum 模型文件夹。 
（2）查看蓝色 Pendulum 文件夹下的内容。Pendulum 文件夹分为多个子文件夹，这些子

文件夹中包含了 Pendulum 模型的所有对象。黄色的文件夹代表对象集合，如点、体、铰

等，蓝色的文件夹代表系统集合。 
（3）展开 Pendulum 下的 Points 文件夹，内含 3 个点：Global Origin、Pivot Point 和 CM 

Point。 
（4）单击 Pivot Point，主菜单区域将进入 Point 面板，面板中显示 Pivot Point 坐标。同

时，Pivot Point 在图形区及项目浏览树中高亮显示。 
（5）在默认情况下，MotionView 中的几何点以黄色球体的形式显示在图形区。使用鼠标

单击几何点将显示该点的名称，释放鼠标后，主面板将进入 Point 面板并显示该点的坐标。 
（6）展开项目浏览树 Bodies 文件夹，该文件夹包含 Ground Body 和 Pendulum Body 两

个几何体。 
（7）单击 Pendulum Body，主菜单区将进入 Body 面板并显示 Pendulum 的属性。 
（8）单击查看 Pendulum 文件夹下其他子文件夹内容。 

对象选择与编辑 

（1）单击 Model-Reference 工具栏中的“几何体”按钮 ，如图 2-89 所示。 

 
图 2-89  Model-Reference 工具栏 

（2）在图形区单击第一个 Link body，如图 2-90 所示。 

 
图 2-90  Link body 选择 

 STEP 

02 

 STEP 

03 



第 2 章 
MotionView 基本知识 

 69 

此时，主菜单区进入 Body 面板并显示该几何体的属性。 
（3）输入下述数值：Mass=1，Ixx=500，Iyy=1000，Izz=1000，Ixy=Ixz=Iyz=0 
（4）在图形区的第一个 Link body 处右击，选择 Joint→Select 命令，如图 2-91 所示。 
此时，该铰将在项目浏览树高亮显示，并且主菜单区将直接进入该铰的属性面板。 

 

图 2-91  铰选择 

鼠标控制与视图控制 

（1）按住<Ctrl>键并移动鼠标左键旋转模型。 
（2）按住<Ctrl>键并移动鼠标右键平移模型。 
（3）按住<Ctrl>键并滚动鼠标中键放缩模型。 
（4）应用 3D View Controls 工具同样可以完成模型的视图控制操作。如“模型放缩”按

钮 ，单击鼠标可以放大模型，右击可以缩小模型。模型放缩比例由 Tools 菜单下的 Options
控制。进入 Options 窗口的 Visualization 选项，将默认的比例系数 1.2 修改为 3.0，如图 2-92
所示。单击 OK 按钮关闭窗口。单击“模型放缩”按钮 ，查看不同的放缩比例带来的视图

变化。 

 

图 2-92  模型放缩比例调整 
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（5）单击 Standard Views 工具栏中的“适合屏幕”按钮 ，可将模型最大化显示在图

形区。 
（6）单击 3D View Controls 工具栏中的“左右旋转”按钮 和“上下旋转”按钮 ，可

使模型分别按照竖直轴和水平轴旋转。鼠标左键和右键用于控制旋转方向。 
（7）单击“顺时针/逆时针”按钮 ，控制模型以垂直屏幕的轴线旋转。鼠标左键用于

顺时针旋转，鼠标右键用于逆时针旋转。 
（8）单击 Standard Views 工具栏中的“等轴视图”按钮 ，控制模型以等轴视图显示。 

窗口布局调整与应用程序调用 

（1）单击 Page Controls 工具栏中页面窗口布局按钮 右侧的三角符号，选择两窗口布

局 。 
（2）在新窗口内单击鼠标左键激活该窗口。 
（3）在应用程序选择列表选择 HyperView 程序，将窗口 2 由 MotionView 更改为

HyperView，如图 2-93 所示。此时，菜单、工具栏等功能也发生相应的改变。 

 

图 2-93  应用程序选择列表 

2.10  小结 

MotionView 是一款通用多体系统动力学分析前处理器，采用 Windows 风格的现代化图

形界面，功能强大，且易学易用。为提高建模效率，MotionView 提供了下拉菜单、模型浏

览树以及快捷工具栏 3 种建模方式，以满足不同建模习惯的用户需求。另外，MotionView
开放的架构以及强大的用户定制功能，将大大扩展软件的应用范围。 
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第 3章     

 刚体系统建模与仿真 

本章通过 5 个刚体系统动力学分析实例，介绍了应用 MotionView & MotionSolve 软件创建

机构虚拟样机模型、仿真分析以及结果后处理的基本方法，主要内容包括构件的创建、约束的

定义、载荷的施加、仿真参数的设置、模型求解、动画结果与曲线结果的输出与查看等。通过

本章的学习，可以深入了解MotionView & MotionSolve 刚体系统建模与仿真的基本过程。 

本章重点知识 
 
 

3.1  汽车前悬架系统建模与仿真 

3.2  汽车后备箱盖开启机构建模与仿真 

3.3  确动凸轮机构建模与仿真 

3.4  随动机构建模与仿真 

3.5  半车机构模态分析 

3.6  小结 
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3.1  汽车前悬架系统建模与仿真 

在 MotionView 前处理环境中，除了使用软件自带工具创建简单的模型外，还可以输

入 CAD 创建复杂模型。在输入 CAD 模型时，零件的质量、转动惯量和质心位置信息可自

动计算出来。同时，为方便边界条件的定义，MotionView 可保留和应用 CAD 模型中的几

何点信息。 

本示例将练习以下 4个方面内容： 

●  CATIA格式的装配体模型导入。 

●  根据多体动力学分析的需要进行模型简化。 

●  约束与其他控制参数定义。 

●  求解与结果查看。 

练习开始前，复制 chap03/CAD 目录下的所有文件到工作文件夹，工作路径中不能含有

中文字符。 

CAD模型导入 

本步将指导用户进行模型导入及简化。 

（1）在MotionView中新建一个会话。 

（2）在菜单栏中，选择 File→Import→Geometry命令。此时，弹出 Import CAD or FE对

话框。 

（3）在 Import Option处，选择 Import CAD or Finite Element Model With Mass and Inertias

选项，即在输入模型的同时，计算模型各个零部件的质量及转动惯量信息。 

（4）在 Import File下拉列表中选择 Catia。 

（5）单击 Import File 栏的“文件浏览”按钮 ，选择工作文件夹下的 Front Assembly. 

CATProduct。 

（6）单击 Open按钮。 

（7）单击Output Graphic File栏的“文件浏览”按钮 ，指定输出文件为 front_assembly.h3d。 

（8）单击 Save按钮。 

（9）单击并展开MDL Options，可以观察到图 3-1所示的选择面板。 

 

图 3-1  Import CAD or FE对话框的MDL Options选项 
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MDL Options 面板给予用户在读取模型文件时最大的灵活性。在本练习中，所有设置均

采用默认设置。 

（10）单击Meshing Options for Surface Data按钮，将展开图 3-2所示的面板。 

除了基本的 CAD模型读取功能外，CAD输入工具还提供了使用 HyperMesh进行模型表

面网格划分的功能。在需要进行接触计算的场合，高质量的表面网格有助于提高仿真结果精

度。此外，Launch HyperMesh to create MDL points可以通过 HyperMesh将模型中的节点转化

为MDL几何点，本练习不使用该功能。 

（11）单击 Locator Points（Must be in source reference frame）按钮，将弹出图 3-3所示的

参数选取面板。 

      

       图 3-2  Import CAD or FE对话框的                  图 3-3  Import CAD or FE对话框的 

      Meshing Options for Surface Data选项                         Locator Points选项 

当 CAD 模型与 MotionView 中的模型不在同一坐标系时，用户可应用 Locator Points 功

能，通过指定 CAD模型中 3个几何点或坐标位置，将 CAD模型转换到与 MotionView模型

相同的坐标系中。 

（12）完成上述设置后，单击 OK按钮。此时将弹出 Import CAD对话框，显示正在读入

的 CAD模型的体积、密度及质量信息。 

（13）将输入模型单位制 Input File Length（长度）设置为Millimeter（毫米），使用默认

的密度 7.83e-6，并单击 OK按钮，如图 3-4所示。 

 

图 3-4  Import CAD对话框 



MotionView & MotionSolve 

应用技巧与实例分析 

 74 

（14）当 CAD 模型成功输入后，用户界面中将弹出

如图 3-5所示的提示信息。 

此时，模型将完整地输入到 MotionView 前处理界面中

的当前活动窗口中。CAD 模型中的各个零部件将在

MotionView 前处理环境中转化为独立的几何体。在 CAD 模

型中，即使是最小的零部件（如螺栓、垫片等）都将作为一

个独立的几何体存在于MotionView的模型中。为了控制模型

规模，用户需要对其进行适当的整理，将这些较小的几何体与模型中的主要零部件进行连接。 

如果希望进一步减小模型规模，对于体积较小的、转动惯量和质量都可以忽略不计的零

部件，可以直接删除，由此对计算结果产生的影响可以忽略不计。 

（15）单击“确定”按钮，关闭导入信息提示对话框。 

（16）单击 Close按钮，关闭Message Log对话框。 

（17）选择 Tools→Check Model命令，检查模型并为转换的对象赋予编号。 

（18）在模型浏览树中，单击 Model，并单击展开模型树。右击编号为 30102 的几何

体，在弹出的快捷菜单中选择 Rename命令，将其重命名为Wheel，如图 3-6所示。 

注意：如果 CAD模型导入时，默认名称与本实例不同，则可使用编号选择对象。 

（19）用同样的方法对模型中其他的几何体，进行重新命名操作。Body 名称对应关系如

表 3-1所示。 

 

 

图 3-6  Body重命名 

（20）在模型浏览树中展开 Graphics 文件夹，并单击最后一个图形文件（编号为

90015）。 

（21）在 Connectivity面板中单击 Body，并选择 Strut Holder。 

（22）在模型浏览树中展开 Bodies 文件夹，右击编号为 30117 的几何体，并选择 Delete

命令，删除这个几何体。 

（23）重复步骤（20）～（22），根据表 3-2的提示信息，对 Graphic图形文件与 Body之

间的关联性进行调整，并删除不必要的 Body对象。 

表 3-2  Graphic与 Body关联性 

待关联的图形编号 目标几何体 待删除的几何体编号 

90014 Strut Holder 30116 

90013 Wheel Hub 30115 

 

图 3-5  模型成功导入提示信息 

表 3-1  Body名称对应关系 

编    号 名    称 

30103 Wheel Hub 

30104 Lower Control Arm 

30105 Axle Shaft 

30106 Strut Holder 

30107 Damper Top 

30109 Damper Lower 
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（续） 

待关联的图形编号 目标几何体 待删除的几何体编号 

90012 Strut Holder 30114 

90011 Wheel Hub 30113 

90010 Strut Holder 30112 

90008 Damper Lower 30110 

90006 Damper Top 30108 

注意：在后续的建模环节中，需要在 Body Damper Top和 Body Damper Lower之间建立

弹簧阻尼单元，因此本模型并不需要编号为 30111的几何体。 

（24）删除编号为 30111 的几何体。在删除该几何体时，将会弹出相应的对话框，提示

是否同时删除与该几何体相关联的图形文件，单击 Yes按钮。 

完成以上操作后，模型已处于最简状态。 

（25）将模型保存为 front_susp.mdl。 

Body创建完毕后，需要创建几何点用于定位铰。这里，可以使用批处理方法创建点。 

（26）在 View菜单中选择 Command Window命令。 

（27）在命令窗口右击，选择 File→Load File命令。 

（28）选择工作文件夹下的 Point_Import.tcl脚本。 

（29）选择工作文件夹下的 suspension_points.csv文件，该文件包含了几何点的坐标信息。 

（30）单击 Open按钮。 

通过脚本，自动完成了几何点创建。 

（31）在 View菜单中单击 Command Window，关闭命令窗口。 

（32）保存模型。 

创建铰链 

（1）在模型浏览树中右击 Model，并选择 Add Constraint→Joint 命令（或右击 Model -

Costaint工具栏的 Joints按钮 ），弹出 Add Joint or JointPair对话框。 

（2）设置 Label为Wheel Spindle RJ，Variable为 j_whl_spindle_revj。 

（3）在 Type中选择 Revolute Joint。 

（4）单击 OK按钮。 

（5）在主面板的 Joint面板中，选择Wheel作为Body1；选择Wheel Hub作为Body 2；单击

Origin处的Point，选择 Point8；单击Alignment axis处的Point，选择 Point20，如图 3-7所示。 

 
图 3-7  Joint 面板（步骤 5） 
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（6）类似地，按表 3-3所示的内容，使用默认的变量名，继续创建铰链。 

表 3-3  铰链参数 

编号 Label Type Body 1 Body 2 Origin（s） Orient Method Reference 1 Reference 2 

1 Strut Hub Fix Fixed Joint Wheel Hub Strut Holder Point9    

2 Damper Hub Fix Fixed Joint 
Damper 

Lower 
Strut Holder

Body.1.4 CG

（编号为 

301006）

   

3 
Damper Lower 

Upper Trans 
Translation Joint

Damper 

Lower 
Damper Top Point24 Axis（Pt） Point10  

4 
Damper Upper 

Ground UJ 
Universal Joint Damper Top

Ground 

Body 
Point10 

Shaft（Pt）， 

Shaft（Vect） 
Point24 Global X 

5 Axle Hub Fix Fixed Joint Axle Shaft Wheel Hub

Body.1.3 CG

（编号为 

301005）

   

6 
Hub Control Arm 

Ball 
Ball Joint 

Lower 

Control Arm
Wheel Hub Point4    

7 
Control Arm 

Ground Rev 
Revolute Joint

Lower 

Control Arm

Ground 

Body 
Point2 Axis（Pt） Point3  

注：选择Ground Body时，可以使用鼠标单击图形区的全局坐标系。类似地，可以选取全局坐标系的某个轴线作为铰的指向。 

创建弹簧阻尼单元 

（1）在模型浏览树中右击Model，并选择 Add Force Entity→Spring Dampers命令（或在

Model-Force 工具栏中右击 Spring Dampers 按钮 ），弹出 Add SpringDamper or Spring 

DamperPair对话框。 

（2）定义 Label 为 Strut-SpringDamper，定义 Variable 为 sd_strut，指定弹簧类型为 Coil 

Spring（拉簧）。 

（3）单击 OK按钮。 

（4）在主菜单的 SpringDamper面板中单击 Body1，选择 Damper Top；单击 Body2中，

选择 Damper Lower。 

（5）在 Point1和 Point2中，分别选择 Point10和 Point1。 

（6）在Measure Between Points中，注意两点的距离应为 259.942，如图 3-8所示。 

 

图 3-8  SpringDamper面板 

（7）在 Preload标签中，定义 Free Length为 259.942。 

（8）在 Properties标签中，设置 stiffness （K Linear）为 10，damping （C linear）为 0.1。 

（9）在模型浏览树中右击 Model，并选择 Add Reference Entity→Graphic 命令（或右击

Model-Reference工具栏中的 Graphic按钮 ）。 

（10）在 Label中，输入 Spring，并接受默认的变量名。在 Type中，选择 Spring。 

（11）单击 OK按钮。 

 STEP 

03 



第 3章 

刚体系统建模与仿真 

 77 

（12）在 Connectivity面板中，选择 Strut-SpringDamper作为其 Parent。 

（13）选择 Point10及 Point1作为该 Graphic文件的 Point1和 Point2，如图 3-9所示。 

 

图 3-9  Graphic面板 

（14）单击 Properties标签，在 Radius中输入 40，在 Coils中输入 10。 

创建台架 

本步将创建用于施加向车轮往复运动的台架。 

（1）在模型浏览树中右击 Model，并选择 Add Reference Entity→Body 命令（或在

Model-Reference工具栏中右击 Body按钮 ），弹出 Add Body or BodyPair对话框。 

（2）指定 Body的 Label为 Jack Dummy，Variable为 b_jdummy。 

（3）单击 OK按钮。 

（4）在 Body面板的 Properties标签中指定质量及转动惯量，如图 3-10所示。 

 

图 3-10  Body面板 

（5）进入 CM Coordinates面板，选中 Use center of mass coordinate system复选框。 

（6）指定 Origin为 Point11。 

（7）在模型浏览树中右击 Model，并选择 Add Reference Entity→Graphic 命令（或右击

Model-Reference工具栏中的 Graphic按钮 ）。 

（8）在弹出的 Add Graphic or GraphicPair 对话框中设置 Label 为 Jack Plate，并选择其

Type为 Cylinder，接受其他的默认设置并单击 OK按钮。 

（9）在 Connectivity面板中，设置其 Parent Body为 Jack Dummy。 

（10）将 Origin设置为 Point11，将 Direction设置为 Point8，如图 3-11所示。 

 

图 3-11  Graphic面板（步骤 10） 
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（11）激活 Properties标签，将 Autolen切换为 Length，并指定其为-30。 

（12）在 Radius 1中输入 250。 

（13）在模型浏览树中右击 Model，并选择 Add Constraint→Joint 命令（或右击 Model-

Constraint工具栏中 Joint按钮 ）。 

（14）在弹出的 Add Joint or JointPair对话框中设置 Label为 Jack Wheel Inplane，设置

Variable为 j_jack_wheel。在 Type下拉菜单中，选择 Inplane Joint。 

（15）单击 OK按钮。 

（16）在 Connectivity 标签的 Body1 中指定 Wheel，在 Body2 中指定 Jack Dummy，在

Origin中指定 Point11，在 Normal中指定 Point8，如图 3-12所示。 

 
图 3-12  Joint面板（步骤 16） 

（17）新建另一铰链，其 Label设置为 Jack Ground Trans，其Variable设置为 j_jack_grnd，

其类型 Type选择为 Translational Joint。 

（18）单击 OK按钮。 

（19）在 Connectivity 面板的 Body1 中选择 Jack Dummy，在 Body2 中选择 Ground 

Body，在 Orgin中选择 Point11，在 Axis中选择 Point8，如图 3-13所示。 

 
图 3-13  Joint 面板（步骤 19） 

（20）至此，所有连接定义完毕，前悬架模型如图 3-14所示。 

 

图 3-14  前悬架模型 
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（21）保存模型。 

定义输入条件，并递交求解 

本步骤将创建驱动约束，并定义结果输出请求。 

（1）在模型浏览树中，右击 Model，选择 Add Constraint→Motion 命令（或在 Model-

constraint工具栏中右击Motion按钮 ）。 

（2）在弹出的 Add Motion 对话框中，设置 Label 为 Jack Motion，设置 Variable 为

mot_jack。 

（3）在 Connectivity面板的 Joint中指定 Jack Ground Trans，如图 3-15所示。 

 

图 3-15  Motion面板 

（4）在 Properties 标签中，指定激励加载方式为 Expression，激活表达式文本框，输入

`50*sin（TIME）`作为位移驱动函数。 

（5）创建另一个驱动约束，设置 Label为Wheel Spindle，设置 Variable为 mot_wheel。 

（6）在 Connectivity标签中的 Joint中选择Wheel Spindle RJ。 

 

图 3-16  Joint 面板（步骤 6） 

（7）在 Properties 标签的 Motion 中输入 0。转角为 0，保证了 Wheel 不会绕着其轴自由

转动。 

（8）在模型浏览树中，右击 Model，选择 Add General MDL entity→Output 命令（或在

Model-General工具栏中右击 Output按钮 ）。 

（9）在弹出的Add Output对话框中，设置 Label为Wheel_center，设置Variable为 o_disp。 

（10）单击 OK按钮。 

（11）在 Output 面板中，选择输出结果为 Displacement，指定 Body1 为 Wheel，Body2

为 Ground Body；pt on Body1为Wheel的质心 Body.1 CG（如不一致，可使用编号选取，该

几何点编号为 301002），其他保留默认设置，如图 3-17所示。 

（12）保存模型。 

（13）单击 Run按钮 ，进入 Run面板。 

（14）在 Main 标签中单击“文件浏览”按钮 ，指定求解器输入文件的名称（front_ 

susp.xml）与路径。 

 STEP 
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图 3-17  Output面板 

（15）在 Sim Type下拉菜单中的求解类型中选择 Static+Transient。 

（16）单击 Check 按钮，检查模型构成、系统自由度、是否有未定义质量的构件以及过

约束情况等。 

注意：在默认情况下，MotionView 仅提示模型中的错误信息及警告信息。如需检查系

统自由度，则可选择 Tools→Options命令，进入 Check Model选项，选中 Degrees of Freedom

复选框。 

（17）确定模型没有错误后，单击 Run按钮。 

（18）完成求解后，单击 Animate 按钮进入 HyperView 后处理界面。HyperView 将自动

加载计算结果。 

（19）单击 Plot按钮，单击窗口 3，进入 HyperGraph后处理界面。根据图 3-18，绘制轮

心位移曲线。 

 

图 3-18  仿真结果 

注：MotionSolve 提供了瞬态（Transient）分析、静态（Static）分析、准静态（Quasi-

Static）分析以及线性模态（Linear）分析 4种仿真类型。 

1.瞬态分析 

在瞬态分析中，求解器将根据系统自由度决定进行运动学分析或是动力学分析。 
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如果系统自由度为 0，则进行运动学分析。此时，由系统中各种类型的铰链以及驱动约

束构成的代数方程完全确定了机构的运动状态。这些约束及其相对时间的导数常用于计算构

件的位移、速度和加速度，根据力平衡方程可计算约束反力。为获得准确的约束反力，需要

提供构件实际的质量、质心位置以及转动惯量等信息。使用不正确的质量、转动惯量等信息

可获得正确的运动结果，但约束反力值却是错误的。运动学分析的主要目的是获得正确的机

构运动结果，而这些参数不会影响运动结果，因此在求解过程中，求解器仅提出警告信息，

而不会报错并中断求解过程。 

如果系统自由度大于 0，则进行动力学分析。动力学分析将求解一系列微分或微分-代数

方程组（其中代数方程组来自模型中的约束），获得力与运动之间的关系。MotionSolve 支持

以下 4种类型的方程构成形式。 

（1）常微分方程组（ODE）。 

MotionSolve 通过坐标分离技术将 DAE 形式的运动方程转换为 ODE 形式，并提供了刚

性（VSTIFF和MSTIFF）和非刚性求解器（ABAM）。 

（2）指标 3方程（Index-3）。 

指标 3 方程方法可将微分—代数方程组（DAE）直接提交给求解器。MotionSolve 使用

DASPK 积分器求解指标 3 形式的机构运动方程。在求解过程中，该方法不会监测机构速度

及加速度状态的积分误差，因而求解速度快，但速度项和加速度项结果存在一定误差。 

（3）指标 2方程（Index-2）。 

指标 2 方程方法提供了一种稳定的微分—代数方程组给求解器。MotionSolve 使用

DASPK 积分器求解指标 2 形式的机构运动方程。在求解过程中，该方法将监测机构位移及

速度状态的积分误差，结果精度高，但求解速度相对指标 3方法稍慢。 

（4）指标 1方程（Index-1）。 

指标 1方程方法作为指标 2方程方法的扩展，提供了一种更加稳定的微分—代数方程组

给求解器。“稳定”是指方程求解过程中除了位移和速度约束，还加入了加速度约束，因此

相对于指标 2 方程方法，指标 1 方程方法结果精度更高，但求解速度更慢。MotionSolve 使

用 DASPK积分器求解指标 1形式的机构运动方程。 

2.静态分析 

静态分析用于寻找系统的静平衡位置。静平衡指系统承受的所有力与力矩平衡的状态。

MotionSolve提供了两种静态分析算法。 

（1）最大动能方法（MKEAM）。 

根据动力学问题构建模型，去掉模型中所有阻尼。此时将获得一个保守系统，即系统能

量（由动能与势能构成）保持不变。 

1）启动数值积分，监测系统动能。如果监测到最大动能，停止积分并回退精确定位最

大动能的时刻。由于系统是保守的，最大动能发生的时刻即是最小势能产生的时刻。 

2）此时，将所有的速度和加速度设置为零，产生零动能。然后重启积分程序。 

3）步骤 1）～2）构成一个完整的迭代，如果找到的最大动能是理想最大动能，则系统

已处于平衡位置。然而，由于积分器的离散特性，实际求解过程并不是如此顺利。因而需要

重复进行上述迭代直至满足下述收敛准则。 
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●  最大动能误差（Max K.E. Tol.）：指两次迭代中最大动能的改变量。 

●  最大位移误差（Max Delta q Tol.）：指两次迭代中广义坐标的最大改变量。 

●  最大迭代次数（Max Iterations）：指求解停止前进行迭代的最大次数。 

MKEAM方法有以下优势： 

●  只寻找稳定的平衡位置。 

●  适用于平衡位置远离装配位置的系统。 

（2）力不平衡方法（Force Imbalance Method，FIM）。 

力不平衡方法将运动方程中所有的速度和加速度项设置为零，以获得一个非线性系统方

程（其中广义坐标和约束力是未知量），然后使用 Newton-Raphson 算法寻找平衡位置。 

与 MKEAM 类似，FIM 方法也可以用于寻找稳定和不稳定的平衡位置。但是，FIM 方

法在处理平衡位置离装配位置较远的情况或模型有不连续因素作用的场合时，会有困难。因

而MKEAM和 FIM方法是互补的。MotionSolve提供了 3种 FIM方法： 

●  FIM_E是原始的力不平衡方法，不支持所有的MotionSolve对象。 

●  FIM_S是一种修正的力不平衡方法，支持除 Force_Contact之外的所有MotionSolve对象。 

●  FIM_D 是一种基于时间积分的准静态方法，不是一种完全静态的解决方案。除了使

用 Param_Static 指定的参数，FIM_D 还使用 Param_Transient 中定义的参数来控制

DAE的积分过程。如果需要一种完全静态的解决方案，FIM_D将自动转到 FIM_S。 

3.准静态分析 

在真实世界中，准静态指系统缓慢运动，不会产生任何动态效应。在数学意义上，准静

态分析是给定时间内一系列静态分析的组合。当需要在含有时变载荷或驱动的系统中寻找一

系列静平衡位置时，准静态分析非常有用。 

分析开始时，模型当前装配位置作为起始点，应用力不平衡方法计算模型平衡位置，因

而系统中不再出现不平衡力或力矩，所有的运动约束均满足。这一位置将作为下一次分析的

起始。求解器将严格根据用户指定的步长求解模型，太大的步长可能导致收敛失效。 

4.线性分析 

MotionSolve线性分析提供以下功能： 

（1）用于稳定性或振动分析。 

MotionSolve线性分析可在以下位置进行模型线性化并计算系统特征值与正则模态。 

●  模型装配位置。 

●  模型静平衡位置。 

●  瞬态分析结束位置。 

特征值用于预测系统稳定性以及共振频率，正则模态用于研究振动系统的运动情况。 

（2）用于控制系统设计。 

通过线性化分析获得一个简化的系统，定义系统输入/输出，然后使用 MotionSolve 可获

得系统的状态空间描述。 

= +

= +

x Ax Bu

y Cx Du

⎧
⎨
⎩

&

&
 （3-1） 
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系统输入/输出可由 Control_PlantInput 和 Control_PlantOutput 分别定义。应用 Param_Linear

命令启动线性分析，产生如下结果： 

●  MATLAB格式的A、B、C、D矩阵，分别写入以*.a、*.b、*.c和*.d为扩展名的文件中。 

●  状态空间形式的线性系统写入.mdl 格式的 Simulink 模型文件（该文件与 MotionView

模型文件的扩展名相同）。 

●  特征值写入*.eig文件。 

●  每个特征向量对应一个.mrf 文件。该文件与 MotionView 模型动画文件（.maf）一起

用于描述系统的振型动画。 

3.2  汽车后备箱盖开启机构建模与仿真 

本示例将练习以下 4个方面内容： 

●  创建汽车后备箱盖开启机构。 

●  为模型附加 H3D格式图形文件。 

●  使用MotionSolve进行机构运动学分析。 

●  使用 HyperView查看求解结果。 

练习中使用的模型如图 3-19 所示。图 3-20 显示了将要创建的四杆机构。表 3-4 列出

了模型中构件定位点坐标。 

      

      图 3-19  汽车后备箱盖模型                    图 3-20  汽车后备箱盖四杆机构简图 

表 3-4  模型中构件定位点坐标 

Label Variable X Y Z 

A p_a 921 580 1124 

B p_b 918 580 1114 

C p_c 915 580 1104 

D p_d 896 580 1106 

E p_e 878 580 1108 

F p_f 878 580 1118 

G p_g 830 580 1080 

H p_h 790 580 1088 

I p_i 825 580 1109 
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在练习开始前，复制 chap03 目录下的 motion_curve.csv、Point_Import.tcl、point_data.csv、

trunk.hm和 trunklid.hm文件到工作文件夹中。 

创建几何点 

（1）启动MotionView。 

（2）右击Model-Reference工具栏中的 Point按钮 。 

（3）在弹出的 Add Point or PointPair 对话框中的 Label 文本框中输入 Point A，在

Variable文本框中输入 p_A，指定点类型为 Single。 

Label 用来帮助用户辨别不同的对象，Variable 将提供给 MoitionSolve 以识别不同的对

象。当然，在 AddPoint or PointPair 对话框中可以使用默认的名称。PointPair 用来创建以总

体坐标系中 X-Z平面为对称面的两个对称点。 

（4）单击 OK按钮，弹出 Point面板。 

（5）输入 Point A的坐标值 X、Y和 Z。 

（6）重复步骤（3）～（5），创建点 B～I。注意，在 Add Point or PointPair对话框中设

置每个点的 Label 和 Variable。单击 Apply 按钮可以一次创建多个几何点。Data Summary 对

话框将显示所有已创建的几何点，同时在该对话框中可以修改几何点的坐标值。 

（7）上述点也可通过 Point_Import.tcl脚本创建。创建步骤如下： 

1）启动MotionView。 

2）在 View菜单下选择 Command Window命令。 

3）在命令窗口区域右击选择 File→Load File命令。 

4）选择并打开工作路径下的 Point_Import.tcl。 

5）在弹出的 Source file对话框中选择 point_data.csv。 

从视窗控制面板将视图转换为 Lft视图，如图 3-21所示。 

 

图 3-21  已创建坐标点的分布 

创建几何体 

汽车后备箱盖开启机构由 4 个刚性杆连接而成：ground、input、coupler 和 follower。

在默认情况下，MotionView 将自动创建 ground，本步将介绍如何创建 input、coupler 和

 STEP 

01 
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follower。 

（1）右击Model-Reference工具栏中的 Body按钮 ，弹出Add Body or BodyPair对话框。 

（2）在 Label文本框中输入 Input link，使用默认的 Variable名称。 

（3）单击 OK按钮，进入 Body面板。 

（4）单击 Properties标签，输入几何体属性，如图 3-22所示。 

 

图 3-22  Body面板（步骤 4） 

（5）激活 CM Coordinates 标签，选中 Use center of mass coordinate system 选项。在

Origin 按钮下单击 Point 按钮，此时 Point 按钮将被浅蓝色方框包围，表明 Point 处于激活

状态。 

（6）再次单击 Point按钮，在弹出的 Select a Point对话框中选择 Point G。或者在图形区

拖动鼠标左键直至出现 G，释放鼠标，即可选择 Point G。使用默认方向 orient two axes。 

上面提及的两种方法可以应用到其他实体选择操作中，如几何体、铰等。在选择大地

（Ground Body）或全局坐标原点（Global Origin）时，可以单击图形区的全局坐标系符号。 

（7）重复步骤（1）～（6），创建刚性杆 Follower和Coupler。分别指定质量及转动惯量为 

-Mass=1 

-Ixx=Iyy=Izz=1000，Ixy=Ixz=Iyz=0 

（8）分别指定 B和 D为刚性杆 Follower和 Coupler的质心。 

添加显示图形 

MotionView 中的图形分为 3 类：隐式图形（Implicit）、基本图形（Primitive）和外部图

形（external）。 

●  Implicit指创建 Point、Body、Joint等对象时在 MotionView 中生成的图标。它们只在

建模过程中帮助用户确认操作正确与否，在运行仿真过程动画时不显示。 

●  Primitive指圆柱、立方体、球体等基本图形，在运行仿真过程动画时显示。 

●  External指外部导入图形。MotionView的 Import CAD or FE菜单能够将 CAD文件及

有限元文件转换成 MotionView 可以识别的.h3d 格式文件。同时，用户可将.g 文件、

ADAMS的.shl文件以及 wavefront的.obj文件直接输入到MotionView中。 

（1）打开所有的隐式图形（Implicit）。 

1）在Model菜单中选择 ImplicitGraphics命令，弹出 Implicit Graphics Settings对话框，

如图 3-23所示。 

2）激活所有 Visible复选框。 
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图 3-23  Implicit Graphics Settings对话框 

3）单击 Close按钮，关闭 Implicit Graphics Settings对话框。 

隐式图形的状态（图形显示或隐藏）不会保存在当前的模型文件中。MotionView 在以

下几种情况中使用默认设置： 

●  在其他窗口中创建一个新的模型。 

●  启动一个新的会话。 

●  载入一个已有的.mdl或.mvw模型到新的会话中。 

（2）为了更好地观察四杆机构，需要在模型中添加基本图形。 

（3）右击Model-Reference工具栏中的 Graphic按钮 ，弹出 Add Graphic orGraphicPair

对话框。 

（4）指定图形名称（Label）和变量名（Variable），可以使用默认名称。 

（5）在 Type下拉菜单中选择 Cylinder并单击 OK按钮，进入 Graphic面板。 

（6）在 Connectivity 标签中双击 Body 按钮，在 SelectaBody 列表中选择 Follower，并单

击 OK按钮。此时，新建的图形与 Follower相关联。 

（7）单击 Origin下的 Point按钮，指定圆柱的原点。 

（8）选择 Point A。 

（9）单击 Direction下的 Point按钮。 

（10）选择 Point C。 

（11）在 Propertie标签中的 Radius 1文本框中输入 2。 

（12）重复步骤（2）～（11），根据表 3-5，为余下的 Bodies创建图形。 

表 3-5  图形参数 

Graphic type  Body Origin Direction Radius 

Cylinder Coupler Point C Point E 2 

Cylinder Input Link Point F Point E 2 

Cylinder Input Link Point E Point G 2 

Cylinder Input Link Point G Point H 2 

Cylinder Input Link Point H Point I 2 
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添加外部图形 

MotionView 可通过 HyperMesh 将 CATIA、IGES、STL、VDAFS、Pro/E 及 UG 等格式

的模型转换成 MotionView 识别的文件以生成更加逼真的图形。本步使用这种转换功能将一

个 HyperMesh 格式的汽车后备箱盖文件转换成 H3D 格式文件，同时使用 locator points功能

将转换成功的 H3D模型定位到MotionView模型中。 

locator points：指 H3D 图形文件坐标系上的 3 个几何点。H3D 图形文件与 MotionView

模型文件匹配时，这 3 个几何点与 MotionView 模型的 3 个点对应，实现自动定位、自动定

向和自动放缩。对于 HyperMesh文件，可以使用节点编号代替几何点坐标。 

（1）在 Tools菜单中选择 Import CAD or FE，弹出 Import CAD or FE对话框。 

（2）激活 Import CAD or Finite Element Model Only选项。 

（3）在 Input File栏中选择 HyperMesh。 

（4）单击 Input File右侧的“文件浏览”按钮 ，选择 trunklid.hm作为输入文件。 

（5）单击 OutputFile 右侧的“文件浏览”按钮 ，指定输出的 H3D 格式文件名为

trunklid.h3d。 

（6）单击 Locator Points前的“+”，展开定位点选项。 

（7）选中 Node Ids单选按钮，分别输入 1、2和 3，代表 HyperMesh文件中的 Node1、

Node2和 Node3，如图 3-24所示。 

（8）单击 OK按钮，开始模型转换。 

（9）Import CAD or FE 程序将在后台运行 Hyper 

Mesh，并将HyperMesh格式文件转换成H3D文件。 

（10）单击 OK 按钮，转换结束后，将提示转换成

功信息“Import was a Success！”。 

（11）按照步骤（1）～（10）将 trunk.hm转换为 trunk.h3d。 

输入 H3D文件 

（1）右击Model-Reference工具栏中的 Point按钮 ，根据表 3-6创建 3个几何点。 

表 3-6  几何点参数 

Point Name X Y Z 

Node 1 365 497 766 

Node 2 362 -436 773 

Node 3 749 10 1144 

（2）在模型浏览树中单击 Graphics文件夹下的 g_trunklid。 

（3）在 Connectivity 标签中双击 Body 按钮，在 Select a Body 下拉列表中选择 Follower

并单击 OK按钮。 

 STEP 

04 

 STEP 

05 

 

图 3-24  定位点设置 
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（4）进入 Location标签，在该标签中设定 H3D图形文件的位置、方向与比例。 

接下来，将 H3D 模型的定位点匹配到 MotionView 模型相应的几何点上，进行

trunklid.h3d模型位置调整。 

（5）将调整方法切换成 Auto Position and Orient。 

（6）根据图 3-25匹配定位点。 

 

图 3-25  定位点匹配 

（7）单击 fit按钮 ，查看后备箱盖是否正确地装配到Motion View中。 

（8）类似地，在模型浏览树中选择 g_trunk，设置 Body为 Ground Body，本步不需调整

定位点。 

注：在 HyperView动画处理窗口中，使用 Add Object工具也可以添加 H3D图形。 

创建旋转副 

汽车后备箱盖开启机构由 4个旋转副连接而成，旋转副分别位于点 A、C、E和 F上，

方向平行于全局坐标系 Y轴。 

（1）右击Model-Constraint工具栏中的 Joint按钮 ，弹出Add Joint or JointPair对话框。 

（2）在 Label文本框中输入 Ground-Follower，使用默认的变量名。 

（3）在 Type中旋转 Revolute Joint。 

（4）单击 OK按钮，进入 Joint面板。 

（5）在 Connectivity标签中单击 Body1按钮，此时 Body1按钮被浅蓝色方框包围。 

（6）在图形区按住鼠标左键滑过总体坐标系图标直至显示 Ground Body，释放鼠标左

键。此时 Bodies 面板中的 Ground Body 已被选作 Body1，而浅蓝色方框移动到 Body2 按

钮， Body2处于激活状态。 

（7）单击 Body2按钮，弹出 Select a Body对话框。 

（8）在模型树左侧区域选择 Bodies文件夹。 

（9）在右侧区域选择 Follower。 

（10）单击 OK按钮，返回 Connectivity标签。 

（11）在 Origin下单击 Point按钮两次，弹出 Select a Point对话框。 

（12）选择 Point A作为旋转副的原点，单击 OK按钮。 

（13）在 Alignment Axis 下指定旋转副的方向。单击 Point 左侧的下三角符号并选择

Vector。 

（14）选择 Global Y作为旋转副方向。 

（15）重复步骤（1）～（14），根据表 3-7创建余下的旋转副。 

 STEP 

06 
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表 3-7  四杆机构中相关约束副参数 

Revolute Joint Label Body1 Body2 Point Vector 

Follower-Coupler Follower Coupler C Global Y 

Coupler-Input Coupler Input Link E Global Y 

Input-Ground Input Link Ground F Global Y 

 

指定机构运动 

机构的驱动约束可由 Linear、Expression 或 Curve 三种方式定义。本例中将使用一条曲

线作为机构驱动输入。 

（1）右击Model-Reference工具栏中的 Curves按钮 ，弹出 Add Curves对话框。 

（2）为新创建的曲线指定名称（Label）和变量名（Variable），或直接使用默认值。 

（3）单击 OK按钮，进入 Curves面板。 

（4）选择 2D Cartesian和 x，然后单击“文件浏览”按钮 ，弹出 Select a file对话框。 

（5）选择工作文件夹下的 motion_curve.csv。 

（6）保留默认值，即 Type：Unknown，Request：Block 1，Component：Column 1。 

（7）选中 y单选按钮，注意到此时 motion_curve.csv文件已被选择。 

（8）指定 y轴数据为 Type：Unknown，Request：Block 1，Component：Column 2。 

（9）单击 Show Curve按钮可以预览曲线，如图 3-26所示。 

 

图 3-26  曲线预览 

（10）右击Model-Constraint工具栏中的Motions按钮 ，弹出 Add Motion or MotionPair

对话框。 

（11）为新的驱动指定名称（Label）和变量名（Variable）。 

（12）单击 OK按钮，进入Motion面板。 

注：这种使用曲线来指定机构运动关系的方法也可用来指定其他约束（如 Force、

Spring、Damper、Bushing等）的属性。 

（13）在 Connectivity标签中单击 Joint按钮两次，弹出 Select a Joint对话框。 

 STEP 

07 
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（14）从模型树中选择名为 Input-Ground的旋转副。 

（15）在 Properties标签中单击 Linear右侧的下三角符号，选择 Curve。 

（16）单击 Curve按钮两次，弹出 Select a Curve对话框。 

（17）从模型树中选择已创建的曲线并单击 OK按钮。 

创建输出请求 

创建结果输出有以下 3种方式： 

●  使用 Body、Point和Marker默认的结果输出。 

●  直接查询 Force、Bushing和 Springle-damper对象结果输出。 

●  创建基于上述对象输出项目的数学表达式进行结果输出。 

在本步骤中将创建两物体间的相对位移输出，使用数学表达式创建 Input Link质心 G相

对全局坐标系的位移输出。 

（1）右击Model-General工具栏中的 Outputs按钮 ，弹出 Add Output对话框。 

（2）为新创建的输出指定名称（Label）和变量名（Variable），也可使用默认值。 

（3）单击 OK按钮，进入 Output面板。 

（4）创建两物体上两点之间的位移输出，选择 Displacement。 

1）Body 1和 Body 2分别选择 Input Link和 Ground Body。 

2）Pt on Body1和 Pt on Body2分别选择 Point I和 Global Origin。 

3）记录两点间的位移（一点相对另一点的位移）。 

（5）创建另一个输出：Input Link质心 G在全局坐标系 X方向的位移输出。 

1）右击工具栏中的 Outputs按钮 。 

2）使用默认的名称和变量名。 

3）单击 OK按钮。 

4）在 Properties标签中选择 Expressions，如图 3-27所示。 

 

图 3-27  Output面板 

5）单击 F2 文本框，此时激活 fx 按钮，单击 fx 按钮，弹出 Expression Building （）对话

框，如图 3-28所示。 

6）在Motion标签中单击 DX按钮。 

7）将光标置于 DX后的括号内。 

8）在 Properties标签中，打开模型树 Bodies/Ground Body/cm。 

9）选择 idstring，如图 3-29所示。 

 STEP 

08 
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                图 3-28  Expression Building对话框                           图 3-29  模型树 

10）单击 Add按钮。 

11）添加一个逗号（，）以分割下一个表达式。 

12）在 Properties标签中，打开模型树 Bodies/Input link/Marker CM。 

13）选择 idstring。 

14）单击 Add按钮。 

（6）编辑窗口中的表达式与下列表达式相一致。 

'DX（{B_Ground.cm.idstring}，{b_0.cm.idstring}）'  

（7）单击 OK按钮。 

注：上述表达式中变量名 b_0代表 input link。如果在创建 input link时指定了不同的变

量名，那么要使用这个指定的变量名来代替上式中的 b_0。所有表达式均要求写在符号``之

间，该符号前后都不能有任何字母、空格以及数字等字符，否则 MotionView 会显示图 3-30

所示的错误信息。该符号与键盘中的～键为同一按键，而不是引号键。 

 

图 3-30  报错信息 

（8）如需检查模型错误，则可进入 Tools菜单选择 Check Model命令。 

模型中所有的错误将在 Message Log 中列出。如果检查模型自由度，则可选择 Tools→
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Options命令，进入Check Model选项，选中Degrees of Freedom复选框。 

使用MotionSolve求解模型 

MotionSolve 可以进行多体系统的静力学、准静力学、运动学及动力学分析。它集成于

MotionView中，MotionSolve的输入文件是由 MotionView创建的 XML格式文件。本步将使

用MotionSolve进行汽车后备箱盖开启机构的运动学分析。 

（1）单击工具栏中的 Run按钮 。 

（2）在 Run面板中，单击 Check按钮检查模型是否存在错误。 

（3）在Main标签中，设置 Sim Type为 Transient。 

（4）在 Save as文本框中指定求解器输出文件为 trunk_fourbar.xml。 

（5）选中 Export MDL snapshot复选框。 

（6）选中 Simulation Parameters标签，指定仿真终止时间 End Time为 5，Print interval为

0.01。在默认情况下 MotionView 使用 second 作为时间单位。用户可以通过 Forms 面板 修

改单位制。 

注：只有运动学仿真结果取决于输出间隔（print interval），动力学仿真结果不依赖于

输出间隔，因为积分器不会改变仿真步长去匹配输出步，相反积分器会提供插值结果进行

输出。 

（7）在Main标签中单击 Run按钮求解模型。 

在同一页面中查看仿真动画和结果曲线 

（1）求解结束后，Animate和 Plot按钮被激活，如图 3-31所示。 

 

图 3-31  Run面板 

（2）单击 Animate按钮，将载入第二个窗口（HyperView），并自动加载动画结果。 

（3）单击工具栏中的 Start/Pause Animation按钮 ，播放动画。 

（4）再次单击 Start/Pause Animation按钮 ，停止播放。 

（5）单击 Plot 按钮，将在同一页面中载入第三个窗口（HyperGraph），并自动加载数据

结果。 

（6）设置 X轴数据类型为 Time。 

（7）根据表 3-8设置 Y轴数据。 

（8）单击 Apply 按钮，Point I 的位移

曲线显示在窗口 3中，如图 3-32所示。 

 STEP 
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10 

表 3-8  输出数据相关参数 

Y Type Marker Displacement 

Y Request Displacement（on input link） 

Y Component DM 
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图 3-32  仿真结果 

3.3  确动凸轮机构建模与仿真 

本示例将学习以下内容： 

●  输入 HM格式装配体到MotionView。 

●  定义约束。 

●  应用MotionSolve进行瞬态分析。 

●  应用 HyperView查看仿真结果。 

本示例将模拟一个确动凸轮机构的运动过程。在该机构中，五边形转子的转动将转换为

滑条的平动。确动凸轮机构模型如图 3-33所示。 

 

图 3-33  确动凸轮机构模型 

练习开始前，复制 chap03目录下的 for_contact_tutorial.hm文件到工作文件夹中。 
 

输入 HM模型 

（1）新建一个MotionView会话。 

（2）从 File下拉菜单中选择 Import→Geometry命令，弹出 Import CAD or FE对话框。 

（3）将 Import Options设置为 Import CAD or Finite Element Model With Mass and Inertias。 

 STEP 
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（4）将 Input File 类型切换成 HyperMesh，单击其后的“文件浏览”按钮 ，选择并打

开工作文件夹下的 for_contact_tutorial.hm模型。 

（5）指定 Output Graphic File到工作路径。 

（6）如图 3-34所示，展开Meshing Options for Surface Data，选中 Allow HyperMesh to 

specify mesh options单选按钮，并选中 Launch HyperMesh to create MDL points复选框。该选

项可激活 HyperMesh，并在 HyperMesh界面中指定节点作为MDL几何点。 

 

图 3-34  Import CAD or FE对话框 

（7）单击 OK 按钮，进行模型转换。此时将启动 HyperMesh，并自动加载 for_contact_ 

tutorial.hm模型。 

（8）进入 HyperMesh，单击模型浏览树区域的 Mask 标签。HyperMesh 中的确动机构模

型如图 3-35所示。 

 

图 3-35  HyperMesh中的确动机构模型 

（9）单击 Elements文件夹下 2D、3D子文件夹处的“-”，隐藏图形区的所有单元。 
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此时，图形区仅显示黄色的节点。这些节点是自定义的，用于 MotionView 建模时定义

约束和加载的辅助点。 

（10）按住<Shift>键，拖动鼠标左键框选所有节点。 

（11）单击 Mask 标签中 Elements 文件夹下 2D、3D 子文件夹处的“+”，显示图形区所

有单元。此步若缺失，MotionView模型输入工具将无法转换 HyperMesh模型。 

（12）单击 proceed按钮。 

（13）在弹出的 Import FE 对话框中使用默认设置，单击

OK 按钮。此时弹出输入成功提示对话框，单击“确定”按钮，

并关闭软件处理日志窗口，如图 3-36所示。 

（14）进入MotionView界面，Motion View中的确动机构模

型如图 3-37所示。 

 

图 3-37  MotionView中的确动机构模型 

（15）进入MotionView模型浏览树，查看自动创建的 Points、Graphics和 Bodies。 

注：如果在 Import CAD or FE 对话框中的 Meshing Options for Surface Data 处选择

interactive mesh，则可以在 HyperMesh 中对模型网格重新编辑。对于参与接触的物体表面，

高质量的网格将有助于获得高精度的仿真结果；对于不参与接触的物体，可以粗化其网格，

以降低转换的 H3D图形文件的规模。 

在本示例中，零件的质量、转动惯量、质心等信息将自动计算。如果待转换的模型文件

中没有材料数据（如 hm 模型没有正确定义 Material 和 Property 卡片），那么转换后的 H3D

文件中将不包含这些信息。这种情况下，用户需要手动输入上述信息。 

简化和整理模型 

展开模型浏览树的 Graphics 文件夹，分别单击 Master 和 Slave，可以看到这两个图形是

 

图 3-36  提示对话框 
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机构中参与接触物体的表面。之所以定义表面图形，是为了减少接触计算的几何特征，以提

高接触约束的稳定性。这里将Master和 Slave分别关联到 Circle和 Pentagon体上，并将其原

始关联的几何体删除。 

（1）单击Master，进入 Graphic面板。 

（2）在 Connectivity 标签中双击 Body 按钮，在弹出的 Select a Body 对话框中选择

Pentagon，如图 3-38所示。 

（3）单击 OK按钮。 

 

图 3-38  Graphic面板（步骤 3） 

（4）类似地，将 Slave与 Circle体关联，如图 3-39所示。 

 

图 3-39  Graphic面板（步骤 4） 

（5）在模型浏览树中展开 Bodies文件夹，选择Master和 Slave，右击删除这两个体。 

（6）在模型浏览树中展开 Points 文件夹，可以看到除自动计算的质心点外，还有通过

HyperMesh选择创建的几何点。为便于后续定义，这里修改几何点名称以提高其可读性。 

（7）根据表 3-9修改几何点名称。如果几何点没有编号，可选择 Tools→Check Model命

令为其赋加编号。 

表 3-9  几何点信息 

坐    标 
编    号 

X Y Z 
推 荐 名 称 

301009 32.44715 45.14389 -47.5214 P_Stand_Driver 

301010 19.84112 65.46389 -29.5293 P_Driver_Pentagon 

301011 -50.2853 62.92389 -47.4706 P_Slider_Circle 

301012 -50.2853 62.92389 -47.4706 P_Stand_Slider 

301013 32.4471 45.14389 37.98218 P_Stand_Ground 

几何点重命名操作可通过以下任一种方式实现： 

1）在模型浏览树中，右击待编辑的几何点，在弹出的快捷菜单中选择 Rename，如图 3-40

所示。 
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2）单击 Point面板的 Entity Note按钮 ，在弹出的 Point or PointPair Info对话框中修改

Label，如图 3-41所示。 

          

                 图 3-40  点重命名                      图 3-41  Point or PointPair Info对话框 

添加约束副 

本步骤将为模型添加约束副，表 3-10列出了需要添加的约束副类型及连接关系。 

表 3-10  约束副类型及连接关系 

Type Label Body 1 Body 2 Origin Vector 

Fixed F_Stand_Ground Stand Ground P_Stand_Ground - 

Revolute R_Stand_Driver Stand Driver P_Stand_Driver Global Y 

Translational T_Stand_Slider Stand Slider P_Stand_Slider Global X 

Revolute R_Driver_Pentagon Driver Pentagon P_Driver_Pentagon Global Y 

Fixed F_Slider_Circle Slider Circle P_Slider_Circle - 

（1）右击 Joint 按钮 ，在弹出的 Add Joint or JointPair 对话框中指定 Label 为

F_Stand_Ground，使用默认的变量名，切换铰类型为 Fixed Joint，单击 OK按钮。 

（2）在 Joint面板中双击 Body1按钮，在弹出的 Select a Body对话框中选择 Stand。 

（3）双击 Body2按钮，在弹出的 Select a Body对话框中选择 Ground Body。 

（4）双击 Point按钮，在弹出的 Select a Point对话框中选择 P_Stand_Ground。 

（5）用同样的方法，按照表 3-10创建余下约束副。 

创建运动驱动 

（1）右击Motion按钮 ，在弹出的 Add Motion or MotionPair对话框中使用默认的名称

与变量名，单击 OK按钮。 

（2）在 Motion 面板中双击 Joint 按钮，在弹出的 Select a Joint 对话框中选择 R_Stand_ 

Driver，指定 Property为 Velocity，如图 3-42所示。 

 STEP 
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图 3-42  Motion面板 

（3）进入 Properties标签，使用 Linear方式定义驱动函数，在 Value文本框中输入 1.0。 

创建接触约束 

（1）右击工具栏中的 Contact 按钮 ，在弹出的 Add Contact 对话框中使用默认的名称

与变量名，单击 OK按钮。 

（2）在 Contact 面板中双击 Body I 按钮，在弹出的 Select a Body 对话框中选择

Pentagon，单击 OK按钮。 

（3）在 Body1下的 Graphic选项区选中Master Graphic。 

（4）Graphic 选项区用于指定参与接触的几何特征。这里仅选择五边形零件的外轮廓曲

面，可以提高接触约束的稳定性以及结果精度。 

（5）双击 Body J按钮，在弹出的 Select a Body对话框中选择 Circle，单击 OK按钮。 

（6）在 BodyJ下的 Graphic选项区选中 Slave Graphic，如图 3-43所示。 

 

图 3-43  Contact面板（Connectivity标签） 

（7）进入 Properties标签，根据图 3-44所示的内容设置接触约束属性。 

 

图 3-44  Contact面板（Properties标签） 

定义输出 

（1）右击工具栏中的 Output 按钮 ，在弹出的 Add Output 对话框中使用默认的名称与

变量名，单击 OK按钮。 

（2）选择结果输出类型为 Force，将输出对象设置为 Joint。 

（3）双击 Joint按钮，在弹出的 Select a Joint对话框中选择 R_Stand_Driver，单击 OK
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按钮。 

此步将输出旋转副 R_Stand_Driver 上的约束反力。接下来再创建一个输出请求，用于输

出 Pentagon与 Circle之间的接触力。 

（4）右击工具栏中的 Output按钮 ，在弹出的 Add Output对话框中使用默认的名称与

变量名，单击 OK按钮。 

（5）选择结果输出类型为 Expressions。 

（6）单击 F2处的文本框，此时将激活 fx按钮。 

（7）单击 fx按钮，进入表达式编辑器。 

（8）在表达式编辑器的文本框中输入以下表达式： 

'CONTACT（{con_0.idstring}， 0， 1， 0）' 

其中，con_0为 Pentagon与 Circle之间接触约束的变量名。 

CONTACT函数语法如下：CONTACT（id， jflag， comp， rm） 

其中，id为接触约束副的编号；jflag用于指定接触对中的 I物体或 J物体接触力或接触

力矩输出；comp 表示定义的输出结果分量，1、2、3、4 分别表示接触力的合值、X 轴分

量、Y 轴分量和 Z 轴分量，5、6、7、8 分别表示接触力矩的合值、X 轴分量、Y 轴分量和 Z

轴分量；rm表示输出结果所参考的坐标系，O表示全局坐标系。 

（9）单击 OK按钮。 

求解模型 

（1）选择 File→Save→Model命令，保存模型为 for_contact_tutorial.mdl。 

（2）单击工具栏中的 Run按钮 ，进入 Run面板。 

（3）在 Main 标签中单击 Save as 区域的“文件浏览器”按钮 ，指定求解模型的名称

（for_contact_tutorial.xml）与存放路径。 

（4）进入 Simulation Parameters标签，指定 End time为 8.0，使用默认的结果输出间隔。 

（5）进入 Transient 标签，将 Integrator type 切换成 VSTIFF，分别指定 Integration 

tolerance和Max stepsize为 0.0001和 0.001。 

（6）返回Main标签，单击 Run按钮，求解模型。 

查看结果 

（1）求解结束后，Animate和 Plot按钮被激活，如图 3-45所示。 

 

图 3-45  Run面板 
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（2）单击 Animate按钮，将载入第二个窗口（HyperView），并自动加载动画结果。 

（3）单击工具栏中的 Start/Pause Animation按钮 ，播放动画。 

（4）再次单击 Start/Pause Animation按钮 ，停止播放。 

（5）单击 Plot 按钮，此时将在同一页面中载入第三个窗口（HyperGraph），并自动加载

数据结果。 

（6）根据图 3-46所示的内容输出旋转副约束反力曲线。 

 

图 3-46  约束反力曲线输出 

（7）根据图 3-47所示的内容输出接触力曲线。 

 

图 3-47  接触力曲线输出 

（8）仿真结果如图 3-48所示。 

 

图 3-48  仿真结果 

（9）从 File下拉菜单中选择 Save→Session命令，保存会话。 

（10）选择 File→Exit命令，关闭会话。 
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3.4  随动机构建模与仿真 

本节将学习如何创建点线副。点线副是一种高副约

束，它约束了一个物体的特定点只能沿着另一体上的某

一指定曲线运动。约束曲线可以是闭合的或开放的平面

或空间曲线，点可以从属于刚性体或柔性体。在某些场

合下，点线副可以替代接触约束。这将为用户提供极大

的便利，因为很多情况下，使用接触约束需要进行多次

参数微调，而恰当地使用点线副约束可以避免这一情

况发生。一个典型的例子是如图 3-49 所示的凸轮结

构。用户可在动杆与凸轮之间建立点线副约束。其中，

点位于动杆端点，而约束曲线可以参考凸轮轮廓，从而

避免了复杂的接触约束设置。 

练习开始前，复制 chap03 目录下的 CamProfile. 

h3d、CamProfile.csv和 FollowerProfile.h3d文件到工作文

件夹中。 

创建几何点 

首先创建用于定位体和铰的几何点。 

（1）新建一个MotionView会话。在本练习使用的单位制有 kg、mm、s、N。 

（2）在模型浏览树中右击 Model，选择 Add Reference Entity→Point命令（或右击 Point

按钮 ），弹出 Add Point or PointPair对话框。 

（3）在 Label中输写 PivotPoint。 

（4）接受默认的变量名称，并单击 OK按钮。 

（5）在 Point面板中单击 Properties标签，指定点坐标为 X=0.0、Y=0.0、Z=0.0。 

（6）使用类似的方法，按照表 3-11所示的内容，继续定义其他点。 

表 3-11  几何点信息 

Point X Y Z 

FollowerCM 0.0 65.557 0.0 

FollowerPoint 0.0 25.0 0.0 

FollowerJoint 0.0 85.0 0.0 

CamCM 0.0 -14.1604 0.0 

创建几何体 

（1）在模型中需要定义凸轮及动杆两个几何体。 

 

图 3-49  动杆-凸轮随动系统 
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（2）在模型浏览树中右击Model，选择 Add Reference Entity→Body命令（或右击 Body

按钮 ），弹出 Add Body or BodyPair对话框。 

（3）在 Label中输入 Cam，并单击 OK按钮。 

（4）在模型浏览树中右击Model，选择 Add Reference Entity→Body命令（或右击 Body

按钮 ），弹出 Add Body or BodyPair对话框。 

（5）在 Label中输入 Follower，并单击 OK按钮。 

（6）在 Properties 面板中，分别为两个 Body 指定质量及转动惯量信息，如表 3-12

所示。 

表 3-12  几何体信息 

Body Mass Ixx Iyy Izz Ixy Iyz Izx 

Cam 0.174526 60.3623 63.699 123.276 0.0 0.0 0.0 

Follower 0.0228149 7.10381 0.219116 7.22026 0.0 0.0 0.0 

（7）在 Cam Body面板中，进入 CM Coordinates标签，选中 Use center of mass coordinate 

system复选框。 

（8）双击 Point 按钮，在弹出的 Select a Point 对话框中选择 CamCM，并单击 OK

按钮。 

（9）接受默认的局部坐标系设置。 

（10）在 Follower Body 面板中，进入 CM Coordinates 标签，选中 Use center of mass 

coordinate system复选框。 

（11）双击 Point按钮，在 Select a Point对话框中选择 FollowerCM，并单击OK按钮。 

（12）接受默认的局部坐标系设置。 

创建约束副 

在这一步骤中将创建除点-曲线副外模型中的其他连接。点-曲线副作为较特殊的一类约

束副，将在下一步中单独创建。除点线副外，模型中的连接还包括两个部分：凸轮与大地之

间的转动副以及动杆与大地之间的平动副。 

（1）在模型浏览树中右击 Model，选择 Add Constraint→Joint（或右击工具栏中的 Joint

按钮 ），弹出 Add Joint or JointPair对话框。 

（2）在 Label中输入 CarmenPivot。 

（3）在 Type中选择 Revolute Joint，并单击 OK按钮。 

（4）在 Connectivity面板中双击 Body 1按钮，在 Select a Body对话框中选择 Cam，并

单击 OK按钮。 

（5）双击 Body 2按钮，在 Select a Body对话框中选择 Ground Body，并单击 OK按钮。 

（6）双击 Origin处的 Point按钮，在 Select a Point对话框中选择 PivotPoint，并单击 OK

按钮。 

（7）将Alignment Axis切换成Vector，激活Vector，选择Global Z作为旋转副旋转轴线。 
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（8）在模型浏览树中右击 Model，选择 Add Constraint→Joint（或右击工具栏中的 Joint

按钮 ），弹出 Add Joint or JointPair对话框。 

（9）在 Label中输入 FollowerJoint。 

（10）在 Type中选择 Translational Joint，并单击 OK按钮。 

（11）在 Connectivity面板中双击 Body 1按钮，在 Select a Body对话框中选择 Follower，

并单击 OK按钮。 

（12）双击Body 2按钮，在 Select a Body对话框中选择Ground Body，并单击OK按钮。 

（13）双击 Origin处的 Point按钮，在 Select a Point对话框中选择 FollowerJoint，并单击

OK按钮。 

（14）将 Alignment Axis切换成 Vector，激活 Vector，选择 Global Y作为平动副移动线。 

创建标记点 

本步将创建一个标记点。后续定义点-曲线副时，该标记点用于关联凸轮轮廓曲线与凸

轮几何体。 

（1）在模型浏览树中右击Model，选择 Add Reference Entity→Marker（或在工具栏中右

击Marker按钮 ），弹出 Add Marker or MarkerPair对话框。 

（2）在 Label中输入 CarmMarker，并单击 OK按钮。 

（3）在 Marker 面板的 Properties 标签中双击 Body，在 Select a Body 对话框中选择

Cam，并单击 OK按钮。 

（4）双击 Point按钮，在 Select a Point对话框中选择 PivotPoint，并单击 OK按钮。 

（5）接受其坐标系的默认设置。 

创建图形文件 

在工作文件夹下，已经给出了 H3D 格式的图形文件。在这一环节中，需要将这些 H3D

文件与已有的 Body进行关联。此外，为了让模型视图更加逼真，还将为铰创建图形。 

（1）在模型浏览树中右击Model，选择 Add Reference Entity→Graphic（或右击工具栏中

的 Graphic按钮 ），弹出 Add Graphics or GraphicsPair对话框。 

（2）在 Label中输入 CamProfile，接受默认的变量名。 

（3）在 Type下拉菜单中选择 File。 

（4）单击“文件浏览”按钮 ，找到工作文件夹下的 CamProfile.h3d 文件，单击 OK 按

钮进入 Graphic面板。 

（5）进入 Connectivity 标签，双击 Body 按钮，在弹出的 Select a Body 对话框中选择

Cam，并单击 OK按钮。此时，将 CamProfile图形关联到 Cam几何体。 

（6）在模型浏览树中右击Model，选择 Add Reference Entity→Graphic（或右击工具栏中

的 Graphic按钮 ），弹出 Add Graphics or GraphicsPair对话框。 

（7）在 Label中输入 FollowerProfile，接受默认的变量名。 
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（8）在 Type下拉菜单中选择 File。 

（9）单击“文件浏览”按钮 ，找到工作文件夹下的 FollowerProfile.h3d文件，单击 OK

按钮进入 Graphic面板。 

（10）进入 Connectivity 标签，双击 Body 按钮，在弹出的 Select a Body 对话框中选择

Follower，并单击 OK按钮。此时，将 FollowerProfile图形关联到 Follower几何体。 

（11）在模型浏览树中右击 Model，选择 Add Reference Entity→Graphic（或右击工具栏

中的 Graphic按钮 ），弹出 Add Graphics or GraphicsPair对话框。 

（12）在 Label中输入 PivotGraphicOne，接受默认的变量名。 

（13）在 Type下拉菜单中选择 Cylinder，并单击 OK按钮。 

（14）在 Graphic面板的 Connectivity标签下双击 Body按钮，在弹出的 Select a Body对

话框中选择 Ground Body，并单击 OK按钮。 

（15）双击 Origin下的 Point按钮，在弹出的 Select a Point对话框中选择 PivotPoint，并

单击 OK按钮。 

（16）单击 Direction处的箭头按钮，并选择 Vector。 

（17）单击 Vector按钮，在弹出的 Select a Vector对话框中选择 Global Z，并单击 OK

按钮。 

（18）进入 Properties标签，根据图 3-50设定图形参数。 

 

图 3-50  Graphic面板（步骤 18） 

（19）在模型浏览树中右击 Model，选择 Add Reference Entity→Graphic（或右击工具栏

中的 Graphic按钮 ），弹出 Add Graphics or GraphicsPair对话框。 

（20）在 Label中输入 PivotGraphicTwo，接受默认的变量名。 

（21）在 Type下拉菜单中选择 Cylinder，并单击 OK按钮。 

（22）在 Graphic面板的 Connectivity标签下，双击 Body按钮。 

（23）在弹出的 Select a Body对话框中选择 Cam，并单击 OK按钮。 

（24）双击 Point 按钮，在弹出的 Select a Point 对话框中选择 PivotPoint，并单击 OK

按钮。 

（25）单击 Direction处的箭头按钮，并选择 Vector。 

（26）单击 Vector按钮，在弹出的 Select a Vector对话框中选择 Global Z，并单击 OK

按钮。 

（27）进入 Properties标签，根据图 3-51设定图形参数。 

（28）在模型浏览树中右击Model，选择 Add Reference Entity→Graphic命令（右击工具

栏中的 Graphic按钮 ），弹出 Add Graphics or GraphicsPair对话框。 
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图 3-51  Graphic面板（步骤 27） 

（29）在 Label中输入 FollowerJointGraphic，接受默认的变量名。 

（30）在下拉菜单中选择 Box，并单击 OK按钮。 

（31）在 Graphic面板的 Connectivity标签下，指定 Type为 Center。 

（32）双击 Body按钮，在弹出的 Select a Body对话框中选择 Ground Body，并单击 OK

按钮。 

（33）双击 Point按钮，在弹出的 Select a Point对话框中选择 FollowerJoint，并单击 OK

按钮。 

（34）对于坐标轴设置，选择 Global Z作为其 Z轴，并选择 Global X，定义 ZX平面。 

（35）进入 Properties面板，输入表 3-13所示的内容。 

（36）定义且关联完毕的模型应如图 3-52 所示，可以看到从属于一个几何体的图形颜色

相同。 

      

图 3-52  动杆-凸轮模型               

创建曲线 

本步将创建凸轮的外轮廓曲线，以约束动杆端点的运动轨迹。曲线数据由 CamProfile.csv文

件提供。 

（1）在模型浏览树中右击 Model，选择 Add Reference Endity→Curve（或右击工具栏中

的 Curve按钮 ），弹出 Add Curve对话框。 

（2）在 Label中输入 CarmProfile，并单击 OK按钮。 

（3）在 Curve面板的 Properties标签中，将 2D Cartesian切换为 3D Cartesian。 

（4）选中 x单选按钮。 

（5）单击“文件浏览”按钮 ，并选择工作文件夹下的 CamProfile.csv文件。 

（6）单击 Open按钮，按图 3-53所示的内容，完成曲线 x轴参数设置。 

表 3-13  图形信息 

Property Value 

Length X 15 

Length Y 10 

Length Z 10 
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图 3-53  Curve面板（步骤 6） 

（7）选中 y 单选按钮，此时 CamProfile.csv 将自动填入 File 栏。如未自动加载，可单击

“文件浏览”按钮 ，选择工作文件夹下的 CamProfile.csv文件，单击 Open按钮加载。 

（8）按图 3-54所示的内容，完成曲线 y轴参数设置。 

 

图 3-54  Curve面板（步骤 8） 

（9）选中 z 单选按钮，此时 CamProfile.csv 将自动填入 File 栏。如未自动加载，可单击

“文件浏览”按钮 ，选择工作文件夹下的 CamProfile.csv文件，单击 Open按钮加载。 

（10）按图 3-55所示的内容，完成曲线 z轴参数设置。 

 

图 3-55  Curve面板（步骤 10） 

注意以上 3张图片中，曲线 3个轴向数据定义的差异。 

（11）在 Curve面板左侧，将曲线类型由 Open Curve切换为 Closed Curve。 

创建点-曲线高副约束。 

（1）在模型浏览树中右击 Model，选择 Add Constraint→Advanced Joint（或右击工具栏

中的 Advanced Joint按钮 ），弹出 Add Advanced Joint对话框。 

（2）在 Label中输入 PTCV，接受默认的变量名。 

（3）在下拉菜单中选择 PointToCurveJoint，并单击 OK按钮。 

（4）在 Joint面板的 Connectivity标签下，双击 Body 1按钮。 

（5）在弹出的 Select a Body对话框中选择 Follower，并单击 OK按钮。 

（6）双击 Point按钮，在 Select a Point对话框中选择 FollowerPoint，并单击OK按钮。 

（7）双击 Curve按钮，在 Select a Curve对话框选择 CamProfile，并单击 OK按钮。 

（8）双击 Ref Marker按钮，在 Select a Marker中选择 CamMarker，并单击 OK按钮。 

在指定 Ref Marker为 CamMarker后，Body2自动加载 Cam。这里，Ref Marker的作用
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有两个：一个是定义曲线在空间的位置；另一个是将曲线与几何体关联。 

定义凸轮驱动 

本步将定义凸轮驱动，定义凸轮绕其转轴作恒速转动。 

（1）在模型浏览树中右击 Model，选择 Add Constraint→Motion 命令（或右击工具栏中

的Motion按钮 ），弹出 Add Motion or MotionPair对话框。 

（2）在 Label中输入 CamMotion，接受默认的变量名，并单击 OK按钮。 

（3）在 Motion面板的 Connectivity标签下双击 Joint按钮，并选择 CamPivot，然后单击

OK按钮。 

（4）在 Properties标签下，定义Motion加载方式为 Expression。 

（5）激活表达式编辑框，输入'10*TIME'，如图 3-56所示。 

 

图 3-56  Motion面板（Properties标签） 

定义重力 

设置模型的重力沿全局坐标系 Y轴负方向。 

（1）在模型浏览树中展开 Forms文件夹，单击 Gravity，进入 Form面板。 

（2）激活重力设置，根据图 3-57定义重力。 

 

图 3-57  重力设置 

定义输出控制 

本步将定义输出请求以检验 PTCV 是否正常工作。关于结果验证将在本示例的最后部分

讨论。 

（1）在模型浏览树中右击Model，选择 Add General MDL Entity→Output（或右击工具栏

中的 Output按钮 ），弹出 Add Output对话框。 

（2）在 Label中输入 PTCV Reaction，接受默认变量名，并单击 OK按钮。 

（3）在 Output面板的 Properties标签中，切换结果类型为 Expressions。 
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（4）单击 F2表达式编辑框。 

（5）单击 fx按钮，弹出表达式编辑器面板。 

（6）设置其表达式为`PTCV（{aj_0.idstring}，0，2，0）`，如图 3-58所示。 

 

图 3-58  表达式编辑器 

（7）单击 OK按钮。 

（8）重复步骤（4）～（7），定义 F3、F4、F6、F7和 F8，按照 F2的表达式，分别将第

三个参数调整为 3、4、6、7和 8。 

注：PTCV（id， jflag， comp， ref_marker）函数用于输出 PTCV铰约束反力。该函数各项参数

的含义如下。 

id：代表 PTCV副的编号。 

jflag：0表示 I-Marker上的约束反力/力矩，1表示 J-Marker上的约束反力/力矩。 

comp：表示约束反力的分量，2、3、4 分别表示约束反力在 ref_marker 三个轴向上的分

力，1 表示约束反力的合值；6、7、8 分别表示约束反力矩在 ref_marker 三个轴向上的力矩

分量，5表示约束反力矩的合值。 

Ref_marker：表示输出结果参考的坐标系（O表示全局坐标系）。 
 

递交求解 

（1）选择 File→Save→Model命令，将模型保存为 CamMotion.mdl。 

 STEP 
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（2）在工具栏中单击 Run按钮 ，进入求解面板。 

（3）在 Simulation Parameters标签下，按图 3-59所示的内容定义参数。 

 

图 3-59  Run面板 

（4）在Main标签下，激活 Save and run current model。 

（5）单击 Save as栏的“文件浏览”按钮 ，指定求解文件名称（CamMotion.xml）

与存储路径。 

（6）单击 Check按钮，进行模型检查。 

（7）完成模型检查后，单击 Run按钮，求解模型。 

计算结果后处理 

（1）成功求解后，Animation 按钮将处于激活状态，单击该按钮，启动 HyperView 并自

动加载计算结果。 

（2）单击“播放/暂停”按钮 ，查看计算结果动画。 

（3）返回 Run面板，单击 Plot按钮，启动 HyperGraph并自动加载计算结果。 

（4）根据图 3-60所示的面板设置，创建曲线。 

 

图 3-60  曲线输出设置（步骤 4） 

（5）Follower的 Y向运动如图 3-61所示。 

 

图 3-61  Follower的 Y向运动曲线（步骤 5） 

（6）单击窗口 3横坐标位置，进入 Axes面板。 

（7）根据图 3-62，调整横坐标范围。 

 STEP 
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图 3-62  横坐标设置 

（8）此时将 X轴的数据缩放至一个周期以内，坐标系中的曲线显示将如图 3-63所示。 

 

图 3-63  Follower的 Y向运动曲线（步骤 8） 

接下来，讨论“接触点悬空（lift-offs）”问题。在某些场合中，系统的动态特性可以导

致动杆脱离凸轮运动。PTCV 约束动杆端点总是沿着凸轮轮廓曲线运动而不能脱离，因此如

果动杆端点出现悬空，则 PTCV 将输出错误的结果。在这种情况下，将不得不使用接触约束

（contact）定义模型。然而，用户一般希望使用简单的 PTCV 来模拟这种机构运动行为。为

此，可参考下述步骤调整模型。 

（9）使用 PTCV建立系统模型。 

（10）监测 PTCV 约束反力。如果注意到作用在动杆上的约束反力表现“拉”力，则表

明动杆端点出现悬空，此时需要使用 contact 而不是 PTCV。否则，PTCV在这一场合的应用

是合理的。 

为了检测在模型中使用 PTCV 是否合理，需要在后处理中绘制作用在动杆上的约束反力

曲线。动杆沿着总体坐标系的 Y轴进行运动，任何 Y负方向的反力均将产生“拉”力效果，

因此下述步骤将绘制动杆上约束反力的 Y轴分量曲线图。 

（11）单击 Add Page按钮 ，在后处理界面中新增一个页面。 

（12）选择模块为 HyperGraph 2D，并在该页面下单击 Build Plot按钮 。 

（13）单击“打开文件”按钮 ，并选择 CamMotion.abf文件。 

（14）根据图 3-64所示的内容绘制曲线。 

 

图 3-64  曲线输出设置（步骤 14） 

（15）单击 Apply按钮，视窗中的曲线显示如图 3-65所示。 
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图 3-65  曲线输出（步骤 15） 

（16）定义横坐标范围为一个运动周期，那么曲线的形状应如图 3-66所示。 

 

图 3-66  曲线输出（步骤 16） 

由图 3-66 可知，在一个周期内的任意时刻，作用于动杆上的反力始终沿 Y 轴正向，即

没有出现“拉”力，因而该 PTCV模型是合理的。 

3.5  半车机构模态分析 

本示例将学习以下内容： 

●  应用MotionSolve进行静态线性分析。 

●  查看静态线性分析结果。 

练习开始前，复制 chap03目录下的 halfcar_lin.mdl文件到工作文件夹中。 

进行静态线性分析 

本步将进行 2D半车模型的静态线性分析。 

（1）新建一个MotionView会话。 

（2）单击 Open Model按钮 ，打开工作文件夹下的 halfcar_lin.mdl模型。 

（3）确认 SolverMode下拉菜单中选中MotionSolve求解器。 
（4）单击工具栏中的 Run按钮 。 
（5）在 Run面板的Main标签中，设定 Sim type为 Static+Linear，接受其他默认设置。 

 STEP 
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（6）单击 Save as栏处的“文件浏览”按钮 ，指定求解文件的名称（halfcar_lin.xml）与

路径。 

（7）进入 Output File Types标签，选中MDL animation file （.maf）。 

（8）返回Main标签，单击 Run按钮，求解模型。 

此时将弹出求解信息窗口。MotionSolve 首先进行静力学分析，生成一个 halfcar_lin.mrf

文件；然后进行线性分析，生成多个 MRF 文件和一个 EIG 文件，这里每个 MRF 文件对应

模型的一个模态振型，而 EIG文件则用于绘制复平面的特征值图。 

查看振型动画 

（1）单击 Add Page按钮 ，新建一个页面。 

（2）从应用程序列表中选择 HyperView。 

（3）单击 Page Window Layout按钮 ，将该页面调整为 4窗口视图 。 

（4）激活窗口 1。 

（5）单击 Open Model按钮 ，进入 Load model and results面板。 

（6）单击 Load model栏的“文件浏览”按钮 ，选择并打开 halfcar_lin.maf。 

（7）单击 Load results 栏的“文件浏览”按钮 ，选择并打开 halfcar_lin_Pair3_ 

Freq2HZ.mrf。 

（8）单击 Apply按钮，此时窗口 1将显示线性分析结果。 

（9）单击“动画”按钮 ，查看系统振型动画。 

（10）再次单击动画按钮，停止动画。 

（11）按照步骤（6）～（7），载入第 4～6阶模态结果。 

（12）单击 Synchronize Windows 按钮 ，按图 3-67 进行窗

口同步设置。 

（13）单击 XY视图按钮 。 

（14）单击“动画”按钮 ，查看系统四阶模态振型动

画，如图 3-68所示。 

 
图 3-68  静态线性分析结果 
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图 3-67  窗口同步设置 
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在复平面绘制特征值图 

MotionSolve 静态线性分析生成的 halfcar_lin.eig 包含了系统的特征值信息，应用该文件

可绘制复平面特征值图，用以检验系统稳定性。halfcar_lin.eig内容如图 3-69所示。 

 
图 3-69  系统特征值信息 

（1）单击 Add Page按钮 ，新建一个页面。 

（2）从应用程序下拉列表中选择 HyperGraph 2D。 

（3）单击 Build Plots按钮 ，进入 Build Plots面板。 

（4）单击 Data file栏的“文件浏览”按钮 ，选择并打开 halfcar_lin.eig文件。 

（5）按照图 3-70所示的内容绘制曲线。 

 
图 3-70  曲线输出定义 

（6）单击工具栏中的 Curve Attributes按钮 ，进入 Cruve Attributes面板。 

（7）在 Line Attributes标签中单击 None按钮。 

（8）进入 Symbol Attributes标签，选择任一种标记。标记将显示系统特征值在复平面的

位置，如图 3-71所示。 

 
图 3-71  复平面特征值图 
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3.6  小结 

多刚体系统动力学分析是多体系统动力学分析的核心，虚拟样机设计分析流程中大都以

简单多刚体系统出发，从完成机构基本运动开始，逐步增加系统复杂性，如精细化建模、使

用非线性单元代替线性单元、考虑摩擦、引入构件柔性变形以及加入控制系统实现闭环控制

等，最终实现复杂多体系统仿真分析。本章通过 5 个实例，详细描述了应用 MotionView & 

MotionSolve 软件进行刚体系统建模与仿真分析的完整工作过程，并对建模过程中的关键步

骤及建模技巧作了深入的介绍，相信读者学习完本章后，会对刚体系统建模与仿真有更加全

面的认识。 



 1

第 4章     

 刚柔耦合分析与柔性体建模 

本章主要介绍 MotionView & MotionSolve 刚柔耦合多体系统建模与仿真的基本功能，包括

柔性体的基本概念、创建以及使用方法等。通过本章的学习，用户可以深入了解构件在运动过

程中产生柔性变形的本质，并能够在实际工作中加以应用，获得更加准确的仿真结果。 

本章重点知识 
 
 

4.1  刚柔耦合分析方法 

4.2  柔性体创建及使用 

4.3  柔性体建模实例 

4.4  刚柔耦合分析实例 

4.5  小结 
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4.1  刚柔耦合分析方法 

随着新材料和新技术的广泛应用，在船舶、车辆、机车、航天航空和机器人等众多工程领

域中，出现了许多轻质、高速运动的多体系统。这些系统在工作时，运动机构的柔性将对系统

性能产生很大的影响。传统多体动力学分析将运动机构假定为没有变形的刚性体，由此得到的

结果将无法反映实际系统的性能。针对这一问题，MotionView & MotionSolve 提供了刚柔耦合分

析能力，在分析过程中考虑到构件的柔性变形，最大程度地模拟机构在实际工作中的状态。 
MotionView 提供了柔性体建模工具，通过 MotionSolve 刚柔耦合动力学仿真能够： 
●  捕捉构件在运动过程中的变形。 
●  在载荷预测场合获得更精确的结果。 
●  研究柔性体的应力应变分布。 
●  进行疲劳分析。 
MotionView 中柔性体是由包含构件模态信息的 H3D 格式文件描述的。构件的模态是构

件自身的固有属性，一个构件一旦制造出来，它的模态就确定下来了。结构模态综合技术

（Component Mode Synthesis，CMS）将构件弹性体的有限元模型缩减到由界面自由度与一系

列正则模态构成的用于多体动力学分析的柔性体。弹性体的位移矢量分为内部（OSET）自

由度与边界（ASET）自由度位移矢量，见式（4-1）。 

= o

a

u
u

u
⎛ ⎞
⎜ ⎟
⎝ ⎠

 （4-1） 

式中，“o”代表内部自由度，“a”代表边界自由度。 
结构模态综合技术中指定界面点的目的在于描述结构因界面点上的约束或载荷产生的变

形。通常在受约束的系统中，相对结构惯性力引起的变形，由约束力引起的柔性变形更能起

到主导作用，因此将所有承载点设置为界面点是获得正确的柔性多体动力学分析结果的重要

一步。结构模态综合过程中使用的界面点应与后续多体动力学分析使用的加载点一致。在多

体动力学模型中，柔性体与其他构件的相互作用是通过定义在柔性体界面点上的约束副或力

元实现的。多体动力学分析中，柔性体中除了因重力或加速度引起的体力外，其节点所承受

的约束或载荷均来自于界面点。 
结构静平衡公式见式（4-2）： 

T =oo oa o o

oa aa a a

K K u P
K K u P

⎛ ⎞⎛ ⎞ ⎛ ⎞
⎜ ⎟⎜ ⎟ ⎜ ⎟
⎝ ⎠⎝ ⎠ ⎝ ⎠

 （4-2） 

在结构的正则模态分析中，由对角质量矩阵表示的特征值问题描述见式（4-3）： 
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 （4-3） 

CMS 的任务是找到一系列描述柔性体位移u 的正交模态，见式（4-4）： 
=u qφ  （4-4） 

式中，q 为模态参与因子或模态坐标矩阵，该矩阵由多体动力学分析获得。参与因子越大，

对应的模态对构件变形的贡献量越多，因此可从构件的模态参与因子出发分析构件的振动性
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能。如果构件在振动时某阶模态的参与因子大，则可以通过改进设计抑制该阶模态对振动贡

献量，降低构件的振动。 
MotionSolve 使用 Craig-Bampton 和 Craig-Chang 两种方法进行结构模态综合。 
（1）Craig-Bampton 方法。 
Craig-Bampton 方法使用界面点约束的结构进行模态综合。结构的正则模态分析将产生特

征值的对角矩阵 wD 和特征向量矩阵 wX 。模态分析时可以设定截止频率或提取的模态阶数，

该值决定了 wX 的列数。此外，还需进行一系列的静态分析，它是通过给定每个边界自由度一

个单位位移，而其他所有边界自由度保持固定来实现的。这里，要注意约束每个节点的自由度

以保证 6 个自由度方向上的刚度均不为零。该分析将获得位移矩阵 sX 与界面力矩阵 cP 。 

应用得到的位移矩阵 = w

s

X
X

X
⎛ ⎞
⎜ ⎟
⎝ ⎠

，可以计算缩减的模态刚度矩阵 K̂ 和质量矩阵 M̂ ： 
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 （4-5） 

然后进行正交化处理，将原始的模态振型 X 转变为一系列正则模态φ。 
（2）Craig-Chang 方法。 
Craig-Chang 方法使用无约束的结构进行模态综合，因而结果中包含六阶刚体模态。结

构的正则模态分析将产生特征值的对角矩阵 wD 和特征向量矩阵 wX 。模态分析时可以设定截

止频率或提取的模态阶数，该值决定了 wX 的列数。结构的刚体模态 RX 将根据质量矩阵正

交化： 
T
R RX MX I=  （4-6） 

此外，使用一个平衡的载荷矩阵 EP 进行结构惯性释放静力分析： 
T（ ）A E R R AKX P I MX X P= = −  （4-7） 

矢量 AP 表示每个界面点的每个自由度方向上的单位力集合，由此获得的模态 XA 称为惯

性释放连接模态。 

应用得到的位移矩阵 = w
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，可以计算缩减的模态刚度矩阵 K̂ 和质量矩阵 M̂ ： 
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 （4-8） 

然后进行正交化处理，将原始的模态振型 X 转变为一系列正则模态φ。 
上述两种方法获得的模态矩阵不是一个正交矩阵，即通过两个方程得到的总的刚度矩阵

和质量矩阵不是正交的，这一问题可通过求解特征值来解决，见式（4-9）： 

=K q M qλ
∧ ∧

 （4-9） 

由此获得的特征向量可以作为转换矩阵 N，它可将 Craig-Bampton 和 Craig-Chang 模态

要素转化为等效的、正交的模态坐标基 *q 。 
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*=Nq q  （4-10） 

该模态合成的公式化表示如下： 

=1 =1 =1
= = *= * *

M M M

i i i i
i i i

u q Nq qφ φ φ∑ ∑ ∑  （4-11） 

式中， *iφ 表示正交化的 Craig-Bampton 或 Craig-Chang 模态。 
正交化的 Craig-Bampton 或 Craig-Chang 模态不是原始系统的特征向量，而是原始系统

的 Craig-Bampton 或 Craig-Chang 变换，但它们具有与原始系统相关的固有频率。 

4.2  柔性体创建及使用 

MotionView 使用 H3D 格式的柔性体文件，该文件存储了用于柔性体前处理可视化和后

处理模态及界面点等必要信息，同时它还存储了用于创建 ADAMS 的 MTX 文件的模态和节

点信息。应用 FlexBody Prep 向导，可根据不同的输入文件（如 ADAMS MNF 文件、

NASTRAN PCH 文件及对称的 H3D 文件等）创建柔性体文件，也可以使用 RADIOSS 直接

创建。柔性体创建时可以指定是否计算应力信息，如果计算，则将在后处理中看到柔性体在

机构运动各个时刻的应力、应变状态。 
应用 MotionView & MotionSolve 进行多体问题分析时，会遇到 3 种类型的 H3D 文件：

用于前处理中的零件图形文件、柔性体文件以及用于后处理的结果文件。为避免与其他 H3D
文件混淆，创建柔性体时建议使用_flex.h3d 作为文件名。 

4. 2.1  MotionViewFlexPrep 工具 

FlexPrep 是 MotionView 中创建柔性体的应用程序，同时还支持不同类型柔性体的转

换。图 4-1 描述了该应用程序的工作流程。 

HyperMesh

Bulk Data File

Interface nodes

Modal synthesis type
（Craig‐Bampton/ 
Craig‐Chang）

Number of modes or 
cut off frequency

Units in Bulk data file

Include Stress/Strain

Create RBE2 Spiders

Flex Prep Tool

Manual edit of 
preparation for 

optimized flex body

RADIOSS 
preparation file 
（*_prp.fem）

RADIOSS 

Flex body file
（*.h3d）

 
图 4-1  FlexPrep 工作流程 

应用 FlexPrep，可以进行以下操作： 
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●  根据 RADIOSS 或 NastranBulk Data 文件创建柔性体。 
●  创建 RBE2 蛛网式刚性单元。 
●  定义应力应变输出。 
●  创建 RADIOSS 准备文件，用于柔性体的缩减。 
由此将获得 H3D 格式的柔性体文件，该文件中包括节点位置、单元连接关系、各阶

模态特征值、惯量不变量（可选）、节点质量、节点惯量（可选）、直线位移模态振型、

角位移模态振型、界面点编号（可选）、单元应力/应变矢量（可选）、全局惯量（可选）

信息。 
应用 FlexPrep 工具除了创建柔性体外，还可以进行不同格式的柔性体转换： 
●  根据指定参考平面镜像已有柔性体。 
●  转换 ADAMS MNF 文件至 Altair H3D 文件。 
●  转换 Altair H3D 文件至 ADAMS MTX 文件。 
●  转换 Altair H3D 文件至 ADAMS MNF 文件。 
●  转换 Nastran PCH 文件至 Altair H3D 文件。 
●  转换 Altair H3D 文件至 DADS DFD 文件。 
MotionView 根据 RADIOSS 或 NASTRAN 有限元文件创建柔性中性文件。这里有限元

文件只需提供用于界面点的节点编号。其他类型的有限元文件可以先输入到 HyperMesh 中，

然后输出成 RADIOSS 文件，再创建柔性体。从 MotionView 的 FlexTools 下拉菜单中选择 
FlexPrep，弹出 FlexBodyPrep 对话框。该对话框由 RadiossFlexbodygeneration 和 Translation 
of Flexbodyfiles 两部分组成。 

1.RadiossFlexbodygeneration 
选中 RadiossFlexbodygeneration 单选按钮，弹出如图 4-2 所示的对话框。 

 
图 4-2  FlexBodyPrep 对话框（RadiossFlexbodygeneration） 



MotionView & MotionSolve 
应用技巧与实例分析 

 120 

该对话框中各选项的功能介绍如下。 
RadiossFlexbodygeneration：柔性体创建。 
●  Create Radioss prp （preparation） file and generate the h3d flexbody：选择一个 Radioss 

Bulk Data 文件并将其转换为 H3D 柔性体文件。 
●  Create Radioss prp （preparation） file：选择一个 Radioss Bulk Data 文件并将其转化成用

于创建柔性体的有限元准备文件。 
●  Create h3d flexbody using pre-existing prp （preparation） file：选择一个有限元准备文件

创建 H3D 柔性体文件。 
Select Bulk Data file （fem/nas/bdf/dat）：选择待转换的 RADIOSS 源文件。 
●  Create RBE2 spiders：在原始 RADIOSS 输入文件中创建用于减少应力集中的蛛网式

RBE2 刚性单元。 
Save the *.h3d file asor Save the *prp file as：指定将生成的 H3D 文件或 PRP 文件的名称

和存储路径。 
Component mode synthesis type：指定模态分析方法。这里支持 Craig-Bampton 和 Craig-

Change 两种算法。Craig-Bampton 用于获得约束模态和静态校正模态，求解时将进行模态正

交化。 
Specify Interface Node List （6：8+10）：指定用于界面点的节点编号，使用“+”连接，可

以输入编号范围，如 4：12，或两者的结合 4：12 +14。 
Cutoff type and value：这里可指定模态阶数或最高截止频率。该选项将决定多体求解器

的性能和精度。选取的柔性体模态越多，获得的振型曲率越精细，分析结果越精确。但是，

额外加入的模态将大大降低求解器的性能。如果需要进行应力恢复，注意精确的应力恢复需

要的模态数量远大于精确位移表达所需的模态数量。前六阶为刚体模态，默认情况下，求解

器中柔性体文件不包括这六阶模态。 
Perform stress recovery：应用 RADIOSS 应力恢复功能可以直接获得结构的应力状态，

应力结果将保存在 H3D 结果文件中。多体系统求解结束后，HyperView 可以根据求解结果

创建应力云图。 
Perform strain recovery：如果使用 RADIOSS 的应变恢复功能，则精确表达应力状态比

位移状态需要更多的模态数量。 
Perform element check in Radioss model：控制 RADIOSS 是否进行单元质量检测。 
Specify units in bulk data file：为保证柔性体和使用柔性体的 MDL 模型的单位统一，有

限元模型的单位必须指定。单位信息将保存在 H3D 文件中，与其相关的参数均根据单位制

的设定进行缩放，参看本书附录 B 问题 5 的相关内容。 
Clear 按钮：单击该按钮清除选择并重置向导。 
OK 按钮：使用上述设置，创建柔性体文件。单击 OK 按钮表示将上述内容整理成一系

列命令提交给 Flexprep 并激活 Flexprep 进行求解。 
Cancel 按钮：单击该按钮退出 FlexBodyPrep 向导。 
注：（1）作为输入的源文件必须包含节点、单元（包括刚性单元）、材料及属性。不需

进行参数定义（Param statements），但这一功能已被保留下来，如进行 mass/inertia 缩放的

wtmass 参数。另外，文件中的卡片不会影响单元连接性、节点位置，如超单元卡片、EIGRL
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卡片以及 SPC 卡片等。界面点将另外指定，因而不需在源文件中设置。 
（2）对于 Craig-Bamption 方法，FlexBodyPrep 向导读入数据文件并为 RADIOSS 生成一

个准备文件以进行柔性体创建。最后一步将计算结构的惯性积，相关结果写入 H3D 文件。 
（3）H3D 文件的默认单位为 kg-mm-N-sec，必要时可进行单位转换。 
（4）所有界面点必须处于 N 集（独立坐标集）。如果使用 RBE3，则在默认情况下

REFGRID 和 REFC 均置于 M 集（非独立坐标集），并且 REFGRID 不能作为界面点。另一方

面，RBE2 中的 GN 和 CM 均指定为 N 集。用户可以使用 UM 功能将 RBE3 中的 REFGRID 和

REFC 移入 N 集。此外，界面点应该具有 6 个方向的刚度，如果需要，则可以使用 RBAR、
RBEi 或 MPC 约束界面点与其他节点的关系以满足这种规定。 

2.Translation of Flexbodyfiles  

在 FlexBodyPrep 向导中选择 Translation of Flexbodyfiles 将获得图 4-3 所示的功能。 

 
图 4-3  FlexBodyPrep 对话框（Translation of Flexbody Files） 

该对话框中各选项的功能介绍如下： 
Translate ADAMS mnf file into MV h3d flexbody：将 ADAMS MNF 文件转换为 Altair 

H3D 柔性体文件，ADAMS MNF 文件已包含所有必要信息，因而不需额外提供信息。 
●  Select ADAMS mnf file：选择待转换的 ADAMS MNF 文件。 
●  Save the h3d file as：指定将要保存的 H3D 文件的名称及路径。 
Mirror existing h3d flexbody：根据指定对称面镜像 H3D 柔性体文件。 
●  Specify the original h3d file：选择原始 H3D 柔性体文件。 
●  Specify the mirrored h3d file name：指定将要保存的 H3D 文件的名称及路径。 
●  Select the plane for the mirror image：指定对称面。默认为 Mirror_XZ plane（与 MDL

对称面一致），也可选择 Mirror_YZ 或 Mirror_XY。 
Translate the MV h3d flexbody into ADAMS mnf file：将 Altair H3D 文件转换为 ADAMS 

MNF 文件。 
●  Select MV h3d file：选择待转换的 Altair H3D 文件。 
●  Save the ADAMS mnf file：指定将要保存的 MNF 文件的名称及路径。 
注：应力和应变模态不参与转换。 
Translate MV h3d flexbody into ADAMS mtx file：为 ADAMS 创建柔性体矩阵文件

（MTX）。 
●  Select MV h3d file：选择待转换的 Altair H3D 文件。 
●  Save the mtx file：指定保存的 MTX 文件的名称及路径。 
●  Specify the Invariants （TTTTFTTTF）：指定 9 个不变量中激活并保存在 MTX 文件中的



MotionView & MotionSolve 
应用技巧与实例分析 

 122 

参量，关于每个不变量详细的数学描述请参考 ADAMS 帮助文档。 
●  Select the nodes：提供 All、Interface Nodes 或 User Specified 三种选项。选择的节点

将用于 ADAMS 求解过程。通常，这些节点将用做界面点（定义铰链、力作用点

等）或定义传感器。 
●  Specify the nodes （6：8+10）：指定用于后续 MDL 建模的界面点。可以输入一个范围，

如 4：12 或组合 4：12 +14。 
●  Select the modes：选择 All 或 User Specified。选择 H3D 文件中的模态子集。可以选

择全部模态或部分模态。注意，无法选择原始 H3D 文件不存在的模态。 
●  Specify the modes：如果选择模态的一个子集，这里需要指定模态子集名称。 
●  Create mtx for the mirrored part：创建两个 MTX 文件，第二个文件为指定对称面的镜

像文件。 
●  Select the plane for the mirrored image：指定对称面。默认为 Mirror_XZ plane （与

MDL 对称面一致），也可选择 Mirror_YZ 或 Mirror_XY。 
●  Specify Units for the MBD Solver：该方法创建的 MTX 文件独立于任何 MDL 模型，

因而需要指定单位制系统。MTX 文件来自于 MDL 文件，这个信息是隐含的。 
注：由于 MotionView 和 HyperView 需要 H3D 文件进行图形显示，这种方法创建的镜

像柔性体文件不能为后处理提供所需的图形信息。 
Clear 按钮：单击该按钮清除选择并重置向导。 
OK 按钮：使用上述设置，创建柔性体文件。单击 OK 按钮表示将上述内容整理成一系

列命令提交给 Flexprep 并激活 Flexprep 进行求解。 
Cancel 按钮：单击该按钮退出 FlexBodyPrep 向导。 

4. 2.2  HyperMesh 工具 

使用 HyperMesh 做有限元前处理，定义相关控制卡片并运行模态综合程序同样可以获得柔

性体。这里需要定义 DTI_UNITS、GLOBAL_OUTPUT_REQUEST、OUTPUT 和 GLOBAL_ 
CASE_CONTROL 四个卡片。表 4-1 说明了上述卡片的用途。各卡片的定义如图 4-4～图 4-7
所示。这里需要注意，DTI_UNITS 卡片定义务必与有限元模型中的材料一致，OUTPUT 卡片

需指定 H3D 格式文件输出，此外还支持其他格式（如 ADAMSMNF）的柔性体文件输出。 

表 4-1  HyperMesh 卡片说明 

卡    片 说    明 

DTI_UNITS 定义模型单位制 

GLOBAL_CASE_CONTROL 调用 CMSMETH 进行模态提取 

GLOBAL_OUTPUT_REQUEST 指定应力、应变恢复 

OUTPUT 指定柔性体输出格式 

 

图 4-4  DTI_UNITS 卡片定义 
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图 4-5  GLOBAL_CASE_CONTROL 卡片定义 

 
图 4-6  GLOBAL_OUTPUT_REQUEST 卡片定义 

 
图 4-7  OUTPUT 卡片定义 

4. 2.3  柔性体使用 

1.柔性体可视化 

柔性体创建后，可使用 HyperView 查看柔性体模态频率与振型，如图 4-8 所示。 

 

图 4-8  柔性体结果后处理 
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（1）打开 HyperView，在标准工具栏中单击 Load results 按钮 ，Load model and results
面板显示如图 4-9 所示。 

 

图 4-9  Load model and results 面板 

（2）单击“文件浏览”按钮 ，在 Load model 文本框处选择柔性体文件。 
此时 Load results 文本框将自动更新到与 Load model 文本框相同的路径与文件名。 
（3）单击 Apply 按钮，HyperView 将载入柔性体文件。 
（4）单击 Set Animation Mode 按钮后的下三角符号并选择 Modal 动画模式 。 
（5）在左侧模型树位置选择相应的模态，如

图 4-10 所示。 
（6）单击 按钮可以查看当前模态下结构的

振型动画。 
（7）单击 左侧

的三角符号可以变换模态频率。 

2.柔性体使用 

在 MotionView 中，通过 Body 面板可将柔性体载入已创建的刚体模型中。在 Body 面板

的 Properties 标签中选中 Deformable 复选框，可将相应的刚体结构替换成柔性体。

MotionView 保留刚体结构信息，以便后续分析中进行结构刚柔转换。DADS 和 NASTRAN
求解器输入文件不能使用柔性体，而 MotionSolve、ADAMS 和 Abaqus 可以使用，选择求解

器不同，该面板将进行相应的改变。 
（1）MotionSolve 求解器。 
选择 MotionSolve 求解器后，在 Body 面板中选中 Deformable 复选框，如图 4-11

所示。 

 

图 4-11  Body 面板（MotionSolve 求解器） 

此时，Body 面板各部分的功能如下。 
●  Animation scale：指定模态振型的缩放因子。该选项将仅用于控制结果动画中结构的

变形程度，与求解无关。 
●  Graphic file：指定用于在图形区显示柔性体的文件。 

 
图 4-10  模态选择框



第 4 章 
刚柔耦合分析与柔性体建模 

 125 

●  H3D file：指定由 RADIOSS 创建的 H3D 格式的柔性体文件。 
（2）ADAMS 求解器。 
选择 ADAMS 求解器后，在 Body 面板中选中 Deformable 复选框，如图 4-12 所示。 

 

图 4-12  Bodies 面板（ADAMS 求解器） 

此时，Body 面板各部分的功能如下。 
Graphic file：指定用于在图形区显示柔性体的文件。 
Use specified （functional） H3D file to create specified MTX file：在前处理器窗口中显示上

述指定的 H3D 图形文件并在输出 ADAMS 模型时创建 MTX 文件。 
Use specified MTX file：在 ADM 文件中生成使用专有 MTX 文件时必要的命令。使用该

功能时，不会新建一个 MTX 文件并且前处理器图形区不会显示柔性体图形。 
H3D file：指定选择由 ADAMS .MNF 文件创建的 H3D 格式的柔性体文件。 
MTX file：创建 MTX 文件。在 MotionView 中保存 ADM 文件时将创建 MTX 文件以及

ADAMS 命令文件。 
（3）ABAQUS 求解器。 
选择 ABAQUS 求解器后，在 Body 面板中选中 Deformable 复选框，如图 4-13 所示。 

 

图 4-13  Body 面板（ABAQUS 求解器） 

此时，Body 面板各部分的功能如下。 
Graphic file：指定用于在图形区显示柔性体的文件。 
Use component mode synthesis：使用柔性体模型。 
Use nodal FEA body：直接使用有限元模型。 
Inp file：指定 INP 格式输入文件。 
Sup file：该选项无论使用 CMS 还是 FE 模型都可用，但仅用在输出 CMS 模型时。 
载入柔性体时，还需在图 4-14 所示的二级窗口中指定相关信息。 
Invariants：指定 MTX 文件中的不变量。关于如何调整不变量以获得最佳的精度/性能平

衡的详细描述请参阅 ADAMS 手册。在默认情况下，将激活前 8 个不变量。该窗口仅用于

ADAMS。 



MotionView & MotionSolve 
应用技巧与实例分析 

 126 

 
图 4-14  不变量设置窗口 

Nodes 按钮：单击 Nodes 按钮将激活 Nodes 对话框，用于装配柔性体到 MDL 模型

中，如图 4-15 所示。可以直接输入界面点编号或使用 Find 功能。使用 Find 功能时要保证

MotionView 可以搜索到目标节点。此外，需要确定用于创建柔性体的有限元模型在与 MDL 模

型装配的位置含有节点。Align 按钮将移动 MDL 几何点，使之与柔性体界面点重合。该功能仅

用于 MDL 几何点与柔性体界面点不重合的场合。使用 Align 按钮将影响 MDL 模型中几何的形

状或位置。Nodes 按钮用于 MotionSolve、ADAMS 或 ABAQUS 求解器输入文件的创建。 

 

图 4-15  Nodes 设置窗口 

Modes 按钮：Modes 按钮可用来激活或取消柔性体文件中的模态，模态设置窗口如图 4-16
所示。减少柔性体中模态的使用可能造成结果精度的下降，但会获得计算效率的提升。有关

模态选择的更多信息，请参考 MotionSolve 或 ADAMS 求解器手册。Modes 对话框提供模态

阻尼设置选项。Modes 选项用于 MotionSolve 或 ADAMS 求解器环境中。 
Damping 按钮：指定柔性体各阶频率阻尼值，阻尼设置窗口如图 4-17 所示。这里提供

了 Default Damping、CRatio Damping、Alpha Damping、Beta Damping、Alpha/Beta Damping
五种阻尼定义方法。 

        

            图 4-16  模态设置窗口                         图 4-17  阻尼设置窗口 
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4.3  柔性体建模实例 

4. 3.1  应用 MotionViewFlexprep 创建柔性体 

本实例将练习使用 FlexPrep 工具创建汽车下控制臂柔性体模型，通过替换汽车前悬架

模型中刚性控制臂完成汽车前悬架的刚柔耦合仿真。本练习中使用的下控制臂模型如图 4-18
所示。图 4-19 显示了汽车前悬架模型。 

           

                图 4-18  下控制臂模型                    图 4-19  汽车前悬架模型 

练习开始前，复制 chap04 目录下的 sla_flex_left.fem、sla_left_stress_strain_set.fem、

sla_left_model_set.fem 和 sla_left_rdof.fem 文件到工作文件夹中。 

使用 FlexPrep 工具 

（1）启动 MotionView。 
（2）在 FlexTools 下拉菜单中选择 FlexPrep，弹出

FlexBodyPrep 对话框，如图 4-20 所示。 
（3）激活 RadiossFlexbodygeneration，在下拉列表中选择

Create Radiossprp（preparation） file and generate the h3d flexbody。 
（4）单击 Select Bulk Data File 右侧的“文件浏览”按钮

选择工作文件夹下的 sla_flex_left.fem 文件。 
注：在这里可以使用任何 RADIOSS（fem）和 NASTRAN（nas、dat、bdf）文件。 
（5）在 Save the h3d file as 文本框中指定输出的 H3D 文件为 sla_flex_left.h3d。 
（6）在构件模态综合方法（Component Mode Synthesis Type）文本框中选择 Craig-

Bampton 方法。 
（7）在指定界面节点文本框中（Specify Interface Node List）输入：4927+4979+4984。 
界面节点（Interface Node）用于定义多体动力学分析中机构约束或施加载荷的位置。 
（8）在 Cutoff Type and value 文本框中选择 Hightest Mode#并设置最高阶数为 10。 
注：MotionView 提供了两种方法约束待生成的 H3D 文件中模型的模态信息：指定模

态最高阶数和指定模态最高截止频率。 

 STEP 

01 

 

图 4-20  选择 FlexProp 工具 
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（9）激活 Perform Stress Recovery 功能，FlexPrep 工具将在处理模型时计算模态应力。 
（10）Perform element check in Radioss model 默认选择 YES，即默认将检查单元质量。 
（11）在 Specify Units in Bulk Data File 选项区中，使用下列单位。 
Mass Units：Kilogram 
Length：Millimeter 
Force：Newton 
Time：Second 
注：HyperMesh 本身没有指定单位制，用户在创建柔性体时必须指定统一的单位以免

产生错误的质量和转动惯量。 
（12）设置好的 FlexBodyPrep 对话框如图 4-21 所示。 

 
图 4-21  FlexBodyPrep 对话框 

创建RBE2 连接单元（可选步骤，如果已建立完整的RBE2 可不进行此步） 

该步是利用 HyperMesh 工具，根据用户所选孔边界上的任意一个网格节点，自动生成

孔中心节点，并建立中心节点与孔边界节点 RBE2 单元的功能。该功能可以大大节省用户

建立 RBE2 的时间，如果用户已经建立完整的蛛网式 RBE2 单元可略过此步。 
RBE2 单元通过指定主从节点来模拟节点间内在的运动关系，它通常用来模拟螺栓一

类的刚性结构。如果有限元模型存在孔特征并且希望使用孔中心节点作为界面点，并且需

要将孔中心承受的载荷传递到孔壁的节点上时，则使用孔中心节点作为主节点、孔壁节点

 STEP 

02 
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作为从节点的蛛网式 RBE2 单元将有效地达到这一目标。另外，这也是减少应力集中问题

的主要解决方法。 
模型 sla_left_flex.fem 中已经创建了 3 个蛛网式 RBE2 单元，本步中将描述使用 Create 

RBE2 Spiders 功能创建第四个蛛网式 RBE2 单元。 
（1）在 FlexBodyPrep 对话框中单击 Create RBE2 

Spiders 按钮，此时将激活 HyperMesh 程序并显示包含

3 个按钮的用户自定义页面，如图 4-22 所示。 
注：如果用户自定义页面没有显示，则可以通过

以下方式打开： 
●  在 View 下拉菜单中选择 utility menu 命令。 
●  在 utility menu 标签中单击 user 按钮。 
（2）单击 Info 按钮，弹出描述蛛网式 RBE2 单元创建过程的对话框。 
（3）如图 4-23 所示，放大球铰位置处的有限元模型。 
（4）单击 Step2：Superspider 按钮创建蛛网式 RBE2 单元，一次只能创建一个。 
（5）选择孔壁处的节点并单击 Proceed 按钮。 
（6）生成的蛛网式 RBE2 单元如图 4-24 所示。 

                       
             图 4-23  控制臂局部视图                图 4-24  新创建的蛛网式 RBE2 单元 

（7）单击 Step3：Save and Close 按钮，指定文件名保存模型（文件名需包括扩展名，如

left.fem），软件将自动抓取孔中心节点（界面点）编号。用户可另存模型文件以便检查界面

点是否已经添加到柔性体预处理文件上。 
（8）新建的界面点编号已经添加到柔性体预处理文件上，如图 4-25 所示。 

 
图 4-25  FlexBodyProp 面板 

（9）单击 OK 按钮，启动 RADIOSS 创建柔性体。 
 

 

图 4-22  HyperMesh 用户自定义页面 
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查看并检验模型 

（1）在工具栏中将应用程序转换成 HyperView。 
（2）单击 Load Model 按钮 ，进入 Load model and results 面板。 
（3）单击“文件浏览”按钮 ，打开 H3D 柔性体文件 sla_flex_left.h3d。由于模态结果

包含在同一个 H3D 文件中，MotionView 将在 Load results 文本框中自动加载相同的文件，

如图 4-26 所示。 

 
图 4-26  Load model and results 面板 

（4）单击 Apply 按钮，载入模型，如图 4-27 所示。 
（5）单击“动画播放”按钮 ，HyperView 将顺序播放柔性控制臂的模态振型动画。 
（6）单击“动画停止”按钮 ，停止模态振型动画播放。 
（7）单击动画类型 按钮，将动画类型设置为 Set Modal Animation Mode，此时将播

放指定模态振型动画。 
（8）从模型浏览树上端的模态选择框选择第 7 阶模态，前六阶模态接近 0 为刚体模

态，如图 4-28 所示。 

               
         图 4-27  控制臂柔性体模型                       图 4-28  模态列表 

（9）单击“动画播放”按钮 ，查看所选模态动画。单击“动画停止”按钮 ，停止

动画。 
（10）单击 Coutour 按钮 ，查看柔性体应力分布。 
（11）在 Result type 下拉菜单中选择 Stress（t）和 vonMises。 
（12）在 Layers 文本框中选择 Z1，如图 4-29 所示。 

 
图 4-29  设置云图类型 
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（13）单击 Apply 按钮，显示柔性体应力云图，如图 4-30 所示。 

 
图 4-30  柔性体应力云图 

批处理模式下使用 FlexPrep 工具 

上述步骤已经创建了汽车悬架左侧控制臂柔性体模型，下面将在批处理模式下使用

FlexPrep 工具创建右侧控制臂柔性体。不同操作系统下调用 FlexPrep 工具的命令如下。 
●  UNIX 下：<install_path>/altair/scripts/flexprep 
●  DOS 下：<install_path>\io\translators\bin\win32\flexprep.exe 
（1）从启动菜单中激活 DOS 窗口。 
（2）使用 cd 命令指向工作文件夹。 
（3）在 DOS 窗口中输入以下命令： 

<install_path>\io\translators\bin\win32\flexprep.exe sla_flex_left.h3d sla_flex_right.h3d -MIRROR_XZ 

（4）此时 FlexPrep 将后台运行，在工作文件夹中将生成名为 sla_flex_right.h3d 的柔性

体文件。 
（5）上述步骤描述了如何使用 Flexprep 工具在批处理模式下创建柔性体。在某些场

合，柔性体规模较大以致模型导入和求解出现困难，下面介绍如何缩减柔性体规模。首先

认识一下创建柔性体的有限元模型构成。 
（6）在文本编辑器中打开 sla_flex_left.fem。 
（7）模型文件前几行命令及解释如下。 
Line 1： SUBCASE     1 定义一个新的分析工况。 
Line 2： OUTFILE， sla_left_flex 指定输出文件名称。 
Line 3： CMSMETH    1 定义 RADIOSS 计算柔性体的模态综合方法。 
Line 4： STRESS=ALL 控制 RADIOSS 计算模型中所有单元的模态应力。 
Line 5： STRAIN=ALL 控制 RADIOSS 计算模型中所有单元的模态应变。 
Line 6： BEGIN BULK 定义有限单元对象的开始。 
Line 7： DTI， UNITS， 1， KG， N， MM， S 定义柔性体单位。 
Line 8： PARAM   COUPMASS -1 定义 RADIOSS 创建柔性体时使用的参数。该参数表
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示使用集中质量方法计算模型特征值。 
Line 9： CMSMETH， 1， CB，   10 选择 Craig Brampton 模态综合方法，提取 10 阶模态。 
Line 10： ASET1， 123456，    4927 定义界面点边界自由度。 
Line 11： ASET1， 123456，    4979 
Line 12： ASET1， 123456，    4984 
Line 13： ASET1， 123456，    4985 
指定这些卡片后，RADIOSS 将创建 H3D 格式的柔性体文件。使用上述设定，生成的柔

性体规模可能非常大，此时可使用 Stress/Strain 集、Model 集、Outline 或释放模型界面点自

由度来的方式缩减柔性规模，提高多体系统前处理、求解以及后处理速度。 

定义应力/应变集 

Stress/strain 集控制柔性体创建过程中应力应变计算的范围。 
Stress/strain 卡片语法： 

STRESS=7 
STRAIN=7 

这里 STRESS 和 STRAIN 为 RADIOSS 卡片，用于控制应力应变信息计算，7 表示单

元集。 
（1）使用文本编辑器打开工作路径下的 sla_left_stress_strain_set.fem 文件。 
（2）分别修改 STRESS=ALL 和 STRAIN=ALL 为 STRESS=7 和 STRAIN=7。 
（3）保存并关闭文件。 
（4）启动 DOS 窗口，进入工作文件夹，然后输入以下命令求解模型： 

<install>\hwsolvers\bin\win32\radioss.batsla_left_stress_strain_set.fem。 

（5）新建一个 MotionView 会话并将窗口类型设定

为 HyperView。 
（6）载入柔性体文件 sla_left_stress_strain_set.h3d。 
（7）单击 Contour 按钮 ，进入云图面板，显示应

力应变云图，如图 4-31 所示。此时图形区仅有部分单

元显示出云图。这些单元即是使用单元集预先选择进

行应力应变计算的单元。 

定义模态集 

该卡片将控制在 MotionView 前后处理中 H3D 文件单元的显示。 
MODEL 卡片语法： 

MODEL=7 

MODEL 是 RADIOSS 中控制柔性体在 MotionView 单元显示的卡片。7 代表待显示的单
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图 4-31  部分单元应力结果输出 
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元集。 
（1）使用文本编辑器打开 sla_left_model_set.fem。 
（2）在 CMSMETH 行后加入 MODEL=7 语句。 
（3）保存并关闭文件。 
（4）启动 DOS 窗口，进入工作文件夹，然后输入以下命令求解模型： 

<install>\hwsolvers\bin\win32\radioss.bat 
sla_left_model_set.fem。 

（5）打开一个新的 MotionView 会话并将窗口类

型设定为 HyperView。 
（6）载入柔性体文件 sla_left_model_set.h3d。如

图 4-32 所示，此时图形区将显示部分柔性体，这些

单元即是 MODEL 卡片中指定的单元。 

RADIOSS PLOTEL 单元的特征线功能 

应用 PLOTEL 单元，MotionView 仅显示柔性体的边界，这样可以极大缩减柔性体规

模。PLOTEL 是专用于显示的一维单元，它可以在输入文件中定义并通过 MODEL 卡片显示

出来。 
PLOTEL 卡片语法： 

PLOTEL EID G1 G2 

PLOTEL 是单元类型，EID 为单元编号，G1 和 G2 代表定义单元的节点。例如： 

PLOTEL      8786    4698    1702  

创建 PLOTEL 单元流程如下： 
（1）打开 HyperMesh，在 OptiStruct 模板下载入工作文件夹的 sla_left_model_set.fem 文件。 
（2）进入 Tool 页面，选中 features 单选按钮，选择所有壳单元，指定 feature angle 为

20，如图 4-33 所示。 

 

图 4-33  HyperMesh features 面板（features 标签） 

（3）单击 features 按钮，HyperMesh 将根据指定的特征角创建 PLOTEL 单元，此时模型

中新增了一个名为^feature 的组件。 
（4）如图 4-34 所示，选中 features 面板下的 edit 单选按钮修改多余或不足的 PLOTEL

单元，修改后的模型如图 4-35 所示。 
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图 4-32  部分单元输出 
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图 4-34  HyperMesh features 面板（edit 标签） 

 
图 4-35  含有 PLOTEL 单元的模型 

（5）进入模型浏览树，将组件^feature 重命名为

feature，如图 4-36 所示。 
注：“^”符号表示临时组件集，该组件在模型输出时

将被忽略。因为后续步骤需要用到 feature 组件，所以这

里将其“^”符号去掉。 
（6）进入 Analysis 页面下的 entity sets 面板，创建包

含上述 PLOTEL 单元的单元集，如图 4-37 所示。 

 
图 4-37  HyperMesh entity sets 面板 

（7）进入 Analysis 页面下的 control cards 面板，创建 MODEL 卡片并指定步骤（6）创

建的单元集编号，如图 4-38 所示。 

 

图 4-38  HyperMesh control cards 面板 

 

图 4-36  组件重命名 
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（8）右击模型树 Cards 文件夹下的 OUTFILE 卡片，将输出文件名设置为 SLA_LEFT_ 
PLOTEL_SET，如图 4-39 所示。 

 

图 4-39  设置输出文件名 

（9）保存模型为 sla_left_plotel.fem，关闭 HyperMesh。 
（10）启动 DOS 窗口，进入工作文件夹，然后输入以下命令求解模型： 

<install>\hwsolvers\bin\win32\radioss.bat 
sla_left_plotel.fem。 

（11）新建一个 MotionView 会话并将窗口

类型设定为 HyperView。 
（12）载入步骤（10）中创建的 H3D 格式

的柔性体文件。此时图形区显示柔性体仅由

PLOTEL 表示的特征线构成，如图 4-40 所示。 

释放界面点自由度 

根据多体模型中的运动学约束和分析类型，可以适当释放界面点的自由度而不影响结果

准确度。界面点自由度的释放将降低 H3D 柔性体文件的规模。 
ASET1 是 RADIOSS 中用于定义柔性体界面边界自由度的卡片。该卡片语法如下： 

ASET1  C G1 or ASET1， C， G1 

这里 ASET1 为卡片名称，C 为被约束的自由度，G1 是约束节点编号。例如： 

ASET1， 123456， 4927 

该语句表示约束界面点 4927 全部自由度，123456 代表 3 个平动自由度和 3 个转动自由

度。因此，如果释放界面点的某个自由度（如 X 方向的旋转自由度），那么 C 值为 12356。
应用一个 ASET1 卡片可以约束多个节点自由度，如： 

ASET1， 123456， 4927， 4797， 4984， 4985 

（1）使用文本编辑器打开 sla_left_rdof.fem。 
（2）根据下述语句修改 ASET1 卡片。 

 

图 4-40  由 PLOTEL 组成的控制臂柔性体模型  STEP 
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ASET1， 123456，    4927 
ASET1， 1234，      4979 
ASET1， 1234，      4984 
ASET1， 123，       4985 

（3）保存文件为 sla_left_rdof.fem，然后关闭文件。 
（4）启动 DOS 窗口，进入工作文件夹，然后输入以下命令求解模型： 

<install>\hwsolvers\bin\win32\radioss.bat sla_left_rdof.fem。 

（5）柔性体创建完毕后，检查 H3D 文件的大小。 

4. 3.2  应用 HyperMesh 创建柔性体 

在这一节将向用户演示如何在 HyperMesh 中读入一个有限元模型，并通过适当的设

置，将该有限元模型转化为 MotionSolve 求解所需要的柔性体模型的过程。图 4-41 给出了该

模型的基本形态。 

 

图 4-41  汽车控制臂模型 

本节的练习将包括以下内容： 
●  读入.hm 格式的数据文件。 
●  在 HyperMesh 中完成模型基本设置。 
●  递交求解。 
在本练习开始前，复制 chap04 目录下的 susp_sla.hm 文件到工作文件夹中。 

在 HyperMesh 中读入已有模型文件 

（1）启动 HyperMesh。 
（2）在 UserProfile 中选择 Radioss Bulk Data 模板。 
（3）单击 Open 按钮 。 
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（4）找到工作文件夹下的 susp_sla.hm 模型文件。 
（5）打开文件。 

定义生成柔性体文件所需的载荷集 

在这一步，将定义两个载荷集，为柔性体模型的创建做准备。其中，名为 ASET 的载荷

集定义了模型自由度信息，名为 CMS 的载荷集定义了模态综合算法及相关参数。 
（1）单击 Load Collector 按钮 。 
（2）定义名为 ASET 的载荷集，其颜色选取为任意颜色，在 Load Collector 的类型

（card image）中选择 no card image。 
（3）单击 Create 按钮。 
（4）定义名为 CMS 的载荷集，其颜色选取为任意颜色，在 Load Collector 的类型（card 

image）中选择 CMSMETH 卡片。 
（5）单击 Create/edit 按钮。 
在默认情况下，求解器将选择 Craig-Bamton 方法（CB 方法）进行模态综合。在此处，

还需要定义 UB_FREQ（模态截止频率）或 NMODES（模态阶数）以完成该卡片的定义。 
（6）在 NMODES 文本框中输入 10，如图 4-42 所示。 

 

图 4-42  CMSMETH 卡片定义 

（7）单击 return 按钮，退出 Load Collector 编辑面板。 

创建 ASET 

（1）在模型浏览树中右击此前创建的 ASET，并选择 Make Current 命令，将其设置为当

前载荷集合。 
（2）在 Analysis 页面下，进入 constraints 面板。 
（3）单击面板右下方的 Load Type 按钮，将约束类型设置为 ASET。 
（4）选中 dof1、dof2 和 dof3 复选框，如图 4-43 所示。 

 

图 4-43  constraints 面板 

（5）单击 node 按钮，选取图 4-44 所示刚性单元的主节点（节点编号为 4984、4985）。 
（6）单击 create 按钮。 
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（7）选中 dof2 和 dof3 复选框，并确认节点选择器仍处于激活状态。 
（8）选取图 4-44 所示刚性单元的主节点（节点编号为 4979），并单击 create 按钮。 
（9）选中 dof3 复选框，并确认节点选择器仍处于激活状态。 
（10）选取图 4-44 所示刚性单元主节点（节点编号为 4927），并单击 create 按钮。完成

设置后，模型中共有 4 个节点进行了 ASET 设置。设置完成的模型如图 4-44 所示。 

 

图 4-44 创建 ASET 

创建 RADIOSS 工况 

（1）进入 Analysis 页面，单击进入 Control cards 面板。 
（2）激活 GLOBAL_CASE_CONTROL 卡片。 
（3）选中 CMSMETH 复选框。 
（4）单击 CMSMETH，并选择 CMS 载荷集。 
（5）单击 return 按钮，回到 Control cards 面板。 

定义分析类型、模型单位制、创建模型名称并设置模态综合输出控制 

（1）单击 Analysis 页面下的 Control cards 按钮，激活 DTI_UNITS 卡片，设置柔性体模

型输出的单位制为国际单位制，如图 4-45 所示。 

 

图 4-45  设置柔性体单位 

（2）在 Control cards 面板下，激活 GLOBAL_OUTPUT_REQUEST 卡片。 
（3）选中 GPSTRESS 复选框。 
（4）按图 4-46 所示完成卡片设置。 
（5）单击 return 按钮。 
（6）依然在 Control cards 页面下，单击 next 按钮，进入下一页面，单击 OUTPUT 卡

片，并按图 4-47 所示进行设置。 
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（7）单击 return 按钮两次，返回主面板。 

 

图 4-46  定义应力输出 

 

图 4-47  输出文件类型设置 

递交求解 

（1）在 Analysis 页面下，进入 Radioss 面板。 
（2）将 export options 设置为 all。 
（3）在 input file 后，单击 Save as 按钮。 
（4）填写 susp_sla.fem。 
（5）在 memory options 中，将其设置为 memory default。 
（6）在 run options 中选择 analysis。 
（7）单击 Radioss 按钮，递交求解。 
顺利完成求解后，RADIOSS 将弹出求解完成的信息。在工作文件夹下，可以查看到生

成了以下结果文件。 
●  susp_sla.h3d：MotionSolve 柔性体模型文件。 
●  susp_sla.out：ASCII 格式的求解输出文件，包含了与求解有关的各类信息。 
●  susp_sla.stat：包括 CPU 时间，求解时间和硬件资源占用等各类信息。 

关于柔性体结果的查看可参考 4.3.1 节应用 MotionView Flexprep 创建柔性体       的
内容。 

4.4  刚柔耦合分析实例 

4. 4.1  汽车前悬架机构刚柔耦合分析 

本节将学习以下内容： 
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●  使用 MotionView 装配向导创建汽车前悬架模型。 
●  在 MotionView 中进行控制臂零件刚柔替换。 
●  使用 MotionSolve 进行刚柔耦合模型求解。 
●  使用 HyperView 进行结果后处理。 
练习开始前，复制 chap04 目录下的 sla_flex_left.h3d 和 sla_flex_right.h3d 文件到工作文

件夹中。 

创建前悬架动力学分析模型 

（1）启动 MotionView。 
（2）在 MotionView 菜单栏中选择 Model 菜单并单击 Assembly Wizard，打开装配体

向导。 
（3）根据表 4-2 创建汽车前悬架模型。 

表 4-2  汽车前悬架模型参数 

面    板 选    项 

Model Type Front-end of vehicle 

Drive Type No driveline 

Primary Systems Frnt SLA susp （1 pc LCA），其余使用默认值 

Steering Subsystems Steering Column = Steering column 1 （not for abaqus） 

Springs，Dampers and Stabars 使用默认值 

Jounce/Rebound bumpers 使用默认值 

Label and varname 使用默认值 

Attachment Wizard Compliant = Yes，其余使用默认值 

（4）设置分析工况：在 MotionView 菜单栏中选择 Analysis 并单击 Task Wizard，打开

工况设置向导。 
（5）在 Select a task 文本框中选择 Static Ride Analysis，单击Next 按钮，单击 Finish 按钮。 

创建位移输出请求 

本步将创建刚性控制臂位移输出请求，与柔性控制臂求解结果进行对比，以考察构件柔

性变形对构件运动状态的影响 
（1）右击工具栏中的 Output 按钮 ，在弹出的 Add Output 对话框中指定标题为 disp_ 

lwr_left。 
（2）使用默认的变量名，单击 OK 按钮。 
（3）进入 Output 面板，将输出类型设置为 Displacement。 
（4）根据图 4-48 定义输出参数。 

 STEP 

01 

 STEP 

02 
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图 4-48  位移输出请求设置 

求解刚体动力学模型 

（1）单击工具栏中的 Save Model 按钮 ，保存当前模型为 sla_rigid.mdl。 
（2）单击工具栏中的 Run 按钮 ，进入 Run 面板。 
（3）单击 Check 按钮，检查创建的多刚体模型是否存在错误。 
（4）单击“文件浏览”按钮 ，将模型保存为 sla_rigid.xml。 
（5）使用默认的仿真参数，单击 Run 按钮，运行仿真。 
（6）求解结束后，单击 Animate 按钮，查看机构运动历程结果。 
（7）单击 Plot，单击窗口 3，进入 HyperGraph 界面。 
（8）根据图 4-49 的设置，绘制控制臂弹簧连接点位移曲线。 

 
图 4-49  刚体模型仿真结果 

 STEP 
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替换刚性控制臂 

（1）单击工具栏中的 Body 按钮 。 
（2）在图形区中选择 Lwr control arm，如图 4-50 所示。 

 

图 4-50  选择几何体 

（3）在 Body 面板的 Properties 标签中取消选择 symmetric properties 复选框。 
（4）在弹出的 Question 对话框中单击 No。 
（5）单击 Left 标签，选中 Deformable 复选框，如图 4-51 所示。在弹出的 Question 对

话框中单击 No，注意到图形区模型左侧的刚性控制臂消失。 

 

图 4-51  选中 Deformable 复选框 

（6）单击 Graphic file 文本框中的“文件浏览”按钮 ，在工作目录下选择柔性体文件

sla_flex_left.h3d。 
（7）H3D file 文本框中将自动加载相同的文件，如图 4-52 所示。此时，指定的柔性体

文件将放置于模型中消失的刚体的位置。 

 
图 4-52  指定模型文件 
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（8）单击 Nodes 按钮，弹出 Nodes 面板，如图 4-53 所示。 

 

图 4-53  Nodes 面板 

（9）单击 Nodes 面板上 Find All 按钮，寻找柔性体上距离悬架模型硬点最近的界面

点。分别单击每栏的 Align 按钮，进行硬点偏置。左侧柔性控制臂替换后的前悬架模型如

图 4-54 所示。 

 

图 4-54  左侧柔性控制臂替换后的前悬架模型 

在大多数情况下，柔性体模型界面点与 MDL 模型对应的连接点会存在一定程度的

偏离。单击 Align 按钮，MotionView 将移动 MDL 模型中的硬点到柔性体模型最近的界

面点位置。如果左右硬点坐标不对称，需要先将坐标对称属性取消，再分别单击 Align
按钮。 

Body 面板中的 Locate 按钮是进行柔性体模型重新定位的工具。在创建柔性体模型时使

用的坐标系与 MDL 模型坐标系不一致的情况下，会用到这一工具。如果柔性体模型已经

处于目标位置，则这一操作可以省略。 
（10）单击 Close 按钮，关闭 Nodes 面板。 
（11）单击 Modes 按钮，弹出 Modes 面板，如图 4-55 所示。Modes 面板将允许用户选
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择仿真过程中激活的模态。在默认情况下，刚体模态将被抑制。同时，用户可以修改各阶

模态的阻尼。 

 

图 4-55  Modes 面板 

在默认情况下，模态频率小于 100Hz 时，阻尼设置为 1%；模态频率在 100～1000Hz，
阻尼设置为 10%；当模态频率大于 1000Hz 时使用临界阻尼。用户可以为各阶模态指定初

始条件。激活不同的模态，仿真结果将有所不同。 
（12）单击 Close 按钮，关闭 Modes 面板。 
（13）重复步骤（5）～（12），替换右侧刚性控制臂。最终模型如图 4-56 所示。 

 

图 4-56  两侧柔性控制臂替换后的前悬架模型 

（14）激活 FEM Inertia Props 标签，如图 4-57 所示。 
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图 4-57  FEM Inertia Props 标签 

（15）在当前会话中新建一页。 
（16）选择应用程序 TextView。将原始 sla_flex_left.fem 文件导入 HyperMesh 中，输出

控制臂质量及转动惯量信息到 summary.txt 文件中。 
（17）在 TextView 中导入 summary.txt 文件，如图 4-58 所示。 

 

图 4-58  控制臂质量及转动惯量信息 

可以看到多体模型中柔性体的质量和转动惯量信息与原始有限元模型相应值相同。 

创建载荷输出请求 

本步将创建柔性控制臂载荷输出请求，获得作用在结构上的约束反力，后处理中可使用

MotionView 载荷输出工具 Load Export 输出 HyperMesh 直接使用的载荷文件。 
（1）右击工具栏中的 Output 按钮 ，在弹出的 Add Output 对话框中指定标题为

Force_lwr_left。 
（2）使用默认的变量名，单击 OK 按钮。 
（3）进入 Output 面板，将输出类型设置为 Force。 
根据图 4-59 定义输出参数。 

 STEP 
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图 4-59  载荷输出请求设置 

使用 MotionSolve 求解前悬架刚柔耦合模型 

（1）返回 MotionView 窗口。 
（2）单击工具栏中的 Save Model 按钮 ，保存当前模型为 sla_flex.mdl。 
（3）单击工具栏中的 Run 按钮 ，进入 Run 面板。 
（4）单击 Check 按钮，检查创建的多刚体模型是否存在错误。 
（5）单击“文件浏览”按钮 ，将模型保存为 sla_flex.xml。 
（6）使用默认的仿真参数，单击 Run 按钮，运行仿真。 
（7）求解结束后，单击 Animate 按钮。此时软件将自动新建一个窗口，进入 HyperView

程序，并载入求解结果。 
（8）单击窗口 4，然后单击 Contour 按钮 ，按照图 4-60 所示设置应力云图。 

 

图 4-60  应力云图设置 

（9）激活窗口 3，根据图 4-61 绘制控制臂弹簧连接点位移曲线。 

 

图 4-61  控制臂弹簧连接点位移曲线绘制 
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此时图形区如图 4-62 所示。 

 

图 4-62  前悬架刚柔耦合模型仿真结果 

由窗口 3 可以看出，控制臂柔性变形确实对弹簧连接点的位移产生了一定的影响。由此

可以联想到工业装配流水线上的焊接机器人结构设计，如若使用刚体模型研究焊接机器人焊

点轨迹，则将无法获得考察构件柔性变形引入的误差，进而造成设计上的失误。因此，在进

行机械系统设计时，结构的柔性变形应当引起足够的重视。 

载荷文件输出与应用 

（1）返回 MotionView 窗口。 
（2）选择 FlexTools 菜单中的 Load Export 命令，弹出 MotionView Load Export Module

对话框。 
（3）单击 Open 按钮，找到刚柔耦合分析获得的 sla_flex.meta 文件，载入该文件。 
（4）如图 4-63 所示，选择左侧控制臂后端衬套连接点（LCA rear bush-left）。 

 

图 4-63  MotionView Load Export Module V7.0 对话框 
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（5）单击 Time Selections 列的 Peak 按钮，将弹出 Time Steps Selection 对话框，如

图 4-64 所示。 

 

图 4-64  Time Steps Selection 对话框 

（6）选中 2.5 时刻的 Fmag-Max 复选框。 
（7）单击 Apply 按钮，此时选择列表中将显示

2.5，在 Description 文本框中可输入该时刻的描述语

句，如图 4-65 所示。 
（8）在 Export 列，激活 RADIOSS/NASTRAN 选

项。 
（9）单击 Nastran Options 按钮，弹出 Nastran 

Export Panel。 
（10）打开 HyperMesh 找到左侧控制臂后端衬套

连接点编号。 
（11）在 Node ID 列中输入该编号，如图 4-66 所示。 

 
图 4-66  Nastran Export Panel 

（12）单击 Apply 按钮，返回 MotionView Load Export 对话框。 
（13）单击 Export 按钮，将文件保存为 Fmag_max_4979.dat。 

 

图 4-65  Time Selection 列表 
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（14）打开 HyperMesh，载入 sla_flex_left.fem。 
（15）单击 Import Solver Deck 按钮 。 
（16）将 File type 切换成 Nastran。 
（17）单击 File 文本框中的“文件浏览”按钮 ，选择 Fmag_max_4979.dat，如图 4-67

所示。 

 

图 4-67  打开载荷文件 

（18）单击 Import 按钮。 
（19）单击 Visualization options 按钮 ，将 Load size 设置为 Uniform，如图 4-68 所示。 

 

图 4-68  载荷图标尺寸设置 

（20）图形区如图 4-69 所示，从 MotionView 中提取的载荷已自动加载到控制臂有限元

模型中。 

 

图 4-69  载荷自动加载 
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4. 4.2  车门闭锁机构刚柔耦合分析 

本节通过一个车门闭锁机构的刚柔耦合分析，将学习以下内容： 
●  根据有限元模型创建柔性体。 
●  闭锁机构刚体系统建模。 
●  车门模型刚柔替换。 
●  进行车门闭锁机构刚柔耦合分析。 
练习开始前，复制 chap04 目录下的 metro_door.fem 和 car_body_graphics.hm 文件到工作

文件夹中。 

在 HyperMesh 前处理环境中查看有限元模型 

（1）在 HyperMesh 中，读入用户工作文件夹下的

metro_ door.fem 文件。 
（2）在 HyperMesh 左侧的模型浏览树中展开模型

树，查看模型中所有的 Assembly 、 Component 、
Material 以及 Property 文件夹，如图 4-70 所示。 

（3）通过模型检查，确认以下内容： 
●  该模型中的所有 Component 均已进行了较高质

量的网格剖分。 
●  所有的 Component 已赋予了合适的单元属性

（Property）。 
●  所有的单元属性均与相应的材料模型进行了

关联。 
（4）查看节点 9751、节点 9750 以及节点 10090

位置。 
（5）将有限元模型输出名为 metro_door_flex.fem 的 RADIOSS 求解器输入文件。 

通过 Flex Prep，创建柔性体模型 

在这一步，将通过 Flex Prep 功能，读入上步保存的

FEM 格式的有限元模型，并将其转化为 H3D 格式的柔性体

模型文件。 
（1）新建一个 MotionView 会话。 
（2）在 MotionView 的 FlexTools 菜单中选择 Flex Prep，

如图 4-71。 
（3）在弹出的 FlexBodyPrep 对话框中设置相应参数，生

成车门柔性体模型，如图 4-72 所示。 

 

图 4-70  模型浏览树 

 

图 4-71  激活 Flex Prep 工具 
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图 4-72  FlexBodyPrep 对话框 

（4）在 Select Bulk Data File 处，选择在第 1 步中保存的 metro_door_flex.fem 文件。 
（5）在 Save the h3d file as 处，定义输出柔性体文件名为 metro_door_flex.h3d。 
（6）在 Specify Interface Node List 处定义界面点，其编号分别为 9750、9751 和 10090。 
（7）在 Cutoff type and value 处选择 Highest Mode，并选择 20，即提取 20 阶模态。 
（8）选中 Perform stress recovery 和 Perform strain recovery 复选框，并在 Perform Element 

Check in Radioss Model 中选择 No。 
（9）在 Mass units 下拉列表中选择 Megagram。 
（10）单击 OK 按钮，创建柔性体模型。 
（11）求解完毕后，将输出名为 metro_door_flex.h3d 的柔性体模型文件。 

创建车身与车门模型 

（1）本模型中，使用的单位制有 mm、t、N、MP、S。单击模型浏览树 Forms 文件夹中

的 Units 项目，进入 Units 面板。 
（2）将模型质量单位由 KILOGRAM 切换为 MEGAGRAM，如图 4-73 所示。 

 
图 4-73  Units 面板 

（3）建模时首先需要创建几何点。在模型浏览树中右击 Model，选择 Add Reference 
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Entity→Point，并按表 4-3 创建 6 个几何点。 

表 4-3  几何点坐标 

Point Label X Y Z 

Car Body CG -2394.080 691.5039 589.8312 

Car Body Fixed Point -2628.550 635.6520 270.5660 

Door Hinge Point Top -1286.420 729.2380 645.1150 

Car Door Lock Bottom -1286.420 729.2380 442.0050 

Car Door Lock Point -2425.640 969.7252 695.0962 

Car Body Lock Point -2448.610 671.1030 695.0962 

（4）本多体动力学分析模型中，需要建立两个几何体，其中一个用于表征车体，另一个

用于表征柔性体车门模型。在模型浏览树中右击 Model，选择 Add Reference Entity→Body 命

令，建立名为 Car Body 的几何体。 
（5）在 CM Coordinates 标签下，选中 Use center of mass coordinate system 复选框，双击

Point 按钮，选择 Car Body CG。 
（6）在 Properties 标签下，按表 4-4 所示的内容，输入质量及转动惯量信息。 

表 4-4  Car body 质量与转动管理信息 

Body Label Mass lxx lyy lzz lxy lxz lyx 

Car Body 0.04854 3184.2 26363 23351 370.82 4069.8 -67.549 

（7）创建名为 Car Door 的 Body。 
（8）在 Properties 标签下，选中 Deformable 复选框，如图 4-74 所示。 

 

图 4-74  Body 面板 

（9）在 Graphic File 和 H3D File 中，选择此前创建的 metro_door_flex.h3d 文件作为 Door 
Body。 

上述步骤创建了车门模型，接下来创建车体模型。 
（10）在 Tools 菜单下，选择 Import CAD or FE 命令。 
（11）在弹出的 Import CAD or FE 对话框中选中 Import CAD or Finite Element Model only

单选按钮。 
（12）在 Input File 下拉菜单中选择 HyperMesh，选择 car_body_ graphics.hm 文件。 
（13）在 Output File 下拉菜单中选择文件类型为 H3D，并定义文件名为 car_body_ 
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graphics.h3d，如图 4-75 所示。 

 

图 4-75  Import CAE or FE 对话框 

（14）单击 OK 按钮，HyperMesh 源文件将被转换为 H3D 格式的图形文件，并读入到当

前 MotionView 会话中。 
（15）在 MotionView 模型浏览树中，单击新添加的图形文件，进入 Graphic 面板。 
（16）在 Graphic 面板的 Connectivity 标签下，双击 Body 按钮，选择 Car Body，将该图

形文件与 Car Body 进行关联。 

创建约束 

在本模型中，需要设置 4 个约束副，其中一个为虚拟约束。 
（1）在模型浏览树中右击 Model，选择 Add Constraint→Joint，按表 4-5 创建 3 个

约束副。 

表 4-5  约束副信息 

Label Car Door Ground Fix Door Hinge Top Door Hinge Bottom 

Type FixedJoint RevoluterJoint RevoluterJoint 

Body1 Car Body Car Door Car Door 

Body2 Ground Body Car Body Car Body 

Origin（s） Car Body Fixed Point Door Hinge Point Top Door Hinge Point Bottom 

Orient Method - Axis（Vector） Axis（Point） 

Reference1 - Global Z Door Hinge Point Top 

（2）模型中包含柔性体模型，因此需要将柔性体模型中的界面点与模型其他部分进

行关联。 
（3）在模型浏览树中单击 Bodies 文件夹中的 Car Door 项，进入 Body 面板，并自动载入

Car Door 信息。 
（4）在 Properties 标签下，单击 Nodes 按钮。 
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（5）在弹出的 Nodes 对话框中，单击 Find All，分别单击界面点后的 Align 按钮，关联

界面点。 

定义车门运动初始条件 

模型初始条件为车门以一定的初速度闭合。接下来，设置模型的初始条件。 
（1）在 Body 面板中单击 Initial Condition 标签。 
（2）激活 WZ，并设置其初始角速度为 5.0。 

创建传感器 

本步将创建传感器，监测车门闭合的时刻。 
（1）在模型浏览树中右击 Model，选择 Add References Entity→Marker 命令，按表 4-6

所示的内容创建标记点。 

表 4-6  Marker 信息 

Marker Label Variable Body Origin 

Door Lock Marker m_door Car Door Car Door Lock Point 

Car Body Lock Marker m_car Car Body Car Body Lock Point 

（2）在模型浏览树中右击 Model，选择 Add Control Entity→Sensor 命令，新建标题为

Lock Recognize 的传感器。 
（3）单击 Signal 标签，将信号类型由 Linear 切换为 Expression。 
（4）单击文本框，激活 fx 按钮。 
（5）单击 fx 按钮，在弹出的表达式编辑器中输入 Signal 表达式： 
'DY（{MODEL.m_door.idstring}，{MODEL.m_car.idstring}，{MODEL.m_car.idstring}）' 
（6）此时将弹出如图 4-76 所示的错误信息。 

 

图 4-76  模型错误提示 

该错误是由于创建传感器信号监测表达式时用到了柔性车门的界面点，这需要在柔性车

门模型中进行界面点关联操作。 
（7）在模型浏览树中单击 Bodies 文件夹中的 Car Door 项，进入 Body 面板，并自动载入

Car Door 信息。 
（8）在 Properties 标签下，单击 Nodes 按钮。 
（9）在弹出的 Nodes 对话框中单击 Find All，寻找柔性体模型中所有的界面点。 
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（10）依次单击 Align 按钮，关联界面点与几何点。 
（11）模型运动过程中，通过上述表达式，传感器将监测 Door Lock Marker 和 Car Body 

Marker 之间 Car Body Lock Marker 标记点 Y 方向的距离。 
（12）在项目浏览树中单击 Sensors 文件夹中的 Lock Recognize 项目，进入传感器面板。 
（13）在 Compare To 标签下，设置 Value 为 0.0010，设置 Error 为 0.0001，指定 Respond 

If 为 Signal is less than value+error。 
（14）在 Response 面板下，激活 Return to command file。 

创建虚拟约束 

本步将使用上步创建的标记点创建虚拟约束以及序列仿真脚本（关于序列仿真，请参看

本书第 7 章）。 
（1）在模型浏览器中，右击 Model，选择 Add General MDL Entity→Template 命令，新

建标题为 Lock Fix Joint 的仿真脚本。 
（2）在 Properties 标签的 Type 文本框中，选择 Write Text To Solver Input Deck。 
（3）输入如下内容，创建虚拟约束副。 

<Constraint_Joint 
    id                  = "1001" 
    type                = "FIXED" 
    i_marker_id         = "{the_model.m_door.idstring}" 
    j_marker_id         = "{the_model.m_car.idstring}" 
/> 

该字段定义了 Door Lock Marker 和 Car Body Lock Marker 之间的固定副。 
（4）在模型浏览器中，右击 Model，选择 Add General MDL Entity→Template 命令，新

建标题为 Seq Sim Commands 的仿真脚本。 
（5）在 Properties 标签的 Type 文本框中，选择 Write Text To Solver Command File。 
（6）输入如下内容，创建序列仿真脚本。 

<Deactivate 
   element_type = "JOINT" 
   element_id   = "1001" 
/> 
<Simulate 
   analysis_type  = "Transient" 
   end_time       = "1.0" 
   print_interval = "0.001" 
/> 
<Activate 
   element_type = "JOINT" 
   element_id   = "1001" 
/> 

 STEP 
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<Deactivate 
   element_type = "SENSOR" 
   element_id   = "{the_model.sen_0.idstring}" 
/> 
<Param_Transient 
    integrator_type     = "VSTIFF" 
/> 
<Simulate 
   analysis_type  = "Transient" 
   end_time       = "2.5" 
   print_interval = "0.001" 
/> 
<Stop/> 

上面的代码定义了一组工作流，以完成最终的求解计算。该工作流的时序可以表示为 
A：在初状态下，失效两个标记点之间的虚拟固定副。 
B：进行 1 秒计算。 
C：激活虚拟固定副。 
D：失效传感器。 
E：将积分类型切换为 VSTIFF。 
F：进行 2.5 秒计算。 
G：终止计算。 

求解模型 

（1）单击 Save 按钮 ，保存模型。 
（2）单击工具栏中的 Run 按钮 ，进入 Run 面板。 
（3）单击 Save As 处的“文件浏览”按钮 ，将模型保存为 XML 格式求解器输入

文件。 
（4）单击 Run 按钮，启动 MotionSolve，求解模型。 
（5）求解结束后，单击 Animate 按钮。此时软件将自动新建一个窗口，进入 HyperView

程序，并载入求解结果。 
（6）单击窗口 2，进入 HyperView 程序。 
（7）单击工具栏中的 Contour 按钮 ，按照图 4-77 设置应力云图。 

 

图 4-77  应力云图设置 

（8）单击“动画播放”按钮 ，播放动画。再次单击该按钮停止动画播放。 

 STEP 

08 
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（9）返回 MotionView 窗口，单击 Plot 按钮。此时软件将自动新建一个窗口，进入

HyperGraph 程序，并载入求解结果。 
（10）单击窗口 3，进入 HyperGraph 程序。 
（11）按照图 4-78 设置绘制柔性体模态参与因子曲线。 
模态参与因子可用于柔性构件的耐久性分析。在 HyperGraph 窗口中，单击 Export 

Curves 按钮 ，可输出曲线。 

 

图 4-78  柔性体模态参与因子曲线绘制 

仿真结果如图 4-79 所示。 

 

图 4-79  仿真结果 

4.5  小结 

刚柔耦合多体系统动力学的发展，大大提高了多体系统动力学分析结果的准确性，同时

也大大拓展了多体系统仿真的应用范围，使其不仅能够为机械系统设计提供系统性能分析，

而且能为后续的结构强度校核以及耐久性分析提供载荷预测数据。MotionView 依托强大的

网格划分工具 HyperMesh，可实现各种复杂结构柔性体的创建，另外通过适当设置还可控制

柔性体的规模。本章详细描述了柔性体创建、刚柔替换以及刚柔耦合分析的完整工作过程，

相信读者学习完本章后，会对刚柔耦合系统建模与仿真有更加全面的认识。 
 



 1

第 5章     

 模型定义语言及其应用 

本章对 MotionView 的模型定义语言（MDL）进行了介绍。通过本章的学习可以掌握

MotionView 模型语言的语法、结构，应用 MDL 进行子系统模型、分析模型、数据库模型以及分

析向导的创建。 

本章重点知识 
 
 

5.1  模型定义语言简介 

5.2  应用 MDL 创建子系统模型 

5.3  应用 MDL 创建分析模型 

5.4  模型向导 

5.5  实例 

5.6  小结 
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5.1  模型定义语言简介 

一个完整的模型定义语言（Model Definition Language，MDL）包含了描述机械系统

必需的所有元素。完整的模型信息包括模型拓扑关系、模型数据以及多体动力学求解器求

解需要的控制信息。使用 MotionView 输出多体系统模型时，模型将自动转换为 MDL 格式

存储。 
使用 MDL 进行多体动力学系统定义具有以下优点： 
●  可以有效地进行模型调试。 
●  可以使用任何文本编辑器打开和修改模型。 
●  可编程功能。 
●  创建模块化及可重用模型。 
●  模型参数化，为多体动力学系统优化提供有力支撑。 
●  创建 MotionView 用户界面不支持的对象。 
●  支持报告模板创建。 
●  快速创建和维护模型、作业以及报告数据库。 
MDL 为一个 ASCII 格式的文件，可以使用任意文本编辑器打开。在 MDL 中，每一句

合法的语句及参数都由（*）进行引导。未被（*）引导的语句将视为注释语句。为了进一步

增强 MDL 的可读性，注释语句通常由“//”符号引导。 
通过 MotionView 用户界面输出的 MDL 文件由两个部分构成：模型拓扑关系部分

（Topology Section）和数据部分（Data Section）。其中，前者定义了模型各个组成部分之间的

连接关系，后者则为前者的各个成员提供数据支撑。 
MDL 模型包含了以下 3 类语句。 
●  用户自定义对象定义语句：如*DefineAnalysis， *DefineSystem。 
●  内置对象和用户自定义对象声明语句，如*Point， *Body， *System。 
●  对象定义语句：如*SetPoint， *SetBody。 
在上述前两类语句描述了多体动力学模型的拓扑关系，第三类语句则对模型对象属性

进行了定义。MDL 中的语句顺序可以任意排列。为了帮助用户更好地理解 MDL 的结构，

在本节及后续的练习中，所有模型的语法顺序都基本依照下列给出的语句实例进行组织： 

//comments about the MDL file 
*BeginMDL（argument list） 
//Topology section 
//user-definitions sub-section 
■  
//declaration of entities sub-section 
■  
//Property section 
■  
*EndMDL 
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多数情况下，MDL 语句的顺序可以是任意的，但有个别的例外。例如，在设置子系统

对象属性时，如果没有指定其显式对象的路径，软件将产生错误信息。推荐用户使用上述的

代码结构组织用户的模型，这为模型后期的编辑、调试等带来了很大的方便。如果用户使用

MotionView 进行多体动力学前处理，那么经 MotionView 编辑并输出的 MDL 模型也将按照

上述的结构进行组织。 
一个典型的 MDL 及语句注释如下： 
所有模型语句起始于*BeginMDL（ ）。名称与变量名主要用于模型识别，名称用于在分析

时调用该文件。在 MDL 中，语句的顺序不重要，但建议用户按照固定的格式编写。该模型

首先创建了两个点，p_pivot 和 p_cm；创建了一个名为 b_link 的体，通过旋转副与大地相连

并定义了其相对 x 轴旋转的结果输出请求；然后为其定义了图形；最后加入了 ACF 控制语

句以调用 ADAMS 求解器求解。 

// body_1.mdl // 
*BeginMDL（pendulum， "Pendulum"） 
points 
*Point（p_pivot， "Pivot point 1"） 
*Point（p_cm， "Pivot point 2"） 
bodies 
*Body（b_link， "First link body"， p_cm） 
joints 
*RevJoint（j_pivot， "Ground Pivot Joint"， B_Ground， b_link， p_pivot， V_Global_X） 
output 
*Output（o_1， "Angular displacement of link_1 about X-Axis"， EXPR， 'AX（{b_link.cm.id， %d}）'） 
*Output（o_2， "Angular velocity of link_1 about X-Axis"， EXPR， 'WX（{b_link.cm.id， %d}）'） 
graphics 
*Graphic（gr_pivot， "Pivot graphic"， CYLINDER， b_link， p_pivot， V_Global_X， 0.25， 0.25， 1， -0.5， 
CAPBOTH） 
*Graphic（gr_link_1， "Link graphic"， CYLINDER， b_link， p_pivot， p_cm， 0.25， CAPBOTH） 
*Graphic（gr_mass， "Mass graphic"， SPHERE， b_link， p_cm， 0.5）  
Template Definition  
*DefineTemplate（temp_def_acf_template）  
output/reqsave， grsave 
sim/dyn， end=2， ste=100 
stop 
*EndDefine（ ） 
setsystem 
*SetSystem（MODEL） 
*SetPoint（p_pivot， 0， 0， 0） 
*SetPoint（p_cm， 0， 5， 5） 
*SetBody（b_link， 1， 1， 1， 1， 0， 0， 0） 
template 
*Template（temp_acf_template， "ACF Template"， ACF， temp_def_acf_template） 
*EndMDL（ ） 
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5. 1.1  MDL 对象类型 

在 MDL 中，对象（entity）是对模型元素（如点、体、铰链连接、坐标系或数据集）的

一种描述。通常，MDL 中的对象可分为两类：内置对象（Built-in Entity）和用户自定义对象

（User-Defined Entity）。 
内置对象为 MDL 中预设的对象，用户可以在建模的任意阶段调用这些对象而不用预先定

义。在 MDL 中，绝大多数的几何及物理形式的对象，如点、体、铰链等，均为内置对象。内置

对象拥有其固定的属性。例如，点的属性包括在空间中的 X、Y、Z 坐标、状态和名称等。 
用户自定义对象，在调用之前需要在 MDL 中进行定义。用户自定义对象是可重用的，一

旦该对象完成定义，那么该对象既可在某一模型中被多次调用，也可以在不同的模型中被反复

调用。另外，用户可以基于一个自定义对象去创建新的对象，或在内置对象基础上创建新的用

户自定义对象。典型的用户自定义对象有子系统对象、分析模型、数据集、模板等。子系统对

象（System）是多个模型对象的集合体，它可在一个或多个 MDL 中重复使用。典型的子系统

对象有汽车前悬架系统、雨刷系统、传动系统等。分析对象（Analysis）则是由应用在多体模

型上、描述特定分析任务的载荷、驱动、结果输出和模型对象（如体、铰链等）构成。如用于

计算不同悬架模型的悬架设计参数（suspension design factor，SDF）的静态平顺性分析模型。

数据集（Dataset）是一系列用户自定义变量（如整数、浮点数、字符串、布尔运算符或文件名

等）的集合。模板（Template）是用于存放任何文件的文本对象，它主要用于创建文本报告和

描述 MDL 中不支持的外部求解器的模型语句与命令。 

5. 1.2  MDL 对象基本属性 

在 MDL 中，任意一个对象均包含变量名（Variable）、标题（Lable）及与之关联的其他

属性。在模型中，每一个对象必须使用唯一的变量名。 
表 5-1 列出了推荐使用的 MDL 对象命名规则，使用简洁明了的变量名有助于在模型调

试时快速识别模型对象。 

表 5-1  MDL 对象命名规则（部分） 

对    象 命名方式 对象属性信息 

Point p_ x、y、z、label、state、varname 

Body b_ Mass、IXX、IYY、IZZ、IXY、IYZ、IXZ、 cg、cm、

im、lprf、label、state、varname 

RevJoint j_ b1、b2、i、j、id 

Vector v_ x、y、z、label、state、varname 

Marker m_ Body、flt、x-axis、y-axis、z-axis、origin 

内置对象 

ActionReactionForce frc_ b1、b2、fx、fy、fz、id、tx、ty、tz 

System sys_ Label、varname、state 

Analysis ana_ Label、varname、state 

Dataset ds_ Label、varname、state 
用户自定义对象 

Template tmplt_ Label、varname、state 
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通过点符号（.）连接的对象变量名及其属性名称即可获得对象的属性信息。表 5-2 列

出了对象变量名示例，表 5-3 描述了获得的对象属性信息。 

表 5-2  对象变量名 

对象变量名 描 述 信 息 

b_knuckle 机械系统中的转向节物体 

p_knuckle_cg 转向节质心点 

表 5-3  对象属性信息 

对象属性名 获得的对象属性 

b_knuckle.cm b_knuckle 的质心标记点. 

b_knuckle.cm.id b_knuckle 的质心标记点编号 

p_knuckle_cg.x p_knuckle_cg 的 x 坐标 

5. 1.3  MDL 关键字 

MDL 还使用关键字描述对象属性。表 5-4 给出了部分典型的关键字。 

表 5-4  关键字及其描述 

关  键  字 意    义 

B_Ground 地面 

P_Global_Origin 坐标原点 

V_Global_X， V_Global_Y， V_Global_Z 整体坐标系下的 X、Y、Z 轴 

Global_Frame 整体坐标系 

MODEL 整个模型 

EXPR 为*Output（ ）定义表达式 

5.2  应用 MDL 创建子系统模型 

应用子系统可以： 
●  模块化组织模型。 
●  重用子系统模型。 
●  方便调试与维护模型。 
●  创建模型库。 
●  在一次操作完成对整个模型的编辑（如子系统的平移操作）。 
多体模型中子系统的定义与编程语言中的程序/子程序的定义类似，即首先定义各个用

户子程序，然后在主程序中调用各个子程序，完成系统装配，如图 5-1 所示。 
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a）                      b）   

图 5-1  子系统定义方法 

a） 程序/子程序—子系统定义  b） 主程序—多体模型 

用户子程序（Procedure）为主程序提供所需的信息。在主程序中，各个子程序可以多次

调用（实例化）。用户子程序是主程序的一部分，其定义过程可以相对主程序独立完成。 
类似地，子系统 （System Definition）也是一个为主系统提供信息以及各个对象之间连

接关系的模型。在主系统中，子系统定义可以多次调用。子系统是主系统的一部分，其定义

过程可以相对主系统独立完成。 
进行系统定义需要两个步骤： 
●  定义子系统。 
●  在 MDL 模型中，实例化子系统。 

5. 2.1  子系统定义 

在 MotionView 中，子系统是一种可重用的模型。只要满足连接要求，子系统可成为

MDL 模型的任一部分，如图 5-2 所示。 

 

图 5-2  子系统定义与调用关系 

子系统的定义可以由以下任一种方式进行： 
●  通过文本编辑器将已定义的模型转换成子系统模型。 
●  通过 GUI 定义子系统。 
注：两种方法都需要手工编辑。方法一用于已经获得多体模型的情况下，而方法二则是

通过 MotionView 新建子系统。相比而言，方法二需要的手工编辑工作量较小。 
图 5-3 描述了 MDL 模型与子系统模型之间的差异。 
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                                     a）                                   b）  

图 5-3  MDL 模型与子系统模型差异对比 

a）  MDL 模型  b） 子系统模型 

5. 2.2  子系统连接关系定义 

子系统模型包括内部对象与连接对象。连接对象主要用来与其他系统进行信息交互，

MotionView 大多数对象，如点、体、铰链、图形等均可作为连接对象。图 5-4 描述了汽车

前悬架子系统以及所需的连接对象。 

 

图 5-4  汽车前悬架子系统 

除了*Attachment（ ）语句，子系统定义与 MDL 模型定义类似。*Attachment（ ）用于定义连

接对象的类型，如点、体等。并通过*DefineSystem（ ）语句中与*Attachment（ ）相同的对象变量

名调用连接对象。下述语句描述了子系统模型的基本结构。 

Systm Definition File， System_def.mdl 
//system definition file： System_def.mdl 
*DefineSystem（sys_definition，b_body_att） 

连接其他对象 
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//attachments 
*Attachment（b_body_att，”Attachment Body”， Body，”This body comes from outsides the system”） 
//System Entities 
//Attachment entity can be used in the definition as shown below 
*RevJoint（j_sys_joint， “Rev. Joint”， b_sys_body， b_body_att， p_sys_point，V_Global_X） 
*EndDefine（ ） 

5. 2.3  子系统实例化 

子系统定义完毕后，可根据该系统创建多个实例，应用到不同的 MDL 模型中。例如，

定义了一个前悬架系统的子系统，用户可在一个或多个车辆模型中实例化该子系统。表 5-5
列出了子系统模型基本结构以及在 MDL 模型文件中的调用方法。 

表 5-5  子系统模型基本结构及其调用方法 

Reference 
Number Systm Definition File， System_def.mdl System Instantiation in an MDL Model File， body.mdl 

1 //system definition file： System_def.mdl //MDL model file：body.mdl 

2 *DefineSystem（sys_definition，b_body_att） *BeginMDL（Base_model，”Base Model”） 

3 //attachments //Include system definition 

4 *Attachment（b_body_att，”Attachment Body”， Body，” 
This body comes from outsides the system”） *Include（“system_def.mdl”） 

5 //System Entities //System Instantiation 

6 //Attachment entity can be used in the definition as 
shown below *System（analysis1，”First system”， sys_definition，B_Ground） 

7 *RevJoint（j_sys_joint， “Rev. Joint”， b_sys_body， 
b_body_att， p_sys_point，V_Global_X） //Set entity properties for system1 

8 *EndDefine（ ） *EndMDL（ ） 

MDL 模型中模型间的调用关系如下。 
System_def.mdl：子系统模型 system_def.mdl 的所有内容由*Include（ ）引用到 MDL 模型中。 
b_body_att：在子系统模型中通过*Attachment（ ）定义的连接对象变量名，由*DefineSystem（ ）

引用。 
sys_definition：在子系统模型中通过*DefineSystem（ ）定义的分析对象名，由*System（ ）引

用到 MDL 模型中。 
子系统模型定义完毕，可以通过以下任一种方式实例化： 
●  手动编辑 MDL 文件。 
●  通过 MotionView 的 System/Analysis 面板载入。 
●  使用 MotionView 的 Assembly Wizard 窗口载入。 

5.3  应用 MDL 创建分析模型 

在 MotionSolve 中，分析模型是载荷、强制运动、结果输出控制要求以及应用到多体模

型上的各类对象（体、铰链等）的集合，如悬架设计参数的平顺性分析模型。 
分析模型与子系统模型在语法结构上是类似的，只是模型引导语句不同，分析模型的语
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句使用*DefinitionAnalysis（ ）引导，而子系统模型的语句使用*DefinitionSystem（ ）引导。 
表 5-6 中给出了分析模型基本结构及其在模型文件中的调用方法。 

表 5-6  分析模型基本结构及其在模型文件中的调用方法 

Reference 
Number Analysis Definition File， analysis.mdl Analysis Instantiation in an MDL Model File 

1 //analysis definition file：analysis.mdl// //MDL model file 

2 *DefineAnalysis（def_analysis1，j_joint_att） *DefineMDL（base_model，”Base Model”） 

3 *Attachment（j_joint_att，”Joint Attachment”，Joint） //Include analysis definition 

4 *Motion（motion_1，”motion 1”，j_joint_att，ROT） *Include（“analysis.mdl”） 

5 *SetMotion（motion_1，DISP，`360D*TIME`） //Analysis Instantiation 

6 *EndDefine（ ） *Analysis（analysis1，”New Analysis”， def_analysis1，MODEL. 
j_revjoint） 

7  *EndMDL（ ） 

在 MDL 模型中，模型间的调用关系如下。 
analysis.mdl：分析模型 analysis.mdl 的所有内容由*Include（ ）引用到 MDL 模型中。 
j_joint_att：在分析模型中通过*Attachment（ ）定义的连接对象变量名，由*DefineAnalysis（ ）

引用。 
def_analysis1：在分析模型中通过*DefineAnalysis（ ）定义的分析对象名，由*Analysis（ ）引

用到 MDL 模型中。 

5.4  模型向导 

向导（Wizard）是 MotionView 强大的功能之一。标准的 MotionView 安装程序中包含两

个向导：模型装配向导（Assembly Wizard）和分析工况向导（Task Wizard）。向导由子系统

库、分析工况库以及报告模板构成。应用向导可以自动完成模型创建、工况分析以及结果后

处理。向导框架如图 5-5 所示。 

 
图 5-5  向导框架 

向导中的模型装配向导和分析工况向导分别由一系列子系统模型库和分析模型库构成。

创建模型时，模型装配向导将指导用户选择子系统以保证所选项目的兼容性，然后根据选

择，从模型库中调用已选子系统并以恰当的方式进行连接。模型创建完毕后，进入分析工况

向导。分析工况向导会根据当前会话中创建的模型进行工况筛选，然后提示用户指定相关参
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数完成工况定义。分析工况向导中的报告模板将根据工况定义做出相应调整，模型求解结束

后，调用报告模板，可以自动完成结果后处理。 
目前，MotionView 已预定义车辆模型装配向导（见图 5-6）及车辆动力学分析工况向导

（见图 5-7）。使用车辆模型装配向导可以完成汽车前悬架系统、后悬架系统、整车系统及动

力总成系统的自动化建模。车辆动力学分析工况向导分别为各系统预置了常用的分析工况，

如用于前悬架系统的 KC 分析、平行跳动分析、转向分析、轮胎包络分析等。车辆模型求解

完毕，应用分析工况向导内置的报告模板自动创建悬架设计参数曲线，可快速完成悬架参数

校验。 

 

图 5-6  车辆模型装配向导 

 

图 5-7  车辆动力学分析工况向导 

MotionView 支持用户自定义向导。完成向导文件的定义之后，在 MotionView 的 Model
菜单下的 Set Wizard Paths 对话框中修改向导文件启动路径即可实现自定义模型装配与分析

工况定义，如图 5-8 所示。 

 

图 5-8  Set Wizard Paths 对话框 
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5.5  实例 

5. 5.1  应用 MDL 创建单摆模型 

本练习将学习以下内容： 
●  创建 MDL 模型文件的基本方法。 
●  完成一个仿真时间为 2s、仿真步数为 500 步的瞬态分析。 
●  进行结果后处理，显示单摆的运动过程。 
●  使用 MotionView 默认的千克-毫米-秒-牛顿单位制体系。 
图 5-9 给出了一个单摆的设计方案。单摆通过一个

转动副与大地连接，连接位置为全局坐标系原点。单摆

在重力（全局坐标系 Z 轴负方向）的作用下自由摆动，

质心位于全局坐标系的（0，10，10）位置。 
本练习中，使用的 MDL 语句有*BeginMDL（ ）、

*EndMDL（ ）、*Point（ ）、*Body（ ）、*Graphic（ ）-cylinder、
*Graphic（ ）-sphere、*RevJoint（ ）、*Output（ ）、*SetPoint（ ）、
*SetBody（ ） 。 

在 MDL 语句中，只有关键字是区分大小写的。 

创建 MDL 模型文件 

（1）打开文本编辑器，新建一个文档，并在其中输入以下的 MDL 模型基本信息： 

//Pendulum falling under gravity 
//date 

（2）在新建会话中，创建语句*BeginMDL 和*EndMDL，它们描述了 MDL 模型的开始

与结束。其他所有语句都将写在上述语句块的内部。 

*BeginMDL（pendulum， "Pendulum Model"） 
*EndMDL（ ） 

*BeginMDL（ ）的语法如下所示： 

*BeginMdl（model_name， "model_label"） 

其中，model_name 是模型变量名，model_label 是模型标题。 

完成对象属性声明 

（1）通过语句*Point（ ）创建旋转副的定义位置。该语句的语法如下所示： 

 

图 5-9  单摆模型 

 STEP 

01 

 STEP 
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*Point（point_name， "point_label"， [point_num]） 

其中，point_name 是点的变量名，point_label 是点的名称，point_num 是点的编号。 
在本节的练习中，需要定义 point_name 和 point_label，如下所示： 

//Points 
*point（p_pendu_pivot， "Pivot Point"） 

（2）使用*Point（ ）创建另外一个点，用于定义单摆质心位置。创建完毕的语句如下所示： 

*point（p_pendu_cm， "Pendulum CM"） 

（3）应用*Body（ ）语句定义模型中的体对象。*Body（ ）语句的语法如下所示： 

*Body（body_name， "body_label"， [cm_origin]， [im_origin]， [lprf_origin]， [body_num]） 

其中，body_name 是该体的变量名；body_label 是体的标题；cm_origin 用于该 body 的

质心定义，该参数为选填参数；im_origin 为转动惯量定义，该参数同样为选填参数；

lprf_origin 为用户自定义与该 body 关联的局部坐标系原点，该参数为选填参数；body_num
为该体对象独有的对象编号。 

定义完成的体对象的语句如下所示： 

//Bodies 
*Body（b_link， "Ball"， p_pendu_cm） 

（4）定义图形，用于后处理结果动画显示。图形定义的语法如下所示： 

*Graphic（gr_name， "gr_label"， SPHERE， body， origin， radius） 

其中，gr_name 为该图形变量名，gr_label 为图形名称，SPHERE 表明该图形为球体，

body 为与该图形相关联的 body 名称，origin 为该球体的球心，radius 为球体的半径。定义完

成的语句应如下所示： 

//Graphics for sphere 
*Graphic（gr_sphere， "pendulum sphere graphic"， SPHERE， b_link， p_pendu_cm， 1） 

（5）定义圆柱体的语法如下： 

*Graphic（gr_name， "gr_label"， CYLINDER， body，point_1，point_2，radius，  
[CAPBOTH|CAPBEGIN|CAPEND]） 

其中，gr_name 是图形变量名，gr_label 是图形名称，CYLINDER 定义了该对象的类型

为一个圆柱体，body 则给出了与该圆柱体相关联的 body，POINT1 和 POINT2 分别为圆柱体

上底面和下底面的形心，Radius 定义了圆柱体的半径。[CAPBOTH|CAPBEGIN|CAPEND]是
该语句中的可选选项，用于控制视图模型的圆柱体两个端面是否封闭。 

在本实例中，完成的圆柱图形对象语句如下所示： 

//Graphics for cylinder 
*Graphic（gr_link， "pendulum link graphic"， CYLINDER， b_link， p_pendu_pivot， p_pendu_cm， 0.5， 
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CAPBOTH ） 

（6）创建转动副。转动副语法格式如下： 

*RevJoint（joint_name， "joint_label"， body_1，body_2， origin， point|vector， [ALLOW_COMPLIANCE]） 

其中，joint_name 是旋转副变量名，joint_labe 是旋转副标题，body_1 与 body_2 给出了

转动副的连接对象，origin 定义了该转动副的旋转点，point|vector 定义了该转动副的转轴。 
在本实例中，转动副定义的语句填写完毕后，应如下所示： 

//Revolute Joint 
*RevJoint（j_joint， "New Joint"， B_Ground， b_link， p_pendu_pivot， V_Global_X） 

（7）定义输出控制。输出控制语句用于定义计算结果输出，该语句的语法如下所示： 

*Output（out_name， "out_label"， DISP|VEL|ACCL|FORCE， ent_name， [ref_marker]） 

其中，out_name 为该输出控制的变量名，out_label 为该输出控制的标题，DISP|VEL| 
ACCL|FORCE 则定义了待输出的类型，包括位移、速度、加速度和力。Ent_name 用于指定

待输出的对象名称。Ref_marker 是可选选项，用于控制输出的参考坐标系。 
定义完成的输出控制语句如下所示： 

//Output 
*Output（o_pendu， "Disp Output"， DISP， b_link） 

（8）为 MDL 模型中的各个对象赋予属性信息。在这一环节，通过*SetSystem（ ）、
*SetPoint（ ）和*SetBody（ ）语句进行属性赋予。定义完成后，相关语句应如下所示： 

//Property data section 
*setsystem（MODEL） 
*setpoint（p_pendu_pivot， 0， 5， 5） 
*setpoint（p_pendu_cm， 0， 10， 10） 
*setbody（b_link， 1， 1000， 1000， 1000， 0， 0， 0） 

这里，建议加入*setsystem（MODEL）语句，MotionView 使用该语句参考整个模型。 
（9）将文本编辑器中创建的 MDL 模型，以文件名 pendulum.mdl 进行保存。定义完毕的

模型应为如下形式： 

//Pendulum Model 
//05/31/XX 
*BeginMDL（pendulum， "Pendulum Model"） 
//Points 
*point（p_pendu_pivot， "Pivot Point"） 
*point（p_pendu_cm， "Pendulum CM"） 
//Bodies 
*Body（b_link， "Ball"， p_pendu_cm） 
//Graphics for sphere 
*Graphic（gr_sphere， "pendulum sphere graphic"， SPHERE， b_link， p_pendu_cm， 1） 
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//Graphics for cylinder 
*Graphic（gr_link， "pendulum link graphic"， CYLINDER， b_link， p_pendu_pivot， p_pendu_cm， 0.5， 
CAPBOTH ） 
//Revolute Joint 
*RevJoint（j_joint， "New Joint"， B_Ground， b_link， p_pendu_pivot， V_Global_X） 
//Output 
*Output（o_pendu， "Disp Output"， DISP， b_link） 
//Property data section 
*setsystem（MODEL） 
*setpoint（p_pendu_pivot， 0， 5， 5） 
*setpoint（p_pendu_cm， 0， 10， 10） 
*setbody（b_link， 1， 1000， 1000， 1000， 0， 0， 0） 
*EndMDL（ ） 

保存并递交求解 

（1）如果用户使用 TextView 进行文本编辑，那么在 TextView 界面下单击按钮 ，新建

一个页面。 
（2）将界面切换到 MotionView。 
（3）单击“打开模型”按钮 ，或通过下拉菜单选择 File→Open→Model 命令。 
（4）在弹出的 Open Model 对话框中，选择此前创建的 pendulum.mdl 模型文件。 
（5）单击 Open 按钮，载入模型，如图 5-10 所示。 

 

图 5-10  MotionView 中的 pendulum 模型 

 STEP 
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（6）通过模型浏览树，查看文本编辑器中建立的模型在 MotionView 界面下的对应关系。 
（7）在 Tools 中选择 Check Model，检查模型是否有定义错误。 
（8）在 SolverMode 菜单下选择 MotionSolve。 
（9）单击工具栏中的 Run 按钮 ，进入 Run 面板，设置分析类型为 Transient。 
（10）进入 Simulation Parameter 标签，设置 End Time 为 2。 
（11）进入 Transient 标签，查看积分器的相关参数设置。 
（12）返回 Main 标签，单击“文件浏览”按钮 ，指定工作目录，以 pendulum.xml

保存模型。 
（13）单击 Run 按钮，求解模型。 
（14）求解结束后，单击 Animate 查看单摆运动历程。 
（15）单击 Plot 查看指定的结果输出，如图 5-11 所示。 

 

图 5-11  单摆运动历程及结果曲线 

5. 5.2  应用 MDL 创建和使用单摆子系统 

本练习将学习如何根据原始 MDL 创建子系统模型以及如何调用子系统模型。调用的语

句包括*Include（ ）、*DefineSystem（ ）、*System（ ）、*SetSystem（ ）、*Attachment（ ） 
该练习分为两部分：第一部分通过手动编辑的方式创建并调用子系统，原始模型为

5.5.1 节中的单摆模型；第二部分使用 MotionView 创建并调用子系统。两部分模型创建

完毕后分别进行多体系统动力学分析。复摆模型如图 5-12 所示。复摆模型参数如表 5-7
所示。 
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图 5-12  复摆模型 

表 5-7  复摆模型参数 

铰    点 质 心 位 置 惯 量 信 息 
参数 

X Y Z X Y Z Mass IXX IYY IZZ IXY IYZ IZX 

单位 mm mm kg kg·mm2 

Link1 0 5 5 0 10 10 1 1000 1000 1000 0 0 0 

Link2 0 10 10 0 15 15 1 1000 1000 1000 0 0 0 

1.通过手动编辑的方式创建并调用子系统 

创建子系统 

子系统结构与 MDL 类似，仅需少量编辑即可将上节定义的单摆模型转换为较为通用的

子系统模型。 
（1）打开上节创建的（或 chap05 目录中的）pendulum.mdl 模型。 
（2）将模型中的*BeginMDL（ ）和*EndMDL（ ）分别替换成*DefineSystem（ ）和 *EndDefine（ ），

为子系统指定适当的变量名。 
（3）单摆子系统模型的定义需要以下信息： 
●  连接位置（attachment point）。 
●  连接对象（attachment body）。 
这里使用 att_point 和 att_body 作为连接对象的变量名。 
（4）在*DefineSystem （ ）中定义连接信息，如下所示： 

*DefineSystem （sys_def_pendulum， att_point， att_body） 

注：连接对象可以是任意一种 MDL 对象。为便于模型调试，建议定义可读性较强的连

接对象变量名，如使用 att_point 表示点对象。 
（5）使用*Attachment 语句定义各变量所代表的对象信息： 

*Attachment （att_point， "Pivot Point"， POINT， "Attachment point where the pendulum definition gets 
attached"） 

 STEP 
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*Attachment （att_body， "Attachment body" ， BODY， " Any body to which the pendulum definition gets 
attached"） 

注：在原始 MDL 中，p_pendu_pivot 表示支点。将单摆模型转换为单摆子系统时，该支

点信息由连接点提供。 
（6）此时 p_pendu_pivot 信息由连接点提供，不再需要定义支点。因此删去*Point 

（p_pendu_pivot， "Pivot Point"）。 
（7）保留 pendulum CM point 不变。 
（8）保留*Body（ ）语句，用以定义单摆体对象。 
（9）*RevoluteJoint（ ）语句连接 B_Ground 和 p_pendu_pivot。这里分别使用 att_body 和

att_point 替代 B_Ground 和 p_pendu_pivot。 
（10）保留球体的外形语句*Graphic（ ）。 
（11）圆柱体的外形语句中参考了 p_pendu_pivot。这里使用 att_point 替代 p_pendu_pivot。 
（12）保留*Output（ ）语句，该语句用于输出模型中每个单摆体的位移信息。 
（13）删除语句*setsystem（MODEL）， *setpoint（p_pendu_pivot， 0， 5， 5）。 
（14）参数化子系统中的点坐标，在它们之间建立相互关系。这里，使用（att_point.y+5， 

att_point.z+5）定义 CM 点的坐标。 
（15）定义完毕的模型如下所示： 

// system.mdl 
// created on： 
*DefineSystem（sys_def_pendulum， att_point， att_body） 
//Topology Data 
// Declaration of Entities 
//Attachments 
*Attachment （att_point， "Pivot Point"， Point， "Attachment point where the pendulum definition gets 
attached"） 
*Attachment （att_body， "Attachment body" ， Body， " Any body to which the pendulum definition gets 
attached"）  
//Points 
*Point（ p_pendu_cm， "Pendulum CM"） 
//Bodies 
*Body（b_link， "Pendulum Body"， p_pendu_cm） 
//Joints 
*RevJoint（j_pivot， " Revolute Joint at Pivot Point "， b_link， att_body， att_point， V_Global_X） 
//Output 
*Output（o_pendu， "Disp Output"， DISP， b_link） 
//Graphics 
*Graphic（gr_sphere， "pendulum sphere graphic"， SPHERE， b_link， p_pendu_cm， 1 ） 
*Graphic（gr_link， "pendulum link graphic"， CYLINDER， b_link， att_point， p_pendu_cm， 0.5， 
CAPBOTH ） 
// Property Data 
*SetPoint（p_pendu_cm， 0， att_point.y+5， att_point.z+5） 
*SetBody（b_link， 1， 1000， 1000， 1000， 0， 0， 0） 
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*EndDefine（ ） 

（16）将模型保存为 system.mdl。 

调用子系统 

上步定义了一个可重用的单摆子系统。本步将进行该子系统的实例化。通过手动编辑的

方式，创建一个 MDL 模型，其中包含子系统定义及多次调用。 
（1）打开文本编辑器，在新的会话中输入*BeginMDL（ ）开始一个模型。 
（2）使用*Include（ ）调用子系统 system.mdl，如下所示： 

*Include（"system.mdl"） 

（3）使用*System（ ）实例化第一个单摆子系统，如下所示： 

*System（system1， "First Pendulum System"， sys_def_pendulum， P_Global_Origin， B_Ground） 

进行子系统实例化时需注意： 
●  在*System（ ）语句中通过指定子系统的变量名来调用子系统，该变量名与子系统

*DefineSystem（ ）语句定义的变量名一致。这里 system1 通过 sys_def_pendulum 调用。 
●  如果子系统中包含连接信息，则在进行实例化时需要编辑连接信息。例如，在子系

统 sys_def_pendulum 中*RevJoint（ ）将单摆与连接体对象 att_body 相连。这里希望将

单摆与大地相连，因此将 att_body 设置为 B_Ground。 
重复上述步骤，创建第二个单摆子系统。 
（4）使用*EndMDL（ ）语句结束模型定义 
（5）将文本编辑器中创建的 MDL 以文件名 doublependulum.mdl 进行保存。定义完毕的

模型，如下所示： 

*BeginMDL（model， "MODEL"） 
*Include（"system.mdl"） 
*System（system1， "First Pendulum System"， sys_def_pendulum， P_Global_Origin， B_Ground） 
*System（system2， "Second Pendulum System"， sys_def_pendulum， system1.p_pendu_cm， 
system1.b_link ） 
*EndMDL（ ） 

保存并递交求解 

（1）如果使用 TextView 进行文本编辑，那么在 TextView 界面下单击按钮 ，新建一个

页面。 
（2）将界面切换到 MotionView。 
（3）单击“打开模型”按钮 ，或通过下拉菜单选择 File→Open→Model 命令。 
（4）在弹出的 Open Model 对话框中，选择此前创建的 doublependulum.mdl 模型文件。 
（5）单击 Open 按钮，载入模型，如图 5-13 所示。 
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图 5-13  doublependulum 模型 

（6）通过模型浏览树查看由文本编辑器建立的模型在 MotionView 界面下的对应关系。 
（7）在 Tools 菜单中选择 Check Model 命令，检查模型是否有定义错误。 
（8）在 SolverMode 菜单下选择 MotionSolve。 
（9）单击工具栏中的 Run 按钮 ，进入 Run 面板，设置分析类型为 Transient。 
（10）进入 Simulation Parameter 标签，设置 End Time 为 2。 
（11）进入 Transient 标签，查看积分器的相关参数设置。 
（12）返回 Main 标签，单击“文件浏览”按钮 ，指定工作目录，以 doublependulum.xml

保存模型。 
（13）单击 Run 按钮，求解模型。 
（14）求解结束后，单击 Animate 按钮查看复摆运动历程，单击 Plot 按钮查看指定的结

果输出，如图 5-14 所示。 

 

图 5-14  复摆运动历程及结果曲线 
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2.使用 MotionView 创建并调用子系统 

首先在 MotionView 中根据表 5-8 中的数据创建单摆子系统，然后将其装配到

doublependulum.mdl 上形成图 5-15 所示的三摆系统。 

表 5-8  单摆子系统模型参数 

铰点 质心位置 惯量信息 
参数 

X Y Z X Y Z Mass IXX IYY IZZ IXY IYZ IZX 

单位 mm mm kg kg·mm2 

Link1 0 0 0 0 5 5 1 1000 1000 1000 0 0 0 

 

图 5-15  三摆系统 

创建子系统 

（1）打开 MotionView，新建一个会话。 
（2）右击工具栏中的 System/Analysis 按钮 。 
（3）在弹出的 Add System/Assembly 对话框中选中 Syetem 单选按钮，单击 Next 按钮，

如图 5-16 所示。 
（4）进入 Add System 对话框，使用默认的名称创建子系统，如图 5-17 所示。 

    
       图 5-16  Add System/Assembly 对话框                   图 5-17  Add System 对话框 
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（5）单击 OK 按钮，进入 System 面板。 
（6）单击 Add 按钮，在弹出的 Add an Attachment 对话框中设定连接对象名称为

att_point。将连接对象类型设置为 point，如图 5-18 所示。 

 

图 5-18  Add an Attachment 对话框 

（7）单击 OK 按钮。 
（8）再次单击 Add 按钮，创建连接体对象，使用 att_body 作为连接对象名称，连接对

象类型为 body。 
（9）单击 OK 按钮。 
（10）连接对象创建完毕，主面板上的状态为 Unresolved。在 Point 位置双击鼠标左键，

在弹出的 Select a Point 对话框中选择 Global Point 作为连接点对象。类似地，双击 Body 按钮

选择 Ground Body 作为连接体对象，如图 5-19 所示。 

 

图 5-19  System/Analysis 面板 

（11）在项目浏览树中的 system 0 位置右击，选择

Add Reference Entity→Point（或在工具栏中的 Points 按钮

处右击）。 
注：子系统对象需要创建在相应的 system 系统文件

夹下。 
（12）在弹出的 Add Point or PointPair 对话框中创建

标题为 Mass CG、变量名为 p_cg 的点，如图 5-20 所示。

在默认情况下，该点从属于 system 0 系统。 
（13）在 Point 面板的 Properties 标签中单击 Y 文本

框，然后再单击面板上端的 fx 按钮 。 
（14）在弹出的表达式编辑器的 Properties 标签中找到连

接点的 y 分量，单击 Add 按钮，将其加载到文本框中，然后

 

图 5-20  Add Point or PointPair 对话框 
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输入“+5”，如图 5-21 所示。 

 
图 5-21  表达式编辑器 

（15）按照上步的操作，使用 arg_0.x 参数定义 X 点，使用表达式 arg_0.z+5 参数化定义

Z 点。参数化定义的点坐标区域呈蓝色背景显示，如图 5-22 所示。 

 

图 5-22  Points 面板 

（16）在项目浏览树的 system 0 位置右击，选择 Add Renference Entity→Body，使用默认

的标题与变量名创建一个几何体。 
（17）在 Body 面板的 Properties 标签中输入图 5-23 所示数据。 

 

图 5-23  Bodies 面板（Properties 标签） 
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（18）单击 CM Coordinates 标签，选中 Use center of mass coordinate system 复选框，选择

Mass CG 作为质心点，如图 5-24 所示。 

 

图 5-24  Bodies 面板（CM Coordinates 标签） 

（19）在项目浏览树的 system 0 位置右击，选择 Add Constraint→Joint，使用默认的标题

与变量名新建一个旋转副（铰链类型为 Revolute Joint）。 
（20）在 Joint 面板中，Body1 选择上步创建的 Body0，双击 Body2 按钮，在弹出的

Select a Body 对话框中选择 system0 中的连接体对象。类似地，选择 system0 中的连接点对

象作为旋转副的支点，旋转方向设置为全局坐标系的 X 轴，如图 5-25 所示。 

 

图 5-25  Joint 面板 

Joint 面板中显示的 Body 2 是参数化几何体，指代 att_body。同理，Point 指代

att_point。 
（21）在项目浏览树的 system 0 位置右击，选择 Add Reference Entity→Graphic，使用默

认的标题创建一个圆柱图形（Cylinder）。 
（22）在 Graphic 面板的 Connectivity 标签中单击 Body 按钮，选择 System0 中的 Body0

作为圆柱图形所从属的几何体对象。单击 Point 按钮，选择 Mass CG 作为圆柱图形的起点，

选择连接点（att_point）定义圆柱副的建模方向，如图 5-26 所示。在 Properties 标签中，指

定圆柱半径为 0.5。 

 

图 5-26  Graphic 面板（步骤 20） 
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（23）按照上述步骤，在 System0 中创建一个球体图形（Sphere），选取 Body0 作为球体

所从属的几何体，Mass CG 作为球心。在 Properties 标签中，指定球体半径为 1，如图 5-27
所示。 

 

图 5-27  Graphic 面板（步骤 21） 

（24）单击工具栏中的 System/Assembly 按钮 ，进入 Import/Export 标签，选中 Export
单选按钮，指定子系统保存的路径与名称并单击 Quick Export。 

此时，上述步骤创建的模型将以子系统的形式保存在工作路径，如图 5-28 所示。 

 

图 5-28  System/Assembly 面板（Import/Export 标签） 

注：使用 MotionView 保存和输入子系统，只能通过 System/Analysis 面板下的

Import/Export 功能。 
（25）使用文本编辑器打开保存的子系统模型，完整的定义如下所示： 

////////////////////////////////////////////////////////////////////// 
 Altair HyperWorks 
 Version ： HWVERSION_11.0 
 Definition ： def_sys_0 
 Customer ID ：  
 Date ： 
////////////////////////////////////////////////////////////////////// 
*DefineSystem（ def_sys_0， arg_0， arg_1 ） 
  *Attachment（ arg_0， "att_point"， Point， "Select attachment."， ，  ） 
  *Attachment（ arg_1， "att_body"， Body， "Select attachment."， ，  ） 
  *SetDefaultSystemInstance（ sys_0， "System 0" ） 
  *Point（ p_0， "Mass CG" ） 
  *Body（ b_0， "Body 0"， p_0， ， ， ，  ） 
  *RevJoint（ j_0， "Joint 0"， b_0， arg_1， arg_0， VECTOR， MODEL.V_Global_X ） 
  *Graphic（ gra_0， "Graphic 0"， CYLINDER， b_0， p_0， POINT， arg_0， 0.5， gra_0.r1， ， 0.0， CAPBOTH ） 
  *Graphic（ gra_1， "Graphic 1"， SPHERE， b_0， p_0， 1 ） 
  *SetPoint（ p_0，                        arg_0.x， arg_0.y+5， arg_0.z+5 ） 
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  *SetBodyInertia（ b_0，                        1， 1000， 1000， 1000 ） 
  *Set（ b_0.usecm， true ） 
  *SetOrientation（ b_0.cm，       TWOAXES， ZX， DXDYDZ， ， ， ， DXDYDZ ） 
*EndDefine（ ） 

检查*Attachment 行最后一项是否有参数，如果有，则将其删除，然后保存模型。例

如，下述语句中 P_Global_Origin 指在子系统建模时用于等效连接点的全局坐标系原点，使

用子系统时需要指定连接点，以将子系统连接到其他系统上，因此这里可以将其删去。 

*Attachment（ arg_0， "att_point"， Point， "Select attachment."， P_Global_Origin，  ） 

调用子系统 

（1）打开 MotionView，新建一个会话。 
（2）单击 Open Model 按钮 ，载入本节第一部分创建的 doublependulum.mdl 模型，如

图 5-29 所示。 
（3）单击工具栏中的 System/Assembly 按钮 ，进入 Import/Export 标签。 
（4）激活 Import 选项，选择上步创建的子系统 subsystem.mdl 模型。 
（5）单击 Import 按钮。 
（6）在弹出的 Specify entity details 对话框中使用默认的名称，单击 OK 按钮，如图 5-30

所示。 

               

        图 5-29  doublependulum 模型                  图 5-30  Specify entity details 对话框 

（7）单击项目浏览树中的 System 0，然后单击主面板区域的 System/Assembly 面板中的

Attachments 标签。此时子系统的连接信息是空置状态，如图 5-31 所示。 

 
图 5-31  System/Assembly 面板（Attachments 标签） 
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（8）单击 Point 按钮，在图形区选择 YZ 视图下右上端的球心 Pendulum CM，如图 5-32
所示。此步操作用于指定子系统中旋转副的支点位置。 

（9）单击 Body 按钮，在图形区选择 YZ 视图下的右上端球体 Pendulum Body，如图 5-33
所示。此操作用于指定子系统中旋转副连接的体对象。 

           

                 图 5-32  指定连接点                      图 5-33  指定连接对象 

（10）在 Tools 中选择 Check Model 命令，以检查模型是否有定义错误。 
（11）选择 File→Save As 命令，保存模型为 triplependulum.mdl。 
（12）在 SolverMode 菜单中选择 MotionSolve。 
（13）单击工具栏中的 Run 按钮 ，进入 Run 面板，设置分析类型为 Transient。 
（14）进入 Simulation Parameter 标签，设置 End Time 为 2。 
（15）进入 Transient 标签，查看积分器的相关参数设置。 
（16）返回 Main 标签，单击“文件浏览”按钮 ，指定工作目录，以 triplependulum.xml

保存模型。 
（17）单击 Run 按钮，求解模型。 
（18）求解结束后，单击 Animate 按钮查看三摆系统运动历程，单击 Plot 按钮查看指定

的结果输出，如图 5-34 所示。 

 

图 5-34  三摆系统分析结果 
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5. 5.3  应用 MDL 创建分析工况 

本练习学习如何创建与使用分析模型，调用的语句包括： *DefineAnalysis（ ）、
*ActionReactionForce（ ）和*SetForce（ ）。 

通过实验测量一个系统的固有频率，典型方法是对系统施

加一个脉冲力或转矩，观察系统在该外加载荷下的响应，然后

对系统的响应频域结果进行傅里叶变换，其响应的峰值频率即

为系统的固有频率。下面介绍在 MotionView 中，采用数值方

法进行固有频率计算的基本流程，重点是分析模型的定义

（Analysis Definition）。 
（1）创建一个分析模型来模拟上述过程，在多体模型上施

加脉冲扭矩，并监测其响应。 
（2）按下式定义绕总体坐标系 X 轴的输入扭矩： 

Tx = step（TIME，.3， 0， .31， 10） + step（TIME， .31， 0， .32， -10） 

（3）应用该分析模型估计图 5-35 所示的三摆机构的固有频率。 
表 5-9 给出了三摆机构的模型定义信息。 

表 5-9  三摆机构模型信息 

铰点 质心位置 惯量信息 
参数 

X Y Z X Y Z Mass IXX IYY IZZ IXY IYZ IZX 

单位 mm mm kg kg·mm2 

Link1 0 0 0 0 0 -5 1 1000 1000 1000 0 0 0 

Link2 0 0 -5 0 0 -10 2 1000 1000 1000 0 0 0 

Link3 0 0 -10 0 0 -15 1 1000 1000 1000 0 0 0 

创建分析模型 

（ 1）在文本编辑器中，新建一个 MDL 模型，添加关键字 *DefineAnalysis（ ）和
*EndDefine（ ），在后续的步骤中，与分析模型定义相关的一些其他控制语句将被陆续添加到

这两条关键字之间。 
（2）通过语句*Attachment（ ），定义转动副上转矩施加的位置。需要注意的是，此处要保

证*Attachment（ ）语句中定义的变量名与*DefineAnalysis（ ）中定义的变量名一致。 
（3）通过语句*ActionReactionForce（ ）语句定义扭矩作用的对象。 
（4）通过句点（“.”）为扭矩定义调用正确的属性。如某转动副连接的几何体可通过<joint 

variable name>.b1 和<joint variable name>.b2 调用。 
（5）通过语句*SetForce（ ），按下式内容设置扭矩的表达式： 

 

图 5-35  三摆机构 
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TX = step（TIME，.3，0，.31，10） + step（TIME，.31，0，.32，-10），TY = 0，TZ = 0 

（6）通过语句*Output（ ）设置载荷输出。 
（7）保存文件名为 analysis.mdl。 
完成定义的完整语句应如下所示： 

*DefineAnalysis（ def_ana_0，j_att ） 
*Attachment（ j_att， "Joint"， Joint， "" ） 
*ActionReactionForce（ force_1， "Force Label"， ROT， j_att.b1， j_att.b2， j_att.i.origin， Global_Frame） 
*Output（o_force，"ForceOutput"，FORCE，force_1，Global_Frame， BOTH_MARKERS ） 
*SetForce（force_1，'step（TIME， 0.3， 0，0.31， 10） + step（TIME， 0.31， 0， 0.32， -10）'，0，0） 
*EndDefine（ ） 

创建模型文件 

（1）启动 MotionView，并打开 5.5.2 节创建的（或

chap05 目录中的）triplependulum.mdl 文件。 
（2）在工具栏中单击 System/Assembly 按钮 。 
（3）在 System/Assembly 面板中激活 Import/Export，

单击“文件浏览”按钮 选择上述定义的分析模型文件。 
（4）单击 Import 按钮。 
（5）在弹出的 Specify entity details 对话框中选择模型

类型 Analysis，如图 5-36 所示。 
（6）单击 OK 按钮，载入分析模型。 
（7）在项目浏览树单击新载入的分析模型，在面板

位置的 Attachments 标签中单击 Joint 按钮，并在图形区选

择任一旋转副，如图 5-37 所示。 

 

图 5-37  分析模型连接关系 

（8）在项目浏览树中右击 Analysis 0，并选择 Activate。 
（9）选择 File→Save as→model 命令，将模型保存为 new_triplependulum.mdl。 
（10）在工具栏中单击 Run 按钮 ，进入 Run 面板。 
（11）保存文件为 new_triplependulum.xml 并使用默认参数求解模型。 
（12）求解结束后，单击 Animate 按钮查看三摆系统运动历程，单击 Plot 按钮查看指定

的结果输出，如图 5-38 所示。 

 

图 5-36  Specify entity details 对话框 
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图 5-38  三摆模型及分析结果 

5. 5.4  应用 MDL 创建数据库 

本练习将学习以下内容： 
●  通过创建数组集，定义模型的计算开始时间、时间中点、计算终止时间以及载荷

大小。 
●  在分析模型中调用数组集。 
●  定义输入扭矩的载荷-时间关系。 
在模型定义过程中，用户可能会接触到各种类型的数据及其组合，如字符串、整数、实

数等。在 MDL 中，数组集（Dataset）是用户自定义的一系列数据的集合。创建完毕的数组

集，可以在 MotionView 用户界面中进行查看、编辑、保存或删除。在 MDL 语言中，数组

集由语句*DefineDataset（ ）-*EndDefine（ ）定义并由*DataSet（ ）调用。 

定义一个数组 

（1）打开文本编辑器，新建一个 MDL。 
（2）创建*DefineDataset（ ）和*EndDefine（ ）语句。为了完成数组的定义和初始化，还需要

在这两条语句之间填入其他内容。 
（3）在这一步的练习中，需要在数组中定义的数据包括计算开始时间、 时间中点、计

算终止时间和扭矩大小。 
上述数据均为实数型数据，因此在数组语句中，需要使用*Real（ ）引导。每定义一个数

据，需要新建一条*Real（ ）语句。当然，用户也可以根据需要，定义其他类型的数组数据，如

整数型数据、字符串等。 
完成定义的数组需要使用*Dataset（ ）语句进行实例化。*Dataset（ ）语句的基本格式如下： 

*DataSet（ds_name， "ds_label"， ds_def， [optional arguments]） 
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其中，ds_name 是数组变量名，ds_label 是该数组标题，ds_def 是已有数组的变量名。 
（4）在工作文件夹下，保存该数组文件名为 dataset.mdl。定义完成的 MDL 模型应如下

所示： 

*DefineDataSet（ds_def_force） 
*Real（start_time， "Starting Time"） 
*Real（mid_point， "Mid Point"） 
*Real（end_time， "End Time"） 
*Real（force_magnitude， "Force Magnitude"） 
*EndDefine（ ） 

在分析模型中调用数组文件 

（1）在文本编辑器中打开 5.5.3 节中创建的 analysis.mdl 模型，在*DefineAnalysis（ ）语句

前使用*Include（ ）调用数据集，调用方法如下： 

*Include（"dataset.mdl"） 

（2）选择合适的变量名和标题完成模型实例化。 

*DataSet（ds_force， "Force Data"， ds_def_force） 

（3）通过*SetReal（ ）关键字，为数组成员指定初始值。*SetReal（ ）关键字语法如下所示： 

*SetReal（real_name， real_value） 

其中，real_name 为变量名，real_value 为变量值。 
这里，实际的变量名应填写为 Dataset def_var.real_name  
如果对计算开始时间这一变量赋值，那么赋值语句应填写为 

*SetReal（ds_name.begin_time， 0.3） 

（4）使用类似的方法，完成数组中其他数据的赋值，并完成数组实例化，如下所示： 

*DataSet（ds_force， "Force Data"， ds_def_force） 
*SetReal（ds_force.start_time， 0.3） 
*SetReal（ds_force.mid_point， 0.31） 
*SetReal（ds_force.end_time， 0.32） 
*SetReal（ds_force.force_magnitude， 10） 

（5）在此前完成的模型中，可以查看到*SetForce（ ）已经按以下内容进行定义： 

*SetForce（force_1， 'step（TIME， 0.3， 0， 0.31， 10） + step（TIME， 0.31， 0， 0.32， -10）'，0，0） 

（6）在文本编辑器中，将*SetForce（ ）内容改写为以下形式： 

*SetForce（force_1， 'step（TIME， {ds_force.start_time.value}，0，{ds_force.mid_point.value}， {ds_force.force_ 
magnitude.value}）+step（TIME，{ds_force.mid_point.value}，0，ds_force.end_time.value），-{ds_force. 
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force_magnitude.value}）'，0，0） 

表达式中大括号“{}”中的内容将传递给 MotionViewTemplex 进行估值。 
（7）在工作文件夹下，保存该数组文件名为 analysis_new.mdl。定义完成的 mdl 文件应

如下所示： 

*Include（"dataset.mdl"） 
*DefineAnalysis（ def_ana_0，j_att ） 
*Attachment（ j_att， "Joint"， Joint， "" ） 
*ActionReactionForce（ force_1， "Force Label"， ROT， j_att.b1， j_att.b2， j_att.i.origin， Global_Frame） 
*Output（o_force，"ForceOutput"，FORCE，force_1，Global_Frame， BOTH_MARKERS ） 
*DataSet（ds_force， "Force Data"， ds_def_force） 
*SetReal（ds_force.start_time， 0.3） 
*SetReal（ds_force.mid_point， 0.31） 
*SetReal（ds_force.end_time， 0.32） 
*SetReal（ds_force.force_magnitude， 10） 
*SetForce（force_1， 'step（TIME， {ds_force.start_time.value}， 0， {ds_force.mid_point.value}， {ds_force. 
force_magnitude.value}） + step（TIME， {ds_force.mid_point.value}， 0， {ds_force.end_time.value}， -{ds_ 
force.force_magnitude.value}）'，0，0） 
*EndDefine（ ） 

创建模型文件 

（1）启动 MotionView，并打开 5.5.2 节创建的（或

目录 chap05 中的）triplependulum.mdl 文件。 
（2）在工具栏中单击 System/Assembly 按钮 。 
（3）在 System/Assembly 面板中激活 Import/Export

选项，单击“文件浏览”按钮 ，选择上述定义的分析

模型文件 analysis_new.mdl。 
（4）单击 Import 按钮。 
（5）在弹出的 Specify entity details 对话框中选择模

型类型 Analysis，如图 5-39 所示。 
（6）单击 OK 按钮，载入分析模型。 
（7）在项目浏览树选择新载入的分析模型，在面板

位置的 Attachments 标签中单击 Joint 按钮，并在图形区选择任一旋转副，如图 5-40 所示。 

 
图 5-40  System/Assembly 面板（Attachments 标签） 

 

图 5-39  Specify entity details 对话框 
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（8）在项目浏览树中右击 Analysis 0，并选择 Activate。 
（9）打开 Analysis 0 下的 Dataset Sets（1），单击 Force Data。 
（10）在主面板区域的 Dataset 面板中，修改 Force Magmotide 为 20，如图 5-41 所示。 

 
图 5-41  Dataset 面板 

（11）选择 File→Save as→model 命令，将模型保存为 new_dataset_triplependulum.mdl。 
（12）在工具栏中单击 Run 按钮 ，进入 Run 面板。 
（13）保存文件为 new_dataset_triplependulum.xml 并使用默认参数求解模型。 
（14）求解结束后，单击 Animate 按钮查看三摆系统运动历程，单击 Plot 按钮查看指定

的结果输出，如图 5-42 所示。 

 

图 5-42  三摆模型及分析结果 

5. 5.5  应用向导创建模型与分析工况 

本练习将学习以下内容： 
●  如何使用预定义向导快速创建前悬架模型及分析工况。 
●  如何自定义向导快速创建飞机起落架模型及分析工况。 

1.应用预定义向导创建模型及分析工况 

应用模型装配向导创建汽车前悬架模型 

（1）打开 MotionView，新建一个会话。 

 STEP 

01 
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（2）在 Model 菜单中单击 Assembly Wizard。 
（3）在 Model type 处选择 Front end of vehicle，单击 Next 按钮。 
（4）在 Drive type 处选择 No driveline，单击 Next 按钮。 
（5）在 Primary Systems for Front end of vehicle 页面，设置以下选项： 

- Vehicle body = Body fixed to ground 
- Front subframe = None 
- Front suspension = Front SLA susp （1 pc. LCA） 
- Steering linkage  =Rackpin steering 
- Powertrain = None 

（6）单击 Next 按钮。 
（7）在 Select steering subsystems 页面中设置以下选项： 

- Steering Column = Steering column 1 （not for abaqus） 
- Steering Boost = None 

（8）单击 Next 按钮。 
（9）在 Select springs， dampers and stabilizer bars 页面中设置以下选项： 

- Front shocks  =Frnt shock absorber （with inline jts）  
- Front stabilizer bars = None 

（10）单击 Next 按钮。 
（11）在 Select jounce and rebound bumpers 页面中选择 None，单击 Next 按钮。 
（12）将 Attachment Wizard 的 Compliant 选项设置为 No，单击 Finish 按钮。 
单击 Finish 按钮之前，可以单击 Next 按钮，修改每个子系统连接信息。装配后的模型

如图 5-43 所示。 

 

图 5-43  汽车前悬架模型 
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使用分析工况向导创建平顺性分析工况 

（1）进入 Analysis 菜单，选择 Task Wizard 命令。 
（2）在 Task Wizards – Front end tasks 页面中选择 Static Ride Analysis 作为 Front end task 
（3）单击 Next 按钮。 
（4）单击 Finish 按钮，弹出 Task Wizard 对话框，这里可以修改轴距、车身重量、轮心

跳动距离等参数，如图 5-44 所示。 

 

图 5-44  Task Wizard 对话框 

（5）使用默认参数，单击 Finish 按钮。 
（6）进入项目浏览树，此时项目树中新增一个名为 Static ride analysis 的文件夹。

在 MotionView 中，可为模型建立若干不同的工况，但一次只能有一个分析工况处于激

活状态。 
（7）单击 Static ride analysis 文件夹前的“+”，查看分析工况中的对象。 
（8）单击 Forms 文件夹，进入表格面板。该面板参数与第 4 步对话框参数相同，可进行

修改。 

保存并求解模型 

（1）单击标准工具栏中的 Save Model 按钮 。 
（2）选择文件保存的路径，以 sla_rigid.mdl 文件名保存模型。 
（3）单击 按钮进入 Run 面板。 
（4）在 main 标签中单击“文件浏览”按钮 ，选择工作路径，保存 MotionSolve 输入

文件为 sla_rigid.xml。 
（5）确认求解类型为 Quasi-Static，其他选项保持不变。 
（6）单击 Run 按钮，求解模型。 
（7）求解结束后，单击 Animate 按钮查看机构运动过程，单击 Plot 按钮查看数据结果，

如图 5-45 所示。 

 STEP 

03 

 STEP 

02 
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图 5-45  前悬架平顺性分析 

查看预定义结果 

MotionView 向导中包括报告模板，模型计算完毕后，该模板将根据分析类型自动调用

求解结果，形成结果报告。本步骤将描述如何查看汽车前悬架平顺性分析标准报告。 
（1）从 Analysis 菜单中单击 View Reports。 
（2）Reports 对话框中列出了包含在.reports 日志文件中的所有报告。这里选择上述分析

的 Front Ride-MSolve SDF based Report Model。 
（3）在 Mode 处激活 Append 选项。 
（4）在 Overlay options 处选择 Auto fit plots。 
（5）单击 OK 按钮。 
此时，MotionView 将自动创建结果报告。报告中都是悬架设计时需要关注的参数

曲线。 

2.应用自定义向导创建模型及分析工况 

练习开始前，复制 chap05 目录下的 landing_gear 文件到工作文件夹中。 

编辑向导 

通过 Model 菜单下的 Set Wizard Paths 选项可对向导属性进行编辑。下述步骤将描述如

何编辑向导并使用新向导创建模型。 
（1）在 Model 菜单中选择 Set Wizard Paths 命令。 
（2）在弹出的 Set Wizard Path 对话框中取消 Use values from preference file 选项的选择，

如图 5-46 所示。 
（3）在 Assembly Wizard file（装配向导）文本框中选择<working directory>\landing_gear\ 

model_wizard_landing_gear。 

 STEP 

04 

 STEP 

01 
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图 5-46  Set Wizard Path 对话框 

（4）在 Task Wizard file（分析工况向导）文本框中选择<working directory>\landing_gear\ 
task_ wizard_landing_gear。 

（5）在 Wizard Library directory（向导库文件）文本框中选择<working directory>\ 
landing_gear\mdllibs。 

（6）单击 OK 按钮，完成编辑。 

创建模型 

（1）选择 Model 菜单下的 Assembly Wizard 命令。 
（2）使用默认参数创建飞机起落架模型。 
（3）选择 Analysis 菜单下的 Task Wizard 命令。 
（4）设置分析工况为 Retraction Analysis。 
（5）选择文件保存的路径，以 Landing_Gear.mdl 文件名保存模型。 
（6）单击 按钮进入 Run 面板，设置仿真时间为 1.3s，使用 MotionSolve 求解模型。 
（7）求解完毕后，单击 Animate 按钮查看机构运动过程，单击 Plot 按钮查看数据结果，

如图 5-47 所示。 

 

图 5-47  飞机起落架运动过程分析 

 STEP 

02 
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注：在 MotionView 的首选项文件 preferences_mbd.mvw（该文件位于<Installation 
directory> \hw\prefinc）中可以设置向导启动的默认路径。在 Set Wizard Path 对话框中激活

Use values from preference file 选项即可回到默认设置。默认的模型库支持 MotionSolve、
ADAMS、Abaqus 求解器。 

5.6  小结 
MotionView 模型定义语言（MDL）是构成 MotionView 模型的基础。它是一种 ASCII 格

式的文本文件，其功能强大、语法简单、易学易用。另外，作为一款通用多体系统前处理软

件，根据 MDL 创建的 MotionView 模型可以转换为多种求解器输入文件，如 MotionSolve
的.xml 文件、Adams 的.adm 和.acf 文件等。限于篇幅，本章仅对 MDL 的基本功能（如创建

模型、子系统、分析工况、数据库）进行了介绍，对 MDL 高级应用——模型向导作了简要

的描述，相信读者学习完本章后，能够对 MDL 有大致的了解，如在实际工作过程中加以应

用，将大大提高建模效率。 
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第 6章     

 仿真结果后处理 

本章主要介绍后处理器 HyperView/HyperGraph 的使用方法，包括仿真结果动画的查看与保

存、仿真结果曲线图的绘制及处理、报告模板的定制及结果演示等内容，最后通过实例介绍

HyperView/HyperGraph 的具体用法。通过本章的学习，可以深入了解 HyperView/HyperGraph 的

功能，能够结合实际需求灵活地进行仿真计算结果的观察和分析。 

本章重点知识 
 
 

6.1  仿真动画处理方法 

6.2  动画结果后处理 

6.3  数据结果后处理 

6.4  演示与报告 

6.5  实例 

6.6  小结 
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6.1  仿真动画处理方法 

MotionSolve 为用户提供了丰富的结果输出，应用 HyperWorks 强大的后处理工具可以以

二维曲线、三维曲线以及动画的形式查看这些结果，如图 6-1 所示。结果可视化功能在模型

的整个设计周期中都发挥着重要的作用，其主要有以下用途： 

  

  

图 6-1  多体系统仿真结果示例 

（1）模型调试，快速捕捉机构的物理现象。 
应用 HyperView，用户可选择最佳的视角查看模型的运动，以确定是否满足预期运动趋

势，从而有助于进行模型调试。 
（2）试验验证，快速检测设计方案中的不足。 
应用 HyperGraph，可将 MotionSolve 仿真结果以坐标曲线图的形式表达出来，然后将其

与测试数据绘制于同一坐标曲线图中进行对比及数学处理，即可快速验证模型的有效性以及

设计方案的合理性。另外，HyperView 提供的动画同步功能，可实现仿真动画与试验动画的

同步播放，将更加直观地验证仿真模型的可靠性。 
（3）设计改进，快速获得最优设计方案。 
应用 HyperView，可在同一界面加载多组设计方案仿真结果，便于方案对比与改进。同

时，通过干涉检验可对机构外形设计提供帮助。 
（4）结果显示，快速创建演示报告。 
应用 HyperView/HyperGraph 可显示 MotionSolve 分析获得的各种仿真结果。为增强结果



第 6 章 
仿真结果后处理 

 197 

可读性，对于动画结果，可加载云图、显示载荷及数值以及改变模型的显示属性等；对于曲

线结果，可在图中增加标题和注释、修改曲线及坐标显示属性，并且以图表的形式表达结果

等。这些结果可以单独输出，也可以根据模板自动输出并创建演示报告。 

6. 1.1  动画结果 

通过仿真结果动画不但可以快速检查模型中存在的问题，还可以创建漂亮的演示报告与

他人交流。根据仿真类型的不同，MotionSolve 将输出 MAF-MRF 和 H3D 两种动画文件。其

中，MDL-MRF 联合文件用于模拟线性分析的模态动画结果。MDL 文件提供图形信息，

MRF 提供结果信息。MotionSolve 为每个模态振型创建一个 MRF 文件。在将来的版本中，

线性分析结果也使用 H3D 格式文件。H3D 文件同时包含模型与仿真结果信息，可用于描述

静态、准静态以及瞬态分析动画结果。此外，通过 HyperView 还可以查看 H3D 文件的其他

结果信息，如刚体模型或刚柔耦合模型中的约束力与力矩

结果，刚柔耦合模型中的应力云图、向量图及张量图等。 
（1）约束力与力矩结果显示。 
如果在 MotionSolve 求解模型中定义了 MARKER_ 

FORCE 输出，H3D 文件中将包含可显示出图 6-2 所示的

约束力或力矩动态结果的信息。 
（2）云图结果显示。 
对于刚柔耦合模型，应用 HyperView 的云图工具，

可以显示柔性体结构在机构运动过程中的位移、应力以及

应变等云图，如图 6-3 所示。其中，应力、应变云图的显

示需要在柔性体创建时指定应力、应变结果输出。 

 
图 6-3  汽车前悬架下控制臂应力云图 

（3）向量图显示。 
对于刚柔耦合模型，应用 HyperView 的向量图工具，可以显示柔性体结构在机构运动过

程中的位移、速度、加速度、力以及转矩结果向量图。 
（4）张量图显示。 
对于刚柔耦合模型，HyperView 还支持应力、应变结果的张量图显示。汽车前悬架下控

制臂应力张量图，如图 6-4 所示。 

 

图 6-2  约束力与力矩结果显示 
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图 6-4  汽车前悬架下控制臂应力张量图 

6. 1.2  数据结果 

结果曲线在研究多体系统性能以及后续的工程计算（如信号滤波处理）时非常有用。在

多体系统求解过程中，MotionSolve 将输出以下 3 种用于绘制曲线的数据文件。 
●  ABF（Altair Binary Format）：一种优化的、适合大规模数据进行快速曲线绘制的二进

制文件（推荐格式）。 
●  MRF（Multibody Results File）：一种主要为后处理模块提供构件位移数据并创建

H3D 文件的二进制文件。该文件可用来绘制曲线，但效率比 ABF 文件低。 
●  Plot File（PLT）：一种主要用在耐久性分析时 MotionSolve 与 FEA 软件（NASTRAN

和 OptiStruct）之间载荷数据转换的 ASCII 文件。 
在默认情况下，MRF 和 ABF 文件包含的信息如表 6-1 所示。 

表 6-1  MRF 和 ABF 文件中的信息输出 

类    型 输 出 信 息 相 关 描 述 

X， Y， Z 构件在全局坐标系下的坐标位置 

PSI， THETA， PHI or YAW， PITCH， ROLL 由欧拉角（B313）或 YAW、PITCH、ROLL 角表示的惯性主轴的指

向。两种表示方式由 ResOutput 命令中的 ANGLE_TYPE 属性控制 

VM， VX， VY， VZ 构件在全局坐标系下的运动速度，包括速度在 3 个坐标轴方向的分量

以及合值结果 

WM， WX， WY， WZ 构件相对惯性主轴的角速度，包括角速度在 3 个坐标轴方向的分量以

及合值结果 

ACCM， ACCX， ACCY， ACCZ 构件在全局坐标系下的运动加速度，包括加速度在 3 个坐标轴方向的

分量以及合值结果 

WDTM， WDTX， WDTY， WDTZ 构件相对惯性主轴的角加速度，包括角加速度在 3 个坐标轴方向的分

量以及合值结果 

刚性体 

KE 构件动能 

刚体系统中所有结果   

Q/i， i = 1， 2， …， n 模态参与因子 

QD/i， i = 1， 2， …， n 模态速度 
柔性体 

QDD/i， i = 1， 2， …， n 模态加速度 

KE 系统动能 

CPU Usage CPU 使用时间 

CPU/Sim. Time Ratio CPU 使用时间与仿真时间之间的比值 

Stepsize 积分运算的实际步长 

系统 

Integration Order 积分运算时积分器的阶数 
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此外，用户可以使用 Post_Request 功能定义更多的结果输出。用户自定义的结果输出将

分别写入 ABF、MRF 和 PLT 文件中。Post_Request 的定义可通过以下任一种方式： 
●  使用软件内置的、常用的结果输出，如位移、速度、加速度以及作用在体和铰链上

的载荷。 
●  使用 MotionSolve 表达式，如 DM（1， 2）将返回编号为 1 和 2 的标记点之间的距离。 
●  使用 C/C++ 或 Fortran 编写的用户自定义程序。 
使用 HyperGraph 加载上述文件后，文件中的数据将自动分为 Type（类型）、Request（输

出请求）和 Component（分量）三组。有效的类型包括 Displacement、Velocity、Acceleration、
Force 和 User-Defined 五种。每种类型的数据可有若干个输出请求，如表 6-2 所示。选定某个

输出请求后，该项目所有可用的分量将显示在 Component 列，如图 6-5 所示。 

表 6-2  各个类型输出请求的预定义分量 

类     型 分     量 相 关 描 述 

DM、DX、DY、DZ 位移合值及 X、Y、Z 轴分量 
Marker Displacement 

E0、E1、E2、E3 欧拉参数方向 

 PSI 、 THETA 、 PHI 或

YAW、PITCH、ROLL 
由欧拉角（B313）或 YAW、PITCH、ROLL 角表示的惯性主轴的

指向。两种表示方式由 ResOutput 命令中的 ANGLE_TYPE 属性控制 

VM、VX、VY、VZ 速度合值及 X、Y、Z 轴分量 
Marker Velocity 

WM、WX、WY、WZ 构件相对惯性主轴的角速度合值及 X、Y、Z 轴分量 

ACCM 、 ACCX 、 ACCY 、
ACCZ 加速度合值及 X、Y、Z 轴分量 

Marker Acceleration 
WDTM、WDTX、WDTY、

WDTZ 构件相对惯性主轴的角加速度合值及 X、Y、Z 轴分量 

FM、FX、FY、FZ 力合值及 X、Y、Z 轴分量 
Marker Force 

TM、TX、TY、TZ 力矩合值及 X、Y、Z 轴分量 

Expressions F1、F2、…、F8 
表达式估值，如果 F2、F3、F4 是某一结果输出的 3 个分量，则 F1

是这个 3 个分量的合值。类似地，如果 F6、F7、F8 是某一结果输出

的 3 个分量，则 F5 是这 3 个分量的合值 

 
图 6-5  曲线结果数据构成 



MotionView & MotionSolve 
应用技巧与实例分析 

 200 

图 6-6 显示了 HyperGraph 2D 创建的二维曲线以及对曲线的后处理结果，这其中包括显

示曲线数据的注释、使用多重坐标轴比对不同尺度的曲线以及棒状图等。 

 

图 6-6  HyperGraph 2D 曲线图与棒状图 

图 6-7 显示了 HyperGraph 3D 创建的三维曲线图，界面中左侧窗口显示的三维曲线是

由数学表达式（6-1）创建的，右侧窗口显示的是机器振动响应瀑布图。 

（ ） （ ）2 2 2 21sin 1 / 25 50 50， 50 50
2 100

xz x y x y x y⎡ ⎤= + + + − < < − < <⎢ ⎥⎣ ⎦
     （6-1） 

 

图 6-7  HyperGraph 3D 三维曲线图 
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6.2  动画结果后处理 

这一节将介绍如何使用 HyperWorks 后处理平台 HyperView 进行动画结果后处理与视图

控制的基本功能，主要包含动画播放、视图控制、对象隐藏等内容。 

6. 2.1  动画类型 

HyperView 可以加载时域和频域动画两种类型的动画。 
（1）时域动画。 
进行机械系统瞬态分析时，MotionSolve 将对仿真过程中的每一个输出步创建一个动

画。画面随输出时间步长而依次生成，称为时域动画。例如，如果在 0.0～5.0s 的时间内完

成仿真，以每 0.01s 作为输出步长，则 MotionSolve 将记录 501 步或帧的数据，它在 5s 中的

每 0.01s 创建一帧动画。 
（2）频域动画。 
进行机械系统线性模态分析时，MotionSolve 在指定工作点对系统进行线性化，并计算

特征值和特征向量。HyperView 利用这些信息来显示通过特征解预测的动画变形形状。通过

在正的最大变形量和负的最大变形量之间进行插值，来生成一系列动画，循环显示柔性体的

变形过程。该动画与频域参数有关，称为频域动画。 
另外，HyerView 还可以查看柔性体的固有频率及其振型。 

6. 2.2  结果载入 

HyperView 开放的架构可读入和查看多种求解器（如 MotionSolve、ADAMS、ABAQUS
等）的结果文件。本节将演示如何进入 Load model and results 面板载入结果文件。 

通过以下任一种方式可进入 Load model and results 面板： 
●  单击标准工具栏中的 Open Model 按钮 。 
●  单击标准工具栏中的 Open Results 按钮 。 
●  从 File 菜单中选择 Open→Model 命令。 
●  从 File 菜单中选择 Import→Model 命令。 
●  从 File 菜单中选择 Load→Results 命令。 
应用 Load Model 面板可载入模型文件及结果文件，如图 6-8 所示。如果结果文件中已

包含模型信息，模型文件就不必载入。例如，瞬态分析中获得的 H3D 结果文件既包含结果

信息又包含模型信息，查看结果时只需载入 H3D 结果文件，而线性模态分析则需要同时载

入模型文件 MAF 及结果文件 MRF。如果仅载入结果文件，则模型中构件的名称、颜色等定

义将不再保留，求解器将为其指定默认属性。用户可以选择仅载入模型文件、结果文件或两

者同时载入。 
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图 6-8  Load model and results 面板 

除了模型载入选项，Load model and results 面板中还包含 Overlay、Result-Math template
和 Reader 选项。激活 Overlay 选项，可在一个窗口中载入多个模型及其结果文件。如图 6-9
所示，用户可在 Result Brouser 中的模型列表中选择当前窗口中活动的模型。 

             

图 6-9  指定当前窗口活动模型 

单击 Results Browser 中的“文件视图”按钮 ，将在 Results Browser 上端加入一个文

件列表，列表中粗体显示的文件路径表示当前窗口中活动的模型，在某个文件路径处右击选

择 Make Current 命令也可设置当前窗口中活动的模型，如图 6-10 所示。 

 

图 6-10  文件列表 

设置当前窗口活动模型 
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Result-Math template 选项用于选择载入 Derived Result 面板的模板，这里有 Standard、
Advanced、NVH、Composite 或 None 五种模板。应用 Derived Result 面板可根据已有结果

（如应力、应变、位移等）导出新的结果。单击 Reader Options 按钮将弹出 Reader Options 对
话框，用于设置不同结果读入接口的信息读入选项，如图 6-11 所示。 

 

图 6-11  Reader Options 对话框 

6. 2.3  动画控制 

HyperWorks Desktop 提供了多种模型动画控制功能，本节将介绍 Animation 工具栏以及

Results Browser 的基本用法。 

1. 动画控制 

Animation 工具栏用于查看模型的动画以及设置动画播放参数，如图 6-12 所示。该工具

栏可通过选择 View→Toolbars→HyperWorks→Animation 命令进入。 

 

图 6-12  Animation 工具栏 

Animation 工具栏中的第一个按钮 用于指定动画类

型，这里支持 Transient、Modal 和 Linear 三种动画类型，

如图 6-13 所示。Transient 指瞬态动画，用于描述结构的

瞬态响应，在多体分析中用于显示机构在每个时刻的位置

变化。Linear 指线性结果动画，创建和显示结构在初始位

置到最大变形位置的变化过程，主要用于查看线性静力分

析结果。Modal 指模态振型动画，根据正弦函数创建和显

示结构在某阶频率下的振动情况，主要用于查看模态分析

结果。 

 

图 6-13  动画类型 
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表 6-3 给出了使用 MotionSolve 和 ADAMS 求解器获得的用于动画显示的结果文件

类型。 

表 6-3  MotionSolve 和 ADAMS 动画结果文件类型 

动 画 类 型 模 型 构 成 求  解  器 模 型 文 件 结 果 文 件 

MotionSolve H3D H3D 
刚体模型 

ADAMS GRA GRA 

MotionSolve H3D H3D 
瞬态 

刚柔耦合模型 
ADAMS FLX FLX 

MotionSolve MAF MRF 
刚体模型 

ADAMS GRA RES 

MotionSolve MAF MRF 
模态 

刚柔耦合模型 
ADAMS FLX FLX 

Animation 工具栏中的其余 5 个按钮用于控制动画的播放、停止以及播放方式。 
●  First Time/Angle/Step ：返回初始时刻/角度/步。 
●  Previous Time/Angle/Step ：回到上一时刻/角度/步。 
●  Start/Pause Animation ：开始/停止。 
●  Next Time/Angle/Step ：进入下一时刻/角度/步。 
●  Last Time/Angle/Step ：到达终止时刻/角度/步。 
接下来是两个滚动条，上滚动条显示动画当前时刻，拖动滚动条，可以控制动画播放的

时刻。下滚动条控制动画播放的速度，向左拖动滚动条，慢放动画；向右拖动滚动条，快进

动画。单击最后一个按钮 将弹出动画控制面板，如图 6-14 所示。该面板可以控制动画播

放的时刻、播放的时间范围、播放帧频以及帧频数。 

 

图 6-14  Animation Controls 面板 

2. 设定工况 

通过 HyperWorks Desktop 左侧的 Results Browser 不但可以查看当前模型的构成，还可

以对模型中的对象进行搜索、显示、编辑等操作。此外还可以设置分析结果当前的活动工况

以及当前时刻/角度/步，如图 6-15 所示。 
单击 Results Browser 中的 Load Case View 按钮 可以查看当前结果中的工况及仿真步信

息，活动的工况及仿真步将以黑体的形式显示出来。选择列表中的任一工况或仿真步，右击

并选择 Make Current 将该工况设置为当前活动工况或仿真步，如图 6-16 所示。 
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图 6-15  指定当前活动工况 

 

图 6-16  Load Case View 

6. 2.4  截面图 

本节介绍 Display 工具栏中的 Section Cut 工具。该工具可在模型内部创建平面或变

形的截面，帮助用户更好地查看模型的内部细节。单击 Section Cut 按钮 ，进入 Section 
Cut 面板，如图 6-17 所示。 

 

图 6-17  Section Cut 面板 

 设置当前活动工况 

  设置当前时刻/角度/步 
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面板左侧的截面列表列出了当前模型使用的所有截面，单击 Add 按钮和 Delete 按钮可

以新建或删除截面。条目前的复选框控制该截面的显示或隐藏。在截面列表区域，使用

<Shift>（或<Ctrl>）键和鼠标左键可以选取多个条目，使用<Ctrl+A>键可以全选列表中的

条目，使用<Delete>键可以删除所选条目。对于变形截面，截面呈平面的时刻将显示在

Time 栏中。此外，在列表区域右击可以弹出与截面列表相关的选项，如图 6-18 所示。各选

项的功能如下。 
●  Delete：删除所选截面。 
●  Rename：弹出 Rename 窗口，为截面重新命名。 
●  Show/Hide：显示或隐藏所选截面。 
●  Show Manipulator：显示/隐藏所选截面图形控制工具。 
Define Plane 用于定义截面的位置，这里支持根据全局坐标系 X、Y、Z 轴，指定向量，3

个节点或垂直屏幕的方式创建截面。Base 用于指定截面的位置，可以使用节点编号，也可以

输入点坐标的方式定义基点。Deform mode 用于定义截面是否变形，变形截面可随着零件的

运动而运动，当选择变形模式为 Deformable 时，创建变形截面的时刻将填入截面列表的

Time 栏中。 
Display options 控制了截面的显示状态，其中 Cross section 单选按钮定义截面的宽度，

当拖动滚动条到最右端时，将显示由截面截取的另一半模型，产生与 Clipping plane 功能相

同的效果。Clip element 复选框控制是否截取单元，形成光滑的截面。Section color 复选框用

于定义截面的颜色。Reverse 用于显示截面截取的另一半模型。Gridline 可以控制截面的显示

状态。另外，对于被截面截去的模型，可以通过 Features 和 Transparent 复选框控制以特征线

或透明的方式显示，如图 6-19 所示。 

         

         图 6-18  列表区快捷菜单                      图 6-19  截面视图 

6. 2.5  爆炸视图 

本节介绍 Visualization 工具栏中的 Exploded View 工具的基本功能，应用该工具可以创

建模型的爆炸视图，帮助用户查看每个零件的运动状态。使用爆炸视图工具获得的模型可继

续其他后处理操作，多个爆炸视图可保存为 MVW 格式的会话文件，供演示或技术交流。单
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击 Exploded View 按钮 ，可进入 Exploded View 面板，如图 6-20 所示。 

 

图 6-20  Exploded View 面板 

面板左侧的列表列出了当前模型定义爆炸视图，单击 Add 和 Delete 按钮可以新建或删

除爆炸视图。条目前的单选按钮控制当前图形区显示的爆炸视图。在列表区域，使用

<Shift>（或<Ctrl>）键和鼠标左键可以选取多个条目，使用<Ctrl+A>键可以全选列表中的

条目，使用<Delete>键可以删除所选条目。 
Selection 选项用于定义包含在爆炸视图中的零件。Mode 决定了爆炸视图的模式。其

中，Explode from model center 和 Explode from selection center 控制爆炸中心，Translate 只是

平移模型，模型相对没有位置变化。该选项可用于对比同一产品的不同设计方案。图 6-21
显示了不同方案下的气囊打开过程对比。这里使用了 Load model and results 面板的 Overlay
选项，读入了两个方案下的结果文件。 

 

图 6-21  同一窗口模型对比 

6.3  数据结果后处理 

在本节中将介绍 HyperWorks 中的数据后处理模块 HyperGraph 的基本功能。HyperGraph
是一款功能强大的数据处理及绘图工具，支持多种主流的数据格式。HyperGraph 良好的用户

界面、强大的流程自动化技术，为设计、测试和分析人员提供了一套完整的数据处理解决方

案，极大地提高了工程师的工作效率。 
数据结果后处理分为两个阶段，一是分析结果可视化，二是仿真数据与试验数据对比。

本节介绍 HyperGraph 曲线绘制、数据对比以及数据后处理的基本方法。 
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6. 3.1  坐标曲线图绘制 

在 HyperGraph 中，曲线绘制是通过 Build Plots 面板完成的。该面板允许用户提取并显

示来自单个数据文件的多条曲线，提取的数据可以同时显示在一个窗口中，也可以单独在每

个窗口中显示。本节将演示如何进入 Build Plots 面板、如何进行数据提取并在单个窗口同时

显示或在多个窗口单独显示。 
通过以下任一种方式可进入 Build Plots 面板（见图 6-22）： 
●  在 Curves 工具栏中，单击 Build Plots 按钮 。 
●  在下拉菜单中，选择 Curves→Build Plots。 

 
图 6-22  Build Plots 面板 

HyperGraph 支持多种数据格式，如 ADAMS 、 ABAQUS 、 DAD 、 GENESIS 、

HyperWorks、MADYMO、NASTRAN、DYNA、PAMCRASH 以及通用数据格式（包括

CSV、ASCII 及 XYDATA 等）。 
数据文件顺利读取后，Bulid Plots 面板将尝试自动匹配这些数据。二维曲线绘制时需要

分别为 X 及 Y 轴定义 Type（数据类型）、Request（输出请求）及 Component（分量）。在 Y 
Request 以及 Y Component 中可以选取多项，从而实现批量绘制多条曲线。图 6-23 给出了在

一个窗口中同时绘制多条曲线的操作方法。在该示例中，X Type 设置为时间（Time），Y 
Type 设置为力（Force）。在 Y Request 中，选择多个对象，分别是 REQ1/ Curve 1，REQ/3 
Curve 3，以及 REQ/4 Curve 4）。在 Y Component 中选择 X。 

 
图 6-23  一个窗口同时绘制多条曲线 
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用户也可以选择在多个窗口中独立绘制各条曲线。这一功能是通过 Build Plots 面板左下

角的 Layout 下拉列表来实现的。Layout 下拉列表中各选项的功能如下。 
●  Use Current Plot：将所有新建曲线均放在当前活动窗口中。 
●  One Plot Per Request：为每一输出请求创建一个窗口，与输出请求相关的分量叠加在

同一窗口中。 
●  One Plot Per Component：为每一分量创建一个窗口，与分量相关的输出请求叠加在

同一窗口中。 
●  One Curve Per Plot：所有曲线均单独显示。 
如果用户选取了除 Use Current Plot 以外任意一个功能，那么在每次新建曲线后，窗口布

局功能 均会处于激活状态，该功能可以控制曲线创建的位置。例如，所有曲线的 Y 
Request 都一致，在 Y Component 中，选择 X、Y 以及 Z，并在 Layout 下拉列表中选择 One 
Plot Per Request，视图区域如图 6-24 所示。 

 

图 6-24  多个窗口同时绘制多条曲线 

6. 3.2  曲线数据评估与参考 

在 HyperGraph 中，除了简单的曲线绘制功能外，还支持根据已有曲线使用内置函数

或用户自定义函数新建曲线的功能，这些功能是通过 Define Curves 面板来实现的，如图 6-25
所示。 

用户可以通过以下任一种方式进入 Define Curves 面板： 
●  在 Curves 工具栏中，单击 Define Curves 按钮 。 
●  从下拉菜单中选择 Curves→Define Curves 命令。 
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图 6-25  Define Curves 面板（Source 为 File） 

在该面板下，可以对已有的曲线数据进行编辑，也可以在当前窗口新建曲线。新建曲线

时，单击 Add 按钮，然后为新曲线的 X 轴和 Y 轴指定数据，这里数据源（Source）包括

File、Math 和 Values 三种类型。 
如果选择 File，即通过选取数据文件的形式提取曲线，那么需要为曲线定义 Type、

Request 以及 Component，这与 Build Plots 的功能是类似的。 
如果选择 Values，则需要手工逐栏输入数据，如图 6-26 所示。如果需要输入的数据较

多，可以通过面板弹出按钮 ，增加表格长度，以完成所有数据的录入。 

 

图 6-26  Define Curves 面板（Source 为 Values） 

如果选择为 Math，那么将进入表达式编辑面板，如图 6-27 所示。该面板拥有丰富的数

学工具和函数，可以帮助用户快速创建所需曲线。 

 

图 6-27  Define Curves 面板（Source 为 Math） 

使用表达式编辑器创建曲线时，需要提供曲线向量。X 轴和 Y 轴可以参考会话中的任一

条曲线的向量。在 HyperGraph 中，曲线向量由页面、窗口、曲线名称以及 x 或 y 坐标值确

定。例如，p2w3c4.x 表示参考页面 2 窗口 3 曲线 4 的 x 轴数据。 
指定曲线参考向量可通过以下两种方式： 
（1）从当前窗口中选择曲线。 
●  X 轴：按住<Shift>键并单击曲线获得该曲线的 x 向量参考。 

按住<Shift+Ctrl>键并单击曲线获得该曲线的 y 向量参考。 
●  Y 轴：按住<Shift>键并单击曲线获得该曲线的 y 向量参考。 

按住<Shift+Ctrl>键并单击曲线获得该曲线的 x 向量参考。 
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（2）通过 Define Curves 面板上的 Curves 文本框选取。 
接下来，给出使用 Math 创建曲线的示例。图 6-28 左侧窗口中的曲线由数据文件创建，

右侧曲线则是左侧曲线的导数曲线。注意，右侧曲线创建时参考的曲线向量为 p4w1c1.x 和

p4w1c1.y，p4w1c1 表示 HyperGraph 页面 4 窗口 1 编号为 1 的曲线。 

 

图 6-28  参考曲线向量创建曲线 

Coordinate Info 面板允许用户提取并查看当前活动窗口中曲线的数据点。单击曲线，面

板将高亮显示单击处数据点的信息。Coordinate Info 面板如图 6-29 所示，可通过以下任一种

方式进入： 
●  在 Curves 工具栏中，单击 Coordinate Info 按钮 。 
●  在下拉菜单中，选择 Curves→Coordinate Info 命令。 

 

 

图 6-29  Coordinate Info 面板 

HyperGraph 提供了 3 种曲线数据点提取方法：单击曲线、使用 Find Point 功能或直接在

数据点列表中选取。其中，Find Point 允许用户在曲线上逐个数据点地查看、查找曲线中最

大最小值点或直接跳到曲线的起点或终点。 
选定曲线的各个数据点将以列表的形式进行显示。列表包含 3 部分内容：数据点编号，

X 坐标值以及 Y 坐标值。拖动滚动条可以查看整个列表。 
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6. 3.3  曲线属性控制 

曲线创建完毕，可对曲线各种属性进行编辑。例如，为曲线图增加页眉页脚、为曲线添

加注释、改变曲线的显示方式、改变 X-Y 视图的各类参数以及使用样式表功能。本节将具

体介绍以上内容。 

1. 页眉页脚 

应用 Headers/Footers 面板可为曲线图添加页眉和页脚。Headers/Footers 面板如图 6-30
所示，可通过以下任一种方式进入： 

●  在 Annotations 工具栏中，单击 Headers/Footer 按钮 。 
●  在视图窗口中，直接单击 Headers/Footer 的相应区域。 
●  在下拉菜单中，选择 Annotations→Headers/Footer 命令。 

 

图 6-30  Headers/Footer 面板 

该面板允许用户为曲线添加页眉与页脚，指定页眉与页脚的字体、颜色和位置以及控制

它们的显示/关闭。在该面板左上角的 Headers 标签与 Footer 标签可以控制后续编辑所作用的

对象。在 Headers/Footer 标签下方是文本编辑框，用于输入页眉页脚显示内容。Font 选项区

用于对字体属性进行控制，单击 按钮，将调用系统字体编辑窗口。Line1、Line2 和 Line3
复选框用于控制字体编辑作用的范围，其中 Line3 控制 3 行之后的所有字符。Alignment 选

项区控制页眉页脚的放置位置，旁边的调色板可以指定页眉页脚的显示颜色，Show 复选框

用于控制页眉页脚的显示或关闭。所有设置完成后，单击 Apply 按钮，保存并使用设置。 

2. 曲线显示控制 

在 Curve Attributes 面板中，用户可以对曲线的显示状态（如线型、颜色、线宽以及标记

点类型与颜色等）进行控制。Curve Attributes 面板如图 6-31 所示，可通过以下任一种方式

进入： 

 

图 6-31  Curve Attributes 面板 
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●  在 Curves 工具栏中，单击 Curve Attributes 按钮 。 
●  在下拉菜单中，选择 Curves→Curve Attributes 命令。 
选中曲线后，单击 ON 或 OFF 按钮，可控制曲线的显示或关闭；单击 Label On 或 Label 

Off，可控制与曲线对应的标签的显示或关闭；Line Attributes 标签用于控制曲线的线型、线

宽及颜色，Shade Area under Line 复选框用于渲染曲线与坐标轴之间的区域，如图 6-32 所示。 

 

图 6-32  曲线包围区域渲染 

如图 6-33 所示，Symbol Attributes 标签用于控制曲线数据点标记的显示状态，如标记类

型、颜色等。在默认情况下，标记不显示。在 Every 文本框中可以设置标记显示的频率，默

认为 1，即曲线上每个数据点均用标记点标出。如果用户希望每隔一个数据点标记一次，则

只需要在 Every 栏中填入 2。单击 User Preferences 按钮可恢复首选项文件 preferences.mvw 中

的默认设置。 

 

图 6-33  Curve Attributes 面板中的 Symbol Attrbutes 标签 

最后一栏为 Data Attributes 标签，它以列表的形式给出常用曲线所有可编辑的属性。

数据接口读入数据后会自动为其附加属性。按<Tab>键或<Enter>键可在表格各列之间

进行切换。 



MotionView & MotionSolve 
应用技巧与实例分析 

 214 

3.注释 

应用 Note 面板，可为曲线添加注释。Note 面板如图 6-34 所示，可通过以下任一种方式

进入： 
●  在 Annotations 面板下，单击 Note 按钮 。 
●  从下拉菜单中选择 Annotations→Note 命令。 
●  在 Plot Window 中，右击空白区域，并选择 New→Note 命令。 
注释可以是关键点标识、曲线趋势描述或与曲线相关的其他内容。注释的编辑通过

Templex 工具完成。 

 
图 6-34  Note 面板 

单击 Add 按钮新建注释。注释创建后，Note 面板 Text 标签下的文本区域将显示注释的

内容。在文本区域的下端放置了 Templex 工具的快捷键。单击这些按钮，可将相应的内容直

接写入文本区域。下面给出了这些 Templex 快捷键对应的功能。 
●  {X}：显示注释关联点的 X 值。 
●  {Y}：显示注释关联点的 Y 值。 
●  {Time}：显示注释关联点的时间值。 
●  {Label}：显示该注释关联点所从属的曲线的名称。 
●  {Slope}：显示注释关联点处曲线的斜率（一阶导数）。 
●  {Curv}：显示注释关联点处曲线的曲率（二阶导数）。 
注释的字体属性可以单击 A 按钮进行修改，Alignment 选项区中的单选按钮控制注释内

容左对齐、居中还是右对齐。 
Attributes 标签（见图 6-35）用于编辑注释框属性（线框与颜色）和字体属性。该标签

的 Apply to 功能用于定义注释编辑操作的作用范围（仅对当前选定的注释有效，或对当前窗

口中所有注释有效，或对某一页面下所有窗口中的注释有效，或对所有页面的注释都有

效）。在 Attributes 标签下也可以进行字体属性的设定，与 Text 标签下的字体属性设置不同，

该标签下的字体属性设置作用范围不仅仅是当前注释（取决于 Apply to 选项）。选中 Auto 
Position 复选框，软件可以自动调整注释的位置，以防止注释遮挡曲线。单击 User 
Preferences 按钮，可恢复首选项文件 preferences.mvw 中的默认设置。 

 

图 6-35  Note 面板中的 Attributes 标签 
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Attach To 标签（图 6-36）用于指定注释关联的对象，可以是窗口（Window）、视图

（View）、曲线（Curve）或曲线某一数据点（Coordinates）。与 Window 关联，即使曲线位置

改变，注释仍保持原位不动；与 View 关联保证了注释随着曲线的位置变化而变化；与

Curve 关联，注释通过直线与曲线数据点相关联，并随着曲线位置变化而变化；与

Coordinates 关联，注释通过直线与曲线指定的数据点相关联。 

 
图 6-36  Note 面板中的 Attach To 标签 

4.默认参数设置 

应用 Options 面板可以设置曲线图的各种默认参数。Options 面板如图 6-37 所示，可通

过以下任一种方式进入： 
●  在 Curves 工具栏中，单击 Options 按钮  
●  从下拉菜单中，选择 Preferences→Options 命令。 

 
图 6-37  Options 面板中的 Session 标签 

Options 面板包含 Session、Range、Color 以及 Animation Cursor 四个标签。Session 标签

用于设置脚本文件（Script File， mvw）默认值以及当前会话中的数据精度。Range 标签用于

设定 X 轴及 Y 轴的取值范围。Color 标签用于设置窗口各部分（如背景、框架、网格线以及

零线）的颜色，如图 6-38 所示。 

 

图 6-38  Options 面板中的 Color 标签 

Animation Cursor 标签用于设置光标的显示状态。播放动画时，光标用于标识曲线当前

时刻的数据点位置。Apply to 用于指定光标设置的作用范围，Display as 用于设置光标的类

型，Attributes 则可设置光标的颜色及线宽。图 6-39 给出了 Large bar 光标的示例。 
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图 6-39  Large bar 光标 

5.样式表 

在 HyperGraph 中，Apply Style 功能支持将当前窗口中的显示设置应用到当前页面的其

他窗口中或其他页面下的窗口中。Apply Style 对话框如图 6-40 所示，可通过以下任一种方

式进入： 
●  从下拉菜单中选择 Tools→Apply Style 命令。 
●  在窗口中右击，选择 HG Apply Style 命令。 
Pre Selection 用于指定样式作用的范围，Options 指定应用的参数，如页眉、页脚、轴线

参数、注释等。对勾符号表示该项已选中。 

 

图 6-40  Apply Style 对话框 

6.坐标轴 

Axis 面板如图 6-41 所示，可通过以下任一种方式进入： 
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●  在 Annotation 工具栏中单击 Axis 按钮 。 
●  在菜单栏中，选择 Annotations→Axes。 
●  在视图窗口中，单击 x 轴或 y 轴。 
应用 Axis 面板可为曲线添加新的坐标轴，同时还可以对坐标轴标题、颜色及尺度等属

性进行编辑。 

 

图 6-41  Axis 面板 

在窗口坐标轴区域右击会弹出两项内容：Convert Units 和 New Axis。Convert Units 可以

将当前坐标系（包括 X 轴和 Y 轴）的单位制转换为另一套单位制系统。转换完毕后，坐标轴

标题将自动缩放以适应新单位制。选择 New Axis，软件将按照当前坐标轴属性新建一个坐标

轴，并自动进入 Axis 面板。 

6. 3.4  曲线视图控制 

HyperGraph 的 2D View Control 工具栏提供了多种视图控制工具，如图 6-42 所示。

表 6-4 描述了该工具栏按钮的基本功能。 

 

图 6-42  2D View Control 工具栏 

表 6-4  2D View Control 工具栏按钮的基本功能 

按    钮 按 钮 名 称 功    能 

 Fit All 图形区所有数据适合屏幕缩放 

 Fit X 图形区所有 x 轴数据适合屏幕缩放 

 Fit Y 图形区所有 y 轴数据适合屏幕缩放 

 Zoom 左键放大，右键缩小 

 Pan Left/Right 左键向左移动，右键向右移动 

 Pan Up/Down 左键向上移动，右键向下移动 

 Pan Diagonal 左键向右上角移动，右键向左下角移动 

 Pan Diagonal 左键向左上角移动，右键向右下角移动 

 Reverse View x 轴和 y 轴数据转换 

 User Views 设置用户视图，这里可以保存两个用户视图 
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6. 3.5  曲线滤波 

本节将介绍如何对一条曲线进行滤波处理。在 6.3.2 节中，已经介绍了如何使用 Define 
Curves 面板创建已有曲线的导数曲线。在这一节，将使用该面板创建已有曲线的滤波曲线。

Define Curves 面板如图 6-43 所示，可通过以下任一种方式进入： 
●  在 Curves 工具栏中，单击 Define Curves 按钮 。 
●  从下拉菜单中，选择 Curves→Define Curves 命令。 

 
图 6-43  Define Curves 面板 

使用滤波函数对已有曲线滤波时，新曲线的来源应选为 Math，x 轴数据参考原始曲线的

x 轴数据，使用滤波函数定义 y 轴数据。HyperGraph 滤波函数向用户提供了多个可调参数，

单击 Define Curve 面板下的滤波器按钮 Fliter，进入滤波器对话框，如图 6-44 所示。 

 
图 6-44  Filter 对话框 

在 Filter 对话框中可以定义 Filter Class、Padding 以及 Direction。本例如图 6-45 所示，

Filter Class 选择 SAE J211/1，Padding 选择 No Padding，Direction 选择 Fwd-Back。确认选择

后单击 OK 按钮，对话框中设置的函数将填入新曲线的 y 轴位置。注意到滤波函数前两项空

缺，并将光标自动停留在第一项，这是因为滤波函数需要参考曲线 x 轴和 y 轴数据。 

 

图 6-45  滤波函数定义 

按住<Shift>和<Ctrl>键，在图形区单击待滤波的曲线，将该曲线的 x 轴数据填入滤

波函数，此时光标自动跳过逗点符号移至函数第二项。按住<Shift>键，在图形区单击待滤

波的曲线，该曲线的 y 轴数据填入滤波函数，如图 6-46 所示。 
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图 6-46  完成定义的滤波函数 

滤波函数定义完毕后，单击 Apply 按钮，新建的滤波曲线显示在图形区中，如图 6-47
所示。 

 

图 6-47  滤波曲线 

6.4  演示与报告 

结果查看完毕，下一个非常重要的工作就是根据计算结果生成相应的报告。HyperWork
后处理平台提供了多种工具，帮助用户将计算结果整理为 HTML 格式、PowerPoint 格式、图

片格式或视频格式的文件，用做仿真分析报告的素材或将这些文件提供给其他的分析人员，

作为设计和决策的依据。这一节将重点介绍创建报告的各类工具的使用方法，并就一些高阶

技巧作进一步的讨论。 

6. 4.1  结果演示 

HyperView 提供了抓屏工具与动画录制工具以及 HTML 和 PowerPoint（XML）报告创

建工具。 

1.捕捉图片及视频 

在 HyperView 中，用户可以将后处理界面中的内容以图片或动画的形式进行保存。相应

的工具可通过选择 View→Toolbars→HyperWorks→Image Capture 命令启动。工具栏中按钮的

功能如下： 
●  Save Image To File /Clipboard ：设置抓取图片的保存位置，File 表示保存到文

件，而 Clipboard 表示保存到剪贴板，可用<Ctrl+V>键粘贴到任一位置。 
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●  Capture Graphic Area ：抓取图形区中的内容以 BMP、JPEG、PNG 或 TIFF 格式进

行存储。存储的图片可由图片编辑工具或 HyperView 动画模块打开。 
●  Capture Panel Area ：抓取主菜单区域内容以 BMP、JPEG、PNG 或 TIFF 格式进行

存储。 
●  Capture Dynamic Rectangular ：抓取框选区域内容以 BMP、JPEG、PNG 或 TIFF 格

式进行存储。 
●  Capture Frame Area ：抓取指定的应用程序区域内容以 BMP、JPEG、PNG 或 TIFF

格式进行存储。 
●  Capture Animation Video ：抓取图形区内的动画以 AVI、AMF（Altair Movie File）、

BMP、JPEG、TIFF 或 PNG 格式进行存储。其中，AVI 格式的视频文件，可以在视

频编辑器或 HyperView 动画模块中进行查看。 
●  Capture Dynamic Rectangular Video ：该功能与 Capture Animation Video 功能类似。

其区别在于该功能允许用户通过框选的方式选取指定区域，对选定区域的动画进行

录制。单击该按钮后，软件提示用户选取录制区域，通过鼠标左键指定矩形框的起

点，鼠标右键指定矩形框的终点，即可录制。 

2.发布 HTML 或 PowerPoint 格式报告 

除了捕捉图片及动画的功能外，HyperView 可将当前视图区域中的内容以 HTML 或

PowerPoint 的格式发布。在 File 菜单中，选择 Publish→HTML/PowerPoint 2003 或

PowerPoint 2007。该功能抓取当前会话中所有页面与窗口中的内容形成多种文件（如 H3D、

AVI、JPEG 等），然后利用这些文件生成 HTML 文件或 PowerPoint 文件（XML 格式或

HTM 格式）。用户可以通过 PowerPoint 2003 读取 XML 格式的 PowerPoint 文件，或通过

PowerPoint 2007 读取 HTM 格式的 PowerPoint 文件。 
会话浏览器（Session Browser）用于定义发布报告的页面，当 Publish 栏中某页复选框被

激活，则表示该页面内容将发布为 HTM 或 PowerPoint 格式的报告，如图 6-48 所示。 
报告的格式取决于用户的设置。在会话浏览器希望输出的页面位置右击，选择 Publish 

Settings，在弹出的 Publish Settings 对话框中可以输入窗口内容的简介和选择发布报告的格

式，如图 6-49 所示。其中，图片格式可以选择为 PNG、JPEG、BMP 以及 TIF，录制动画格

式可以选择为 PNG、JPEG、TIF、BMP、AVI 以及 H3D。 

         

图 6-48  会话浏览器                             图 6-49  Publish Settings 对话框 

关于 AMF、AVI、H3D 以及 JPEG 格式输出文件的详细参数设置可通过单击 Preferences
→Export Settings→AMV/AVI/H3D/JPEG 选项完成。该选项提供了诸如颜色、尺寸、图片质
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量设置功能，如图 6-50 所示。 

 

 
图 6-50  AMV/AVI/H3D/JPEG 文件输出选项 

6. 4.2  报告模板 

后处理过程中，常常需要为不同的迭代工况或模型进行类似的操作，以便对不同工况或

模型的分析结果进行细致的比对研究。然而，这些“类似的操作”往往是较为繁琐的。针对

这一问题，HyperWorks 后处理模块提供了报告模板（Report Template）功能，它可以捕捉某

次结果后处理过程中的操作，将其保存成报告模板，然后应用该模板即可快速完成其他工况

分析的结果后处理，减少了重复工作，大大提高了工作效率。在这一节，将演示如何创建一

个报告模板以及如何将该模板应用到其他结果后处理中，以实现后处理过程的自动化。 
本节将学习如何以下内容： 
●  进入 Report 面板。 
●  使用参数浏览器创建报告模板，并对其进行参数化。 
●  在报告模板中进行曲线、动画以及视频数据的叠加与追加。 
●  在曲线窗口中显示或隐藏数据层。 

1.Report 面板 

应用 Report 工具栏可进入 Report 面板。如果当前界面中没有显

示 Report 工具（见图 6-51），可选择 View→Toolbars →HyperWorks→
Reports命令。工具栏上各按钮功能如下。 

●  Open Report Template ：打开已有 Report 模板。 
●  Save as report template ：将当前会话保存为 Report 模板。 

 
图 6-51  Report 工具 
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●  Open reports panel ：打开 Report 面板。 
Report 面板（见图 6-52）可将报告模板中的页面设置（追加、替换或叠加）应用到

HyperWorks 后处理模块当前会话中。报告模板由一系列描述如何处理特定测试或分析数据

的报告定义语句构成，可自动处理类似的数据。 

 

图 6-52  Report 面板 

一旦报告模板成功载入，会话中的设置将自动更新。接下来将讨论如何使用参数浏览器 
（Parameter Browser）创建参数。 

2.参数浏览器 

参数浏览器支持会话文件或报告模板文件中几乎所有对象的参数化处理，联合报告模板

可实现 HyperWorks 后处理模块中整个分析会话结果后处理的自动化。真正的自动化是指自

动化脚本会随着应用对象的变化而变化，而不是保持脚本原始设置不变。为达到这一目标，

可使用参数浏览器对脚本参数化定义，以便在脚本执行时可适应不同的应用对象。成功定义

报告模板中的参数后，将其保存为脚本文件，该脚本可以通过 Report 面板调用。 
选择 View→Browsers→HyperWorks→Parameters命令即可进入参数浏览器。如图 6-53 所

示，参数浏览器由属性列表、属性可用参数与选中的参数及参数值 3 个部分构成。它显示了

当前会话中所有的页面、窗口以及与每个对象相关联的属性。激活属性前的复选框即可将该

属性加载到参数表中（位于参数浏览器的底部）进行参数化设置。 

        

图 6-53  参数浏览器  

属性列表 

属性可用参数 

参数及参数值 
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参数浏览器中列出的属性与当前会话的功能有关，因此不同的应用程序显示的属性是不

同的。选中某一属性将弹出该属性可用的参数，选中 Header 对象（见图 6-53），参数浏览器

中部显示出 Alignment、Color 以及 Text 三个参数，即 Header 对象有 3 个属性可参数化。该

示例中，激活了 Text 属性并创建了默认值为 Airbag 1- Volume 的参数 Plotheader Text。 
单击“…”按钮可查看当前参数的附加设置。More Options 对话框如图 6-54 所示，对

话框中各项的功能如下。 

 

图 6-54  More Options 对话框 

Name：参数名称，与参数表的 Name 栏一致。 
Value type：value 脚本运行时，该值将替代整个字符串值。 
Prefix：为页眉添加前缀。 
Suffix：为页眉添加后缀。 
Search and replace：搜索并替换页眉名称。 
Range：替换选定范围所有字符。 
Default value：默认值，该值在脚本运行时将被替换。 
Remove Parameter：删除参数。 
Add Parameter：为该属性添加另一个参数、该参数具有不同于原始参数的默认名，但其

参数值与原始参数的默认值相同。 
单击 OK 按钮，关闭对话框，为参数浏览器新建参数。 

3.对象显示模式 

如图 6-55 所示，在 Report 面板中可以设置显示模式

（Mode），这里支持叠加（Overlay）、追加（Append）及取代

（Replace）3 种显示方式。 
选择 Overlay 模式，新建的曲线或动画将被叠加到当前的

窗口中。如图 6-56 所示，报告中的数据（run2）叠加到了当

前会话（run 1）窗口中。 
如果选择 Overlay 模式，图形区原有曲线的颜色保持不变，但坐标轴将根据叠加曲线作

相应调整。原有曲线的颜色与坐标轴属性可由以下叠加选项控制。 

 

图 6-55  报告模板显示模式 
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图 6-56  曲线叠加 

●  Autofit plots：锁定原有坐标轴，曲线叠加时坐标轴保持不变。 
●  Auto place notes：自动放置添加到窗口的注释。 
●  Use report colors：选中该选项后，曲线颜色、线型、标记颜色以及标记类型取决于报

告模板的设置。 
如果选择 Append 模式，报告中的内容将追加到当前会话之后。例如，一个具有 3 个页

面内容的报告追加到具有两个页面的会话中，追加的内容将显示在第 3、4 和 5 页中。 
如果选择 Replace 模式，报告中的内容将取代当前会话中的内容。 

4.图层显示及隐藏 

如果选择 Overlay 模式，每次应用报告添加的数据将以图层 Layer 的形式进行存储。单

击 Layer 按钮，可在弹出的 Layers 对话框中控制每一图层的显示/关闭，如图 6-57 所示。 

 

图 6-57  Layers 对话框 

6. 4.3  模型与结果播放器 HyperView Player 

HyperView Player 是一款独立的、用于查看计算机辅助工程模型（CAE Model）以及

H3D 格式计算结果的、互联网浏览器插件式播放器。它可以嵌入 HTML 格式或 XML 格式

报告中。通过这一功能，用户可以在报告中查看三维模型及计算结果。 
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如果用户打开的是 HTML 格式的报告，H3D 数据可以二维预览图片的形式显示在报告

中。单击预览图片，打开 HyperView Player 应用程序，此时 HyperView Player 已加载 H3D 数据

文件，如图 6-58 所示。目前，Windows 系统和 UNIX 系统都支持这种二维图片预览功能。 

 

图 6-58  二维图片预览 

如果用户希望在 HyperView 中输出 H3D 文件供 HyperView Player 查看，那么在 HyperView
菜单中单击 File→Export→Model，保存模型即可。H3D 文件是一种二进制三维动画文件，它

将模型和结果数据保存成一个单独的、压缩的文件而不是多个、大规模的结果文件，大大提

高了结果后处理效率。使用 HyperView 创建 H3D 文件时，用户可以选择 H3D 文件中所包含

的内容。单击菜单 Preferences→Export Settings，用户可以控制对象属性、动画、结果以及视

图属性是否输出。HyperView Player 还可以直接嵌入到 Word 以及 PowerPoint 中。使用该功

能时，只需将 H3D 文件拖放至目标位置或使用 Word 以及 PowerPoint 的插入功能，即可完

成播放器及数据的嵌入。 

6.5  实例 

6. 5.1  动画结果后处理应用实例 

本节将学习如何使用 HyperView 进行多体系统动力学分析动画结果后处理的基本方法。

练习开始前，首先将目录 chap06 下的 H3D 格式文件复制到工作文件夹中。 

查看文件并进行基本的视图控制 

（1）启动 HyperView。 
（2）在 File 菜单中选择 New→Session 命令，新建一个会话。 

 STEP 
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如果在用户界面中弹出警告信息，询问用户是否将清除当前作业中的数据并开始新的会

话，则单击 Yes 按钮。 
（3）单击 Open Model 按钮 ，进入 Load model and results 面板，如图 6-59 所示。 

 

图 6-59  Load model and results 面板 

（4）在 Load model 栏处单击“文件浏览”按钮 ，选择载入 single_pendulum.h3d。 
（5）Load results 栏将自动填入 Load model 栏中模型的路径及文件名。 
注：H3D 格式结果文件同时包括模型与结果数据，因此在 Load model 栏中选择

single_pendulum.h3d 后，Load results 栏将自动加载该文件。 
（6）单击 Apply 按钮，载入模型。 
（7）单击 HyperView 的标准视图工具栏中的“XZ 平面显示”按钮 ，将模型显示切换

到 X-Z 平面。 
（8）单击动画播放工具栏中的“播放”按钮 ，查看结果动画。 
（9）在 Fit Model/Fit All Frame 按钮 处单击鼠标右键，最大化显示结果。 
（10）在动画播放工具栏中，单击“动画播放控制”按钮 ，进入动画播放控制面板，

如图 6-60 所示。在该面板中，用户可以控制动画播放的帧频、起始时间、结束时间等。 

 
图 6-60  动画控制面板 

（11）单击“暂停播放”按钮 ，停止动画播放。 

查看模型中对象的运行轨迹 

（1）单击工具栏中 Tracing 按钮 ，进入对象跟踪面板，如图 6-61 所示。 

 

图 6-61  对象跟踪面板 
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（2）在该面板下，选择跟踪对象类型为 Component。 
（3）在图形区，选择希望跟踪查看的组件。 
（4）将视图角度切换为等轴视图 。 
（5）在跟踪类型（Tracing mode）中选择 Last，并在 steps 中输入 10。 
（6）单击播放动画，此时图形区将显示包含当前时刻最后 10 步的单摆运动轨迹。 
（7）如果用户不需要继续跟踪某一对象，则可以在该面板下，单击 Delete 按钮，删除图

形区的跟踪轨迹。 
（8）切换到 From first step 选项和 All stepson 选项，查看相应的结果输出。 
（9）通过 Display options 选项区可修改轨迹线的颜色及线型。 

对象定位 

（1）Tracking 工具用于设定机构运动过程中的参考对象，模型中其余的对象，将以相对

运动的方式在图形区中展示。 
（2）单击 Add Page 按钮 ，在当前会话中新建一个页面。 
（3）读取工作文件夹下 front_ride.h3d 文件。 
（4）单击 Tracking systems 按钮 ，进入对象定位面板，如图 6-62 所示。 
（5）通过单击左侧的 Add 按钮，添加一个新的对象定位体系。 
（6）将定位对象类型设置为 Component。 

 
图 6-62  对象定位面板 

（7）在图形区中选取一个感兴趣的构件，作为定位查看的对象。 
（8）单击“播放”按钮 ，观察模型跟踪查看结果。 
（9）单击“暂停播放”按钮 ，停止动画播放。 

对象属性编辑 

（1）继续留在 Front_ride.h3d 结果的页面中。 
（2）单击“对象属性”按钮 ，将进入对象属性面板，如图 6-63 所示。 

 

图 6-63  对象属性面板 
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（3）单击 Entity 选项右侧的下拉按钮，可以看到，在对象属性面板中，可以控制的对象

包括装配（Assembly Hierarchy）、部件（Components）、坐标系（Systems）以及用户自定义组

集（Sets）。 
（4）将对象类型设置为 Assembly Hierarchy。 
（5）在对象列表中选择某个部件，在调色板中选取颜色，即可修改该部件的颜色。 
（6）在对象列表中选择某个部件，单击“线框模式显示”按钮 ，即可令该部件以线框

模式显示。另外，单击“渲染模式显示”按钮 ，可以渲染模式显示部件；单击“透明显

示”按钮 ，可以透明模式显示部件。 
（7）通过单击 Display 处的 On 或 Off 按钮，打开或关闭选定部件。 
（8）通过单击 ID 处的 On 或 Off 按钮，打开或关闭选定部件的编号。 

查看力及力矩矢量 

（1）在 HyperView 结果后处理中，允许用户提取 MotionSolve 计算结果中的力及力矩的

矢量信息，包括其大小及方向，并实时显示在屏幕中。 
（2）单击 Add Page 按钮 ，在当前会话中新建一个页面。 
（3）确定当前用户界面为 HyperView。 
（4）载入 front_ride.h3d 文件。 
（5）单击“向量”按钮 ，进入向量提取及显示面板，如图 6-64 所示。 
 

 

图 6-64  向量图面板 

（6）在 Result Type 下拉列表中选择 Force（v）。 
（7）在 Display options 选项区中的 Size scaling 下拉列表中选择 By Magnitude。 
（8）选中 Show Values 复选框。 
（9）单击 Apply 按钮。 
（10）以上设置完毕后，单击工具栏中的“动画播放”按钮 。 
（11）从图形区可以看到，在整个动画播放的过程中，力的大小和方向在实时更新。 
（12）单击 Clear Vector 按钮，清除图形区中的力矢量。 
（13）在 Result type 下拉列表中选择 Moment（v）。 
（14）重复步骤（7）～（11），查看计算结果中的力矩信息。 
（15）在 Display options 选项区中的 Size scaling 下拉列表中选择 By Magnitude，修改其

后文本框中的放缩比，可改变向量符号的大小。 
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碰撞及干涉检查 

（1）单击 Add Page 按钮 ，在当前会话中新建一个页面。 
（2）确定当前用户界面为 HyperView。 
（3）读取工作文件夹下的 collision.h3d 文件。 
（4）单击“动画播放”按钮 ，查看计算结果。 
（5）查看后，单击“停止播放”按钮 ，停止结果动画播放。 
（6）选择 Tools→Collision Detection 命令，进入碰撞及干涉检查面板，如图 6-65 所示。 
（7）在左侧的碰撞及干涉检查对象列表中单击 Add 按钮，新建一组对象。 
（8）此时 Selection 选项区中的 Components 按钮处于激活状态。 
（9）在图形区选择后备箱盖。 
（10）单击 Add to Group A 按钮。 
（11）在图形区选择车身。 
（12）单击 Add to Group B 按钮。 
（13）在 Proximity 选项区中，选中 Enable proximity checking 复选框，并指定最小检查

距离 Minimum distance 为 1。 
（14）在 Show results by 选项区中，选中 Elements 单选按钮。 
（15）单击 Apply 按钮。 

 
图 6-65  碰撞及干涉检查面板 

（16）单击“播放”按钮 ，播放结果动画。 
在机构运动过程中，如果模型中的某些单元发生了碰撞和干涉，那么其颜色将变为红色，
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黄色表示可能发生碰撞的区域。如果没有发生碰撞及干涉，那么该单元将保持原来的颜色。 
（17）单击“停止播放”按钮 ，停止动画播放。 
（18）在 Show results by 选项区选中 Components 单选按钮，查看结果动画。 
（19）通过 Summary 功能，对所有检测到的碰撞及干涉现象进行总结并输出文本格式的

报告文件。 

使用测量面板 

HyperView 允许用户在进行图形历程后处理时，实时测量各类模型参数在整个过程中的

变化，并进行处理。 
（1）单击 Add Page 按钮 ，在当前会话中新建一个页面。 
（2）确定当前界面为 HyperView。 
（3）读取工作目录下的 front_ride.h3d 文件。 
（4）单击工具栏中的 Measures 按钮 ，进入测量面板。 
（5）在 Measure Groups 下，单击 Add 按钮，新建一组测量。 
（6）在 Measure Type 下拉列表中选择 Position，如图 6-66 所示。 

 

图 6-66  测量面板 

（7）在图形区中，选取待查看的节点。 
（8）选中 X、Y、Z 复选框。 
（9）单击 Create Curves 按钮，弹出如图 6-67 所示的 Create Curves 对话框。 
（10）在 Place on 下拉列表中选择 New Plot 选

项。 
（11）在 Y Axis 下拉列表中选择 X，并选中 Live 

Link 复选框。 
（12）单击 OK 按钮。 
（13）重复步骤（10）～（13），可以查看目标对

象在 Y 及 Z 向的位置变化情况。 
（14）单击“动画播放”按钮 ，播放动画。 
可以注意到，Measure Group 中的曲线图将随着

动画的播放而实时更新。 

6. 5.2  数据结果后处理应用实例 

本节将学习如何使用 HyperGraph 进行多体系统动力学分析曲线结果后处理的基本方

 
图 6-67  Create Curves 对话框 
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法。练习开始前，首先将目录 chap06 下的 LINACC 文件复制到工作文件夹中。 

读取文件 LINACC，创建多条曲线 

（1）启动 HyperGraph，并选择模块 HyperGraph 2D 。 
（2）在 Curves 工具栏下，单击 Build Plots 按钮 。 
（3）单击“文件浏览”按钮 ，选择工作路径中的 LINACC 文件。 
（4）选择 Y Type 为 Linear Acceleration。 
（5）在 Y Request 中，选择 Lower torso、Upper torso 及 Head。按住<Ctrl>键，可同时

选择多个对象。 
（6）在 Y Component 下拉列表中选择 Res. Acceleration （m/s**2）。 
（7）在 Layout 处下拉列表中选择 One Plot Per Request，并选择双窗口显示模式 ，如图

6-68 所示。 

 

图 6-68  Build Plots 面板 

（8）单击 Apply 按钮，创建曲线。 
（9）注意到在 HyperGraph 界面中，共创建了两个页面 3 条曲线，如图 6-69 所示。 

 

图 6-69  加速度曲线 

 STEP 

01 



MotionView & MotionSolve 
应用技巧与实例分析 

 232 

 

积分加速度曲线 

（1）激活页面 1 窗口 1，此时该窗口被青色的框条包围。 
（2）单击工具栏下的 Define Curves 按钮 。 
（3）在 Curve 列表中，单击 Add 按钮，新建一条曲线。 
（4）将 Source 设置为 Math，即通过数学表达式新建曲线。 
（5）选中 x=单选按钮，按住<Shift>键，同时单击窗口 1 中的曲线 1。 
（6）选中 y=单选按钮，单击“积分”按钮 。 
此时，积分函数填入 y 栏。注意到积分函数中前两项空缺，第一项需要填入 x 轴数据，

第二项需填入 y 轴数据。 
（7）同时按住<Shift>键和<Ctrl>键，单击窗口 1 中的曲线 1，此时将引用曲线 1 的 x

轴数据。光标自动移至第二项处。 
（8）按住<Shift>键，选择窗口 1 中的曲线，此时将引用曲线 1 的 y 轴数据，如图 6-70

所示。 

 

图 6-70  积分函数 

（9）单击 Apply 按钮，建立曲线，如图 6-71 所示。 

 

图 6-71  加速度曲线及其积分曲线 
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（10）在曲线浏览树中，右击 w2：XY Plot c1： Res. Acceleration （m/s**2），选择 Single 
Curve Math→Integral 命令，如图 6-72 所示。这是创建积分曲线的另一种方式。Define 
Curves 面板中提供的函数功能，在曲线浏览树的快捷菜单中也能找到。 

 

图 6-72  曲线浏览树 

（11）可以通过曲线浏览树或者通过 Define Curves 面板，关闭新建积分曲线。使用曲线

浏览树只需在曲线名称上单击鼠标右键，并选择 Turn Off 命令即可。使用 Define Curve 面板

只需在积分曲线激活的情况下，取消选择 Curve 前的复选框即可，如图 6-73 所示。 
（12）隐藏曲线后，可单击 Fit All 按钮 ，适合屏幕缩放曲线。 

 
a）                                           b） 

图 6-73  隐藏曲线 

a） 曲线浏览树  b） Define Curves 面板 

编辑曲线属性 

（1）确认页面 1 下的窗口 1 仍处于激活状态（有青色框线包围），如未激活，可在图形
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区单击鼠标。 
（2）单击工具栏中的 Curve Attributes 按钮 。 
（3）在 Curves 列表中，选择 Res. Acceleration （m/s**2）。 
（4）在 Line Attributes 标签下，选择间断线风格显示 ，中等线宽，并将曲线颜色设

置为红色，如图 6-74 所示。 

 
图 6-74  曲线属性控制 

（5）单击窗口 1 的页眉（LOWER TORSO），或单击工具栏中的 Headers/Footers 按钮 。 
（6）确认 Header 标签处于激活状态，为页眉选择一个不同的颜色，如图 6-75 所示。 

 
图 6-75  页眉颜色控制 

（7）单击 Y 轴，进入 Aies 面板。 
（8）单击 按钮，进入字体编辑对话框。 
（9）将 Font Style 设置为 Bold，并设置字号为 14，如图 6-76 所示。 

 
图 6-76  坐标轴字体控制 
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（10）在工具栏中，单击 Options 按钮 。 
（11）进入 Color 标签。 
（12）激活 Frame 选项，为该窗口框架选择一个新颜色，如图 6-77 所示。 

 

图 6-77  窗口框架颜色控制 

（13）右击窗口 1，选择 HG ApplyStyle。 
（14）在弹出的 Apply Sheet 窗口的 Pre Selection 栏中选择 Current Page 命令。 
（15）在 Options 栏选中 Plot、Header、Aies 及 Curves。 
（16）单击 OK 按钮，窗口 1 中的参数设置被应用到了窗口 2 中，但是窗口 2 中的曲线

保持不变，如图 6-78 所示。 
（17）右击窗口 1，选择 HG ApplyStyle。 
（18）在弹出的 Apply Sheet 窗口的 Pre Selection 栏选择 All Pages 命令。 
（19）在 Options 栏选中 Plot、Header、Aies 以及 Curves。 
（20）单击 OK 按钮。 
（21）单击 Next Page 按钮 ，进入下一页。 

 

图 6-78  应用样式表功能（Current Page） 
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注意，这一次的操作，影响范围为所有页面的窗口，如图 6-79 所示。 

 

图 6-79  应用样式表功能（All Pages） 

标记和注释曲线的最大值 

（1）单击 Previous Page 按钮 ，返回第一页。 
（2）激活窗口 1，在 Annotations 工具栏中选择 Notes 按钮 。 
（3）单击 Add 按钮，新增一条注释。 
（4）在 Attach To 中，选择关联对象为 Curve。 
（5）在 Find Point 中，通过功能 ，寻找曲线的最大值点。 
（6）在 Text 标签中，填入描述的内容 Maximum Value=。 
（7）单击 Templex 快捷键中的{Y}按钮，自动提取此处的 Y 值。 
（8）单击 Apply 按钮，创建注释，如图 6-80 所示。 

 

图 6-80  创建注释 

（9）在注释列表中选择 Copy 命令，复制 Note 1。 
（10）在窗口 2 的 Notes 面板下，选择 Paste 命令，如图 6-81 所示。 
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图 6-81  注释复制 

注意：虽然注释指定 Attach To 为 Curve，但是复制后的注释最大值取值并没有指向曲线

2 的最大值，而是指向了与曲线 1 最大值点 X 坐标值对应的 Y 坐标值。在下一步中，这一问

题将被修正。 
（11）单击 Attach to 面板，并选择 ，查找曲线最大值，如图 6-82 所示。 

 

图 6-82  注释编辑 

 

显示曲线数据点 

（1）激活窗口 1。 
（2）在 Curves 工具栏中，单击 按钮进入 Coordinate Info 面板。 
（3）在曲线的任意位置单击。随着单击位置的变化，Coordinate Info 面板上的数据也随

之变化，如图 6-83 所示。 

 
图 6-83  Coordinate Info 面板 
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（4）通过 、 、 、 按钮，可以查看各个数据点的数值。 
（5）通过最大及最小数据点按钮 和 ，查找曲线的最大及最小值点。 

输出曲线 

（1）单击 Export Curves 按钮 ，在弹出的 Export Curves 对话框中选择输出曲线的类

型，这里支持 Excel、Columns、XY Data、X GRAPH、Summary、Adams Spline、Altair 
Binary、CSV Blocks、DAC、RPC、Excel Europe 等格式。 

（2）在 File 栏中指定输出曲线的名称与位置。 
（3）选择 Current plot，仅输出当前活动曲线，如图 6-84 所示。 

 
图 6-84  曲线输出 

保存作业（可选） 

（1）选择 File→Save As→Session 命令。 
（2）指定待保存会话的工作文件夹路径及名称。 
（3）单击 Save 按钮，保存文件。 

6. 5.3  报告模板应用实例 

练习开始前，首先将目录 chap06 下的 airbag 文件夹复制到工作文件夹中。 

启动 HyperGraph，创建曲线 

（1）启动 HyperGraph，并切换到 HyperGraph 2D 模块。 
（2）单击 按钮进入 Build Plots 面板。 
（3）单击“文件浏览”按钮 ，选择 airbag\run1\下的 abstat 文件。 
（4）在 Y Type 中选择 Airbag Statistics，在 Y Request 中选择 Airbag 1，在 Y Component

中同时选择 Volume、Pressure、Internal Energy 以及 dm/dt in。 
（5）在Layout 中选择One plot per Component，并将显示窗口设置为 ，同时显示4 个窗口。 

 STEP 
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 STEP 
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（6）单击 Apply 按钮，创建曲线，如图 6-85 所示。 

 
图 6-85  HyperGraph 2D 界面 

读取 glstat 文件，并在 HyperGraph 2D 中创建能量曲线 

（1）单击 Build Plots 面板中的“文件浏览”按钮 ，选择 airbag\run1\下的 glstat 文件。 
（2）在 Y Type 中选择 Energy，在 Y Request 中选择 Kinetic Energy 和 Internal Energy，在

Y Component 中选择 Energy。 
（3）在 Layout 中选择 One plot per Request，并将窗口设置为 ，同时显示两个窗口。 
（4）单击 Apply 按钮，创建曲线，如图 6-86 所示。 

 

图 6-86  能量曲线 

创建报告模板参数，用于定义曲线颜色、曲线视图风格以及曲线名称 

（1）选择 View →Browsers→HyperWorks→Parameters 命令，进入参数浏览器。 
（2）展开 p1： Airbag Statistics-1 以及 p2： Energy-1。 

 STEP 

02 
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（3）展开 w1： XY Plot、w2： XY Plot、w3： XY Plot 以及 w4： XY Plot。 
（4）展开每个窗口下的 Curves 文件夹。 
（5）按住<Ctrl>键，单击鼠标左键，选择页面 1 下所有窗口中的 c1：Airbag 1，如图 6-87

所示。 
（6）选择曲线中用于报告模板的参数。这里选择 LineColor、LineStyle 以及 Name，如图

6-88 所示。这三个参数对四条曲线都有效。 

                   

图 6-87  选择 c1 曲线                       图 6-88  选择页面 1 曲线参数 

（7）使用类似的方式，对页面 2 下的曲线参数进行设置。在参数浏览器中选择窗口 1 和

窗口 2 中的 c1：Energy，然后选择两条曲线中用于报告模板的参数 LineColor、Linestyle 以

及 Name，如图 6-89 所示。 

 
图 6-89  选择页面 2 曲线参数 
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上述步骤为参数列表添加了另外一组参数，接下来介绍如何将类似的参数合并在一起。 
（8）在 Name 列表中，按住<Ctrl>键的同时，通过鼠标单击 XycurveLinecolor 以及

XycurveLinecolor 1。 
（9）单击鼠标右键，在弹出的快捷菜单中选择 Merge 命令。两个参数将被合并为一个参

数，如图 6-90 所示。 
（10）重复步骤（8）～（9），合并 LineStyle 以及 Name 这两组参数。合并后的报告模

板参数应仅包含 3 组，如图 6-91 所示。 

         
图 6-90  合并曲线参数                       图 6-91  参数合并后的参数列表 

设置参数默认值并保存报告模板 

（1）此前进行的操作中所有参数的名称都是按照其默认名称进行存储的。参数合并后，

双击各个参数名称按照图 6-92 重新命名。 
（2）曲线的默认颜色及线型同样可以修改。单击 Default 列中的颜色按钮，从弹出的调

色板中选择新颜色，在 Linestyle 栏指定一个新的线型。 
（3）在{p2w2c1.y.HWComponent}右侧，单击...按钮，在弹出的 More Options 对话框中设

置曲线的默认名称。 
（4）保持 Value type 为 value 不变，将 Default value 设置为 Run 1，如图 6-93 所示。 

          
图 6-92  参数重命名                          图 6-93  More Options 对话框 

（5）单击 OK 按钮。 
（6）选择 File→Save As→Report Template 命令。 
（7）选择合适的路径，将报告模板保存为 airbag.tpl。 

新建会话，载入报告模板 

（1）选择 File→New→Session命令，在弹出的确认对话框中单击Yes 按钮，新建一个会话。 

 STEP 

04 

 STEP 

05 
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（2）选择 View→Toolbars→HyperWorks→Report 命令打开

Report 工具栏，如图 6-94 所示。 
（3）单击 Open Reports Panel 按钮 ，进入 Open Reports 面

板。 
（4）单击 Delete 按钮，删除在该面板下的模板文件。 
（5）单击 Add 按钮，并选择 airbag.tpl。 
（6）单击 Open 按钮，上述定义的参数同时显示在 Report 面板中，如图 6-95 所示。 

 

图 6-95  Report 面板 

（7）将 Linecolor 改为 2，Linestyle 改为 2。 
（8）在 Name 一栏保留默认值 Run 1。 
（9）单击 Apply 按钮，页面 1 如图 6-96 所示。 

 
图 6-96  曲线追加 

（10）返回 Open Reports 面板，将 PLOT_FILE_1 修改为 airbag\run2\的文件 abstat。 
（11）右击 PLOT_FILE_1 路径，并选择 Autofill directory，如图 6-97 所示。 

 

图 6-97  Autofill directory 功能 

（12）应用该功能，Open Reports 面板上其他栏的文件路径将自动更新。 
（13）将 Linecolor 修改为 3，Linestyle 修改为 1，Name 为 Run 2。 
（14）在 Mode 选项区中，选中 Overlay 单选按钮。 

 

图 6-94  Report 工具栏 



第 6 章 
仿真结果后处理 

 243 

（15）单击 Apply 按钮，页面 1 如图 6-98 所示。 

 
图 6-98  页面 1 曲线叠加 

（16）此时，同一个分析结果中的曲线使用相同的颜色显示，另外通过曲线名称可以区

分曲线来自 Run1 还是 Run2。 
（17）单击 Next Page 按钮 进入页面 2，可以注意到报告模板对页面 2 的曲线作了更

新，如图 6-99 所示。 

 

图 6-99  页面 2 曲线叠加 

6. 5.4  结果可视化及 HyperView Player 

练习开始前，首先将目录 chap06 下的 airbag 文件夹和 airbag.mvw 文件复制到工作文件

夹中。 

读取模型，在图形区输出图片及动画 

（1）启动 MotionView，在 File 菜单中选择 Open→Session 命令，打开一个会话。 
（2）选择工作文件夹下的模型文件 airbag.mvw。 
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（3）单击“播放”按钮 ，播放动画，如图 6-100 所示。 

 

图 6-100  airbag 结果界面 

（4）选择 View→Toolbars→HyperWorks→Image Capture 命令，启动 Image Capture（标

准截图）工具栏，如图 6-101 所示。 
（5）单击 Capture Graphic Area 按钮 ，截取图形区。 
（6）选择存储路径，并将图片命名为 graphics_area。 
（7）选择图片保存格式为 JPEG。 
（8）单击 Save 按钮，保存图片。图片保存后，用户可

以使用任一种图片编辑工具查看该图片。 
（9）单击 Capture Graphics Area Video 按钮 ，录制动画。 
（10）选择存储路径，命名该文件为 graphics_area_video。 
（11）单击 Save 按钮，保存文件。 
（12）动画存储后，用户可以使用任一种视频播放器播放该动画文件。 
（13）单击 Capture Rectangular Area Video 按钮 ，录制特定区域内的动画。 
（14）选择存储路径，命名该文件为 dynamic_rect_video。 
（15）单击 Save 按钮，保存文件。 
（16）使用鼠标左键在图形区画出矩形框。 
（17）使用鼠标右键接受矩形框并开始录制。 
此时，只有位于矩形框内的动画被存储。 

设置发布参数，并将当前会话发布为 HTML 格式报告 

（1）选择 Preferences→Export Settings→JPEG 命令，设置 JPEG 格式图片的输出参数，

如图 6-102 所示。 
（2）设置 JPEG quality（图片质量）为 99，单击 OK 按钮。 

 

图 6-101  Image Capture 工具栏 
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（3）选择 Preferences→Export Settings→H3D，设置 H3D 文件的相关参数，如图 6-103
所示。 

                

图 6-102  Export Settings JPEG 对话框                  图 6-103  Export Settings H3D 对话框 

（4）确认选中 Export Settings H3D 对话框中的 Animation 和 Results 复选框，然后单击

OK 按钮。 
（5）选择 View→Browsers→HyperWorks→Session 命令，启动会话浏览器（Session 

Browser），如图 6-104 所示。 
（6）在会话浏览器中的 HyperView 处右击，选择 Publish Settings 命令。 
（7）在 Window description 文本框中输入 Displacement，在 Format 下拉列表中选择

H3D，然后单击 OK 按钮，如图 6-105 所示。 

    

图 6-104  会话浏览器                          图 6-105  Publish Settings 对话框 

（8）该对话框定义了窗口 2 的内容简介，并指定了输出文件的格式。对于动画窗口，

这里支持动画文件（H3D 和 AVI）与图片文件（JPEG、TIF、PNG 或 BMP 格式）输出。 
（9）回到会话浏览器，并在第一个 HyperGraph2D 处右击，选择 Publish Settings。 
（10）在 Publish Settings 对话框中的 Window description 文本框中，输入 Volume，并在

Format 下拉列表中选择 JPEG，然后单击 OK 按钮。 
（11）类似地，将第二个 HyperGraph2D 窗口描述为 Energy，指定输出文件格式为

PNG。 
（12）单击 OK 按钮，回到会话浏览器。 
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（13）确认页面 1 右侧的 Publish 选项已被选中，如图 6-106 所示。 

 

图 6-106  Session Browser 

（14）选择 File→Publish→HTML 命令，将该会话保存为名为 Airbag.html 的 HTML 报

告文件。 

打开 Airbag.html 文件 

（1）使用互联网浏览器（如 Internet Explorer），打开此前保存的 Airbag.html 文件，如图

6-107 所示。 

 

图 6-107  Airbag.html 报告文件 

（2）互联网浏览器左侧是页面列表，单击列表，可在各个页面之间进行切换。 
（3）每个页面的窗口下方列出了该窗口的描述信息，这部分信息即是 Description 中定义

的内容。 
（4）单击页面上描述信息为 Airbag 的窗口，将启动 HyperView Player。用户可在
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HyperView Player 中查看三维模型及播放动画结果。 
（5）单击描述信息为 Volume 的窗口，浏览器将进入另一页面显示曲线图片。 

输出包含计算结果的 H3D 文件 

（1）进入窗口 3 的 HyperView 界面。 
（2）选择 Preferences→Export Settings→H3D 命令，设置 H3D 文件输出参数。 
（3）取消选择 Results 前方的选项。此时，如果输出 H3D 文件，H3D 文件中不包含云图

结果。 
（4）选择 File→Export→Model 命令，将其输出为 H3D 格式文件。 
（5）指定合适的工作目录，将该文件保存为 export_h3d_results.h3d。 
（6）选择 Start→All Programs→Altair HyperWorks 11.0→HyperView Player 命令，启动

HyperView Player，如图 6-108 所示。 
（7）单击“文件浏览”按钮 ，然后打开 export_h3d_results.h3d 文件，如图 6-109 所示。 
注意：打开的 H3D 文件仅包含动画结果，不含有云图结果。 

     

图 6-108  HyperView Player 播放器界面           图 6-109  HyperView Player 载入结果 

（8）回到窗口 2，在 Export Settings H3D 对话框中选中 Results 复选框。 
（9）单击工具栏中的 Contour 按钮 ，根据图 6-110 进行设置，单击 Apply 按钮，显示

当前结果的位移云图。 

 

图 6-110  Contour 面板 

（10）选择 File→Export→Model 命令，输出H3D 文件，对比两次输出文件的不同之处。 
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6.6  小结 

虚拟样机的目的在于通过计算机仿真预测和改进设计方案，而预测与改进设计方案的依

据则是仿真结果。因此，仿真结果后处理在虚拟样机设计中起到举足轻重的作用。

MotionView 通过强大的结果后处理工具 HyperView/HyperGraph，不但可以实现多体系统动

力学分析各种仿真结果的查看，而且支持仿真结果的再处理，如曲线的数学运算、结果的整

理与查询等。另外，其丰富的界面设置及结果编辑工具为用户提供了所见即所得的工作环

境。本章通过功能介绍与应用结合的方式描述了多体系统动力学分析中的一些常用后处理功

能，相信读者学习完本章后，一定能够熟练地应用这些功能，高效完成结果后处理工作。 
 



 

 

第 7章     

 传感器与仿真脚本 

本章介绍 MotionView 传感器与仿真脚本的基本用法，并通过实例说明机械系统序列仿真的

实现过程。通过本章的学习，用户可以根据实际需要进行较为复杂的机械系统仿真分析。 

本章重点知识 
 
 
 
7.1  传感器 

7.2  仿真脚本 

7.3  实例 

7.4  小结 

 

 



MotionView & MotionSolve 
应用技巧与实例分析 

 250 

7.1  传感器 

MotionSolve 中的传感器（Sensor）功能可用于监控指定事件的状态，当事件发生时可以

改变仿真设置，同时配合仿真脚本可实现不连续动作的连续仿真。利用传感器可在仿真过程

中激发以下动作： 
●  结束仿真。例如，监测到车辆轮心与地面之间的距离超过轮胎未变形半径时，停止

仿真。 
●  改变仿真参数。例如，在仿真过程中监测两个可能相互碰撞物体之间的距离，在碰

撞发生前，减少仿真步长避免出现求解不收敛，并加密结果输出间隔以捕捉碰撞产

生的接触力。 
●  改变仿真输入量。例如，在车辆变线操纵仿真中，使用传感器监测当前车辆运行状

态，通过修改输入，可实现直线行驶到加速—急停—变向的运动过程仿真。 
●  改变模型拓扑关系。例如，使用传感器监测铰链的约束反力，如果该力超过给定

值，则失效铰链，如图 7-1 所示。 

 
a）                               b） 

图 7-1  使用传感器改变模型拓扑关系 

a） 旋转副生效  b） 旋转副失效 

7. 1.1  事件监测 

传感器监测的事件可由函数来定义，这些函数可以是标记点之间的位移、速度、加速度

或力，用户自定义变量，仿真时间。 
进行动力学仿真时，MotionSolve 在每个成功的仿真步后会估算这些函数。定义函数时

可以使用表达式或用户自定义程序。 
传感器事件函数应该是连续的，因为 MotionSolve 会调整仿真步长以确定传感器触发的

精确时刻。如果函数是不连续的，则这一过程将变得耗时耗力且结果不准确。因此对传感器

事件函数来说，时间或位移函数是较好的选择，而速度、加速度或力效果会差些。 
通常，MotionSolve 会在每个成功的仿真步检查传感器的状态，如果达到了触发条件，则

传感器会触发并一直保持触发状态。用户需要关闭传感器的监测功能，可使用 DEACTIVATE
命令失效传感器以使其不再持续触发。 

7. 1.2  传感器触发 

定义传感器触发条件时，需要指定目标值、容差以及设定比较方法。在仿真过程中，函

数很少会精确到设定的目标值，所以设定容差可以提高传感器触发的成功率。MotionSolve
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将在每个仿真步对比函数当前值与设定的目标值+/-容差值。这里的容差必须为正数。 
MotionSolve 支持以下 3 种比较方法。 
●  Signal is greater than VALUE – ERROR：当函数值大于（目标值-容差）时触发传感器。 
●  Signal is less than VALUE + ERROR：当函数值小于（目标值+容差）时触发传感器。 
●  Abs（Signal） is less than or equal to VALUE + ERROR：当函数值位于（目标值-容差）

和（目标值+容差）之间时触发传感器。 

7. 1.3  动作执行 

传感器触发后，执行的任务可分为标准任务和特殊任务两类。标准任务是指常用的仿真

任务，分为以下几类。 
●  Halt simulation：终止仿真。 
●  Restart simulation：重启动仿真。 
●  New output step：设置新的输出间隔。 
●  Return to command file：读取新的仿真命令。 
特殊任务用于调试模型，分为以下几类。 
●  Print to output：将结果输出到求解窗口。 
●  Integration step size：重置积分器步长。 
●  New pivot sequence：重新启动矩阵分解。在计算不能收敛的情况下，重新分解矩阵

有利于收敛。 
●  Export state variable vector：输出状态变量矢量。 
●  Evaluate expression：评估表达式值。 

7. 1.4  传感器定义 

MotionView 传感器的定义可通过下述步骤实现。 
（1）通过以下任一种方式进入 Sensor 面板： 
●  在 Model Control 工具栏中单击 Sensor 按钮 。 
●  在模型浏览树的 Model 位置右击，选择 Add Control Entity→Sensor 命令。 
（2）在弹出的 Add Sensor 对话框中指定传感器的标题与变量名。 
（3）进入 Sensor 面板，如图 7-2 所示。Signal 标签用于定义描述监测事件的函数表达

式，这里支持常数、曲线、表达式和用户自定义 4 种定义方式。常数可以是位移、速度或加

速度值；曲线可以是由位移、速度或加速度曲线描述的驱动函数，使用曲线时需要指定曲线

插值方法以及独立变量名；表达式可以使用表达式编辑器创建求解器函数表达式。 

 
图 7-2  Sensor 面板 
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（4）进入 Compare To 标签。该标签用于定义传感器响应条件，Value 为传感器触发阈

值，Error 为触发阈值的容差。Response if 用于定义触发的类型。 
（5）进入 Response 标签。该标签用于传感器触发后执行任务。 

7.2  仿真脚本 

MotionView 提交求解作业时，除了使用 Run 面板设置求解参数外，还可以创建仿真脚

本。仿真脚本是一系列求解指令，在仿真过程中，求解器通过调用求解指令完成对模型或求

解参数的修改。一个典型的应用是一次仿真分析中模拟飞机起落架在飞机起飞、平稳飞行以

及降落过程中的收放运动。起落架模型如图 7-3 所示。下述脚本描述了起落架的运动过程。 

<Deactivate    
 element_type = "MOTION"    
 element_id   = "{the_model.mot_2.idstring}"  
/> 
<Simulate 
    analysis_type       = "Transient" 
    end_time            = "5.0" 
    print_interval      = "0.01" 
 /> 
<Deactivate    
 element_type = "MOTION"    
 element_id   = "{the_model.mot_0.idstring}" 
/> 
<Activate    
 element_type = "MOTION"    
 element_id   = "{the_model.mot_2.idstring}" 
/> 
<Simulate 
    analysis_type       = "Transient" 
    end_time            = "10.0" 
    print_interval      = "0.01" 
 /> 
<STOP/> 

 

图 7-3  起落架模型 

收起运动作用的旋转副

伸展运动作用的平移副
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整个脚本由 5 个数据块构成，每个数据块的含义如下。 
●  数据块 1：失效起落架的伸展驱动函数。 
●  数据块 2：运动学仿真模拟起落架的收起动作。 
●  数据块 3：失效起落架的收起驱动函数。 
●  数据块 4：激活起落架的伸展驱动函数。 
●  数据块 5：运动学仿真模拟起落架的伸展动作。 
仿真脚本中常用的关键字解释如下： 
（1）Activate（激活）。 
Activate 用于激活模型中失效的对象，激活的对象在后续仿真过程中将成为系统的一个

组成部分。该关键字调用语法如下： 

<Activate 
element_type    = "string" 
element_id      = "integer" 
/> 

其中，element_type 为待激活对象的类型，表 7-1 描述了可应用的对象；element_id 指

待激活对象的编号，可直接只用对象编号，也可使用对象的编号变量。例如，以下两种用法

均是正确的： 
●  element_id = "301001" 
●  element_id = "{the_model.j_1.idstring}" 

表 7-1  激活/失效功能控制的对象 

关  键  字 对 象 名 称 关  键  字 对 象 名 称 

"BEAM" 梁单元 "FIELD" 场力单元 

"BUSH" 线性衬套单元 "FORCE" 集中力/力矩单元 

"CONTACT" 接触约束 "FRICTION" 摩擦力单元 

"COUPLER" 耦合约束 "GEAR" 齿轮约束 

"CVCV" 曲线-曲线约束 "GFORCE" 矢量力/力矩 

"CVSF" 曲线-曲面约束 "GSE" 状态方程 

"DIFF" 微分方程 "JOINT" 约束副 

"PTDCV" 点—变形线约束 "JPRIM" 基本副 

"PTDSF" 点—变形面约束 "PTSF" 点—面约束 

"MATE" 广义耦合约束 "NFORCE" 多点作用力 

"MFORCE" 模态力 "VTORQUE" 矢量力矩 

"MOTION" 驱动 "PTCV" 点—曲线约束 

"SENSOR" 传感器 "SPDP" 弹簧阻尼单元 

"SFORCE" 标量力/力矩 "TFSISO" 单入单出控制单元 

"SFSF" 曲面-曲面约束 "UCON" 用户自定义约束 

"VFORCE" 矢量力 "YFORCE" 状态方程力 

（2）Deactivate（失效）。 
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Deactivate 用于失效模型中活动的对象，失效的对象在后续仿真过程中不起任何作用。

该命令与 Activate 用法类似。 
（3）Simulate（仿真）。 
Simulate 用于定义仿真参数。其调用格式如下： 

<Simulate 
    analysis_type       = "Static/Transient/Linear/Static+Transient/Static+Linear" 
    end_time          = " real " 
print_interval = " real " 
print_increment= "integer " 
    num_steps    = "integer " 
    print_array_id     = "integer " 
    restart_array_id    = "integer " 
 /> 

其中，analysis_type 用于指定仿真类型；end_time 定义仿真终止时间；print_interval 指

定结果输出间隔；print_increment 定义结果输出的积分步，print_increment=1 表示每一积分

步输出，print_increment=n 表示每 n 步积分输出一次结果；num_steps 表示最大初始步长；

print_array_id 用于调用包含输出时间步的矢量；restart_array_id 用于调用定义积分器重启动

时间步的矢量。 
（4）Stop（终止仿真）。 
脚本最后的 Stop 命令用于终止仿真。 

7.3  实例 

7. 3.1  滑杆序列运动仿真 

本实例将学习以下内容： 
●  建立标记点并在标记点之间建立失效状态的固定副。 
●  定义传感器，在两个标记点距离靠近至重叠时，激活固定副。 
●  通过 Templex 工具创建仿真脚本。 
在练习开始前，首先将目录 chap07 下的 Sequential_Simulation.mdl 文件复制到工作文件

夹中。 

创建铰链、标志点和传感器 

（1）新建一个 MotionView 会话。 
（2）在标准工具栏中单击 Open Model 按钮 ，或在下拉菜单中选择 Open→Model 命

令，打开工作文件夹下的 Sequential_Simulation.mdl 文件。该模型中包含 Slider 和 Picker 的

两个几何体。为了完成本节的练习，还需要在模型中创建铰、标记点和传感器，并使用

 STEP 

01 
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Templex 创建仿真脚本。Slider-Picker 模型如图 7-4 所示。 

 

图 7-4  Slider-Picker 模型 

（3）在模型浏览树中右击 The Model，选择 Add Constraint→Joint 命令，在 Type 中选择

Translational Joint，指定标题（Label）为 Slider Trans。 
（4）在 Joint 面板中选择 slider 作为 Body 1，选择 Ground Body 作为 Body 2，指定 slider 

cg 为 Origin，并通过 slide end 点定义该平移铰的方向，如图 7-5 所示。 

 

图 7-5  Joint 面板（平移铰） 

（5）使用类似的方法，在模型中创建另一铰链。该铰的类型为固定铰（fixed joint），指

定标题为 picker rest fix。 
（6）在 Joint 面板中，选择 picker 作为 Body 1，选择 Ground Body 作为 Body 2，指定

part fix 为 Origin，如图 7-6 所示。 

 

图 7-6  Joint 面板（固定铰） 

在完成了 Slider 和 Ground Body 之间固定铰定义后，还需要在模型中定义两个标记点，

这两个标记点分别与模型中的两个几何体相关联，且在初始状态下不重叠。在仿真求解的过

程中，随着这两个几何体的相对运动，标记点逐渐靠近直至重合，重合的瞬间，两个标记点

之间的虚拟固定铰将被激活，从而使用虚拟固定铰将两个物体连接在一起。注意，此类铰的

定义无法在 MotionView 界面中完成，需要使用 Templex 对其进行定义。 
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（7）在模型浏览树中右击 The Model，选择 Add Reference Entity→Marker 命令，或右击

Marker 按钮 ，新建标题为 Marker Slider Track 的标记点，并按图 7-7 所示的内容指定

Marker 相关参数。 

 

图 7-7  Marker 面板（步骤 7） 

（8）使用类似的方式，建立标题为 Marker Picker Track 的标记点，并按图 7-8 所示的内

容指定 Marker 相关参数。 

 

图 7-8  Marker 面板（步骤 8） 

（9）在模型浏览树中右击 The Model，选择 Add Control Entity→Sensor 命令，或在工具

栏中右击 Sensor 按钮 ，使用默认标题与变量名，新建一个传感器。 
（10）在 Signal 一栏中，将 Sensor 的类型设置为表达式 Expression 类型。 
（11）激活 Expression 文本框后，单击按钮 ，进入表达式编辑器。 
（12）将光标置于“`”符号内，然后进入 Motion 标签，单击 DM 按钮，此时文本框将

填入 DM 函数。 
（13）进入 Properties 标签，单击 Markers 文件夹，展开 Marker Slider Track 内容，然后

单击 idstring 将其添加到文本框中。 
（14）类似地，将 Marker Picker Track 的 idstring 添加到文本框中，完整的表达式如下： 

`DM（{m_0.idstring}，{m_1.idstring}）`。 

该表达式将测量 m_0 和 m_1 之间的距离，这里使用标记点的编号来引用标记。m_0 和

m_1 分别是步骤（5）和步骤（6）创建的标记点的变量名。 
（15）单击 OK 按钮，返回传感器面板。 
（16）在 Compare to 一栏的 Value 中填入 0.0010，在 Error 一栏中输入 0.0010。将

Respond if 设置为 Abs（Signal） is less than or equal to VALUE+ERROR。 
（17）在 Response 一栏中，激活 Return to Command File 选项。 
在求解过程中，如果达到传感器的触发条件，则求解将中断并回到脚本文件。 
（18）在模型浏览树中右击 The Model，选择 Add Constraint→Motion 命令，或右击工具

栏中 Motion 按钮 ，使用默认的标题与变量名创建驱动。 
（19）根据图 7-9 所示的内容定义驱动。 
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图 7-9  Motion 面板 

通过 Templex 工具，在两个标记点间建立虚拟固定铰 

在这一步中将在两个标记点之间建立虚拟固定铰。该铰在初始状态下处于失效状态，当

且仅当两个标记点的距离在运动过程中变为 0 时，该铰方被激活。 
（1）在模型浏览树中右击 The Model，选择 Add General MDL Entity→Template 命令，或

在工具栏中右击 Template 按钮 。 
（2）在 Label 中输入 Fixed Joint Defn，创建虚拟固定铰。 
（3）在 Template 面板中的 Type 下拉列表中，选择 Write text to solver input deck。输入以

下文本，注意文本格式和语序： 

<Constraint_Joint 
id                 = "5000" 
type               = "FIXED" 
    i_marker_id      = "{m_0.idstring}" 
    j_marker_id      = "{m_1.idstring}" 
/> 

（4）输入完毕后，该面板的形式应如图 7-10 所示。 

 

图 7-10  定义虚拟固定铰 

通过 Templex 工具，定义序列求解脚本 

在这一步中，将定义序列求解脚本： 
●  定义输出结果请求。 
●  在初始状态下，将两个标记点之间的虚拟固定铰设置为失效状态。 
●  进行 3.5s 的瞬态分析。 

 STEP 

02 

 STEP 

03 
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●  当两个标记点（Slider 和 Picker）重合时，激活虚拟固定铰。 
●  失效 Picker 和 Ground 之间的固定铰。 
●  失效已经完成功能的传感器单元。 
●  再进行 5s 的瞬态分析。 
（1）在模型浏览树中右击 The Model，选择 Add General MDL Entity→Template 命令，或

在工具栏中右击 Template 按钮 ，使用默认标题与变量名创建脚本。 
（2）在 Template 面板中的 Type 下拉列表中，选择 Write text to solver command file。 
（3）在 Template 编辑窗口中，输入以下语句： 

<ResOutput 
    plt_angle           = "YAW_PITCH_ROLL" 
 /> 
 <ResOutput 
    mrf_file            = "TRUE" 
 /> 
 <ResOutput 
    plt_file            = "TRUE" 
 /> 
 <H3DOutput 
    switch_on           = "TRUE" 
    increment           = "1" 
 /> 
 <ResOutput 
    abf_file            = "TRUE" 
 /> 
 <Deactivate 
   element_type = "JOINT" 
   element_id   = "5000" 
/> 
<Simulate 
    analysis_type       = "Transient" 
    end_time            = "3.5" 
    print_interval      = "0.01" 
/> 
<Deactivate 
   element_type = "JOINT" 
   element_id   = "{the_model.j_1.idstring}" 
/> 
<Deactivate 
   element_type = "SENSOR" 
   element_id   = "{the_model.sen_0.idstring}" 
/> 
<Activate 
   element_type = "JOINT" 
   element_id   = "5000" 
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/> 
<Simulate 
    analysis_type       = "Transient" 
    end_time            = "5." 
    print_interval      = "0.01" 
/> 
<Stop/> 

递交求解并进行结果后处理 

（1）单击 Run 按钮 ，进入 Run 面板。 
（2）选中 Export MDL snapshot，可保存当前会话中的 MDL 模型。 
（3）单击 Save As 栏的“文件浏览”按钮 ，为输出文件命名。 
（4）在 Simulation Parameter 标签中，将计算终止时间 End Time 设置为 5，并定义 Print 

Interval 为 0.01。 
（5）在 Transient 标签中，将积分类型 Intergrator type 设置为 DSTIFF。 
（6）返回 Main 标签，单击 Run 按钮。 
（7）求解结束后，单击 Main 标签中的 Animate 按钮进入 HyperView 后处理界面。 
（8）单击“动画播放”按钮 和“停止播放”按钮 ，查看机构运动状态，如图 7-11

所示。 

 
a） 

 
b） 

 
c） 

图 7-11  机构运动状态 

a） 初始时刻  b） Slider 和 Picker 重合  c） Slider 和 Picker 一起运动 

7. 3.2  吊杆序列运动仿真 

本练习将学习以下内容： 
●  应用 Templex 创建虚拟旋转铰。 
●  定义传感器检测吊杆运动状态。 
●  创建序列仿真脚本。 
本练习中使用的吊杆模型如图 7-12 所示。 

 STEP 
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图 7-12  吊杆模型 

创建吊杆模型 

（1）新建一个 MotionView 会话。 
（2）在 Model-Reference 工具栏中的 Point 按钮 处右击，在弹出的 Add Point or 

Pointpair 对话框中使用默认标题与变量名创建 5 个几何点，点坐标如表 7-2 所示。 

表 7-2  点坐标 

名    称 变  量  名 X Y Z 

Point 0 p_0 0 0 0 

Point 1 p_1 50 0 0 

Point 2 p_2 100 0 0 

Point 3 p_3 200 0 0 

Point 4 p_4 300 0 0 

（3）在 Model-Reference 工具栏中的 Graphic 按钮 处右击，在弹出的 Add Graphic or 
GraphicPair 对话框中 Label 文本框中输入 Ground，使用默认的变量名，指定 Type 为

Single、图形类型为 Cylinder，单击 OK 按钮创建图形。 
（4）在 Graphic 面板中，激活 Connectivity 标签，单击 Body 按钮，在图形区单击全局坐

标系，指定该图形所从属的体为 Ground Body，指定 Origin 和 Direction 分别为 Point 0 和

Point4，如图 7-13 所示。 

 

图 7-13  Graphic 面板（步骤 4） 

（5）进入 Graphic 面板的 Properties 标签，将 Radius 1 修改为 1.0。 
Ground 图形用于后处理中查看吊杆在空间中的运动状态。 
（6）在 Model-Reference 工具栏中的 Body 按钮 处右击，在弹出的 Add Body or 

BodyPair 对话框中的 Label 文本框中输入 suspender，使用默认的变量名，指定 Type 为

Single，单击 OK 按钮创建吊杆。 

 STEP 
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（7）在 Body 面板中，激活 Properties 标签，定义吊杆属性，如图 7-14 所示。 

 

图 7-14  Body 面板 

（8）进入 CM Coordinates 标签，激活 Use center of mass coordinate system 选项，指定

Origin 为 Point 1。 
（9）在 Model-Reference 工具栏中的 Graphic 按钮 处右击，在弹出的 Add Graphic or 

GraphicPair 对话框中的 Label 文本框中输入 suspender，使用默认的变量名，指定 Type 为

Single、图形类型为 Cylinder，单击 OK 按钮为吊杆创建图形。 
（10）在 Graphic 面板中，激活 Connectivity 标签，单击 Body 按钮，在图形区单击步骤

（6）创建的吊杆，指定 Origin 和 Direction 分别为 Point 0 和 Point 2，如图 7-15 所示。 

 

图 7-15  Graphic 面板（步骤 10） 

（11）进入 Graphic 面板的 Properties 标签，将 Radius 修改为 5.0。图形创建完毕应如图

7-16 所示。 

 

图 7-16  吊杆模型 

（12）在 Model-Constraint 工具栏中的 Joint 按钮 处右击，在弹出的 Add Joint or 
JointPair 对话框中使用默认的标题与变量名，指定 Type 为 Single、铰类型为 Revolute Joint，
单击 OK 按钮创建旋转铰。 

（13）在主面板的 Joint 面板中激活 Connectivity 标签，单击 Body 1 按钮，在图形区单击

步骤（6）创建的吊杆。单击 Body 2，在图形区单击 Ground 图形，此时该图形代表大地。指

定 Origin 为 Point 2，切换旋转铰的指向方式为 Vector，单击图形区的全局坐标系 z 轴。完成

定义的 Joint 面板如图 7-17 所示。 
（14）在模型浏览树中右击 The Model，选择 Add Control Entity→Sensor，或在工具栏中

右击 Sensor 按钮 ，使用默认标题与变量名，新建一个传感器。 
（15）在 Signal 一栏中，将 Sensor 的类型选取为表达式 Expression 类型。 
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图 7-17  Joint 面板 

（16）单击 按钮，进入表达式编辑器。 
（17）将光标置于“`”符号内，然后进入 Motion 标签，单击 DX 按钮，此时文本框将

填入 DX 函数。 
（18）进入 Properties 标签，单击 Bodies 文件夹，展开 suspender 内容，然后单击 Marker 

CM idstring 将其添加到文本框中。注意到 Add 文本框中 Marker 编号没有估值，这是因为新

建的对象还没有分配编号，选择 Tool→Check Model 命令即可完成对象编号操作。完整的表

达式为`DX（{b_0.cm.idstring}）`，如图 7-18 所示。 

 

图 7-18  表达式编辑器 

（19）在 Compare to 一栏的 Value 中输入 150.0，在 Error 一栏中输入 0.010。将 Respond 
if 设置为 Signal is greater than VALUE -ERROR。 

（20）在 Response 一栏中，选择 Return to Command File。 
（21）在求解过程中，如果达到传感器的触发条件，则求解将中断并回到脚本文件。 
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应用 Templex 工具创建虚拟旋转副 

在完成了模型的基本定义后，还需要在模型中定义两个标记点，这两个标记点分别与模

型中的两个 Body 相关联，且在初始状态下并不处于重合状态。在仿真求解的过程中，随着

这两个 Body 的相对运动，标记点逐渐靠近直至重合，重合的瞬间，两个标记点之间的旋转

副将被激活，从而使用旋转副将两个物体连接一起。注意，此类 Joint 的定义无法在

MotionView 界面中完成，需要使用 Templex 定义。 
（1）在模型浏览树中右击 The Model，选择 Add Reference Entity→Marker 命令，或右击

Marker 按钮 ，新建标题为 Marker suspender 的标记点，并按图 7-19 所示的内容指定

Marker 相关参数信息。 

 

图 7-19  Marker 面板（步骤 1） 

（2）使用类似的方式，建立标题为 Marker Ground 的标记点，并按图 7-20 所示的内

容，指定 Marker 相关参数。 

 

图 7-20  Marker 面板（步骤 2） 

（3）在这一步中将在两个标记点之间建立旋转铰。该旋转铰在初始状态下处于失效状

态，当且仅当两个标志点的距离在运动过程中变为 0 时，该旋转铰方被激活。在模型浏览树

中右击 The Model，选择 Add General MDL Entity→Template 命令，或在工具栏中右击

Template 按钮 。 
（4）在 Label 中，输入 Revolute。在 Type 下拉列表中，选择 Write text to solver input 

deck。输入以下文本，注意格式和语序： 

<Constraint_Joint      
id                  = "301003"  
type                = "REVOLUTE"  
           i_marker_id         = "{m_0.idstring}"  
           j_marker_id         = "{m_1.idstring}"  
  /> 

 STEP 

02 
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文本中使用标记点的编号来引用标记。m_0 和 m_1 分别是步骤（1）和步骤（2）创建

的标记点的变量名。 
（5）输入完毕后，该面板应如图 7-21 所示。 

 

图 7-21  虚拟旋转铰 

通过 Templex 工具，定义序列求解脚本 

在这一步中，将定义序列求解脚本： 
●  定义仿真参数与输出结果请求。 
●  在初始状态下，将两个标记点之间的虚拟旋转铰设置为失效状态。 
●  进行 1s 的瞬态分析。 
●  当两个标记点重合时，激活虚拟旋转铰。 
●  失效 suspender 和 Ground 之间的原始旋转铰。 
●  失效已经完成功能的传感器单元。 
●  再进行 1s 的瞬态分析。 
（1）在模型浏览树中右击 The Model，选择 Add General MDL Entity→Template 命令，或

在工具栏中右击 Template 按钮 ，使用默认标题与变量名创建仿真脚本。 
（2）将其类型设置为 Write text to solver command file。 
（3）在 Template 编辑窗口中，输入以下语句： 

<H3DOutput 
     switch_on           = "TRUE" 
increment           = "1" 
     start_time          = "0." 
     end_time            = "9999999." 
     format_option       = "AUTO" 
     stress_option       = "TENSOR" 
     strain_option       = "TENSOR" 
  /> 
<Param_Simulation 
constr_tol          = "1.0000E-10" 
     implicit_diff_tol   = "1.0000E-06" 
  /> 
<Param_Transient 
     integr_tol          = "0.0001" 
     integrator_type     = "DSTIFF" 

 STEP 

03 
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     h_max               = "0.01" 
     h0_max              = "0.001" 
  /> 
<Deactivate 
     element_type        = "JOINT" 
     element_id          = "301003" 
  /> 
<Simulate 
     analysis_type       = "Transient" 
     end_time            = "1." 
     print_interval      = "0.01" 
  /> 
<Deactivate 
     element_type        = "JOINT" 
     element_id          = "301001" 
  /> 
<Deactivate 
     element_type        = "SENSOR" 
     element_id          = "301001" 
  /> 
<Activate 
     element_type        = "JOINT" 
     element_id          = "301003" 
  /> 
<Simulate 
     analysis_type       = "Transient" 
     end_time            = "1." 
     print_interval      = "0.01" 
  /> 
<Stop/> 

递交求解并进行结果后处理 

（1）在模型浏览树展开 Form 文件夹，单击 Gravity，在弹出的 Gravity 面板中修改当前

模型重力方向为 y 方向，重力加速度为-9810.0。 
（2）单击 Run 按钮 ，进入 Run 面板。 
（3）选中 Export MDL snapshot 复选框，可保存当前会话中的 MDL 模型。 
（4）单击 Save As 栏的“文件浏览”按钮 ，为输出文件命名。 
（5）在 Simulation Parameter 标签中，将计算终止时间 End Time 设置为 5，并定义 Print 

Interval 为 0.01。 
（6）在 Transient 标签中，将积分类型 Intergrator type 设置为 DSTIFF。 
（7）返回 Main 标签，单击 Run 按钮。 
（8）求解结束后，单击 Main 标签中的 Animate 按钮进入 HyperView 后处理界面。 

 STEP 

04 
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（9）单击“动画播放”按钮 和“停止播放”按钮 ，查看机构运动状态。图 7-22 显

示了吊杆的运动轨迹。 

 

图 7-22  吊杆运动轨迹 

7.4  小结 

MotionView 仿真脚本为用户提供了一个更加高级的仿真控制工具。应用仿真脚本，用

户可控制 MotionSolve 按照一套预先设置好的仿真参数，反复进行仿真分析，实现复杂的机

构运动过程。这其中一个必不可少的工具即是传感器。通过传感器对机构运动状态的感知，

为仿真过程的分段控制提供了可能。本章通过功能介绍与应用结合的方式详细描述了

MotionView 仿真脚本与传感器的使用方法，相信读者学习完本章后，会对序列仿真有更加

深入的了解，并且能够在实际工作中加以应用。 



 

 

第 8章     

 机构优化设计 

本章主要介绍 MotionSolve 联合系统优化求解器 HyperStudy 和结构优化求解器 OptiStruct

进行机构优化设计的基本方法，描述了 HyperStudy 的工作流程，阐述了 OptiStruct 等效静态

载荷法的基本原理及其使用方法，最后通过实例说明两种优化方法的实现过程。通过本章的学

习，用户可以根据实际需要进行机械系统零件级或系统级的优化设计。 

本章重点知识 
 
 

8.1  优化设计方法 

8.2  MotionSolve 联合 HyperStudy 进行系统级优化 

8.3  MotionSolve 联合 OptiStruct 进行零件级优化 

8.4  实例 

8.5  小结 
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8.1  优化设计方法 

随着仿真技术的发展，工程师们已不再满足于使用仿真工具完成简单的分析任务，而将

精力逐渐转移到更高的层次——优化设计上。优化设计反映出人们对于设计规律这一客观世

界认识的变化，设计上的“最优值”是指一定条件下所能得到的最佳设计值。最优值是一个

相对概念，在大多数情况下，可以使用最大值或最小值来表示。 
概括起来，优化设计的工作包括以下两部分内容： 
●  将实际设计问题的物理模型抽象为数学模型。建立数学模型时要选取设计变量、列

出目标函数、给出约束条件。目标函数是设计问题所需求的最优指标与设计变量之

间的函数表达式。 
●  选取适当的最优化算法求解数学模型，也即在给定的条件下，求目标函数的极值或

最优值问题。 

8. 1.1  设计变量 

在设计过程中进行选择，并最终必须确定的各项独立的参数称为设计变量或优化

参数。 
在选择过程中它们是变量，但这些变量一旦确定后，设计对象也就完全确定了。最优化

设计的实质就是研究怎样合理地选择这些设计变量。 
机械设计中常用的独立参数有总体的布置尺寸、构件的几何尺寸、材料的力学性能

和物理特性等。这些参数中，凡是可以根据设计要求事先给定的，就不是设计变量，而

是设计常量，只有那些需要在设计过程中优选的参数，才可作为最优设计过程中的设计

变量。 
在实际问题中，设计变量可分为两类：一类是连续变化的设计变量；另一类是离散变化

的设计变量，如齿轮的齿数、管材的壁厚等。 
设计变量的个数称为优化设计的维数，如有 n 个设计变量则称为 n 维设计问题，设计变

量可用 n 维向量表示： T
1 2 3（ ， ， ）nX = x ，x ，x x… 。通常设计变量的个数 n>3 时，很难用图像表

示，设计空间只能想象为一个抽象 n 维超越空间。当以这种 n 个独立变量为坐标组成的 n 维

向量空间是一个 n 维实空间时，用 Rn 表示。如果其中任意两向量具有内积计算，则称 n 维

欧式空间，用 En表示。 

8. 1.2  约束条件 

机械设计中的设计变量 xi 不能任取，一般总要受到某些条件的限制，这些限制条件就是

设计的约束条件。每一个约束条件用设计变量或它的函数表示，故又称为约束函数。 
设计变量的约束分为边界约束和性能约束。边界约束是指设计变量取值范围的界限，如

机械设计中的杆长度取值的上下限、齿轮最小和最大齿数限制范围等。有些设计变量，如长

度、重量等，取正值才有实际意义。性能约束是指对机械工作性能上要求的限制条件，如零
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件的强度、刚度或振动频率的允许范围等。 
机械优化设计的约束函数大部分是不等式的，也有等式的。不等式、等式的约束函数一

般表示形式为 
（ ） 0 （ 1， 2， ， ）ug X  u = m…≤  

或                           （ ） 0 （ 1，2， ， ）ug X   u = m…≥  
和                           （ ） 0 （ 1，2， ， ）vh X =    v = p < n…  

这 3 种形式都可以处理成统一的形式： （ ） 0 ug X ≤ ，因为 （ ） 0ug X− ≤ 可用来代替

（ ） 0ug X ≥ ；而 （ ） 0vh X = 可用两个不等式约束函数 （ ） 0vh X ≤ 和 （ ） 0vh X− ≤ 来代替。等式约

束中 p<n 的含义是等式约束条件数目应小于设计变量数。理论上，一个等式约束可以消去一

个设计变量，目标函数降一维。由此若 p≥ n，即等式约束条件数等于或多于设计变量，显

然是没有实际意义的。因此，只能取 p<n。 
设计空间中满足所有约束条件的区域称为可行域，可行域之外的区域则为非可行域。优

化设计中，只有位于可行域的设计方案才是可行的设计方案。对于无约束优化设计问题，因

为没有约束条件，自然就不存在可行域和非可行域。 

8. 1.3  目标函数 

在无约束优化问题的设计空间或在约束优化问题的可行域中，都有无数可行设计方案供

设计者选择。优化设计的目的在于从一切可能的方案中选出一个最优的方案来，这就需要一

个衡量设计方案的标准。在机械设计中，结构尺寸、重量、强度、承受载荷的能力等根据设

计的要求都可作为衡量设计变量优劣的标准。 
优化设计把设计变量与某种衡量标准的关系用函数式表达出来，寻找使函数值最小（或

最大）的一组设计变量，从而获得一个最优设计方案。这个函数称为目标函数，它是以设计

变量为自变量，以要求的某种目标为因变量，按一定的关系所建立的用以评价设计方案优劣

的数学表达式，一般表述为 1 2 3（ ）= （ ， ， ， ， ）nf X f x x x x… 。 
在优化设计中，若寻找目标函数最小值可写为

R
min （ ）

nx
f X

∈
，寻找目标函数最大值可写为

R
max （ ）

nx
f X

∈
，由于

R
max （ ）

nx
f X

∈
和

R
min （ ）

nx
f X

∈
− 等价，因此一般统一写为

R
min （ ）

nx
f X

∈
。 

在工程设计优化问题中，目标函数多种多样，由一个评价标准或一个目标建立的目标函

数称为单目标函数。如果同时兼顾多个评价标准，由此建立的目标函数称为多目标函数，或

称多目标优化问题。 

8.2  MotionSolve 联合 HyperStudy 进行系统级优化 

8. 2.1  HyperStudy 简介 

HyperStudy 是一款 CAE 环境下的试验设计、优化、随机性研究工具，适用于研究不同变

化条件下设计变量的特性以及多学科优化设计。HyperStudy 紧密集成在 HyperWorks 软件平台

中，通过 MotionView、HyperMesh 等应用程序可直接进入 HyperStudy，同时 HyperStudy 可



MotionView & MotionSolve 
应用技巧与实例分析 

 270 

直接获得应用程序中的数据并将其转换为设计变量。HyperStudy 后处理模块提供了结果显

示、数据分析以及数据挖掘功能，帮助用户从大量的研究计算中提取有效信息，高效完成对

特定系统的研究工作。 

1.试验设计 

DOE 又称试验设计，通过计算不同参数组合的模型研究设计变量间的交互作用及设计

变量对系统性能的影响，以减少实际试验次数，节省人力物力和时间。正确合理的试验设计，

可使试验结果的可靠性显著提高。试验设计还可以为寻求参数的优化数值和选择最佳工艺方案

指明方向。HyperStudy 不但可以使用预定义的 DOE 方法，还支持用户自定义 DOE 方法。 

2.近似模型 

根据试验设计分析结果，HyperStudy 可获得描述模型响应的关于设计变量的代数或数值

方程。这些方程也称为响应面，是模型真实响应的近似。模型的响应面一经产生，就被作为

整个精确求解方程的近似表达式。新的设计变量的组合不再用于原来的求解过程中，而是被

插入响应面方程以快速估算模型的响应，不需要实际运算整个分析。 

3.优化研究 

优化研究用于寻找参数的最佳设定，以满足一定数目约束下的特定目标最大化（最小化

或趋近设定值）。利用 HyperStudy 的向导系统定义设计参数，从求解的模型结果中提取数据

来定义作为响应，再把响应分别定义为约束和目标进行优化研究。利用其提供的优化引擎，

将求解器或响应面方程纳入优化计算循环，不断调整在求解模型文件中设定的参数值，求解

模型，然后比较每一次的响应计算结果，从而完成优化循环。它联合多种外部求解器进行线

性和非线性优化分析，如耐撞性设计、多体动力系统模拟、金属成形模拟、计算流体动力学

问题以及多学科问题。 

4.随机性研究 

随机性分析用于研究在一个设计中包含不确定设计变量的特定响应的随机分布特性，用

于稳健性设计。HyperStudy 采用蒙特卡罗法进行随机分析，并且提供了多种抽样方法。随机

分析研究采用精确的求解器或 DOE 研究中的响应面算法。 
应用HyperStudy 强大的试验设计、随机性研究、优化设计功能，用户可以进行以下研究： 
●  快速洞悉设计方案的物理性能。 
●  评估设计变量中可控或非可控因素的稳健性。 
●  实现多学科优化设计。 

8. 2.2  HyperStudy 工作流程 

HyperStudy 导向式架构由 Study setup、DOE study、Approximation、Optimization study
和 Stochastic study 五个模块构成，如图 8-1 所示。每完成一步，流程树将使用绿色的勾号标

识，并引导用户进入下一步，当模块内所有步骤前均打上绿色勾号时，表明该模块的研究工

作完成。 
HyperStudy 界面中各模块的功能及工作流程描述如下。 
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图 8-1  HyperStudy 用户界面及导向式架构 

1.定义模型 

Study setup 模块用于定义研究的模型，DOE study、Optimization study与Stochastic study模
块的研究均建立在该模块定义的模型之上。因此，不管后续的研究类型是什么，首先需要完

成模型定义。Study setup 模块由以下步骤组成。 
●  Create studies：创建研究任务。 
●  Create models：创建研究模型。 
●  Create design variables：创建设计变量。 
●  Do nominal run：进行模型的初始计算。 
●  Create responses：根据初始计算结果创建响应。 
●  Link design variables：建立设计变量间关系式。 
●  Sensitivity：定义响应的灵敏度，这些灵敏度（一般为解析灵敏度）将取代 HyperStudy

使用有限差分方法计算的灵敏度，进行系统优化研究（如 SQP 优化算法）。 
图 8-2 描述了 Study setup 模块的工作流程。 

创建研究任务

创建研究模型

定义设计变量

初始计算

创建响应

关联设计变量

转向试验设计、优化

研究或随机性研究

创建输入

提交求解器

分析结果

 
图 8-2  Study setup 模块的工作流程 
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在 HyperStudy 中，多体系统模型设置可通过以下两种方法实现。 
（1）Template：使用 HyperStudy 模板文件。使用 HyperStudy 的 Create Template 工具根

据 ASCII 格式的模型文件创建模板文件，然后 Templex 工具使用设计变量替换模板文件中的

数值，并保存为求解器输入文件。 
（ 2）MotionView：使用 MotionView MDL 数据文件，此时 HyperStudy 必须从

MotionView 界面启动，并且在研究过程中 MotionView 要保持打开状态。通过 MDL 模型树

查找并定义设计变量。MotionView 使用设计变量替换 MDL 模型中的数值并输出求解器输入

文件，这里支持的求解器有 MotionSolve、Adams、Simpack、DADS、Abaqus、NASTRAN 等。

图 8-3 描述了使用 Template 和 MotionView 方式创建研究模型的流程。表 8-1 描述了 MotionView 
MDL 数据文件中可用于定义设计变量的参数。 

原始求解器

输入文件

Templex

求解器输入文件

输入

MDL数据文件

MotionView

求解器输入文件

输入

 
a）                                            b） 

图 8-3  求解器输入文件创建流程 

a） 使用 Template  b） 使用 MotionView 

表 8-1  MotionView MDL 数据文件中可用于定义设计变量的参数 

对    象 变  量  名 描    述 

fx，fy，fz/l.fx，l.fy，l.fz/r.fx，r.fy，r.fz 作用力 

tx，ty，tz/l.tx，l.ty，l.tz/r.tx，r.ty，r.tz 作用力矩 

f/l.f/r.f 反作用力 

ActionOnlyForce （and Pair）， 
ActionReactionForce （and Pair） 

t/l.t/r.t 反作用力矩 

AdvancedJoint ic_x_disp/ic_y_disp/ic_z_disp x/y/z 轴初始位移 

len/l.len/r.len 梁长 

E/l.E/r.E 弹性模量 

G/l.G/r.G 剪切模量 

Area/l.area/r.area 梁横截面积 

Ixx/l.Ixx/r.Ixx 关于 x 轴转动惯量 

Iyy/l.Iyy/r.Iyy 关于 y 轴转动惯量 

Izz/l.Izz/r.Izz 关于 z 轴转动惯量 

asy/l.asy/r.asy y 轴剪切变形修正系数 

asz/l.asz/r.asz z 轴剪切变形修正系数 

Beam （and Pair） 

ratio/l.ratio/r.ratio 阻尼比 
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（续） 

对    象 变  量  名 描    述 

mass/l.mass/r.mass 质量 

Ixx，Iyy，Izz/l.ixx，l.iyy，l.izz/r.ixx，r.iyy，r.izz 刚体转动惯量 Body （and Pair） 

Ixy，Iyz，Ixz/l.Ixy，l.Iyz，l.Ixz/r.Ixy，r.Iyz，r.lxz 刚体惯量积 

ctx，cty，ctz/l.ctx，l.cty，l.ctz/r.ctx，r.cty，r.ctz x/y/z 轴转动阻尼 

cx，cy，cz/l.cx，l.cy，l.cz/r.cx，r.cy，r.cz x/y/z 轴平动阻尼 

fx，fy，fz/l.fx，l.fy，l.fz/r.fx，r.fy，r.fz x/y/z 轴平动预载 

ktx，kty，ktz/l.ktx，l.kty，l.ktz/r.ktx，r.kty，r.ktz x/y/z 轴转动刚度 

kx，ky，kz/l.kx，l.ky，l.kz/r.kx，r.ky，r.kz x/y/z 轴平动刚度 

Bushing （and Pair） 

tx，ty，tz/l.tx，l.ty，l.tz/r.tx，r.ty，r.tz x/y/z 轴转动预载 

f/l.f/r.f 拉簧预载 

k/l.k/r.k 拉簧刚度 CoilSpring （and Pair） 

l/l.l/r.l 拉簧自由长度 

radius 接触对象中的球体半径 

stiffness 接触刚度 

damping 接触阻尼 

penalty 泊松接触算法中的惩罚系数 

Contact（Type Point To Deformable 
SurfaceContact） 
 

rest_coeff 泊松接触算法中的补偿系数 

ratio 耦合副连接的两个运动副间的位移比 
Coupler（and Pair） 

ratio1， ratio2 耦合副连接的 3 个运动副间的位移比 

DataSet value 数据组数值 

lambda_left/lambda_right 三次样条插值曲线端点条件 
Deformable Curve 

uspan 插值曲线范围 

Deformable Surface uspan/vspan 变形曲面 u、v 方向范围 

k 刚度矩阵（6×6） 

c 阻尼矩阵（6×6） 

cratio 阻尼比 

f 预载（6×1） 

Field 

length 自由长度（6×1） 

Joint （Type Screw） pitch 单位长度的螺纹头数 

Motion （and Pair） value/l.value/r.value 运动驱动量 

Point （and Pair） x，y，z/l.x，l.y，l.z/r.x，r.y，r.z 点坐标 

rho 多义梁质量密度 

E 弹性模量 

G 切变模量 

OD 多义梁横截面外径 

ID 多义梁横截面内径 

as 切变修正因子 

Polybeam 

cratio 阻尼比 
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（续） 

对    象 变  量  名 描    述 

SolverArray Value 求解器数列值 

SolverVariable value 求解器变量值 

ang/l.ang/r.ang 扭簧自由转角 

ct/l.ct/r.ct 扭簧阻尼 

ft/l.ft/r.ft 扭簧预载 
TorsionSpring （and Pair） 
 

kt/l.kt/r.kt 扭簧刚度 

Vector （and Pair） x，y，z/l.x，l.y，l.z/r.x，r.y，r.z 向量 3 个轴向分量 

注：表中 l.表示成对对象中，左侧对象的参数。 

2.DOE 研究 

DOE study 模块用于模型设计变量间相互作用及设计变量对系统性能影响的研究。该模

块由以下步骤组成。 
●  Create DOE study：创建 DOE 研究模型。 
●  Controlled variables：定义可控设计变量。 
●  Controlled interactions：定义是否计算可控设计变量间的交互作用。 
●  Controlled allocations：定义可控设计变量的试验设计矩阵。 
●  Uncontrolled variables：定义不可控设计变量。 
●  Uncontrolled interactions：定义是否计算不可控设计变量间的交互作用。 
●  Uncontrolled allocations：定义不可控设计变量的试验设计矩阵。 
●  Select responses：选择响应。 
●  Write/Execute runs：试验设计计算。 
●  Extract responses：提取响应结果。 
●  Post processing：试验设计后处理。 
图 8-4 描述了使用求解器进行试验设计的工作流程。 

模型定义

试验设计模型定义

输出试验设计

分析模型

求解模型

结果处理

创建近似模型

输入

求解器

分析结果

求解器求解

 

图 8-4  HyperStudy 试验设计的工作流程 
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3.近似模型 

近似模型可根据 DOE 和随机性研究结果创建。该模块由以下步骤组成。 
●  Create approximation：创建近似模型的数学模型。 
●  Input matrix：导入设计矩阵及相关结果。 
●  Validation matrix：导入验证矩阵及相关结果。 
●  Build approximation：构建近似模型。 
●  Residuals：残差对比。 
●  Trade-off：查看近似结果并进行参数调整。 
●  Anova：方差分析。 

4.优化研究 

Optimization study 模块可通过精确的求解器分析或近似响应面进行优化研究。该模块由

以下步骤组成。 
●  Create optimization study：创建优化研究模型。 
●  Define design variables：定义设计变量。 
●  Constraints：定义约束。 
●  Objectives：定义目标函数。 
●  Post processing：优化结果后处理。 
图 8-5 描述了 HyperStudy 优化研究的工作流程。 

模型定义

优化模型定义

优化求解

优化结果

求解器求解

输入

求解器

分析结果

模型定义

优化模型定义

优化求解

优化结果

求解器求解

近似模型估值

 
a）                                             b） 

图 8-5  HyperStudy 优化研究的工作流程 

a） 使用求解器 b） 使用近似响应面 

5.随机性研究 

Stochastic study 模块可通过精确的求解器分析或近似响应面进行优化研究。该模块由以

下步骤组成。 
●  Create stochastic study：创建随机性研究模型。 
●  Define random variables：定义随机变量。 
●  Define correlation：定义随机变量间的相互关系。 
●  Select responses：选择响应。 
●  Write/Execute runs：求解模型。 
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●  Post processing：随机性研究结果后处理。 
图 8-6 描述了 HyperStudy 随机性研究的工作流程。 

模型定义

随机性分析

模型定义

输出随机性

分析文件

求解器求解

输入

随机性分析

结果处理

求解器

结果

      

模型定义

随机性分析

模型定义

结果处理

求解器求解

近似模型估值

 
a）                                                b） 

图 8-6  HyperStudy 随机性研究的工作流程 

a） 使用求解器  b） 使用近似响应面 

8.3  MotionSolve 联合 OptiStruct 进行零件级优化 

结构优化技术在静态响应优化领域已经非常成熟，这里结构承受的外载都是静态力，而

非动态力。尽管在真实世界中，作用到结构上的载荷都是动态变化的，但在大多数工程问题

中，这些动态载荷都假定为静态载荷。这种假定来自于动态响应优化领域的两大难题：灵敏

度分析与动态约束处理。为解决这两项难题，韩国汉阳大学 Park 博士提出使用等效静态载

荷法（即将动态载荷转换为一组等效静态载荷集），然后使用等效静态载荷集产生的静态响

应完成结构在动态载荷作用的优化设计。该方法被 Altair 应用到 OptiStruct 结构优化技术

中，成功实现了多体系统零件级的结构优化。 

8. 3.1  等效静态载荷技术（ESL） 

等效静态载荷主要是用来代替动态载荷产生的效果，并且等效静态载荷对动态载荷效果

的替代不仅仅局限于单一工况。在动态载荷下，物体表现最明显的一个特征就是动态载荷所

造成的位移。因此，引入一个静态载荷，使物体在该静态载荷下变形形成的位移场同物体在

承受某一动态载荷时的位移场相同，即通过位移场等效原理引入等效静态载荷。事实上，等

效静态载荷已经被广泛应用于工程领域。在大多数工程实践中，等效静态载荷主要用来预测

某些关键部位的变形或位移情况，如桥梁中点的位移情况。在这些应用中，这些等效静态载

荷的时间信息已不是考虑对象，所考虑的仅仅是其数值的大小。以往，一般通过实验数据、

动载系数及其他经验方法来获取等效静态载荷。一直以来，对于等效静态载荷也没有明确的

概念。韩国学者 Kang BS 对其进行了总结，给出了等效静态载荷的明确定义并将其推广到更

广的应用领域。 
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等效静态载荷的定义：当结构承受动态载荷时，在某一时刻，结构发生变形从而形成一

个位移场。如果一个静态载荷能够产生相同的位移场，则称该静态载荷为这一动态载荷在某

一时刻的等效静态载荷。 
根据上面的定义，可通过有限元法得到等效静态载荷的计算公式。若不考虑阻尼，受动

态载荷结构的运动方程可以表达为 
（ ） （ ） （ ） （ ） （ ）M b y t K b y t r t+ =■■                    （8-1） 

式中， （ ）M b 为质量矩阵， （ ）K b 为刚度矩阵， （ ）y t 为位移， （ ）r t 为结构所受外力。式

（8-1）移项后可得： 
 （ ） （ ） （ ） （ ） （ ）K b y t r t M b y t= − ■■                     （8-2） 

根据位移场等效，所以静态载荷 eqf 为 

（ ） （ ） （ ） （ ） （ ）eqf K b y t r t M b y t= = − ■■                   （8-3） 

从式（8-3）中可以看出，等效静态载荷可以由外力和结构的惯性力求出。因此，等效

静态载荷是设计变量的隐函数。尽管外力是沿某个固定的方向作用在物体上，但由于惯性力

（ ） （ ）M b y t■■ 是不为零的，所以等效静态载荷可以是沿任意方向的。这样就可以更加精确地描

述出结构在某一时刻的受力情况。 
另外，根据式（8-3），等效静态载荷只有在对结构进行瞬态分析之后才能计算得到，也

就是说通过等效静态载荷计算的是已知的位移场。从这个角度来说，等效静态载荷对我们是

没有任何意义的。但是，这里研究的不是利用等效静态载荷来预测动态载荷产生的变形情

况，而是希望根据位移等效原理得到等效静态载荷，并将其应用于结构优化中。换句话说，

这里的等效静态载荷是以设计为导向的载荷而不是以分析为导向的载荷。接下来将介绍设计

为导向的载荷在动态响应优化领域的应用。 
类似地，等效惯性力可以定义为 

（ ） （ ） （ ） （ ） （ ）eqp M b y t r t K b y t= = −■■                  （8-4） 

该式将用于优化过程中加速度的定义。 

8. 3.2  ESL 优化流程 

目前，在离散的时域中求解式（8-1）是很容易实现的。在 u 时刻，等效静态载荷可以

在进行柔性多体动力学后求得： 

（ ） （ ） （ ）
（ ） （ ） （ ）

（ 1，2， ， ）

（ 1，2， ， ）

u
eq u u u

u
eq u u u

f K b y r t M b y u q

p M b y r t K b y u q

⎧ = = − =⎪
⎨

= = − =⎪⎩

■■ …

■■ …
             （8-5） 

式中，q 为采样时间点，即等效静态载荷的数目。 
大多数应用场合中不会引入速度约束，因此离散时间区域内的动态优化问题可表达为 

（ ）
（ ） （ ） （ ）

（ ）

min

s.t. （ 1，2， ， ）

， ， ， 0 （ 1，2， ， ； 1，2， ， ）
u u u

ju u u u

b

M b y K b y r t u q

g b y y y j m u q

ϕ

+ = =

= =

■■ …

■ ■■ … …≤
            （8-6） 
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根据等效静态载荷算法，使用一系列等效静态载荷重复进行静态响应优化来代替直接求

解式（8-6），则动态结构优化问题可以转化为 

（ ）
（ ）
（ ）

（ ）

min

s.t. （ 1，2， ， ）

（ 1，2， ， ）

， ， ， 0 （ 1，2， ， ； 1，2， ， ）

u
u eq

u
u eq

ju u u u

b

K b y f u q

M b y p u q

g b y y y j m u q

ϕ

= =

= =

= =

…

■■ …

■ ■■ … …≤

       （8-7） 

利用等效静态载荷法进行动态结构优化的算法如下： 
（1）赋初值 00， pp b b= = 。 

（2）将 pb 代入式（8-1）进行瞬态分析。 
（3）计算时域内的等效静态载荷 

（ ）
（ ）

（ 1，2， ， ）

（ 1，2， ， ）

u
eq p u

u
eq p u

f K b y u q

p M b y u q

⎧ = =⎪
⎨

= =⎪⎩

…

■■ …
                 （8-8） 

（4）若 0p = ，转到步骤（5）。若 0p > ，并且 

（ ） （ ）
1

1
q

u u
eq eq

u
f p f p ε

=

− − <∑                    （8-9） 

优化完成。 （ ）u
eqf p 是u 时刻，第 p 次循环的等效静态载荷矢量。 

（5）解决下列静态结构优化问题： 

（ ）
（ ）
（ ）

（ ）

1

1

1

1

1， 1， 1，

min

s.t. （ 1，2， ， ）

（ 1，2， ， ）

， 0 （ 1，2， ， ； 1，2， ， ）

（ 1，2， ， ）

p

u
p u eq

u
p u eq

ju p u

p kL p k p kU

b

K b z f u q

M b a p u q

g b z j m u q

b b b k n

ϕ +

+

+

+

+ + +

= =

= =

= =

=

…

…

… …

…

≤

≤ ≤

      （8-10） 

式中， uz 和 ua 分别是静态响应优化过程中等效静态载荷/惯性力产生的位移和加速度。 
（6）令 1p p= + ，转到（2）。 
上述步骤中，步骤（3）～（5）称为内循环，步骤（2）～（6）构成了外循环，第

（5）步的收敛解是下一循环的起始点（如果该优化迭代未在当前外循环收敛）。注意，如

果步骤（2）中含有多个时间步，那么在步骤（3）、（4）和（5）将创建静态响应优化工

况（只要时间步屏蔽功能未被激活）。步骤（5）中的等效静态载荷/惯性力是固定的，位

移和加速度分量将根据式（8-10）进行更新。等效静态载荷是设计变量 y 和 y■■的函数，

随着位移和加速度的更新，上述循环需要重复进行以获得新的等效静态载荷/惯性力值。

在等效静态载荷法中，每次循环执行一次瞬态分析。在传统的动态响应优化中，瞬态分

析的次数约为设计变量的个数或每次迭代中活动约束的个数。通常来说，能够使等效静

态响应优化获得收敛解的瞬态分析次数将小于传统动态响应分析。 
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将整个时域[0，T]离散成 q 个时间点，由此获得的等效静态载荷的数量也为 q，因而进

行等效静态响应分析的工况也是 q。这种场合计算一个静态响应优化问题是非常困难的，如

果采用约束屏蔽策略，将大大降低待考虑约束的实际数目。 

8. 3.3  优化模型定义及输出 

应用等效静态载荷技术，MotionSolve 联合 OptiStruct 可实现多体系统中柔性体的拓扑优

化、形貌优化、自由尺寸优化、尺寸优化、形状优化、自由形状优化以及材料优化。优化中

可应用的响应包括质量、体积、质心、转动惯量、应力、应变、柔度以及柔性体的位移等。

使用柔性体位移做响应时需考虑柔性体的局部边界条件。多体优化模型的定义与传统静

力优化模型（如拓扑优化、形貌优化、尺寸优化等）的定义类似，响应由 DRESP1、
DRESP2 和 DRESP3 卡片定义，设计变量由 DESVAR 、 DVPREL1 、 DVPREL2 、

DVMREL1、DVMREL2、DSHAPE， DTPL、DTPG、DSIZE 和 DVGRID 定义。约束由

DCONSTR、DCONADD 和 DOBJREF 卡片定义。约束函数中的响应可使用 DESOBJ、
DESSUB、DESGLB 卡片选取，目标函数中的响应可使用 MINMAX 卡片定义。 

在优化迭代过程中，外循环迭代次数由ESLMAX、ESLSOPT、ESLSTOL控制。其中

ESLMAX用于设定最大外循环迭代次数，默认值为 30。如果指定 ESLMAX 为 0，将不进行

优化迭代。ESLSOPT用于屏蔽优化过程中不重要的时间步。在大多数情况下，该功能能够提

高优化迭代效率。ESLSOPT可设置为 0 或 1，其中 0 表示取消该功能，1 表示激活该功能，

默认值为 1。时间步屏蔽功能与算法步骤（5）中的约束屏蔽不同，尽管两种屏蔽功能概念类

似。时间步屏蔽作用在步骤（2）即将进入静态载荷等效的阶段。通过进行时间步屏蔽，将

为后续的结构分析以及约束屏蔽节省大量的 CPU 时间。ESLSOPT功能激活后，时间步数将

由 ESLSTOL 卡片控制。该卡片取值范围为 0～1.0 的任意实数。数值越小，进入优化迭代的

时间步越少。如果 ESLSTOL 设定为 1.0，则多体动力学分析中的所有时间步均进入优化迭代

流程。很明显，ESLSTOL 越小，优化时间消耗约少，但是较小的 ESLSTOL，可能导致发散

的迭代结果。因而，如果由 ESLSTOL 保留的时间步小于 10，那么多体动力学分析中最重要

的 10 步将进入优化流程。ESLSTOL 默认值为 0.3。 
优化求解后将获得以下结果文件。 
（1）.eslout：该文本文件包含了优化过程的简要描述以及有用信息（如参与优化过程的

时间步及其相应的工况、参与优化的时间步数、优化结果、内循环迭代次数等）。 

（2）_mbd_#.h3d：该二进制文件包含了第#次外循环的多体动力学分析结果。结果文件

为 H3D 格式的模态结果文件（PARAM，MBDH3D，MODAL），包含位移、应力以及变形信

息。该文件只在 ESL 优化中输出，可通过 HyperView 查看。 
（3）_des_#.h3d：该二进制文件包含了第#次外循环的设计变更结果。应用 HyperView 云

图工具，可查看相应的设计变化。 
（4）_mbd_#.abf：该二进制文件包含了第#次外循环中刚体动力学和模态参与因子信

息，可使用 HyperGraph 查看。 
此外，还输出.desvar、.prop、.grid、.fsthick 和.oss 文件。 
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8. 3.4  柔性体局部边界条件 

进行 ESL 优化时，需为柔性体定义局部边界条件。在多体系统瞬态分析时，柔性体和刚性

体由铰链连接，而在进行静态载荷等效时，这些铰链在基于静态响应结构优化中不再适用，也

就是说柔性体将出现 6 个刚体模态。因此，在结构分析时需要去除模型中每个柔性体的 6 个刚

体模态。这里去除的柔性体自由度精确为 6 个，如果约束了多于 6 个自由度，柔性体将被额外

的约束限制，将增加 ESL 优化外循环的迭代次数并且可能无法获得最优的结果。 
由于静态载荷等效时，每个柔性体在每次外循环的第 0 次内循环处于平衡位置。因此，可

以固定任意 6 个自由度（通常固定一个节点）去除柔性体所有刚体模态进行等效静力分析。每

个内循环的第 0 次迭代约束节点的反力为零，因而尽管柔性体 6 个自由度被限制，却没有额外

的载荷加载的到柔性体上。然而随着内循环迭代的进行，模型中原始平衡被打破，从第 1 次循

环开始，系统不再保持平衡。由此造成的不利结果是约束点处的反力不再是零，也就意味着有

附加载荷作用在约束点。随着结构形状或尺寸的变化，这种不利影响可通过以下方法最小化。 
去除柔性体 6 个刚体模态最常用的方法是固定一个节点的 6 个自由度。选择固定节点时，

尽量选择不在高应力区域的节点。如果约束节点位于高应力区，将不容易获得最优结果。这

里，推荐选择蛛网单元的独立节点或用于模拟铰链的刚性单元作为约束节点。实体单元模型，

节点没有旋转刚度，如果模型中没有合适的刚性单元作为约束节点，那么最佳做法是通过固定

一个节点的 3 个平动自由度（123）、第二个节点的两个平动自由度（23）和第三个节点的一个

平动自由度（3）来去除柔性体的 6 个刚体模态。这 3 个节点选取时要保证其不在高应力区

域，否则将达不到预期的效果。约束节点时，可使用 SPC、SPC1 或 SPCADD 卡片定义。 
图 8-7 描述了一个包含两个铰接孔的实体单元模型约束方法。图 8-8 显示了两个时间步

中的应力云图。 

 
图 8-7  实体单元约束定义 

 
图 8-8  两个时间步中的应力云图 
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图 8-7 中的节点 A 与节点 B 是铰链连接点。该模型最佳的约束方式是固定节点 A 或节

点 B 的 6 个自由度。其他方法可以是固定节点 E1 的 3 个平动自由度（123）、E2 的两个平动

自由度（23）、E3 的一个平动自由度（3）。这 3 个节点位于相对低应力区。在该模型中，如

果固定 C1、C2、C3 或者 D1、D2、D3，优化迭代将不容易收敛。 
定义了柔性体的局部边界条件，优化模型中的位移约束可用来限制柔性体的最大变形。

接下来以旋转悬臂梁优化的示例（如图 8-9 所示）说明这一

问题。模型定义时，可以固定悬臂梁的左端点（见图 8-10a）
或中间点（见图 8-10b）来满足变形约束，只要这些节点不

影响形状扰动向量或对形状扰动向量影响很小。如果优化问

题需要约束梁左端点和右端点之间的相对位移，那么限制左端点的 6 个自由度将便于测量这

一相对位移。类似地，如果优化问题需要约束梁左端点和中间点之间的相对位移，那么限制

中间点的 6 个自由度将便于测量这一相对位移。这里不管限制左端点还是中间点，产生的梁

应力是相同的。如果优化问题仅仅是约束柔性体应力或最小化、最大化柔性体应力，则建模

时只需限制柔性体中一个合适的节点。 

 
a）                                   b） 

图 8-10  不同固定位置产生的梁柔性变形 

a） 左端固定  b） 中间固定 

8. 3.5  优化收敛性研究 

在结构优化过程中，能够捕捉结构的关键响应是优化成功的保证。通常，为了捕捉关键

响应，一个很好的做法是在感兴趣的关键响应处定义多个时间步，帮助优化器在这些关键时

刻计算更加精确的响应，以降低优化在外部循环进入错误搜索方向的概率。 
下面是个细化仿真时间间隔的示例。假定分析时间间隔为 0～1.0s。为了找到关键响应

出现的时刻，可设置如下等间隔的时间步： 

MBSIM   4       TRANS   END    1.0     NSTEPS   100 

上述卡片将持续 1.0s 的仿真时间等间隔地分成 100 步。应用该卡片求解模型后，可获得图

8-11 所示的应力时间历程：在 0～0.02s 和 0.60～0.63s 时刻分别出现了应力突变（关键响应）。

通常来说，这些关键响应主导了整个优化进程。因此，有必要在这些重要时刻附近寻找更多的

关键响应。为此，增加这些时刻的仿真步重新定义 MBSIM 卡片，如下所示： 

$more time steps from 0.0 sec to 0.02 sec. 
MBSIM   1       TRANS   END     0.02     NSTEPS   200      
+         VSTIFF                  
MBSIM   2       TRANS   END     0.61     NSTEPS   200      
+         VSTIFF  

 

图 8-9  旋转悬臂梁 
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$more time steps from 0.61 sec to 0.63 sec. 
MBSIM   3       TRANS   END     0.63     NSTEPS   200    
+         VSTIFF      
MBSIM   4       TRANS   END     1.0      NSTEPS   100  
$ 
MBSEQ   10       1      2        3         4 

 

图 8-11  应力响应时间历程 

上述 MBSIM 卡片中，0～0.02s 和 0.60～0.63s 的时间区间内分别定义了 200 个仿真步。

通常，优化器获得关于模型的信息越多，它所提供的优化方案越好。为此，通过增加重要时

刻的仿真步尽可能多地获得关键响应，将极大提高优化迭代的收敛性。 

8. 3.6  多体系统级响应优化 

OptiStruct 应用 ESL 技术不但可以优化柔性体的应力、变形等结构响应，还可以处理多

体系统中的位移、速度、加速度、铰链约束力响应以及由 MBVAR 定义的 4 种响应的组合响

应等系统级响应问题。典型的系统级响应问题描述如下。 
●  目标：最小化铰链约束力。 
●  约束：应力<允许值。 
●  变形<允许值。 
●  节点速度<允许值。 
在多体动力学系统中，PRBODY、CMBUSH（M）、CMBEAM（M）、CMSPDP（M）属性以

及结构优化中的结构厚度、结构形状均可定义为系统响应。DVMBRL1 和 DVMBRL2 卡片

可用于关联设计变量与 PRBODY、CMBUSH（M）、CMBEAM（M）、CMSPDP（M）属性。 

1.大规模的设计变量 

多体动力学系统级响应优化通过构建自适应响应面来寻找最优值，其实现过程与 HyperStudy
类似。通常，基于响应面的优化不能处理包含大规模设计变量的优化问题。针对这一问题，

OptiStruct 采用构建多体系统中间设计变量的方法来解决。在优化模型中，所有关于刚性体/
柔性体的设计变量均转变为一些预定义的中间设计变量，然后根据这些中间设计变量构建自

适应响应面。因此，即使多体系统中定义了成百上千个关于物体的设计变量，用于多体动力

学系统级响应优化的自适应响应面也只需使用少量的中间设计变量来构造。这样，OptiStruct
就可以处理包含大规模设计变量的系统级响应优化问题。 
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2.形状优化改变结构长度 

如果希望获得一个小于允许值的速度，通过形状优化改变结构的长度是一种便捷的方

法。OptiStruct 支持刚性体和柔性体的形状优化。在使用 DVGRID 卡片定义形状扰动向量

时，需保证扰动向量不会破坏系统原始的铰链连接关系。例如，旋转副由连接到两个不同物

体的重合节点定义，如果优化过程中，扰动向量仅改变了其中一个节点的位置，那么在下一

个设计迭代中，这个旋转副将失效。 

3.多体动力学系统级响应优化局限性 

与 PRBODY、CMBUSH（M）、CMBEAM（M）、CMSPDP（M）属性相关的设计变量不会影

响结构响应（如应力、变形等）的大小，它们只会影响 MBDIS、MBVEL、MBACC、MBFRC
和 MBEXPR 等多体动力学系统级响应。与结构有关的设计变量，如长度、形状、厚度不但

影响结构响应还影响系统级响应的大小。因此、如果结构响应与系统级响应之间的交互作用

比较强，系统级响应优化功能将不再适用。 
刚体不能同时定义结构设计变量（如形状、厚度、结构属性等）和包含 TYPE=PRBODY 的

DVMBRL1/2 设计变量。 
目前，可用系统级响应必须是一个标量。使用 DRESP1 卡片定义系统级响应时，OptiStruct

提供了一个选项，用于提取位移、速度、加速度和铰链约束力响应的最大值、最小值、最大

绝对值或最小绝对值。如果指定系统级响应为目标函数，在优化过程中，如果目标函数值在

采样时刻出现较大跳动，则优化收敛将变得非常缓慢甚至会发散。 

8.4  实例 

8. 4.1  汽车前束曲线优化 

本实例以汽车前悬架系统为对象，通过悬架平顺性分析研究拉杆球铰坐标变化对悬架性

能的影响，主要包括以下内容： 
●  使用 HyperStudy 创建 DOE 分析模型。 
●  DOE 分析。 
●  基于 DOE 分析结果创建近似方程并进行模型优化。 
●  原始模型与优化模型结果对比。 
练习开始前，从目录 chap08 中复制 hs.mdl 和 target_toe.csv 文件到工作文件夹中。 

创建 DOE 分析模型 

（1）新建一个 MotionView 会话。 
（2）单击工具栏中的 Open Model 按钮 ，从工作目录中选择 hs.mdl。 
（3）查看模型以及束角输出（toe-curve output request）设置。 
该模型是一个完整的动力学分析模型，已预定义了束角输出请求。由于模型中包含多个

 STEP 
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子系统，所以定义的对象较多。用户可将模型浏览树设置为 View selected type，然后单击工

具栏中的 Output 按钮 ，即可过滤除输出请求之外的对象，模型树仅显示输出请求设置，

如图 8-12 所示。 

 

图 8-12  输出设置定义 

输出请求 toe-curve 中 F2 代表前束，F3 代表轮心 Z 向跳动量。 
（4）从 Applications 下拉菜单中选择 HyperStudy，启动 HyperStudy。 
（5）在 Create studies（创建研究）对话框中单击 Add Study 按钮并选择 New。 
（6）使用默认标题以及变量名，单击 OK 按钮。 
（7）在 Study directory（研究目录）中，单击“文件浏览”按钮 ，将文件目录定位在

工作目录中。 
（8）单击 Next 按钮创建模型。 
（9）在 Create models（创建模型）对话框中单击 Add Model 按钮。 
（10）模型类型选择 MotionView。 
（11）接受默认的变量名。 
（12）单击 OK 按钮，如图 8-13 所示。 

 
图 8-13  Create models 对话框 
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此时，HyperStudy界面将显示当前模型以及分析任务，如图 8-12所示。Label栏表明调

用MotionView会话中第一页第一窗口中标题为model_4的模型。Analysis task栏表明调用的

分析工况是 an_ride_event.frnt。Solver栏表示 HyperStudy调用的求解器是MotionSolve。 

（13）单击 Next按钮进入 Create Design Variables（创建设计变量）窗口。 

（14）在 Create Design Variables 窗口中单击 Add Model Parameter（创建模型参数）按

钮，将弹出模型树窗口。 

（15）如图 8-14所示，在模型树中选择表 8-2所列参数。 

 

图 8-14  模型树窗口 

表 8-2  设计变量 

System Point Coordinate Function 

Frnt SLA susp（1 pc. LCA） Otrtierod balljt-left Y 单击 Add 按钮 

Frnt SLA susp（1 pc. LCA） Otrtierod balljt-left Z 单击 Add 按钮 

Parallel Steering Inrtierod ball-left Y 单击 Add 按钮 

Parallel Steering Inrtierod ball-left Z 单击 Add 按钮 

（16）单击 Done按钮。 

（17）在设计变量属性窗口中，根据表 8-3 修改设计变量的最大、最小限值。第一个设

计变量已经处在激活状态，单击设计变量列表第一列激活不同的设计变量。 

表 8-3  设计变量取值范围 

Point Coordinate Lower Upper 

Otrtierod balljt-left Y -571.15 -559.15 

Otrtierod balljt-left Z 246.92 250.92 

Inrtierod ball-left Y -221.9 -209.9 

Inrtierod ball-left Z 274.86 278.86 
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（18）单击 Next按钮进入 Do nominal run（初始运行）窗口。 

（19）在 Solver input file文本框中输入 m_1。 

（20）选择MotionSolve_Hst作为 Solver Execution Script（求解执行脚本）。 

（21）单击Write/Execute按钮。 

此时，MotionSolve 根据上述设置后台求解。在求解过程中，注意 HyperStudy 与

MotionView信息窗口中的内容。 

（22）求解结束后，单击 Next按钮，将弹出 Create responses（创建响应）窗口。 

（23）单击 Add Response按钮创建一个响应。 

（24）指定响应名为 Sum of Squared Error（误差平方和）。 

（25）接受默认的变量名并单击 OK按钮，此时 Expr Builder处于可用状态。 

（26）单击 Expr Builder按钮，进入 HyperStudy响应函数编辑窗口。 

本示例需要创建以下两个响应矢量。 

●  响应矢量 1（Vector 1）：指向从求解器获得的初始方案中仿真束角曲线数据。 

●  响应矢量 2（Vector 2）：指向目标束角曲线数据。 

（27）单击 Add按钮，创建响应矢量 1，此时 Vector resource file（响应矢量源文件）窗

口处于可用状态。 

（28）单击响应矢量源文件窗口中的“文件浏览”按钮 ，并从路径<working directory> 

\nom_run\m_1\中选择 m_1.abf。此时 Type、Request以及 Component等区域将被激活。 

（29）在 Type下拉列表中选择 Expressions。 

（30）在 Request下拉列表中选择 REQ/70000033 toe-curve。 

（31）选择分量 F2。 

（32）单击 Apply按钮。 

此时，从求解器中获得的束角曲线数据将作为响应矢量 1，接下来根据目标束角曲线创

建响应矢量 2。 

（33）在 Vectors（响应）标签中单击 Add按钮。 

（34）在矢量源文件窗口中，单击“文件浏览”按钮并从工作路径中选择 target_toe. 

csv，弹出 Load Data Vectors对话框。 

（35）在 Load Data Vectors（矢量数据载入）对话框中的矢量数据类型处选择 Reference 

file。 

（36）单击 Open按钮。 

（37）保持 Type和 Request分别为 Unkown和 Block1不变。 

（38）在分量选择框中选择 Column1。 

（39）单击 Apply按钮。 

（40）在响应函数栏中创建函数 sum（（v_1-v_2）^2），如图 8-15所示。 

（41）选中响应函数编辑窗口中的 Evaluate expression（评估）复选框，确认函数表达式

是否正确，此时函数返回值应是 16.2891。 

（42）如果上述过程中没有出现错误信息，则表示已经从初始运行中成功提取响应参

数。取消选中 Evaluate expression复选框，返回表达式。 
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图 8-15  响应函数编辑窗口 

（43）单击 OK按钮，返回响应创建对话框。 

（44）单击 Next按钮，进入 Link design variables（关联设计变量模块）。 

注：此模块可使用函数对设计变量进行数学处理，实现设计变量与当前研究的关联以进

行试验设计、优化分析以及随机性研究。本例不需要关联设计变量。 

（45）单击 Next按钮，进入 Sensitivity（灵敏度）窗口。 

（46）在 File菜单中选择 Save Current Study As（保存当前研究为）按钮。 

（47）在工作目录中将当前研究设置保存为 Setup.xml。 

DOE研究 

（1）在 Sensitivity窗口中单击 Continue To按钮并选择 DOE Study。 

（2）单击 Add DOE Study按钮。 

（3）接受默认的标题并单击 OK按钮。 

（4）选择 DOE的 Controlled factors（可控因子）类型为 Fractional Factorial。 

（5）本示例中所有的设计变量均为可控，因此 Uncontrolled factors栏中选择 None。 

（6）单击 Next按钮。 

（7）确认 Controlled variables（可控变量）对话框中 Design variables栏 4个设计变量均

处于激活状态（即 On栏均为选中状态）。 

（8）单击 Next 按钮，进入 Controlled interactions（可控因子交互作用）对话框，如图 8-16
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所示。 

可控因子交互作用对话框用来设置不同变量间的交互作用。 

 

图 8-16  可控因子交互作用对话框 

（9）确认选中所有的复选框以考查设计变量间所有的交互作用。可单击 All 按钮激活所

有设计变量的交互作用。 

（10）单击 Next按钮，进入 Controlled allocations对话框。 

（11）在 Design栏中选择 L16设计矩阵。 

Allocations sub-panel（设计变量分配子面板）显示了设计变量根据设计矩阵的分配情

况。整个设计矩阵描述了各个求解所使用的设计变量值。 

（12）单击 Next按钮。 

本示例不考查不可控因子的影响，因此 Uncontrolled variables、Uncontrolled interacti-ons

和 Uncontrolled allocations 窗口均为灰色不可用状态，此时窗口将直接转至 Select responses

对话框。 

（13）确认当前响应是否为已创建的响应。 

（14）单击 Next按钮。 

（15）在Write/Execute runs窗口中将看到分配好的设计变量值。 

（16）单击 Write 按钮创建求解器输入文件，单击 Execute 按钮可调用求解器执行脚本求

解上述创建的求解器输入文件。 

（17）单击 Write/Execute 按钮开始求解。如果弹出是否希望以交互模式创建输入文件和

提交求解窗口时，单击 Yes按钮。此时，MotionSolve启动并求解模型。 

（18）求解结束后，单击 Next按钮。 

（19）在 Extract Responses（响应提取）对话框中，确认选择所有的求解结果。 

（20）单击 Extract按钮。 

此时，HyperStudy将提取所有运行获得的响应值。 
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（21）单击 Next按钮进入 Post processing（后处理）面板，如图 8-17所示。 

Main Effects（主效应）标签将显示各个可控因子对响应的作用。 

 

图 8-17  DOE ­主效应图 

（22）单击 Controlled Design Variable Interaction（可控因子交互作用）标签并选择已创建

的响应。 

（23）单击 DV’s标签，选择一个交互作用，然后观察交互作用曲线。 

可控设计变量交互作用曲线显示了不同设计变量对响应的交互作用。如果交互曲线为平

行线，表示当前显示的两个参数之间没有交互作用。 

（24）观察图 8-18中变量 C1和 C3之间的交互曲线。 

 

图 8-18  变量 C1和 C3间的可控因子交互作用图 
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近似模型 

（1）在 Study Setup 模块的 Sensitivity 窗口中单击 Continue to 按钮并选择 Approxim-

ation。 

（2）单击 Add按钮创建一个近似模型。 

（3）在 Add Approximation窗口中选择近似模型类型为Moving Least Squares（移动最小

二乘法）。 

（4）单击 OK按钮。 

（5）单击 Next按钮进入 Input Matrix（输入矩阵）对话框。 

（6）单击 Import Matrix，然后在 Import DOE窗口中单击OK按钮，输入DOE设计矩阵。 

（7）单击 Next按钮进入 Validation Matrix（验证矩阵）对话框。 

单击 Import Matrix按钮可以输入验证矩阵（Validation matrix），本例不使用验证矩阵。 

（8）单击 Next按钮。 

（9）在 Build approximation对话框中指定近似方程阶数为 1，如图 8-19所示。 

由于本例设计变量水平为 2，因此创建的近似方程阶数指定为 1。如果研究中使用了多

个水平的设计变量，就可以创建高阶的近似方程。 

（10）单击 Build按钮创建近似方程。 

 

图 8-19  近似模型创建窗口 

（11）单击 Next按钮进入 Residual（残差）对话框。 
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残差标签显示了从求解器获得的响应值与当前创建的回归方程获得的响应值之间的差

异。残差图可以用来衡量基本假设与实际模型之间的差异。 

（12）单击 Next按钮，Trade-off对话框显示了近似模型中主效应与响应之间的关系。 

（13）单击 3-D plots标签，以三维视图的方式显示主效应与响应的关系，如图 8-20所示。 

 

图 8-20  Trade-off三维视图 

（14）从 File 菜单中选择 Save Output Files

命令。 

（15）在 File Save Options 中选择 DOE 文

件和近似模型文件并单击 Save按钮，如图 8-21

所示。 

上述文件将保存在工作目录相应的文件夹下。 

（16）在 File 菜单中选择 Save Current Study 

As命令。 

（17）在工作目录中保存当前研究为 Study_1. 

xml。 

优化分析 

（1）在 Study Setup 模块的 Sensitivity 窗口中单击 Continue to 按钮并选择 Optimization 

Study，进行优化分析设置。 

（2）在 Create Optimization study对话框中单击 Add Optimization按钮。 
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图 8-21  文件保存选项窗口 
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（3）接受默认的标题及变量名并单击 OK按钮。 

（4）接受默认的优化算法：Adaptive Response Surface Method（自适应响应面法），单击

Next按钮。 

（5）在 Define design variables面板，确认选择所有的设计变量。 

（6）此面板将显示所有的设计变量以及相应变量的最大、最小值。 

（7）单击 Next按钮。 

（8）本示例中不需创建任何约束，所以单击 Constraints 对话框中的 Next 按钮进入

Objective对话框，如图 8-22所示。 

（9）单击 Add Objective按钮。 

（10）接受默认的标题与变量名，已定义的响应显示在当前面板上。 

（11）本示例优化目标是最小化响应函数（均方误差和）以获得设计参数（内外束角拉

杆 Y和 Z坐标值）最优值。 

（12）检查并确认 Evaluate From（评估目标）设置为 SOLVER。 

 

图 8-22  优化目标窗口 

（13）当前窗口可以设置最大迭代步以及收敛标准。 

（14）单击 Launch Optimization按钮，开始优化迭代。 

（15）此时启动MotionSolve进行求解，优化引擎 HyperOpt开始寻找目标最优值。 

（16）优化迭代过程结束后，单击 Next按钮，进入后处理对话框（Post processing）。 

（17）单击 Optimization Iteration History Plot（优化迭代历程曲线）标签。 

（18）如图 8-23 所示，当前面板显示了不同迭代步中目标函数、约束、设计变量以及响

应的变化情况。Optimization Iteration History Table（优化迭代历程表）以表格形式显示了上

述数据。 
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图 8-23  优化历程窗口 

注意本示例中，第 6步迭代找到了最优值。 

（19）在工作目录中保存当前研究为 Study_2.xml。 

对比原始模型与优化后模型 

（1）单击 Add Page按钮 ，在当前会话中新建一个页面。 

（2）将应用程序切换为 HyperView。 

（3）单击 Open Model按钮 ，在 Load Model and Results面板中载入<working directory> 

\nom_run\m_1\m_1.h3d。 

（4）单击工具栏中的“页面布局”按钮 并选择“两窗口布局” 。 

（5）将第二窗口的应用程序切换成 HyperGraph。 

（6）单击工具栏中的 Build Plots按钮 。 

（7）在 Build Plots面板中单击“文件浏览”按钮 并从工作路径中选择 target_toe.csv。 

（8）对于 X-axis，选择： 

Type = Unknown 

Request = Block1 

Component = Column 1 

（9）对于 Y-axis，选择： 

Type = Unknown 

Request = Block1 

Component = Column 2 

（10）单击 Apply按钮。 

（11）在 Build Plots 面板中单击“文件浏览”按钮 ，选择文件<working directory>\ 
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nom_run\m_1\m_1.abf。该文件为初始设计方案的仿真结果。 

（12）对于 X-axis，选择： 

Type = Expressions 

Request = REQ/70000033 toe-curve 

Component = F2 

（13）对于 Y-axis，选择： 

Type = Expressions 

Request = REQ/70000033 toe-curve 

Component = F3 

（14）单击 Apply按钮。 

（15）按照上述方法绘制文件<working directory>\optimization\opt_1\run6\m_1.abf的曲线图。 

本示例最后将获得图 8-24 所示结果，仔细观察优化后的前束曲线。在动画窗口可以载

入优化后的模型动画以查看优化前后前束曲线的差异。 

 

图 8-24  优化结果 

（16）单击菜单 File→Save As→Session命令。 

（17）指定待保存会话路径及名称。 

（18）单击 Save按钮，保存会话。 

8. 4.2  压力机压紧力优化 

本练习优化施加在压力机上的外力 F，已获得指定压紧力。压力机如图 8-25 所示，模
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型中使用弹簧模拟压紧力 P。本练习包括以下内容： 

●  根据MotionSolve输入文件创建 HyperStudy模板文件。 

●  设置一个 HyperStudy研究任务。 

●  进行优化分析。 

练习开始前，从目录 chap08 中复制 Pressure.mdl 文件到工作文

件夹中。 

获取MotionSolve求解器输入文件 

创建 HyperStudy 模板文件需使用求解器输入文件，这里首先使

用 MotionView 载入工作目录下的 Pressure.mdl 文件，输出 Motion- 

Solve 求解器输入文件 Pressure.xml，然后根据 Pressure.xml 文件创

建 HyperStudy模板文件。 

（1）启动MotionView。 

（2）打开 Pressure.mdl文件，查看模型的构成。 

（3）单击 按钮，弹出 Export Solver Deck对话框。 

（4）单击“文件浏览”按钮 ，选择工作文件夹并以 Pressure.xml保存求解器输入文件。 

创建 HyperStudy模板文件 

（1）启动 HyperStudy。 

（2）选择 Utilities下拉菜单中的 Editor命令。 

（3）在弹出的 Editor窗口中，单击菜单 File→Open命令。 

（4）在弹出的 Open a file对话框中，设置文件类型为 All File（*）。 

（5）选择并打开上步生成的 Pressure.xml文件。 

（6）在 Edit下拉菜单中选择 Find，查找 fx_expression。 

（7）选择 fx_expression栏的 500，并右击。 

（8）在弹出的快捷菜单中选择 Create Design Variable命令，如图 8-26所示。 

（9）在弹出的 Design Variable Properties对话框中，输入以下内容： 

Name： Force 

Label： Force 

Description： Property 1 

Initial value： 500 （taken from the input deck） 

Lower Bound： 200 

Upper Bound： 800 

Format： %3.1f  

（10）单击 OK按钮，定义系统变量为设计变量。 
（11）单击 Show/Generate Templex按钮 ，在弹出的 Generate temple file对话框中单击

Yes，创建模板文件。 
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图 8-25  压力机模型 
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图 8-26  创建设计变量 

（12）查看创建的模板文件。 

（13）单击 Save As按钮将模板保存为 Pressure.tpl。 

（14）选择 File→Quit命令，关闭 Editor窗口。 

使用 TextView工具查看模板文件 

（1）启动MotionView。 

（2）将应用程序切换为 TextView。 

（3）从工具栏中单击 Open Document按钮 ，选择并打开 Pressure.tpl文件。 

（4）文件的上端，设计变量由模板参数语句定义： 

{parameter（Force， "Force"， 500， 200， 800） 'Property 1} 

（5）单击 Find 按钮 ，在文件中搜索 fx_expression，可以看到 fx_expression 栏已参

数化。 

fx_expression       = "{templex_on}{Force， %3.1f}{templex_off}" 

（6）单击工具栏中的 Evaluation Mode Control按钮 ，此时模板参数语句被估值，使用

初始值取代参数值。expr栏变为 

fx_expression       = "500.0"  
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创建研究任务 

（1）进入 HyperStudy。 

（2）单击 Add study按钮。 

（3）选择 New，此时弹出 Add Study对话框。 

（4）使用默认的标题与变量名，单击 OK按钮。 

（5）选择工作文件夹。 

（6）单击 Next按钮进入 Create models窗口。 

（7）单击 Add model按钮。 

（8）使用默认的标题与变量名，Model type选择 Template，单击 OK按钮。此时在列表

中新建了一个模型。 

（9）单击 Template file处的“文件浏览”按钮 ，选择并打开 Pressure.tpl文件。 

（10）单击 Next按钮，进入 Create design variables对话框。 

（11）确认设计变量上、下限值分别为 200和 800。 

（12）单击 Next按钮，进入 Do nominal run窗口，如图 8-27所示。 

 

图 8-27  Do nominal run窗口 

（13）在 Solver input Files文本框中输入MotionSolve输入文件 Pressure.xml。 

（14）在 Solver execution script栏中选择MotionSolve-standalone。 

初始计算 

（1）单击Write/Execute按钮，进行初始计算。 

此时，工作文件夹下将新建一个名为 nom_run/m_1的文件夹，初始计算的结果文件将写

入该文件。 

（2）单击 Next按钮，进入 Create responses窗口。 

创建响应 

（1）单击 Add response按钮。 

（2）使用默认的标题与变量名，单击 OK按钮。 

（3）单击 Expr Builder按钮，进入表达式编辑窗口。 

（4）在 Vectors标签中单击 Add按钮，新建一个响应向量。 

（5）单击Vector resource file处的“文件浏览”按钮 ，选择并打开m_1目录下的 Pressure. 

abf文件。 
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（6）如图 8-28 所示，定义 Vector1 为弹簧所承受

的载荷。 

（7）单击Apply按钮，将该向量填入表达式区域。 

（8）在表达式区域，编辑响应表达式为 max 

（V_1）。该表达式表示压力机产生的最大压紧力。 

（9）激活 Evaluate expression 选项，对响应表达

式进行估值。此时表达式应显示为 1029.81。 

（10）单击 OK按钮，返回 Create responses窗口。 

（11）单击两次 next按钮进入 Sensitivity窗口。 

优化求解 

（1）单击 Continue To进入 Optimization Study。 

（2）单击 Add optimization按钮。 

（3）使用默认的优化模型标题与变量名，单击 OK按钮。 

（4）选择（ARSM） - Adaptive Response Surface Method作为 Optimization Engine。 

（5）单击 Next按钮，进入 Design variables窗口，查看设计变量的定义。 

（6）单击 Next按钮，进入 Constraints窗口。 

（7）单击 Next按钮，进入 Define objectives窗口，如图 8-29所示。 

（8）单击 Add Objective按钮。 

（9）使用默认的目标函数标题与变量名，单击 OK按钮。 

（10）设置 Goal为 System Identification（系统辨识）。 

（11）修改 Targe Value为 1500。 

 

图 8-29  定义目标函数 

（12）单击 Launch Optimization按钮，启动优化求解。 

查看迭代历程 

（1）求解结束后，在 Post processing窗口中单击 Optimization Iteration History Plot标签，

查看迭代历程，如图 8-30所示。单击 Optimization Iteration History Table标签，查看各次迭

代中设计变量以及响应值，如图 8-31所示。 

（2）根据迭代结果，当施加的外载为 738.14N时，压力机产生的压紧力为 1500N。 
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图 8-28  定义响应向量 
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图 8-30  Optimization Iteration History Plot标签 

 

图 8-31  Optimization Iteration History Table标签 

8. 4.3  挖掘机臂拓扑优化 

本练习将学习以下内容： 

●  查看由 HyperMesh创建的多体动力学瞬态分析模型。 

●  将刚性构件转换为柔性构件。 

●  通过等效静态载荷法，建立多体动力学系统的拓扑优化模型。 

●  应用 HyperView进行优化结果后处理。 

本练习使用的挖掘机模型如图 8-32所示。 

该优化问题三要素可以表示如下。 

●  目标函数：在等效静态载荷工况下，模型最大柔度最小化。 

●  设计约束：质量比。 

●  设计变量：挖掘机斗杆材料空间分布。 

本练习开始前，从目录 chap08中复制 Excavator_MBD.hm文件到工作文件夹中。 

启动 HyperMesh，选取求解器模板，并提取相关文件 

（1）启动 HyperMesh。 
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图 8-32  挖掘机模型 

（2）在 User Profiles中选择 OptiStruct。 

（3）单击 OK按钮。 

以上三步骤完成后，HyperMesh将切换到 OptiStruct模板。 

（4）在 File菜单中选择 Open命令。 

（5）读取工作目录下的 HyperMesh数据文件 Excavator_MBD.hm。 

在 Radioss中递交瞬态分析 

（1）在 Analysis页面下，单击 Radioss按钮。 

（2）在 export options里选择 all。 

（3）在 run options里选择 analysis。 

（4）在 memory options里选择 memory default。 

（5）单击 Save as按钮。 

（6）找到计算结果输出文件夹，将模型保存为 excavator_MBD_analysis.fem。 

（7）单击 Radioss按钮，开始求解。 

在 HyperView中，进行多体动力学分析结果后处理 

（1）Radioss求解完成后，关闭求解器窗口。 

（2）返回递交求解的 Radioss 页面，单击 HyperView 按钮，启动 HyperView，进行结果

后处理。 

（3）将动画类型设置为 Set Transient Animation Mode 。 

（4）单击“动画播放”按钮 ，观察挖掘机运动过程。 

（5）关闭 HyperView，并返回 HyperMesh前处理界面。 

将刚性体模型转化为柔性体模型 

接下来，将在 HyperMesh 中定义挖掘机斗杆拓扑优化模型。为了完成拓扑优化，首先

需要将原有多体系统动力学模型中的刚体斗杆转化为柔体斗杆。 
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（1）在 Analysis页面下，单击 bodies按钮。 

（2）选择 update选项。 

（3）双击 body=，然后选择 Lower_Arm。 

（4）单击 review按钮。 

可以注意到，图形区中 Lower_Arm 组件高亮显示。在 type=栏，可以看到其类型为

PRBODY，即该组件为刚性体模型。在后续的操作中，该刚性体模型转化为柔性体模型。 

（5）单击 type=，选择 PFBODY。 

（6）将 number of modes设置为 nmodes，并输入 20，即使用模态综合法构建柔性体模型

时，提取模型前 20阶模态，如图 8-33所示。 

 

图 8-33  bodies面板 

（7）单击 update按钮，状态栏中显示“The body has been updated”，表示模型类型切换

成功。 

（8）单击 return按钮。 

定义拓扑优化设计变量 

（1）在 Analysis页面下，单击 optimization按钮。 

（2）单击 topology按钮进入拓扑优化面板。 

（3）激活 create标签。 

（4）在 desvar=栏中填入 L_Arm_Topology，并按<Enter>键确定。 

（5）单击 Props 按钮，并在弹出的单元类型选择栏中选中挖掘机斗杆对应的标题为

lowerarm的属性。 

（6）在类型中，选择 PSOLID。 

（7）单击 Create按钮，创建拓扑优化设计变量。 

（8）激活 parameter标签。 

（9）单击 review按钮。 

（10）选择 L_Arm_Toplogy。 

（11）将 minmem off选项切换为 mindim，并在其后输入 0.05。 

（12）单击 update按钮。 

（13）单击 return按钮，回到 optimization面板。 

定义响应 

在这个优化问题中，将定义两个响应，其中柔度用于定义目标函数，而体积比用于定义
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设计约束。 

（1）在 optimization面板下，单击 responses按钮。 

（2）单击 response=，并输入 Volfrac。 

（3）在 response type中选择 volumefrac。 

（4）将 total切换为 by entity。 

（5）单击 props按钮，选中 lowerarm。 

（6）单击 return回到 responses面板。 

（7）单击 Create按钮。 

（8）在 response=一栏中，输入 Comp。 

（9）在 response type中，选择 compliance。 

（10）将 by entity切换为 total。 

（11）单击 create按钮。 

（12）单击 return按钮，回到 optimization面板。 

定义优化设计参数 

（1）单击 obj reference按钮。 

（2）在 dobjref=中，输入Max_Comp。 

（3）选中 pos reference，并输入 1.0。 

（4）选中 neg reference，并输入-1.0。 

（5）单击 Response按钮，并选择 Comp。 

（6）将 loadsteps切换为 all。 

（7）单击 create按钮。 

（8）单击 return按钮，退出该面板。 

定义目标函数 

该优化问题的目标函数为在等效静态载荷工况下，最小化模型的最大柔度。 

（1）在 optimization面板下，选择 objective面板。 

（2）在目标函数类型中，将类型设置为 minmax。 

（3）单击 dobjrefs按钮，并选中Max_Comp。 

（4）单击 return按钮，返回 objective面板。 

（5）单击 create按钮。 

（6）单击 return按钮，回到 optimization面板。 

定义设计约束 

该优化问题的约束条件为在拓扑优化模型中的设计空间体积比。 
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（1）在 optimization页面下，选择 dconstraints面板。 

（2）在 constraint=栏中，输入 Vol_constr。 

（3）选中 upper bound=栏，并在其中输入 0.5。 

（4）在 response=中，选择 Volfrac。 

（5）单击 create按钮。 

（6）单击 return按钮，回到上级面板。 

保存模型文件 

（1）在 File菜单下，选择 Save as。 

（2）选择工作路径，并将模型保存为 excavator_MBD_Topology.hm。 

（3）保存文件。 

递交 OptiStruct，求解模型 

（1）在 Analysis页面下，单击 OptiStruct。 

（2）将 export options设置为 all。 

（3）在 run options中，选择 optimization。 

（4）在 memory options中，选择 memory default。 

（5）单击 Save as按钮。 

（6）在工作文件夹下，将模型输出为 excavator_MBD_Topology.fem。 

（7）单击 Save按钮。 

（8）单击 OptiStruct按钮，开始求解。 

顺利递交求解后，将弹出 OptiStruct 的 DOS 求解器界面和相关的求解信息。求解完成

后，将在工作文件夹下生成若干结果文件。 

在 HyperView中进行优化结果后处理 

（1）在优化迭代完成后，关闭 OptiStruct的求解 DOS窗口。 

（2）在原HyperMesh的OptiStruct页面下，单击HyperView按钮，启动结果后处理模块。 

（3）单击 Close按钮，关闭 HyperView页面下弹出的信息提示窗口。 

（4）在结果浏览树中，按图 8-34所示方式选取优化迭代的最后一步结果。 

 

图 8-34  Result Browser 
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（5）在 HyperView 工具栏中，单击 iso 按钮 ，进入等值面面板。该面板用于滤去优化

结果中的低密度部分。 

（6）在 Result Type中，选择 Element Densities（s）。 

（7）单击 Apply按钮，显示优化迭代结果的密度文件。 

（8）在 Current value栏输入 0.5，并按<Enter>键确认，滤去斗杆结构中低密度材料。 

（9）选中 Transparent复选框，透明显示斗杆模型优化前的外形，如图 8-35所示。 

 

图 8-35  斗杆拓扑优化结果 

8. 4.4  四杆机构形状优化 

本节将学习以下内容： 

●  使用 HyperMesh建立基于 ESL方法的多体系统动力学分析及优化模型。 

●  在 HyperView中进行多体系统动力学分析及优化分析结果后处理。 

本练习中使用的模型如图 8-36所示。 

 

图 8-36  四连杆机构 
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问题描述：使用 HyperMesh 建立一个多体系统动力学优化模型，并调用 OptiStruct 进行

形状优化（Shape Optimization）。优化目标为在满足应力约束的条件下，模型重量最轻。设

计变量为四连杆机构的 12 个形状变量。左侧杆为驱动杆，转速为 50rad/sec。模型单位制为

kg-N-cm-s。 

优化问题的三要素如下。 

●  目标：最小化质量。 

●  约束：单元应力。 

●  设计变量：3个柔性连杆的形状变量。 

练习开始前，从目录 chap08中复制 4bar_design.hm文件到工作文件夹中。 

启动 HyperMesh，调用求解器模板，并读取模型文件 

（1）启动 HyperMesh。 

（2）在 User Profiles中，选择 OptiStruct。 

（3）单击 OK按钮。 

（4）以上 3步骤完成后，HyperMesh将被切换到 OptiStruct模板。 

（5）在 File下拉菜单中，选择 Open命令。 

（6）从工作目录中选择 4bar_design.hm文件。 

定义驱动 

在模型中，驱动杆通过旋转铰连接在大地上，驱动

函数由关键字MOTNG定义。 

（1）在模型浏览树的空白位置右击，选择 Create→

Load Collector命令。 

（2）在弹出的 Create Load Collector 对话框中指定

载荷集的名称为 motion，在 Card image 下拉列表中选

择 none，如图 8-37所示。 

（3）单击 Create按钮，创建载荷集。 

（4）从 Preferences 下拉菜单中选择 Graphics，进入图形首选项设置面板，如图 8-38

所示。 

 

图 8-38  图形首选项设置面板 
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（5）选中 graphics 单选按钮，选中 coincident picking 复选框，该选项用于显示重合的

对象。 

（6）单击 return按钮，返回主面板。 

（7）在 Analysis页面下，选择 constraints。 

（8）在 nodes 激活的状态下，单击图形区红色连杆与大地连接的位置。此时将显示出重

合节点的编号，这里选择与红色连杆相连的 288节点，如图 8-39所示。 

 

图 8-39  选取节点 

（9）单击 load types = 按钮，选择MOTNG（V）。 

（10）仅选中 dof6复选框，定义驱动函数，产生红色连杆绕 z轴旋转效果。 

（11）在 dof6文本框中输入 50.0，表示施加了 50rad/s的转动驱动。 

（12）查看该卡片中的内容是否与图 8-40所示的内容一致。 

 

图 8-40  constraints面板 

（13）单击 create按钮，创建驱动。 

（14）单击 return按钮。 

在预定义的MBD工况中，更新边界条件及运动信息 

（1）在 Analysis页面下，单击 loadsteps按钮。 

（2）单击 review查看当前模型中定义的工况（SUBCASE1）。 

（3）该模型已定义了 multi-body dynamics工况。 

（4）选中MOTION复选框，选择上步定义的驱动，如图 8-41所示。 
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（5）单击 update按钮。 

 

图 8-41  loadsteps面板 

（6）单击 return按钮，回到主面板。 

在 Radioss中递交模型，进行瞬态分析 

（1）在 Analysis页面下，单击 Radioss按钮。 

（2）在 export options里选择 all。 

（3）在 run options里选择 analysis。 

（4）在 memory options里选择 memory default。 

（5）单击 Save as按钮。 

（6）在计算结果输出文件夹下，将模型保存为 4bar_design_analysis.fem。 

（7）单击 Radioss按钮，求解模型。 

在 HyperView中，进行多体系统动力学分析结果后处理 

（1）在 Radioss求解结束后，关闭求解窗口。 

（2）在原递交 Radioss求解页面下，单击 HyperView，进入结果后处理环节。 

（3）启动 HyperView后，关闭弹出的模型信息窗口。 

（4）在 HyperView中，单击 Contour按钮 ，进入云图显示。 

（5）在 Result type下拉菜单中，选择应力结果显示（Element Stresses（2D&3D）（t））。 

（6）单击 Apply按钮。 

（7）单击 Edit Legend按钮，在弹出的 Edit Legend对话框中将图例类型切换为 Dynamic 

Scale。 

（8）单击 OK按钮返回 Contour面板。 

（9）单击 Page Window Layout 按钮 ，将 HyperView 窗口布局由单一窗口切换为两窗

口显示 。 

（10）单击图形区窗口 2，将其激活。 

（11）单击“模块选择”按钮 ，将当前模块由 HyperView切换为 HyperGraph 2D。 

（12）单击Window 1（即 HyperView窗口），将其激活。 

（13）单击工具栏中的Measures按钮 。 

（14）在Measure Group中，选中 Dynamic MinMax Result复选框。 
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（15）选中Max，并单击 Create Curves按钮。 

（16）在弹出的 Create Curves对话框中将 Place on切换为为 Existing Plot。 

（17）选中 live link，并选择Window 2，单击 OK按钮。 

以上的操作将保证Window 1和Window 2同步显示结果。 

（18）单击“动画播放”按钮 ，此时图形区如图 8-42所示。 

 

图 8-42  瞬态分析结果 

（19）在 File 菜单中选择 Save As→Report Template 命令，并将保存类型选取为 Report 

Template（*.tpl）。 

（20）输入 Stress_Report.tpl，并单击 Save按钮。 

（21）回到 HyperMesh用户环境。 

在 HyperMesh中设置 ESL优化模型边界条件 

接下来，将应用等效静态载荷法对多体动力学模型进行结构优化设计。为了实现这一目

标，首先需要在 HyperMesh环境下，对柔性体模型边界条件进行设置。 

（1）在HyperMesh工具栏中单击 Load Collector按钮 ，进入载荷集创建和编辑面板。 

（2）激活 Create子菜单。 

（3）在 Name=文本框中输入 BCFOROPTI。 

（4）将 Load类型切换为 No card image。 

（5）单击 create按钮。 

（6）单击 return按钮，回到主面板。 

（7）在 Analysis页面下，单击 constraints按钮。 

（8）在这一环节中，需要保证所有对象的 6 个自由度均被正确约束，以确保柔性体模型

的刚体模态被移除。请确认选中 dof1～dof6复选框，如图 8-43所示。 

（9）在激活了 coincident picking后，可以通过单击或节点编号选取的形式，选择柔性体

模型中需要约束的节点，以抑制刚体模态。选择节点 143、节点 288 和节点 441，确保选中

dof1～dof6复选框，指定约束类型为 SPC，如图 8-43所示。 
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图 8-43  约束节点 

（10）单击 create按钮。 

在此前定义的多体动力学分析工况中，修改边界条件和强制运动的属性 

（1）在 Analysis页面下，单击 loadsteps按钮。 

（2）单击 review查看当前模型中定义的工况（SUBCASE1）。 

（3）该模型已定义了 multi-body dynamics工况。 

（4）选中 SPC复选框，并选择 BCFOROPT，如图 8-44所示。 

 

图 8-44  loadsteps面板 

（5）单击 update按钮。 

（6）单击 return按钮，回到主面板。 

定义形状优化设计变量 

在该模型中已经包含创建好的形状扰动变量。关于如何创建形状扰动变量的信息，可以

查看 HyperMorph 在线帮助文档。在这一节，将在预定义的形状扰动变量的基础上，创建形

状优化设计变量。 
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（1）在 Analysis面板下，选择 optimization面板。 

（2）单击 shape按钮。 

（3）选择 desvar即设计变量子面板。 

（4）将 single desvar切换为 multiple desvars，即在本优化模型中使用多设计变量。 

（5）单击 shapes按钮，并选择所有的形状扰动变量。 

（6）单击 return按钮。 

（7）在 lower bound=文本框中输入-1.0，在 upper bound=文本框中输入 1.2，如图 8-45

所示。 

 

图 8-45  Shapes面板 

（8）单击 create按钮。 

此时，在优化模型中共建立了 12个形状优化设计变量。 

（9）单击 return按钮，回到 optimization面板。 

定义响应 

在该模型中，需要定义两个响应，一个是作为目标函数的模型质量响应，另一个是作为

设计约束的应力响应。 

（1）在 optimization面板下，选择 responses面板。 

（2）单击 response=，输入Mass。 

（3）在下方的 response type中选择 mass，即质量响应。 

（4）单击 create按钮。 

（5）在 response=文本框中输入 Stress。 

（6）在下方的 response type中，选择 static stress。 

（7）在单元类型对象 props中，选中标题为Middle、Left和 Right的属性。 

（8）单击 return按钮。 

（9）确认应力类型为 von mises，并将应力位置指定为 both surfaces。 

（10）单击 create按钮。 

（11）单击 return按钮，回到 optimization面板。 

定义目标函数 

在本优化模型中，目标函数为最小化模型质量。 
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（1）在 optimization面板下，选择 objective。 

（2）将目标函数类型设置为 min。 

（3）在 response=文本框中，选择Mass。 

（4）单击 create按钮。 

（5）单击 return按钮，回到 optimization面板。 

定义模型应力约束条件 

在本优化模型中，设计约束为单元应力（von mises）小于某一限值。 

（1）在 optimization面板下，选择 dconstraints面板。 

（2）单击 constraint=处的文本框，并输入 Constraint。 

（3）单击 upperbound=按钮。 

（4）在 upperbound=后输入 30000。 

（5）单击 response=按钮，并选择此前创建的 Stress响应。 

（6）单击 loadsteps按钮。 

（7）选择名为 SUBCASE 1的工况，并单击 select按钮。 

（8）单击 create按钮。 

（9）单击 return按钮两次，回到主面板。 

保存模型文件 

（1）在 File下拉菜单中选择 Save as命令。 

（2）选取待输出的工作文件夹，输入文件名 4bar_design_opt.hm。 

（3）单击 Save按钮。 

递交 OptiStruct进行求解计算 

（1）在 Analysis页面下，单击 OptiStruct按钮。 

（2）将 export options设置为 all。 

（3）在 run options中，选择 optimization。 

（4）在 memory options中，选择 memory default。 

（5）单击 save as按钮。 

（6）在工作文件夹下，将模型输出为 4bar_design_opt.fem。 

（7）单击 save按钮。 

（8）单击 OptiStruct按钮，开始求解。 

顺利递交求解后，将弹出 OptiStruct 的 DOS 求解器界面及相关的求解信息。求解完成

后，将在用户的工作文件夹下生成若干结果文件，其中 4bar_design_user.eslout 文件包含了优

化迭代历程的信息。 
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在 HyperView中，查看最后一步迭代模型的应力分布 

（1）完成求解后，关闭OptiStruct的DOS求解页面，并回到HyperMesh前处理环境中。 

（2）在 OptiStruct面板下，单击 HyperView按钮，进入结果后处理模块。 

（3）在 File菜单中选择Open→Report Template命令，调用此前保存的结果后处理模板。 

（4）选择此前保存的 Stress_report.tpl模板，并单击 OK按钮。 

（5）在 GRAPHIC_FILE_1和 RESULT_FILE_1中，选择由优化迭代生成的 4bar_design_ 

opt_mbd_0#.h3d文件。其中，文件名中的#表示实际迭代中最后一步迭代的编号。 

（6）单击 Apply按钮，关闭弹出的 HyperView信息栏。 

（7）单击Window 1，使其处于激活状态。 

（8）在 HyperView工具栏中单击 Contour按钮 。 

（9）在 Result Type中选择 Stress（t），单击 Apply按钮。 

（10）单击“动画播放”按钮 ，查看瞬态分析结果，如图 8-46所示。 

 

图 8-46  优化结果 

查看形状优化后的模型形态 

（1）在 HyperView中，新建一个页面。 

（2）在 HyperView工具栏中单击 Load Model按钮 ，读取工作文件夹下名为 4bar_design_ 

opt_des_0#.h3d的结果文件。 

（3）单击 Apply按钮。 

（4）单击“云图”按钮 ，进入云图面板。 

（5）将 Result Type切换为 Shape Change（v）。 

（6）单击 Apply按钮，查看优化后的连杆形状，如图 8-47所示。 
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图 8-47  优化后的连杆形状 

8.5  小结 

优化分析在虚拟样机设计过程中有两种应用场合，一种是在初始方案仿真分析后发现设

计方案没有达到设计要求，如机构运动轨迹不合理、运动构件产生干涉、速度或加速度性能

不满足使用要求等；另一种是在获得满足设计要求的情况下改进设计以实现最优性能，如动

力输入最小、系统重量最轻、系统所占空间最小等。这些场合下均可应用 MotionSolve 优化

功能对设计方案加以改进。具体来说，对于系统级的性能改进，可使用 MotionSolve 联合

HyperStudy的优化解决方案，而对于零件级的性能改进，可使用MotionSolve联合 OptiStruct

的优化解决方案。本章通过功能介绍与应用结合的方式详细描述了两套优化解决方案的基本

功能与实现方法，相信读者学习完本章后，可对机构优化设计有更加深入的认识，能够将优

化设计广泛地应用于实际工作中。 
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第 9章     

 机械控制系统建模与仿真 

 

本章主要介绍 MotionView & MotionSolve 机械控制联合仿真功能，描述了控制系统建模工

具及使用方法，并通过实例说明了 MotionSolve 自身以及联合 Simulink 进行机械控制系统联合

仿真的基本过程。通过本章的学习，用户能够根据实际需要创建机械控制系统模型并进行联合

仿真分析。 

本章重点知识 
 
 

9.1  机械控制系统简介 

9.2  建模工具 

9.3  实例 

9.4  小结 
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9.1  机械控制系统简介 

在传统的机械控制系统设计过程中，机械工程师和控制工程师需要独立开发一个模型，

使用不同的分析软件，对机械系统和控制系统分别进行独立设计、调试和试验，最后建造物

理样机，进行机械系统和控制系统的联合调试。此时，如果发现问题，机械工程师和控制工

程师需要回到各自的系统中进行修改，然后进行物理样机的反复调试。这个过程不仅浪费了

大量的人力物力，而且延长了产品设计周期。 

应用 MotionView & MotionSolve 机械控制联合分析功能，机械工程师和控制工程师可

合作建立同一分析模型，并在该模型上对机械系统和控制系统进行反复设计调试，直至达

到设计目标，然后进行物理样机建造与调试。显然，相对于传统的设计方案，机械控制联

合设计方案将大大提高设计效率，缩短研发周期，降低产品开发成本，并且可获得最优的

系统性能。 

在MotionView & MotionSolve中提供了以下 6种控制模型设计方法： 

（1）力和力矩函数。这是一种最直接的控制方法，如定义形如 F=10*DV（{m_0.idstring}）

的力，即基于线速度、增益为 10 的阻尼类型力。这种力函数可以是连续的，也可以是高度

非线性的，可以使用 STEP函数定义力的开闭。 

（2）用户自定义子程序。如 SFOSUB，用户可以子程序的形式定义控制策略，并将这种

策略与力或力矩的定义联系起来。 

（3）MotionView 提供的控制工具直接建立控制模型，这些模型在 MotionSolve中是以微

分方程的形式出现的。 

（4）导出状态矩阵。用户可以定义输入，如受控力、速度、加速度偏差，应用 Motion 

Solve/Linear 分析功能，然后导出整个系统在某个平衡点附近的状态矩阵（支持 Matlab 矩阵

格式）。该方法的主要优点是可以利用第三方软件强大的控制器设计工具。 

（5）联合仿真。利用 MotionSolve 提供的与其他控制程序的数据接口，在 MotionView

环境中建立机械系统，在其他控制程序中建立控制系统，仿真过程中 MotionSolve 与控制程

序进行数据交换，共同完成仿真分析。 

（6）控制系统导入。将控制模型转换为 C 或 Fortran 代码，然后导入到 MotionSolve 中

作为广义状态方程。这样整个仿真均由 MotionSolve 积分器完成，大大提高了计算效率并避

免了因积分步长不一致带来的错误。 

上述方法中，前 3种利用MotionView & MotionSolve软件本身即可实现，后 3种需要第

三方软件支持。本章将介绍除方法 2、6外的其余 4种方法。 

使用MotionView & MotionSolve进行机械控制系统设计主要分为以下 4个步骤： 

（1）建立机械系统模型。 

根据实际系统创建几何模型、定义各种约束与载荷并完成机械系统动力学分析。 

（2）确定输入/输出量。 

确定机械系统的输入/输出量，可在机械系统和控制系统之间建立一个闭合回路。这

里，输入指来自控制系统的控制信号，输出指监测到的机械系统运动状态信息。系统输入/

输出量如图 9-1所示。 
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（3）建立控制系统方框图。 

控制系统方框图是用 MATLAB 等控制软

件编写的整个系统的控制图，机械系统作为控

制图中的一个部分。 
（4）求解。 

定义控制参数，使用 MotionSolve 或联合

Simulink求解机械控制系统模型。 

MATLAB 是美国 MathWorks 公司出品的商业数学软件，是一种用于算法开发、数据可

视化、数据分析以及数值计算的高级技术计算语言和交互式环境。MATLAB 有很多工具

箱，其中 Simulink工具箱可用于动态系统仿真与分析。有关 MATLAB和 Simulink的具体使

用方法，可以查阅MATLAB参考书。 

9.2  建模工具 

MotionSolve 提供了以下模型单元模拟单输入单输出系统（SISO）或多输入多输出系统 

（MIMO）。这些系统可使用第三方控制软件定义并输入到MotionSolve中。 

表 9-1  MotionSolve控制对象 

Control_SISO-单输

入单输出控制单元

（SISO） 

Control_SISO定义了频域的传递函数： 

0 1

0 1

（ ）
（ ） ，

（ ）

m

m

n

n

b b s b sY s
G s m n

U s a a s a s

+ +…+
= =

+ +…+
≤                         （9-1） 

 

上图描述了单输入单输出动态系统的基本构成。该单元定义了复频域的线性时不变系统，可用于模拟

促动器（如电子、液压促动器）、振动隔离器（如衬套、减震器）以及控制器（如比例积分微分控制器）

等单元，也可用于拟合试验测量的传递函数（其中曲线拟合需在其他软件（如MATLAB）中完成） 

Control_StateEqn ­

多输入/多输出控制

单元（MIMO） 

该单元是一种抽象的模型单元，用于模拟时域中多输入多输出系统及控制器。系统特性由输入矢量 u、

状态矢量 x以及输出矢量 y描述。其中状态矢量通过一系列微分方程定义，输出矢量由一系列代数方程定

义。下图描述了多输入多输出动态系统的基本构成 

 

Control_StateEqn有以下两种形式 

 

图 9-1  系统输入/输出量 
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（续） 

LINEAR 

通过状态空间方程形式定义一个多维、线性时变系统： 

x Ax Bu

y Cx Du

= +⎧
⎨

= +⎩

&

                            （9-2） 

系统可由下图描述

 

 

式（9-2）中第一个方程定义系统状态，第二个方程定义输出，4 个矩阵 A、B、C、D

均为常数矩阵 

A 矩阵称状态矩阵，它定义了系统特性，如果系统中有 n 个状态，则 A 矩阵维数为

n×n，需保证 A 矩阵非奇异。B 矩阵称输入矩阵，它描述了输入对系统状态的影响，如果

系统中有 m个输入，则 B矩阵维数为 n×m。C矩阵称输出矩阵，它描述了系统状态对输出

的影响，如果系统中有 p 个输入，则 C 矩阵维数为 p×n。D 矩阵称直接反馈矩阵，它描述

了系统输入对输出的直接影响，D矩阵维数为 p×m 

Control_StateEqn ­

多输入/多输出控制

单元（MIMO） 

USERSUB 

通过状态空间方程形式定义一个多维、非线性时变系统： 

0 0
（ ， ， ） （ （ ） ）

（ ， ， ）

x f x u t   x t x

y g x u t

= =⎧
⎨

=⎩

&

                   （9-3） 

式中 f（）和 g（）必须连续，可使用 FORTRAN 或 C/C++定义成用户子程序加载到 Motion-

Solve中 

MotionView支持以上对象的创建，工具栏建模工具按钮及功能如表 9-2所示。 

表 9-2  控制对象建模工具按钮及功能 

鼠标操作执行功能 
按    钮 

单    击 右    击 

x 进入 Solver Variable面板 创建求解器变量 

[A1A2] 进入 Solver Array面板 创建矢量 

'abc' 进入 Solver String面板 创建字符串 

t

∂

∂
 进入 Solver Differential Equation面板 创建微分方程 

 进入 Control SISO面板 创建单入单出传递函数 

（1）求解器变量。 

Solver Variable面板用于定义求解器变量，如图 9-2所示。 

Solver Variable用于MotionSolve中显式、代数状态变量的定义。代数变量可以是系统中

某个状态的函数，也可以参考其他变量定义。因此 Solver Variable 分为两种类型，即基于表

达式的求解器变量和基于用户子程序的求解器变量。前者用于简单代数变量的定义，后者用

于复杂代数变量的定义。 

●  求解器变量是一种通用单元，常用于各种信号（如定义力、插值中的独立变量、通

用控制单元的输入/输出信号等）的定义。 
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图 9-2  Solver Variable面板 

●  Solver Variable用于定义 Control_PlantInput、Control_PlantOutput、Reference_Array等

单元的定义。 

●  通常，不建议使用 Solver Variable 定义驱动约束，因为 MotionSolve 可能无法获得收

敛解。 

●  用户子程序（VARSUB）可用于定义离散型的代数状态，即状态只在特定采样点发生

变化。但需保证用户子程序中应包含采样及数据更新的管理逻辑语句。 

（2）矢量。 

矢量型数据是由按照一定顺序排成的一行数据构成的。Solver Array 面板用于定义矢

量，如图 9-3所示。 

 

图 9-3  Solver Array面板 

矢量是一种数据保存单元，可用于线性系统方程、传递函数和运行过程函数的定义。

MotionView支持以下 6种矢量单元的创建。 

●  IC：储存一系列数据，用于 Control_Stateeqn和 Control_SISO 单元初始条件的定义。

用户可使用 IC矢量单元创建一系列数据并通过用户子程序调用。 

●  X：储存一系列数据，用于 Control_StateEqn和 Control_SISO单元状态矢量的定义。 

●  Y：储存一系列数据，用于 Control_StateEqn、Control_SISO和 Control_PlantOutput单

元输出矢量的定义。 

●  U：储存一系列数据，用于 Control_StateEqn、Control_SISO 和 Control_PlantInput 单

元输入矢量的定义。该单元储存的是一系列定义输入的求解器变量的编号。 

●  PlantInput：用于定义机械系统的输入，是定义线性系统的必要部分。 

●  PlantOutput：用于定义机械系统的输出，是定义线性系统的必要部分。 

定义了输入/输出后，用户可使用 MotionSolve 线性分析功能求解式（9-2）所示的线

性、状态空间形式的系统。 

注： 

●  IC 矢量值可通过 GTARAY 返回，其他类型的矢量值可使用 SYSARY、ARRAY 或

SYSFNC函数返回。 
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●  IC矢量可定义一系列常数传递到用户自定义程序中。 

●  MotionView & MotionSolve 与其他控制程序之间的数据交换是通过状态变量实现的。

状态变量在计算过程中是一个数组，包含一系列数值。在定义输入/输出之前需将相

应的状态变量定义好，用于输入/输出的状态变量一般是系统模型元素的函数，如构

件的位置、速度及作用力函数等。输入量是机械系统控制量，而输出量是机械系统

输出到控制系统的变量，它的值经过控制方案后，又返回到输入量。 

（3）字符串。 

字符串型数据用于传递字符形式的数据，可由 Solver String 面板定义（MotionSolve 中

对应的关键字为 Reference_String），如图 9-4所示。 

 

图 9-4  Solver String面板 

MotionSolve 支持无限长度的字符数据，但必须是可以打印的 ASCII 字符。字符型数据

常用于自定义程序中文件名、信息、数据块名以及 DLL 名称的传递。在自定义程序中，可

使用 GTSTRG调用 Reference_String定义的字符。 

（4）微分方程。 

Solver Differential Equation 面板用于简单的、一阶微分方程的创建（在 MotionSolve 中

的对应关键字为 Control_Diff），如图 9-5所示。 

 

图 9-5  Solver Differential Equation面板 

1）Control_Diff 是一种通用单元，常用于模拟低通滤波器、时滞信号、简单反馈回路或

积分信号等，这些信号可用来定义载荷、用做样条插值函数的独立变量以及通用控制单元的

输入/输出信号等。 

2）Control_Diff 可以是用户自定义的动态状态变量的函数，也可以是系统变量的函数，

前者可通过用户子程序 DIFSUB实现，后者可由MotionSolve表达式创建。 

3）MotionSolve支持显式和隐式两种类型的微分方程。 

●  典型的显式微分方程形式为 （ ， ， ）y f y u t=& 。式中，y为待求解的变量；u为输入量，与

系统状态相关；t 为独立变量，一般为时间。单摆运动方程 （ / ）sin（ ） 0g Lθ θ+ =&& ，即

属于这一类方程。 

●  典型的隐式微分方程形式为 （ ， ， ， ） 0F y y u t =& 。式中，y为待求解的变量；u为输入量，
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与系统状态相关；t 为独立变量，一般为时间。方程
2 3 3 2 2（ ） （ ） （ 1）ty y y y t t y− + + −& & &  

2 0t y = 即属于这一类方程，该方程无法显式的表达 y& 。对于隐式微分方程，需确保
F y∂ ∂&非零，并需要提供 y&的初值。 

4）定义隐式时需要提供待求解变量值及其关于时间的导数值，MotionSolve 的 DIF（ID）

函数用于获取状态变量值，DIF1（ID）函数用于获取状态变量关于时间的导数值。 

5）如果定义微分方程组，可考虑使用 Control_StateEqe单元。 

（5）单输入单输出传递函数。 

Control SISO 面板用于定义单输入单输出传递函数，如图 9-6 所示。传递函数决定了一

个系统输出与输入之间的关系。 

 

图 9-6  Control SISO面板 

在 Properties标签的 Numerators和 Denominators选项区可定义传递函数的分子与分母系

数，Input 标签用于定义输入量。由此获得了式（9-1）所示的传递函数及输入 u。Motion- 

Solve会将频域模型自动转换成时域一阶微分代数方程组，如式（9-2）所示，这里 u和 y 均

是一维数组。 

Control_SISO 是个通用单元，在多学科系统中有不同的应用。它可以传递函数的形式定

义外部子系统。典型的子系统如下： 

●  PID及其他控制器。 

●  液压、气动及机电式作动器。 

●  一阶延迟单元。 

●  简单驾驶员模型。 

●  隔振器。 

在静态和准静态分析中，系统状态特性由 is_static_hold功能控制。 

当 is_static_hold = "TRUE"时，如果求解开始于 0时刻，则系统状态保持 IC矢量指定的

初始值不变。如果求解开始于动力学分析之后，系统状态则保持动力学分析最后时刻的结果

不变。此时 Control_SISO 中定义状态的方程将变为 x（t*） = x*，其中 x*为常数。注意当系统状

态保持固定时，在静平衡或准静态分析后，系统状态关于时间的导数将不再为 0，此时输入

u将会发生变化。如果后续进行动力学分析，将会在结果中产生瞬态影响。 

当 is_static_hold = "FALSE"时，系统状态不再保持不变，而是随着求解过程中整个系统

属性的变化而变化。过程如下所述：在静态或准静态分析中，系统状态关于时间的导数设置

为 0，使得 Control_SISO转换为一组代数方程。此时微分方程变为 0Ax Bu+ = 。静平衡分析
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时，输入 u 随着系统属性的变化而变化，以获得静平衡。因此按照上述方程根据当前的输入

u 求解系统状态。这种方法保证了静态或准静态分析结束后，系统状态关于时间的导数为

0，因而可以保证后续平滑的动力学分析。 

9.3  实例 

9. 3.1  弹簧质量系统仿真分析 

本实例通过弹簧阻尼-质量系统（见图 9-7 所

示）介绍 MotionView & MotionSolve 中的微分方

程、线性系统方程和传递函数的建模方法。 

弹簧阻尼-质量系统的动力学方程可写为 

           0mx cx kx f+ + − =&& &  （9-4） 

式中，x 为方块位移，m 为方块质量，k 为弹簧刚度，c 为弹簧阻尼，f 为方块承受的重力。

本例取 m=1kg，k=10N/m，c=2Ns/m，f=10N，则弹簧阻尼-质量系统动力学方程可写为 

                               2 10 10 0x x x+ + − =&& &  （9-5） 

将弹簧阻尼-质量系统动力学方程进行拉普拉斯变换，可得到弹簧阻尼-系统的传递函

数为 

                         
2 2

1 1
（ ）

10 2

X
G s

F k cs ms s s
= = =

+ + + +

 （9-6） 

根据线性系统理论， 

                                  
x Ax Bu

y Cx Du

= +⎧
⎨

= +⎩

&
 （9-7） 

取 1
x 和 2 1

x x= & 为线性系统的状态变量，可将弹簧阻尼-质量系统动力学方程转化为线性

系统方程： 

            
1 1 1

2 2 2

0 1 0 0 1 0

/ / 1/ 10 2 10

x x x
f

x x xk m c m m

⎛ ⎞ ⎛ ⎞ ⎛ ⎞⎛ ⎞ ⎛ ⎞ ⎛ ⎞ ⎛ ⎞
= + = +⎜ ⎟ ⎜ ⎟ ⎜ ⎟⎜ ⎟ ⎜ ⎟ ⎜ ⎟ ⎜ ⎟

− − − −⎝ ⎠ ⎝ ⎠ ⎝ ⎠ ⎝ ⎠⎝ ⎠ ⎝ ⎠ ⎝ ⎠

&
&

 （9-8） 

下面分别用微分方程、传递函数和线性系统方程方法进行弹簧阻尼-质量系统动力学

分析。 

1.微分方程方法 

首先定义弹簧阻尼-质量系统数学模型。MotionView & MotionSolve 支持一阶微分方程

的建模与求解，因此需将上述二阶微分方程降阶。另外，取状态变量初始值为 1
（0） 0x = ，

2
（0） 0x = ，由此得到的系统数学模型为： 

 

图 9-7  弹簧阻尼-质量系统 
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1 2

2 1 2

1 2

1

（0） 0，   （0） 0

1， 10， 2， 10

x x

k c
x x x f

m m m

x x

m k c f

=⎧
⎪
⎪ = − − +
⎨
⎪ = =
⎪

= = = =⎩

&

&
 （9-9） 

创建求解器变量 

（1）启动MotionView，新建一个会话。 

（2）从项目浏览树中右击Model，并选择 Add Control Entity→Solver Variable（或右击工

具栏中的“求解器变量”按钮 ）。 

（3）在弹出的 Add Solver Variable对话框中，指定标题为 m。 

（4）使用默认的变量名，如图 9-8所示。 

（5）单击 OK按钮。 

（6）在 Solver Variable面板的 Properties标签中，选择变量类型为 Linear，并指定数值为

1.0，如图 9-9所示。 

         

       图 9-8  Add Solver Variable对话框                  图 9-9  Solver Variable面板 

（7）重复上述步骤，分别定义系统变量 k=10、c=2、f=10。 

定义微分方程 

（1）从项目浏览树中右击Model，并选择 Add Control Entity→Solver Differential Equation

（或右击工具栏中的“求解器变量”按钮 ）。 

（2）在弹出的 Add SolverDiff对话框中，指定标题为 x1。 

（3）使用默认的变量名，如图 9-10所示。 

（4）单击 OK按钮。 

（5）创建一个标题为 x2的微分方程，变量名可取默认值。 

（6）在项目浏览树中单击 x1，进入微分方程面板。 

（7）将微分方程类型设置为 Value Expression，如图 9-11所示。 

（8）单击按钮 ，进入表达式编辑器对话框。 

 STEP 

01 

 STEP 

02 
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       图 9-10  Add SolverDiff对话框                图 9-11  Solver Differential Equation面板 

（9）根据图 9-12，创建微分方程`DIF（{diff_1.id}）`。创建完毕可单击 Evaluated按钮对表

达式进行评估。 

 

图 9-12  表达式编辑器对话框 

（10）单击 OK按钮，微分表达式出现在微分方程面板中。 

（11）重复步骤（6）～（10），创建第二个微分方程，表达式为 

`-{sv_1.value.lin}/{sv_0.value.lin}*DIF（{diff_0.id}）-{sv_2.value.lin}/{sv_0.value.lin} 

*DIF（{diff_1.id}） +{sv_3.value.lin}/{sv_0.value.lin}` 

定义输出 

（1）右击工具栏中的 Output按钮 。 

（2）在弹出的 Add Output对话框中使用默认的标题与变量名创建一个输出请求。 

（3）在 Output面板中将输出请求类型设置为 Expressions。 

（4）激活 F2，单击按钮 ，进入表达式编辑器对话框。 

 STEP 

03 
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（5）定义输出请求表达式为`DIF（{diff_0.id}）`。此表达式将输出 x1状态。 

求解微分方程 

（1）单击 Save按钮 ，保存模型为 Spring_Diff.mdl。 

（2）单击工具栏中的 Run按钮 ，进入 Run面板。 

（3）进入 Simulation Parameter标签，将 End time设置为 5，其余使用默认设置。 

（4）返回Main标签，单击“文件浏览”按钮 。 

（5）指定工作文件夹，将模型保存为 Spring_Diff.xml。 

（6）单击 Run按钮，求解模型。 

2.传递函数方法 

定义单入单出传递函数 

（1）启动MotionView，新建一个会话。 

（2）从项目浏览树中右击Model，并选择 Add Control Entity→ControlSISO（或右击工具

栏中的“单入单出传递函数”按钮 ）。 

（3）在弹出的Add ControlSISO对话框中，使用默认的标题和变量名新建一个传递函数。 

（4）进入 ControlSISO面板。 

（5）激活 Properties 标签，定义传递函数参数，如图 9-13 所示。创建分母时，单击

Append按钮可增加项目。 

 

图 9-13  ControlSISO面板（Properties标签） 

这里定义传递函数为 

                              
2 2

1 1
（ ）

10 2

X
G s

F k cs ms s s
= = =

+ + + +

 （9-10） 

（6）进入 Input标签，定义输入类型为 Linear。 

（7）指定输入值为 10，如图 9-14所示。 

 

图 9-14  ControlSISO面板（Input标签） 
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这里定义系统承受外载为 10N。 

定义输出 

（1）右击工具栏中的 Output按钮 。 

（2）在弹出的 Add Output对话框中使用默认的标题与变量名创建一个输出。 

（3）在 Output面板中将输出请求类型设置为 Expression。 

（4）激活 F2，单击 按钮，进入表达式编辑器对话框。 

（5）定义输出请求表达式为`{siso_0.OUTPUT}`。此表达式将输出 X的状态。 

求解单入单出系统 

（1）单击 Save按钮 ，保存模型为 Spring_Transfer.mdl。 

（2）单击工具栏中的 Run按钮 ，进入 Run面板。 

（3）进入 Simulation Parameter标签，将 End time设置为 5，其余使用默认设置。 

（4）返回Main标签，单击“文件浏览”按钮 。 

（5）指定工作文件夹，将模型保存为 Spring_Transfer.xml。 

（6）单击 Run按钮，求解模型。 

3.线性系统方程方法 

定义求解器变量 

本例将 f作为系统输入，x作为系统输出，因此只需定义线性系统的常系数矩阵。 

0 1

10 2
A

⎛ ⎞
= ⎜ ⎟

− −⎝ ⎠
，

0

1
B

⎛ ⎞
= ⎜ ⎟
⎝ ⎠
。这里使用求解器变量定义系统输入。 

（1）启动MotionView，新建一个会话。 

（2）从项目浏览树中右击Model，选择 Add Control Entity→Solver Variable（或右击工具

栏中的“求解器变量”按钮 ）。 

（3）在弹出的 Add Solver Variable对话框中，指定标题为 f。 

（4）使用默认的变量名。 

（5）单击 OK按钮。 

（6）在求解器变量面板的 Properties标签中，选择变量类型为 Linear，并指定数值为 10。 

定义系统状态与输入矢量 

（1）从项目浏览树中右击Model，选择 Add Control Entity→Solver Array（或右击工具栏

中的“求解器变量”按钮 ）。 

（2）在弹出的 Add Solver Array对话框中，指定标题为 U。 
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（3）使用默认的变量名。 

（4）在 Solver Array面板的 Properties标签中，将Array type设置为U，如图 9-15所示。 

 

图 9-15  Solver Array面板 

（5）单击 SolverVariable按钮，选择上步定义的求解器变量 f。该矢量用于提供输入。 

（6）新建一个标题为 X的 Solver Array。 

（7）在 Solver Array面板的 Properties标签中，将 Array type设置为 X。该矢量用于定义

系统状态。 

定义线性系统常数矩阵 

目前，MotionView 不支持矩阵对象的建模，因此需要手动编辑求解器文件。本步首先

将上述创建的模型导出，然后对其进行编辑。 

（1）单击 Export Solver Deck按钮 。 

（2）在弹出的 Export Solver Deck对话框中单击“文件浏览”按钮 ，指定工作路径。 

（3）将模型保存为 Spring_Linear.xml。 

（4）使用文本编辑器打开 Spring_Linear.xml。 

（5）在命令行</Model>前定义常数矩阵 A。 

  <Reference_Matrix 

id   = "1" 

nrow                = "2" 

ncol   = "2" 

isSparse = "FALSE" 

isRowOrder   = “TRUE" 

nval    = "16"> 

  0  1 

 -10 -2 

</Reference_Matrix> 

（6）定义常数矩阵 B。 

<Reference_Matrix 

id                  = "2" 

nrow                = "2" 

ncol                = "1" 
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isSparse= "FALSE" 

isRowOrder          ="TRUE" 

nval                ="8"> 

     0    1 

</Reference_Matrix> 

（7）定义状态方程。 

<Control_StateEqn 

id                  = "301001" 
type                = "LINEAR" 

     x_solver_array_id   = "30100200" 
     u_solver_array_id   = "30100100" 

     a_matrix_id         = "1" 

     b_matrix_id         = "2" 

/> 

（8）保存模型。 

求解线性系统 

（1）启动MotionSolve。 

（2）找到上步保存的 Spring_Linear.xml文件。 

（3）单击 Run按钮，求解模型。 

查看结果 

（1）启动 HyperGraph。 

（2）单击 Data file 栏的“文件浏览”按钮 ，载入 Spring_Diff.abf 文件，定义绘制曲

线，如图 9-16所示。 

 

图 9-16  Build plots面板（载入 Spring_Diff.abf文件） 

（3）单击工具栏中的 Define plot按钮 。 

（4）将曲线名称修改为 Spring_Diff，如图 9-17所示。 

（5）单击 Build Plots按钮 ，进入 Build Plots面板。 

（6）单击 Data file 栏的“文件浏览”按钮 ，载入 Spring_ 

Transfer.abf文件，定义绘制曲线如图 9-18所示。 

（7）将曲线名称修改为 Spring_Transfer。 
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图 9-18  Build plots面板（载入 Spring_Transfer.abf文件） 

（8）类似地，载入 Spring_Linar.abf文件。绘制曲线，如图 9-19所示。 

 

图 9-19  Build plots面板（载入 Spring_Linar.abf文件） 

（9）将曲线名称修改为 Spring_Linear。 

（10）此时图形区曲线如图 9-20所示。可以看出 3种方法获得的结果相同，即方块在重

力作用下位移变化稳定于 1m。读者可以试着创建弹簧阻尼-质量系统虚拟样机模型，求解并

对比结果。 

 

图 9-20  曲线对比 

9. 3.2  单入单出系统控制分析 

考查一个机电系统的转子模型在存在外界干扰的情况下，通过控制系统将转子转速维持

在一个稳定的水平。控制系统的框图如图 9-21所示。 

这个控制系统使用经典的 PI控制（Ogata，1995），其控制方程为 

                                （ ） P

C

K s K
G s

s

+

=  （9-11） 
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图 9-21  转子控制系统控制框图 

本例将演示如何在 MotionView 中建立这个单入单出控制系统模型，并在 MotionSolve

中进行求解。练习开始前，首先将目录 chap09下的 rotor.mdl文件复制到工作文件夹中。 

读取转子模型 

（1）启动MotionView。 

（2）读取工作目录下的模型 rotor.mdl。 

（3）模型中包含了名为 rotor 的几何体，该几何体通过一个转动副与地面连接。转动副

的转轴与 Z 轴平行。为加快系统稳定，在转动副上添加了阻尼。模型中同时包含输出控制请

求，用于在后续的求解过程中，输出转子的位移及速度信息。 

为参考速度添加求解器参数 

（1）在项目浏览树中右击MBD Model，选择 Add Control Entity→Solver Variable，或右

击 Solver Variable按钮 。 

（2）在弹出的 Add SolverVariable对话框中，将 Label改为 Reference Speed。 

（3）保持其变量名为 sv_0。 

（4）单击 OK按钮。 

（5）设定转速为 3rad/s，在 Type栏中选择 Linear，并输入 3。 

添加一个 SISO控制器 

本步将在模型中添加一个 SISO 控制器。该单输入单输出控制器，其输入为转子当前转

速与参考速度的差值，输出为控制器根据输入结果，输出给转子的扭矩改变量。该控制方程

中的参数 Kp=1，K=10，在此处仅为建模方便需要，没有实际的意义。 

（1）在项目浏览树中右击MBD Model，选择 Add Control Entity→Control SISO，或在工

具栏中右击 Control SISO按钮 。 

（2）在弹出的 Add Control对话框中使用默认的标题与变量名。 

（3）单击 OK按钮。 

（4）单击 Properties标签。 

（5）在 Numerators栏中单击 Append，定义传递函数分子。 

（6）在栏 l中输入 10，在栏 s中输入 1。 

（7）类似地，在 Denominators栏单击 Append，定义传递函数分母。 
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（8）在栏 l中输入 0，在栏 s中输入 1。 

此时创建的传递函数为
10

（ ）
C

s
G s

s

+
= 。 

（9）激活 Input标签，在 Type中选择 Expression，并输入以下表达式： 

`-WZ（{b_0.cm.idstring}）+{sv_0.value.lin}` 

添加控制扭矩 

在这一步中，将向转子添加一个控制扭矩。 

（1）在项目浏览树中右击MBD Model，选择 Add Force Entity→Force，或右击工具栏中

的 Force按钮 。 

（2）在弹出的 Add Force or ForcePair对话框中设定标题为 control。 

（3）使用默认的变量名，单击 OK按钮。 

（4）在 Connectivity 面板中的 Force 下拉列表中选择 Action reaction，在 Properties 下拉

列表中选择 Rotational。 

（5）在 Action force on处，双击 Body1按钮，并选择 rotor。 

（6）在 Reaction force on处，双击 Body2按钮，并选择 Ground Body。 

（7）在 Apply force at处，双击 Point 1按钮，并选择 Point 0。 

（8）在 Local ref.frame处，双击 Ref Marker按钮，选择 Global Frame，如图 9-22所示。 

 

图 9-22  Force面板（control） 

（9）激活 Rot Properties标签，将 TX和 TY都置为 0。 

（10）在 TZ下拉列表中选择 Expression，并输入`{siso_0.OUTPUT}` 

定义控制力矩输出请求 

（1）在项目浏览树中右击Model，选择 Add General MDL Entity→Output命令，或右击

Outputs按钮 。 

（2）在弹出的 Add Output对话框中，设定标题为 Control Force。 

（3）使用默认的变量名，单击 OK按钮。 

（4）按图 9-23所示的内容，定义输出参数。 
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图 9-23  Output面板（control） 

递交求解 

（1）在 File菜单中选择 Save As→Model命令，另存模型为 rotor_control.mdl。 

（2）在工具栏下单击 按钮，进入 Run面板。 

（3）在 Sim Type下选择 Transient，并指定文件名 rotor_control.xml。 

（4）在 Simulation Parameters标签下将 End Time设置为 25。 

（5）回到Main标签，并单击 Run按钮。 

（6）求解结束后，返回 Run面板。 

（7）单击 Plot，激活窗口 2，并进入 HyperGraph界面。 

（8）根据图 9-24绘制转子 Z轴角速度曲线。 

 

图 9-24  Build Plots面板（Z轴角速度曲线） 

（9）将窗口布局设置为 。 

（10）激活窗口 3，并切换为 HyperGraph界面。 

（11）根据图 9-25绘制控制力矩曲线。 

 

图 9-25  Build Plots面板（力矩曲线） 

（12）由图 9-26可以看出转子在 3rad/s的转速下稳定转动。 

接下来，给转子施加扰动，考察控制系统是否起作用。这里将定义一个脉冲作为扰动。 

定义扰动 

（1）激活窗口 1。 

（2）在项目浏览树中右击MBD Model，选择 Add Force Entity→Force命令，或右击工具

栏中的 Force按钮 。 
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图 9-26  转子运动结果 

（3）在弹出的 Add Force or ForcePair对话框中设定标题为 disturbance。 

（4）使用默认的变量名，单击 OK按钮。 

（5）在 Connectivity 面板中的 Force 下拉列表中选择 Action reaction，在 Properties 下拉

列表中选择 Rotational。 

（6）在 Action force on处，双击 Body1按钮，并选择 rotor。 

（7）在 Reaction force on处，双击 Body2按钮，并选择 Ground Body。 

（8）在 Apply force at处，双击 Point 1按钮，并选择 Point 0。 

（9）在 Local ref.frame处，双击 Ref Marker按钮，选择 Global Frame，如图 9-27所示。 

 

图 9-27  Force面板（disturbance） 

（10）激活 Rot Properties标签，将 TX和 TY都置为 0。 

（11）在 TZ下，选择 Expression，并输入 

`3*STEP（time，12，0，12.1，1）*STEP（time，12.2，1，12.3，0）`。 

定义扰动输出请求 

（1）在项目浏览树中右击MBD Model，选择 Add General MDL Entity→Output命令，或

右击 Outputs按钮 。 
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（2）在弹出 Add Output对话框中，设定标题为 disturbance Force。 

（3）使用默认的变量名，单击 OK按钮。 

（4）按图 9-28所示的内容，定义输出参数。 

 

图 9-28  Output面板（disturbance Force） 

递交求解 

（1）在 File 菜单中选择 Save As→Model 命令，另存模型为 rotor_control_disturbance. 

mdl。 

（2）在工具栏下单击 按钮，进入 Run面板。 

（3）在 Sim Type下选择 Transient，并指定文件名 rotor_control_disturbance.xml。 

（4）设置 Simulation Parameters标签的 End Time为 25。 

（5）回到Main标签，单击 Run按钮，求解模型。 

（6）求解结束后，单击窗口 2。 

（7）根据图 9-29绘制受扰动转子 Z轴角速度曲线。 

 

图 9-29  Build Plots面板（Z轴角速度曲线） 

（8）单击窗口 3。 

（9）根据图 9-30绘制受扰动转子控制力矩曲线。 

 

图 9-30  Build Plots面板（控制力矩曲线） 

（10）根据图 9-31绘制扰动力矩曲线。 

 

图 9-31  Build Plots面板（扰动力矩曲线） 
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（11）由图 9-32 可以看出转子在受到扰动后，在控制器的作用下很快恢复到 3rad/s 的稳

定转动状态。 

 

图 9-32  扰动作用下的转子运动结果 

9. 3.3  汽车悬架系统控制分析 

本示例将演示汽车悬架系统联合仿真过程。汽车悬架系统由车身、悬挂系统以及虚拟路

面构成，车身、悬挂系统以及路面通过移动副串联。同时，为模拟路面颠簸，在模型中为虚

拟路面模型添加了正弦形式的驱动约束。汽车悬架系统如图 9-33所示。 

 

图 9-33  汽车悬架系统 

除了定义机械系统模型外，还需创建控制系统。控制系统为整个悬挂系统提供参考位移

和参考速度，并与从多体系统中获得的位移和速度信息进行比较，根据比较结果输出控制信

号。控制系统框图如图 9-34 所示，Gc（S）表示多输入多输出控制器；D（S）表示在汽车悬挂系

统模型中，车体集中质量位移信息；V（S）表示在汽车悬挂系统中；车体集中质量速度信息；

Rd（S）表示参考位移信号；Rv（S）表示参考速度信号；E1（S）表示监测到的位移信号与参考位移

信号之差；E2（S）表示监测到的速度信号与参考速度信号之差；Y1（S）表示控制器输出控制信
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号 1，Y2（S）表示控制器输出控制信号 2。 

 

图 9-34  汽车悬架控制系统框图 

控制器的传递函数为 

                                          
x Ax Bu

y Cx Du

= +⎧
⎨

= +⎩

&
 （9-12） 

式中，A为状态矩阵，B为输入矩阵，C为输出矩阵，D为直接反馈矩阵。 

下面给出了控制器的状态空间： 

A = [0 0；0 0]，B = [1 0；0 1]，C = [10 0；0 20]，D = [10000 0；0 20000]， 

u = [车体集中质量位移，车体集中质量速度]，y = [输出力（刚度），输出力（阻尼）] 

在本练习中，控制系统将检测车体集中质量的位移和速度信息，并与参考位移和速度信

号进行比较，根据比较结果，输出控制信号，包括悬挂系统刚度和阻尼的控制信息，保证系

统平稳运转。 

在本练习中，将学习以下内容： 

●  在 MotionView 中建立车身及悬挂系统多体动力学模型，通过 MotionSolve 关键字

Control_Stateeqn Element建立内置的控制方程，对多体系统进行试算，获取基本计算

结果。 

●  编辑 MotionSolve XML 格式模型，添加 Control_Plantinput 和 Control_Plantoutput 关

键字，为联合仿真建立输出信号和输入信号。 

●  在 Simulink中对控制器模型进行调试。 

●  进行联合仿真，并与使用MotionSolve内置控制模型的计算结果进行对比。 

1.创建机械系统模型 

创建几何点 

（1）启动MotionView。 

（2）右击工具栏中的 Point按钮 。 

（3）在弹出的 Add Point or PointPair对话框中，设置标题为 road_cg。 

（4）使用默认的变量名，单击 OK按钮。 

（5）在 Point面板中，定义该点的空间坐标为（0，0，0）。 

（6）类似地，定义标题为 suspension_cg 的点，空间坐标为（0，0，0.1）；标题为 bus_cg 的

点，空间坐标为（0，0，0.2）。 
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创建几何体 

（1）右击工具栏中的 Body按钮 。 

（2）在弹出的 Add Body or Bodypair对话框中，设置标题为 road dummy。 

（3）使用默认的变量名，单击 OK按钮，创建虚拟路面体。 

（4）在 Body面板中，进入 Properties标签，根据图 9-35定义体参数。 

 

图 9-35  Body面板（road dummy） 

（5）进入 CM Coordinates标签，激活 Use center of mass coordinate systems选项，设置体

质心为 road_cg。 

（6）类似地，定义标题为 suspension的几何体，根据图 9-36定义该体质量和转动惯量

参数。 

 

图 9-36  Body面板（suspension） 

（7）进入 CM Coordinates标签，激活 Use center of mass coordinate systems选项，设置体

质心为 suspension_cg。 

（8）类似地，定义标题为 bus的几何体，根据图 9-37定义该体质量和转动惯量参数。 

 

图 9-37  Body面板（bus） 

（9）进入 CM Coordinates标签，激活 Use center of mass coordinate systems选项，设置体

质心为 bus_cg。 
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创建图形 

（1）右击工具栏中的 Graphic按钮 。 

（2）在弹出的 Add Graphic对话框中，设置标题为 road。 

（3）使用默认的变量名，设置图形类型为 Box。 

（4）单击 OK按钮，创建虚拟路面体图形。 

（5）在 Graphic面板中，进入 Connectivity标签，根据图 9-38定义图形的关联对象。 

 

图 9-38  Graphic面板 Connectivity标签（road） 

（6）进入 Properties标签，根据图 9-39定义图形参数。 

 

图 9-39  Graphic面板 Properties标签（road） 

（7）类似地，创建标题为 suspension的图形，设置图形类型为 Cylinder。 

（8）在 Graphic面板中，进入 Connectivity标签，根据图 9-40定义图形的关联对象。 

 

图 9-40  Graphic面板 Connectivity标签（suspension） 

（9）进入 Properties标签，根据图 9-41定义图形参数。 

（10）类似地，创建标题为 bus的图形，设置图形类型为 Cylinder。 

（11）在 Graphic面板中，进入 Connectivity标签，根据图 9-42定义图形的关联对象。 
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图 9-41  Graphic面板 Properties标签（suspension） 

 

图 9-42  Graphic面板 Connectivity标签（bus） 

（12）进入 Properties标签，根据图 9-43定义图形参数。 

 

图 9-43  Graphic面板 Properties标签（bus） 

创建弹簧 

（1）右击工具栏中的 Spring Damper按钮 。 

（2）在弹出的 Add SpringDamper or SpringDamperPair 对话框中，设置标题为 road_ 

suspension。 

（3）使用默认的变量名，设置弹簧类型为 Coil Spring（拉伸弹簧）。 

（4）单击 OK按钮。 

（5）在 Spring Damper面板中，进入 Connectivity标签，根据图 9-44定义弹簧阻尼单元

的关联对象。 

（6）进入 Properties标签，根据图 9-45定义弹簧刚度阻尼参数。 

（7）类似地，创建标题为 suspension_bus 的弹簧，设置弹簧类型为 Coil Spring（拉伸

弹簧）。 
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图 9-44  Spring Damper面板 Connectivity标签（road_suspension） 

 

图 9-45  Spring Damper面板 Properties标签（road_suspension） 

（8）在 Spring Damper 面板中，进入 Connectivity 标签，根据图 9-46 定义图形的关联

对象。 

 

图 9-46  Spring Damper面板 Connectivity标签（suspension_bus） 

（9）进入 Properties标签，根据图 9-47定义弹簧刚度阻尼参数。 

 

图 9-47  Spring Damper面板 Properties标签（suspension_bus） 

创建弹簧图形 

（1）右击工具栏中的 Graphic按钮 。 

（2）在弹出的Add Graphic or GraphicPair对话框中，设置标题为 Spring_road_suspension。 

（3）使用默认的变量名，设置图形类型为 Spring。 

（4）单击 OK按钮。 
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（5）在 Graphic面板中，进入 Connectivity标签，根据图 9-48定义图形的关联对象。 

 

图 9-48  Graphic面板 Connectivity标签（Spring_road_suspension） 

（6）进入 Properties标签，根据图 9-49定义图形外形参数。 

 

图 9-49  Graphic面板 Properties标签（Spring_road_suspension） 

（7）类似地，创建标题为 Spring_suspension_bus的图形，设置图形类型为 Spring。 

（8）在 Graphic面板中，进入 Connectivity标签，根据图 9-50定义图形的关联对象。 

 

图 9-50  Graphic面板 Connectivity标签（Spring_suspension_bus） 

（9）进入 Properties标签，根据图 9-51定义弹簧图形的外形参数。 

 

图 9-51  Graphic面板 Properties标签（Spring_suspension_bus） 

创建约束副 

（1）右击工具栏中的 Joint按钮 。 

（2）在弹出的 Add Joint or JointPair对话框中，设置标题为 road_ground。 
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（3）使用默认的变量名，设置图形类型为 Translational Joint（平移副）。 

（4）单击 OK按钮。 

（5）在 Joint面板中，进入 Connectivity标签，根据图 9-52定义铰的关联对象。 

 

图 9-52  Joint面板 Connectivity标签（road_ground） 

（6）类似地，创建标题为 suspension_ground的平移副。 

（7）在 Joint面板中，进入 Connectivity标签，根据图 9-53定义铰的关联对象。 

 

图 9-53  Joint面板 Connectivity标签（suspension_ground） 

（8）类似地，创建标题为 bus_ground的平移副。 

（9）在 Joint面板中，进入 Connectivity标签，根据图 9-54定义铰的关联对象。 

 

图 9-54  Joint面板 Connectivity标签（bus_ground） 

创建驱动约束 

（1）右击工具栏中的Motion按钮 。 

（2）在弹出的 Add Motion or MotionPair对话框中，使用默认的标题和变量名，单击 OK

按钮。 

（3）在Motion面板中，进入 Connectivity标签，根据图 9-55定义驱动的关联对象。 
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图 9-55  Motion面板 Connectivity标签 

（4）进入 Properties 标签，定义驱动类型为 Expression，定义驱动函数为`sin（2*pi* 

TIME）*0.05`。 

创建输出请求 

（1）右击工具栏中的 Output按钮 。 

（2）在弹出的 Add Output对话框中，设置标题为 original_disp_vel。 

（3）使用默认的变量名，单击 OK按钮。 

（4）在 Output面板中，将输出类型设置为 Expressions。 

（5）单击 F2 处的文本框，输入`DZ（{b_2.cm.idstring}，{b_0.cm.idstring}）-0.2`，输出 bus

与 road之间的相对位移。 

（6）单击 F3 处的文本框，输入`VZ（{b_2.cm.idstring}，{b_0.cm.idstring}）`，输出 bus 与

road之间的相对速度。 

设置工作环境 

（1）单击打开模型浏览树 Form文件夹，单击 Gravity，进入重力设置面板。 

（2）将 Gravity由 On切换成 Off，关闭重力设置面板。 

（3）单击打开模型浏览树中的 Units项，进入单位制设置面板。 

（4）将 LENGTH设置为METER，其他单位不变。 

当前单位制系统为 m-kg-s-N。 

求解模型 

（1）在工具栏下单击 按钮，进入 Run面板。 

（2）在 Sim Type下，选择 Transient，并指定文件名 bus_suspension_original.xml。 

（3）激活 Export MDL snapshot选项，将模型保存为.mdl格式的文件。 

（4）在 Simulation Parameters标签下的 End Time中，输入 5。 

（5）回到Main标签，并单击 Run按钮。 

（6）单击 Animate按钮，进入 HyperView，查看汽车悬架系统运动历程动画。 

（7）单击 Plot按钮，进入 HyperGraph。按照图 9-56分别绘制 bus相对 road的位移和速

度曲线，结果如图 9-57所示。 
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a） 

 

b） 

图 9-56  Build Plots 面板 

a） bus 相对 road 的位移曲线  b） bus 相对 road 的速度曲线 

 

图 9-57  仿真结果 

由图 9-57 可以看到 bus 在 road 的正弦激励作用下振动，接下来将设计控制系统，减轻

振动效果。 

2.在MotionSolve中创建控制系统模型 

创建求解器变量 

（1）返回窗口 1的MotionView界面。 

（2）右击工具栏中的 Solver Variable按钮 。 

（3）在弹出的 Add Solver Variable对话框中，设置标题为 disp_bus_road。 

（4）使用默认的变量名，单击 OK按钮。 
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（5）在 Solver Variable面板中，将求解器变量类型设置为 Expression。 

（6）单击文本框，输入`DZ（{b_2.cm.idstring}，{b_0.cm.idstring}）-0.2`。 

（7）类似地，创建标题为 vel_bus_road的求解器变量。 

（8）定义该求解器变量值为`VZ（{b_2.cm.idstring}，{b_0.cm.idstring}）`。 

定义系统状态与输入矢量 

（1）右击工具栏中的 Solver Array按钮 。 

（2）在弹出的 Add Solver Array对话框中，指定标题为 U。 

（3）使用默认的变量名。 

（4）在 Solver Array面板的 Properties标签中，将 Array type设置为 U。 

（5）单击 SolverVariable按钮，选择上步定义的求解器变量 disp_bus_road。 

（6）单击 Append 按钮，增加一个求解器变量，并设置该变量为 vel_bus_road，如图 9-58

所示。 

 

图 9-58  Solver Array面板（U） 

（7）新建一个标题名为 X的 Solver Array。 

（8）在 Solver Array面板的 Properties标签中，将 Array type设置为 X。该矢量用于定义

系统状态。 

（9）新建一个标题名为 Y的 Solver Array。 

（10）在 Solver Array面板的 Properties标签中，将 Array type设置为 Y。该矢量用于定

义系统状态。 

（11）新建一个标题名为 IC的 Solver Array。 

（12）在 Solver Array面板的 Properties标签中，将 Array type设置为 IC。该矢量用于定

义初始值状态。 

（13）进入 Values 标签，激活 Edit 选项，单击 Append 按钮增加一个初始值项目，并定

义两个初值为 0，如图 9-59所示。 

定义控制力 

（1）右击工具栏中的力按钮 。 

（2）在弹出的 Add Force or ForcePair对话框中，指定标题为 bus_suspension_1。 

（3）使用默认的变量名，单击 OK按钮，创建力。 
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图 9-59  Solver Array面板（IC） 

（4）在 Force面板的 Connectivity标签中，根据图 9-60所示的内容定义力加载对象。 

 

图 9-60  Force面板（bus_suspension_1） 

（5）进入 Trans Properties 标签，将力类型设置为 Expression，并定义力函数表达式为

`-1*ARYVAL（{sa_2.id}，1）`。 

（6）类似地，定义标题为 bus_suspension_2的力，根据图 9-61所示的内容定义力加载对象。 

 

图 9-61  Force面板（bus_suspension_2） 

（7）进入 Trans Properties 标签，将力类型设置为 Expression，并定义力函数表达式为  

`-1*ARYVAL（{sa_2.id}，2）`。 

定义线性系统常数矩阵 

目前，MotionView 不支持矩阵对象的建模，因此需要手动编辑求解器文件。本步首先

将上述创建的模型导出，然后对其进行编辑。 

（1）在File菜单中选择Save As→Model命令，另存模型为 bus_suspension_motionsolve.mdl。 

（2）单击 Export Solver Deck按钮 。 

（3）在弹出的 Export Solver Deck对话框中，单击“文件浏览”按钮 ，指定工作路径。 

（4）输出模型为 bus_suspension_motionsolve.xml。 
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（5）使用文本编辑器打开 bus_suspension_motionsolve.xml。 

（6）在命令行</Model>前定义常数矩阵 A。 

<Reference_Matrix 

id                  = "1" 

nrow                = "2" 

ncol                = "2" 

isSparse            = "FALSE" 

isRowOrder          = "TRUE" 

nval                = "16"> 

  0  0 

  0  0 

</Reference_Matrix> 

（7）定义常数矩阵 B。 

<Reference_Matrix 

id                  = "2" 

nrow                = "2" 

ncol                = "2" 

isSparse            = "FALSE" 

isRowOrder          = "TRUE" 

nval                = "8"> 

   1  0 

   0  1 

</Reference_Matrix> 

（8）定义常数矩阵 C。 

<Reference_Matrix 

id                  = "3" 

nrow                = "2" 

ncol                = "2" 

isSparse            = "FALSE" 

isRowOrder          = "TRUE" 

nval                = "1"> 

   10  0 

   0    20 

</Reference_Matrix> 

（9）定义常数矩阵 D。 

<Reference_Matrix 

id                  = "4" 

nrow                = "2" 

ncol                = "2" 

isSparse            = "FALSE" 

isRowOrder          = "TRUE" 

nval                = "1"> 
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     10000  0 

     0    20000 

</Reference_Matrix> 

（10）定义状态方程。 

<Control_StateEqn 

id                  = "301001" 

type                = "LINEAR" 

     x_solver_array_id   = "30100200" 

     y_solver_array_id   = "30100300" 

     u_solver_array_id   = "30100100" 

     ic_solver_array_id  = "30100400" 

     a_matrix_id         = "1" 

     b_matrix_id         = "2" 

     c_matrix_id         = "3" 

     d_matrix_id         = "4" 

/> 

（11）修改状态矢量与输出矢量维数为 2。 

<Reference_Array 

id                  = "30100200" 

label               = "X" 

type                = "X" 

     num_element         = "2" 

  /> 

<Reference_Array 

id                  = "30100300" 

label               = "Y" 

type                = "Y" 

     num_element         = "2" 

  /> 

（12）保存模型。 

求解模型 

（1）启动MotionSolve。 

（2）单击 Input file（s）栏的“文件浏览”按钮 ，打开上步保存的 bus_suspension_motionsolve. 

xml文件。 

（3）单击 Run按钮，求解模型。 

（4）返回MotionView界面，单击 Page Window Layout按钮，将当前界面设置为 。 

（5）激活窗口 4，将窗口 4切换到 HyperGraph程序。 

（6）根据图 9-62绘制MotionSolve控制系统作用下 bus相对 road的位移和速度曲线。 
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可以看出，在控制系统的作用下，1.25s后由路面激励产生的振动消失。 

 

图 9-62  MotionSolve控制仿真结果 

接下来联合 Simulink设计控制系统，并进行联合仿真分析。 

3.联合 Simulink设计控制系统 

定义环境变量 

联合仿真前需要定义环境变量以实现在Matlab Simulink中调用MotionSolve求解模型。 

（1）设置环境变量指向求解器执行文件工作目录。 

NUSOL_DLL_DIR=<installation directory>\hwsolvers\bin\<platform> 

这里<installation directory>为 HyperWorks 完整安装路径，<platform>为软件版本，如

win32 指 32-bit Windows版，win64指 64-bit Windows版。 

例如，在 Windows 64-bit 操作系统中设置 NUSOL_DLL_DIR=E：\Altair\HW11.0\ 

hwsolvers\bin\win64。 

（2）设置环境变量指向许可证。 

RADFLEX_PATH =<installation directory>\hwsolvers\bin\<platform> 

PATH =<installation directory>\hwsolvers\bin\<platform>；%PATH% 

注：HyperWorks工作路径已经由 PATH定义。 
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定义系统变量 

（1）回到MotionView界面。 

（2）右击工具栏中的 Solver Variable按钮 。 

（3）在弹出的 Add Solver Variable对话框中，设置标题为 FZ_disp_bus_road。 

（4）使用默认的变量名，单击 OK按钮，创建求解器变量。 

（5）在 Solver Variable面板中，将求解器变量类型设置为 Expression。 

（6）单击文本框，输入`SFORCE（{frc_0.id}，{0}，{4}，{0}）`。 

SFORCE用于返回施加的力值，调用格式为 SFORCE （id， jflag， comp， RM）。其中，id为

力对象编号；jflag值为 0 或 1，分别表示返回力对象作用物体的 I标记点或 J标记点；comp

可取值 1～8，1、2、3、4分别为合力、X轴分量、Y轴分量以及 Z轴分量的力，5、6、7和

8分别为合力矩、X轴分量、Y轴分量以及 Z轴分量的力矩；RM表示参考的坐标系，RM=0

时，表示参看全局坐标系。 

（7）类似地，创建标题为 vel_bus_road的求解器变量。 

（8）定义该求解器变量值为`SFORCE（{frc_1.id}，{0}，{4}，{0}）`。 

定义控制系统输入/输出矢量 

（1）在项目浏览树中右击 Solver Array文件夹，选择 Delete命令，删除已创建的系统状

态与输入矢量。这里将定义输入/输出量用于接收来自 Simulink的信息。 

（2）右击工具栏中的 Solver Array按钮 。 

（3）在弹出的 Add Solver Array对话框中，指定标题为 PlantInput。 

（4）使用默认的变量名，单击 OK按钮，创建控制系统输入量。 

（5）在 Solver Array面板的 Properties标签中，将 Array type设置为 Plant Input。 

（6）单击 Append按钮，增加一个 SolverVariable。 

（7）单击 SolverVariable按钮，根据图 9-63定义求解器输入量。 

 

图 9-63  Solver Array面板（PlantInput） 

（8）类似地，创建标题名为 PlantOutput的矢量。 

（9）在 Solver Array面板的 Properties标签中，将 Array type设置为 Plant Output。 

（10）单击 Append按钮，增加一个 SolverVariable。 

（11）单击 SolverVariable按钮，根据图 9-64定义求解器输出量。 
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图 9-64  Solver Array面板（Plant Output） 

修改控制力 

（1）打开项目浏览树中的 Force文件夹，单击 bus_suspension_1，进入 Force面板。 

（2）进入 Trans Properties标签，可以看到 Expression处有错误提示“Error Evaluating”。

这是由于第二部分定义的控制力中使用的输入矢量被删除了，表达式找不到相应的对象造成

的。下面将修复该错误。 

（3）单击 Expression处的文本框，输入`-1*PINVAL（{sa_0.id}，1）`。 

PINVAL 用于返回控制系统输入单元的值，其调用格式为 PINVAL（id， comp）。其中，id 为

控制系统输入单元编号，comp 表示其分量。与该函数对应的是 POUVAL（id，comp），POUVAL

用于返回控制系统输出单元的值。 

（4）类似地，单击项目浏览树 bus_suspension_2，进入 Trans Properties标签。 

（5）单击 Expression 处的文本框，将 bus_suspension_2 的表达式修改为`-1*PINVAL 

（{sa_0.id}，2）`。 

可以看到，当前表达式评估是正确的。 

求解模型 

联合仿真时，Simulink 以 S-Function 的形式调用 MotionSolve 求解机械系统模型。需要

使用 XML 文件向机械系统输出被控信号，使用 MRF 文件从机械系统获得控制信号。本步

将首先输出 XML模型，然后求解该模型，获取 MRF文件。 

（1）在 File菜单中选择 Save As→Model命令，另存模型为 bus_suspension_simulink.mdl。 

（2）单击工具栏中的 按钮，进入 Run面板。 

（3）在 Sim Type下，选择 Transient，并指定文件名 bus_suspension_simulink.xml。 

（4）在 Simulation Parameters标签下的 End Time中，输入 5。 

（5）回到Main标签，并单击 Run按钮求解模型。 

此时工作文件夹下将生成MRF、H3D、ABF等格式的结果文件。 

定义控制系统 

（1）启动Matlab。 

（2）选择 File→Set Path命令，在弹出的 Set Path对话框中单击 Add Folder按钮，选择

工作路径。 
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（3）单击 Save按钮，将工作路径加入到Matlab工作路径中。 

（4）单击 Close按钮，关闭 Set Path对话框。 

（5）返回Matlab主界面，单击 Current Folder处的 Browse for folder按钮 。 

（6）在弹出的 Select a new folder对话框中选择工作文件夹，单击OK按钮关闭该对话框。 

此时Matlab主界面中的 Current folder栏将显示工作文件夹中的所有文件。 

（7）单击 Simulink按钮 ，进入 Simulink界面。 

（8）单击 New Model按钮 ，新建一个 Simulink模型。 

（9）创建 Simulink控制系统，如图 9-65所示。 

 

图 9-65  Simulink控制系统模型（草图） 

（10）双击 State-Space，根据图 9-66修改传递函数参数。 

（11）双击 S-Function1，弹出 Function Block Parameters对话框。 

（12）将 S-function name修改为 mscosim。 

（13）在 S-function parameter文本框中输入：'bus_suspension_simulink.xml'， 'bus_suspension_ 

simulink.mrf'，''，如图 9-67所示。 

（14）单击 OK按钮，关闭 Function Block Parameters对话框。 

为提高控制系统框图的可读性，接下来修改对象名称。 

（15）双击 To Workspace，将 Variable name修改为 Pin。 

（16）单击 Scope图标下的名称，将其修改为 Scope_PIn。 

（17）双击 To Workspace 1，将 Variable name修改为 POut。 

（18）单击 Scope1图标下的名称，将其修改为 Scope_Pout。 

（19）双击 To Workspace 2，将 Variable name修改为 Time。 

修改完毕的控制系统如图 9-68所示。 

（20）单击 Save按钮 ，将模型保存为 BusSuspension.mdl。 

注意，Simulink 模型文件的扩展名也为.mdl，与 MotionView 相同。至此，已将机械控

制系统模型全部定义完毕，接下来进行联合求解。 

联合仿真 

（1）在 Simulink 模型界面上选择 Simulation→configuration parameters 命令，弹出

 STEP 

07 
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Configuration parameter对话框。 

        

         图 9-66  传递函数参数设置                 图 9-67  Function Block Parameters对话框 

 

图 9-68  Simulink控制系统模型（最终） 

（2）进入 Solver标签，将 Stop time修改为 5。 

（3）将求解器类型设置为 Variable-step，并选择 ode45求解器。 

（4）设置Max step size为 0.01，保持其他参数不变，如图 9-69所示。 

（5）单击 OK按钮，保存设置并退出 Configuration parameter对话框。 

（6）单击 Save按钮 ，保存模型。 

（7）单击 Start simulation按钮 ，求解模型。 

（8）求解结束后，双击 Scope按钮，可查看控制系统输入/输出信号，如图 9-70所示。 

比较MotionSolve自求解结果与联合仿真结果 

（1）返回 HyperView，激活窗口 4。 

（2）根据图 9-71绘制联合仿真中 Simulink控制系统作用下 bus相对 road的位移和速度

曲线。 

 STEP 

08 
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图 9-69  Configuration parameter对话框 

 
                      a）                                                      b）  

图 9-70 控制系统输入/输出信号 

a） 输出信号    b） 输入信号 

 
图 9-71  MotionSolve联合控制仿真结果 
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由图 9-71可以看出两种方法获得的结果一致。 

注：联合仿真时，仅获得 bus_suspension_simulink.mrf 和 bus_suspension_simulink.log 结

果文件。因此，绘制曲线时，打开的结果文件是 bus_suspension_simulink.mrf。 

（3）选择 File→Save→Session命令，将整个窗口保存为一个会话文件。 

（4）选择 File→Exit，退出程序。 

9.4  小结 

对于含有控制作用的机械系统，MotionView & MotionSolve 提供了两种解决方案：对于

简单的控制策略，使用自带的反馈单元创建控制系统，然后联合机械系统进行仿真；对于复

杂的控制策略，可联合第三方软件（如 Simulink），实现复杂机电系统仿真分析。本章简要

介绍了 MotionView & MotionSolve 中各种控制单元的基本功能，并通过实例详细描述了这些

单元的使用方法。相信读者学习完本章后，会对机械控制系统建模与仿真有更加全面的认

识，并且能够在实际工作中加以应用。 



 

 

第 10章     

 耐久性分析 

本章主要介绍耐久性分析向导 Durability Director 的使用方法，包括向导的基本构成、参

数设置、多体系统模型及疲劳分析模型的定义等内容，最后通过实例说明了 Durability 

Director 三种分析流程的具体用法。通过本章的学习，可以深入了解结构耐久性分析的基本过

程，根据实际需要进行机械结构的耐久性分析。 

本章重点知识 
 
 

10.1  耐久性分析流程 

10.2  启动向导与首选项设置 

10.3  标准工作流程 

10.4  实例 

10.5  小结 
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10.1  耐久性分析流程 

据统计，50%～90%的结构失效源于结构耐久性问题。结构耐久性设计需密切联系疲劳

物理现象并揭示结构在实际工作过程中的裂缝形式，因此需要一个有效的疲劳设计分析工

具。Durability Director 是一个独立于求解器的、流程化的结构耐久性分析向导，它能够实现

从载荷测量到疲劳预测的全周期管理。Durability Director 包括 3 种标准分析流程，这些流程

通过 HyperWorks 软件的另一款产品 Process Manager 进行组织管理，用户可以根据需要修改

或创建新的工作流程。图 10-1 描述了一种典型的耐久性分析工作流程。 

 

图 10-1  典型的耐久性分析工作流程 

该流程假定施加在多体系统上的载荷已知，求解包含已知载荷的多体系统模型可获得作

用在指定零件上的载荷；提取这些载荷并加载到该零件的有限元模型中，计算加载位置在单

位力工况下有限元模型的应力状态；然后将多体动力学分析获得的循环载荷和单位应力信息

提交给耐久性分析求解器，计算该零件的疲劳寿命；计算结果在通用后处理器 HyperView 中

查看。 
完成这一流程需要做以下准备工作： 
●  可以施加到多体系统或有限元模型上的测试载荷或由载荷发生装置产生的载荷。 
●  一套明确定义的信息传递流程。 
●  完整定义的多体动力学模型。 
●  完整定义的有限元模型。 
●  进行耐久性分析的材料参数。 
耐久性是指结构在远低于材料极限应力的循环载荷作用下的性能。耐久性分析用于预测

给定工作环境下的零件寿命。典型的耐久性分析流程由系统设计部门制定，主要用于设计和

验证系统。耐久性分析需要确定载荷、明确可重复的测试流程、目标零件的有限元模型、耐

久性分析材料的相关参数等。Durability Director 将管理这些数据并自动完成各种分析

任务。 
耐久性分析流程需要试验部门测试机械系统的激励，多体分析部门计算作用在目标零件

的载荷，有限元分析部门计算目标零件上的应力状态，最后由耐久性分析部门评估目标零件

的寿命。 
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耐久性分析流程集成了多个部门和多个领域工程师的工作，因此在实际操作过程中可能

面临以下挑战： 
●  多个部门之间的合作。 
●  不同部门的数据交流。 
●  标准工作流程的定义。 
●  满足特定要求的模板定制。 
●  实际工况、实验室和虚拟仿真数据间的映射。 
●  大规模仿真计算。 
●  仿真驱动的耐久性设计。 
●  优化分析。 
●  变量分析。 

10. 1.1  软件架构 

Durability Director 构建于 HyperWorks Process Manager 框架之上。Process Manager 是
一款程序化的任务管理软件，用于标准工作流程的预定义。应用该工具，可在 HyperWorks
环境下快速建立和实施标准工程产品的自动化分析流程。Durability Director 开放的架构

允许： 
（1）模块化。 
●  测试、有限元分析、多体动力学分析、耐久性分析、结果可视化。 
●  定制模板满足所需。 
●  独立于求解器。 
（2）支持多种文件格式。 
●  RPC、DAC、CSV。 
●  RADIOSS、NASTRAN。 
●  MotionSolve、ADAMS。 
（3）流程捕捉和自动化实施。 
●  符合企业标准。 
●  高质量、高效率的解决方案。 
●  PBS 作业管理。 
（4）客制化。从客制化层面捕捉客户工作流程。 
这一流程为导向的分析向导符合企业标准并保证了分析结果的可重复性，为用户提供了

以下便利： 
●  加速产品创新。 
●  降低产品研发成本并缩短研发周期。 
●  避免零件的不足/过量设计。 
●  加强了企业政策和标准的实施。 
●  信息交流与共享。 
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10. 1.2  所需的仿真软件 

耐久性分析向导需要以下软件和输入文件。 
●  循环工况文件：支持 RPC、DAC、CSV 以及 MBS（定义在多体模型中的工况）格式

文件。 
●  多体动力学分析：支持 MotionView & MotionSolve（10.0 版及以上）、ADAMS。 
●  有限元分析：支持 HyperMesh（10.0 版及以上）、RADIOSS（10.0 版及以上）、

NASTRAN。 
●  耐久性分析：RADIOSS（10.0 版及以上）、FEfatigue 7。 
●  作业提交与资源调度：支持 PBS（10.1 版及以上）。 
注：由于本书交稿之际，HyperWorks11.0 版中的 Durability Director 还未正式发布，所以

本章内容均是基于 10.0 版本。 

10. 1.3  分析需要的模型与数据 

应用 Durability Director 进行零件耐久性分析需要以下模型与数据： 
●  输入载荷、位移、速度或加速度。 
●  耐久时刻表与目标寿命。 
●  多体动力学分析模型。 
●  虚拟测试台（可选）。 
●  目标零件有限元模型。 
●  材料疲劳分析参数。 
典型的疲劳分析流程是：首先在试验场测试车辆工作载荷，然后将不同路面数据加载到

多体动力学模型中分析目标零件的受力情况，最后将目标零件承受的载荷提取出来加载到其

有限元模型中。选择的仿真软件必须很好地支持这一流程以保证仿真分析的可重复性。 
输入数据通常包括载荷、位移、速度和加速度，它们可以使用各种途径获得。这里支持

CSV、RSP 和 DAC 三种类型数据，这些数据在读入 Durability Director 后可进行放缩或偏置

处理。用户根据这些数据为目标零件建立多组循环工况。 
耐久时间表是指由一系列测试数据组成的零件全寿命周期。输入数据名及循环次数将以

循环文件（DCY）的形式保存在指定的工作路径（Master_Solution）中。时间表用于耐久性

分析向导的零件寿命分析中。用户可以选择进行应变-寿命分析或应力-寿命分析来预测零件

的寿命。大多数标准的疲劳分析是指零件的疲劳裂缝长度达到 2mm 的时间。 
多体动力学模型用于再现系统的性能。输入激励可以加载到虚拟测试台或直接加载到模

型上。多体动力学分析结果（通常为载荷）将直接应用到有限元模型中。应用多体动力学仿

真软件最初的目的是载入一个多体系统模型（如悬架系统），然后将激励载荷加载到虚拟测

试台（高性能汽车整车振动台架）进行多体系统动力学分析以获得目标零件所承受的载荷。

这一流程具有一般性，因此适用于大多数系统和测试装置。多体系统模型可由 MotionView
读入。这里的多体系统模型，建议用户使用 MotionView 的 MDL 模型，因为它应用了 Motion 
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View 的建模体系，在与虚拟试验台装配时可以自动完成。而通过模型接口读入的模型（如

ADAMS 的 ADM 模型）需要手动完成装配。 
虚拟测试台模拟了系统在实验室或试验场测试时的安装和测试方法。它与多体动力学模

型独立开来以便在测试不同系统时可以重用。这里，建议用户使用 MotionView 建立虚拟测

试台模型并将其保存成 MDL 模型。虚拟测试台可以精确模拟实际测试装置的行为，如应用

柔性体和 PID 控制器来模拟液压回路。 

10. 1.4  作业提交 

计算作业可提交到本地计算机，也可以通过 AIF/PBS 提交到远程计算集群。目前开发的

远程提交功能已实现了最大限度的后台工作。Durability Director 支持作业提交及结果处理，

同时还支持计算过程中的任务监测和作业状态报告等功能。 
PBS Works（个人批处理作业调度）是一款安装在远程计算集群的资源工作调度软件，

远程计算集群由本地 IT 部门管理，他们负责用户名和密码的管理。由于个人 PBS 许可端口

与作业提交端口冲突，因此不能在运行 Durability Director 的本地计算机上安装。 
AIF（应用程序集成框架）是一项实现用户界面和 PBS Professional 交互的 Web 服务。

应用 AIF，可从 HyperWorks 任意应用程序中提交作业。 
Durability Director 需要 10.1 版本及以上的 PBS。通常，PBS 安装到远程计算集群上并

由 IT 部门负责管理。 
作业提交流程如下： 
（1）在工作流的初始设置中选择 Set Preferences 标签，如图 10-2 所示。 

 

图 10-2  Durability Director 的 Set Preference 标签 

（2）在 Job Scheduler Preference 下选择 Local 或 PBS。 
●  Local 表示在本地计算机计算作业。 
●  PBS 表示在远程计算集群或本地计算机和远程计算集群上计算作业。 
（3）如果选择 PBS，系统将提示用户登录计算集群，如图 10-3 所示。 
●  若希望现在登录集群并设置相关属性则单击 Yes 按钮。 
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●  若希望在计算任务设置完毕后登录集群则单击 No 按钮。 
（4）在登录面板，输入服务器地址、用户名以及密码。服务器地址由系统部门负责管

理，用户名及密码由 IT 部门负责管理。计算集群登录面板如图 10-4 所示。 

    
图 10-3  Durability Director 信息提示对话框                  图 10-4  计算集群登录面板 

（5）登录集群后，Set Preference 标签如图 10-5 所示。 
●  在 Solver Preference 栏中可指定求解器及其版本。 
●  如果希望在本地计算机求解，则取消选中求解器选项右侧的复选框。 

 

图 10-5  求解器设置 

10.2  启动向导与首选项设置 

10. 2.1  启动向导 

Durability Director 启动过程如下： 
（1）打开 MotionView 程序，然后从 Directors 下拉菜单中选择 Durability Director，如
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图 10-6 所示。 

 

图 10-6  Durability Director 启动菜单 

（2）在弹出的 Project and Solutions 对话框中，可以选择载入一个已有项目或新建一

个项目。 
●  Create New：用于新建一个项目。根据用户在 Project Type 标签中选择的流程，分析

向导将提示用户在 Projects and Solutions Menu 模块指定相关的首选项设置。 
●  Load Existing：用于载入已有项目，根据已有项目选择对应的分析流程，然后进入

Define Project 载入项目。 

10. 2.2  新建项目 

开始分析流程之前，需要为即将开始的项目指定一个工作路径。如果没有恰当地设置工

作路径，项目分析过程中生成的大量数据可能造成分析向导的终止。 
（1）在 Durability Director 面板上选择 Create New，新建一个项目。 
（2）在进入的 Project Type 标签中选择分析使用的流程，如图 10-7 所示。选择完毕，单

击 Next 按钮进入下一标签。 

 

图 10-7  耐久性分析流程 

（3）在 Define Project 标签中，定义下述内容。 
●  Project Name：定义项目的名称，名称中不允许有空格。 
●  Project Date：项目开展的时间。该时间根据当前系统时间自动填写。 
●  Project Engineer：项目负责人姓名。该名称根据登录用户名自动填写。 
●  Project Description：项目描述。 
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●  Solution Directory：用于定于项目工作路径。 
设置完毕后，单击 Next 按钮进入下一标签。 
（4）Set Preference 标签显示了当前项目的工作路径以及文件首选项。项目工作文件夹以

及求解器路径可在此标签修改。该标签包括前处理、求解器、数据管理以及作业提交首选项

的设置。 
1）前处理首选项设置。 
前处理首选项设置包括 Duty Cycle、MBD processor 及 FE Preprocessor 的首选项定义，

如图 10-8 所示。 

 
图 10-8  前处理首选项设置窗口 

① Duty Cycle：负载循环可根据输入数据（典型数据为测试载荷、位移或其他条件）

创建。 
输入数据可以是多种格式，但为了方便数据管理，这里使用 RSP、DAC、CSV 和 MBS

（定义在多体模型中的工况）四种格式。在 Duty Cycle 栏可以设置输入数据的类型以及该数

据存储的路径。 
为方便负载数据的自动选择，数据通道由数据文件名称最后的数字定义。例如，atv_01.dac 

和 atv_22.dac 描述了通道编号为 1 和 22 的测试数据 atv。CSV 文件与 DAC 文件也遵循这个

命名规则，而 RSP 文件则在一个文件中包含了多个通道数据。 
② MBD Preprocessor：MotionView 用于创建多体系统模型以及测试模型。该栏用于设

置储存多体模型和测试模型的文件夹路径。 
③ FE Preprocessor：HyperMesh 用于有限元模型的前后处理。该栏用于设置有限元模型

的存储路径。 
2）求解器首选项设置。 
Durability Director 支持耐久性分析多个领域的多款求解器。该栏用于设置求解器及其启

动脚本，如图 10-9 所示。 

 

图 10-9  求解器首选项设置窗口 

●  MBD Solver：支持 MotionSolve 和 ADAMS。当前默认 tcl 脚本用于启动 MotionSolve。 
●  FE Solver：支持 OptiStruct 和 NASTRAN。默认求解器为 OptiStruct。 
●  Fatigue Solver：支持 OptiStruct 疲劳求解功能和 nCode 的 FEfatigue。 
3）数据管理首选项设置。 
数据管理首选项设置如图 10-10 所示。 
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图 10-10  数据管理首选项设置 

4）作业提交首选项设置。 
耐久性分析向导支持 PBS 进行作业调度，它可用于远程计算集群作业提交，如图 10-11

所示。 

 

图 10-11  作业提交首选项设置 

10. 2.3  已有项目载入 

已有项目载入的过程如下： 
（1）在 Durability Director 面板上单击 Load Existing 按钮。 
（2）在进入的 Project Type 标签中选择创建已有项目时使用的分析流程。 
（3）单击 Next 按钮，进入 Define Project 标签。在 Durability Project File 栏选择已有项目

的数据文件（XML 格式）。Durability Solution Files 栏用于设定载入已有项目的所有模型与结

果文件或根据已有项目的设置定义新分析。例如，在图 10-12 中选择 Master Solution 为载入

已有项目所有文件，选择 Create Solutions 为根据已有项目的设置定义新分析。 

 

图 10-12  已有项目数据文件载入窗口 

（4）上述设置完毕后，单击 Load 按钮载入数据。 

10.3  标准工作流程 

10. 3.1  流程一 

流程一（见图 10-13）假定已获取可用于多体动力学模型的测试载荷，将测试载荷加载
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到多体动力学模型，求解并提取目标零件在机构运动过程中承受的载荷；然后在 HyperMesh
中载入目标零件的有限元模型，根据其在多体动力学模型中的安装方式约束，进行单位载荷工

况有限元分析获得相应的应力状态；最后联合目标零件在多体动力学分析中承受的载荷以及在

单位载荷工况下的应力信息进行耐久性分析，分析结果在 HyperView 中查看。 

 
图 10-13  耐久性分析流程一 

接下来将介绍耐久性分析流程一中循环工况、多体动力学模型、虚拟测试台、有限元模

型以及不同模型间数据关联的定义方法。 

1.创建负载循环（Generate Duty Cycle） 

耐久性分析需要定义零件工作的负载循环。这里，可以使用载荷、位移、速度或加速度

数据创建负载循环。整个创建过程可在 Specify Duty Cycle 面板完成，下面介绍该面板的使用。 
（1）新建一个负载循环（Specify Duty Cycle）。 
1）在 Specify Duty Cycle 面板中单击“文件浏览”按钮 ，指定负载循环文件名称及存

储路径，如图 10-14 所示。 

 
图 10-14  Specify Duty Cycle 面板 

2）单击 Launch 按钮，打开 Schedule Create 对话框，如图 10-15 所示。 

 
图 10-15  Schedule Create 对话框 

Info Panel 标签是对该对话框功能的简要描述，它提示用户测试通道需根据数据类型进
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行分类。 
3）单击 Next 按钮进入 Select File 标签。 
Select File 标签显示了负载循环文件的名称及存储路径，该信息在 Specify Duty Cycle 面

板中指定，此处无法修改。如果指定了已有循环工况文件，该文件的名称、存储路径以及相

关信息将显示在 Duty Cycle Log 区域，如图 10-16 所示。 

 

图 10-16  Schedule Create 对话框的 Select File 标签 

4）单击 Next 按钮，进入 Create Duty Cycle 标签，如图 10-17 所示。在该标签下单击

Add Event 按钮加载数据文件。对于 CSV 和 DAC 文件，选择序列中第一个文件。每个事件

只能加载一个数据文件。对于 RSP 和 MDL 文件，加载所有文件。上述过程定义了每个事件

的数据位置和重复次数。单个通道的数据稍后指定。 

 

图 10-17  Schedule Create 对话框的 Create Duty Cycle 标签 

●  每个负载循环中数据文件必须保持一致。分析过程中负载循环使用的通道必须保持

一致。 



MotionView & MotionSolve 
应用技巧与实例分析 

 366 

●  定义可读性较强的负载循环名称。 
●  RSP 扩展名常为 MTS 输出 RPC III 文件时使用。 
●  DAC 扩展名常为多种软件输出数据采集文件时使用。 
（2）查看负载循环。 
1）单击 Next 按钮进入 Display Duty Cycle 标签，如图 10-18 所示。这里将以图表的形

式显示创建好的循环工况。 

 

图 10-18  查看负载循环 

2）单击 Channels 按钮查看每个文件关联的时间序列。 
3）单击 Close 按钮关闭 Schedule Create 对话框。 

2.创建目标零件载荷（Generate Component Loads） 

该部分将打开一个包含目标零件的多体动力学模型，选择是否使用虚拟试验台模型。该

模型用于模拟实验室或其他试验环境，然后将循环工况通道数据（载荷、位移、速度或加速

度）加载到模型或虚拟试验台上。提交求解任务时可以选择本地计算机或通过 PBS 提交到

计算集群。指定目标零件可以将需要的载荷输出请求自动提交给求解器。另外，多体求解器

求解参数也可在本部分设置。 
接下来将具体描述各面板的使用方法。 
（1）多体模型设置面板（Setup System Model）。 
应用该面板可输入和编辑多体动力学模型（支持 ADAMS ADM 模型、MotionView MDL

模型等）。 
1）单击“文件浏览”按钮 选择多体动力学模型文件。 
2）单击 Load Model 按钮将其载入到当前 MotionView 会话，如图 10-19 所示。在

MotionView 中可修改模型或查询模型信息。Model Info 按钮用于查看模型定义在 Meta File
部分的数据。 

3）单击 Apply 按钮，进入 Setup Test Rig Model 面板。 
（2）定义测试台模型（Setup Test Rig Model）。 



第 10 章 
耐久性分析 

 367 

Test Rig 面板用于加载测试台模型，如图 10-20 所示。该类模型是独立于产品的多体模

型，主要用来模拟进行产品检测的实验室或测试场环境。Test Rig 面板支持包括用户自定义

测试台模型在内的多种模型。测试台模型包括四轴测试台架、五轴测试台以及用于车辆测试

的三向力和三向转矩的加载系统。 

 

图 10-19  载入多体模型 

 

图 10-20  载入测试台模型 

测试台模型通过模型中的专门语句实现加载通道的快速识别。 
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单击 Test Rig Info 按钮将弹出测试台激励信息，如激励类型、方向、缩放、持续时间、

偏置等，如图 10-21 所示。这里支持载荷（力、转矩）和运动（位移、速度、加速度）两种

类型的激励。 

 
图 10-21  测试台信息 

单击 Apply 按钮进入 Assign Channels 面板。 
注：测试台模型载入后需要使用 Tool/Check Model 工具检验测试台模型与产品多体模型

是否正确连接。如未正确连接，可通过 MotionView 界面手动编辑。多体系统模型库已预定

义底盘/车身测试台。此外，用户可以自定义测试台模型。 
（3）指定激励通道（Assign Channels）。 
应用 Assign Channels 面板可为多体模型加载激励。激活 Assign Channels 可指定数据文

件（DAC、RSP 或 CSV）作为激励，而 Assign Analysis 可使用 MotionView 分析工况作为激

励。Assign Channels 面板如图 10-22 所示。 

 
图 10-22  Assign Channels 面板 

激活 Assign Channels 后，单击 Launch 按钮将弹出包含 3 个表格的 Assign Channels 窗

口，如图 10-23 所示。master event 选项用于选择在 Generate Duty Cycle 面板中定义的工况。

通过 motions 和 forces 标签，可将数据文件中的驱动和载荷激励信息与 MotionView 模型中已

定义的驱动和载荷激励关联。 

 
图 10-23  Assign Channels 窗口 



第 10 章 
耐久性分析 

 369 

如图 10-24 所示，在 motions 或 forces 标签下，左侧是使用 MotionView 命名规则描述

的驱动/载荷激励和加载约束副的名称。中间可以设置激励的方向、缩放比例、加载时间与数

据的偏置，右侧用于指定数据文件通道。指定完毕，单击 OK 按钮保存设置并退出该窗口。 

 

图 10-24  设置激励通道 

位移、速度或加速度激励通过 motions 标签指定到多体模型相应的铰，载荷激励使用 forces
标签指定。这里仅需指定主工况的数据文件，其他工况软件将按照相同的格式自动指定。 

某些场合下，工况包含了信号通道，用户可以将特定工况下的信号通道关联到多体系统

模型已定义的驱动或载荷激励上。Assign Channel 面板会根据 Duty Cycle 中定义的其他工况

自动识别等效的通道完成关联操作。Test MBD Setup 将根据这些关联为每个工况创建多体动

力学分析模型，以 3 个工况、每个工况包含两个通道为例，关联过程如表 10-1 所示。 

表 10-1  工况与通道信息 

Event 1 Belgian_01.dac Belgian_02.dac 

Event 2 GravelStop_01.dac GravelStop_02.dac 

Event 3 RailCross_01.dac RailCross_02.dac 

1）用户只需指定表 10-2 中的通道信息。 

表 10-2  指定通道信息 

MODEL.mot_0 Belgian_01.dac 

MODEL.mot_1 Belgian_02.dac 

2）通过标准测试通道（Standard Test channel）命名规则，Assign Channel map 自动关联

表 10-3 中的通道。 

表 10-3  工况与通道关联 

MODEl.mot_0 Belgian_01.dac GravelStop_01.dac RailCross_01.dac 

MODEL.mot_1 Belgian_02.dac GravelStop_02.dac RailCross_02.dac 
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对于 CSV 和 RSP 格式的数据文件，关联过程与之类似。为保证自动关联的顺利进行，

不同工况下的通道编号与命名规则应保持一致。 
（4）结果输出（Request Outputs）。 
Request Outputs 面板（见图 10-25）定义多体动力学分析的结果输出请求。通过指定目

标零件以及参考坐标系，可在分析后获得作用在该零件上的力与转矩大小。 

 
图 10-25  Request Outputs 面板 

具体操作过程如下： 
1）在 Request Outputs 面板上的 BODY 列，单击 Body 按钮激活该选项。 
2）在弹出的模型树窗口或在图形区选择目标零件。 
3）在 REF MARKER 列，单击 Ref Marker 按钮选择参考坐标系（多数情况下使用全局

坐标系）。 
4）在 CREATE REQUEST 列，单击 Create Request 按钮提交结果输出指令。 
（5）多体动力学分析求解参数（Solver Commands）。 
Solver Commands 面板（见图 10-26）可定义多体动力学分析求解参数以及输出文件类

型，激活 Use Predefined Solver and Analysis Settings 选项可以使用 MotionView 模型中定义的

求解参数与输出设置。如果不使用该功能，则本面板的设置会覆盖 MotionView 模型中的相

关设置。 

 
图 10-26  Solver Commands 面板 

（6）多体动力学测试模型设置（Test MBD Setup）。 
Test MBD Setup 面板（见图 10-27）用于输出多体动力学模型文件（单击 Export Deck

按钮）或提交分析（单击 Run Analysis 按钮）。 

 
图 10-27  Test MBD Setup 面板 

3.创建单位载荷响应（Generate Unit Load Response） 

创建单位载荷响应的目的在于将多体动力学分析时目标零件受到的载荷映射到其有限元
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模型上。该模块首先载入目标零件的有限元模型，然后将多体动力学模型中目标零件的连接

位置信息与分析获得的各连接位置载荷时间历程映射到有限元模型上。显然，使用每个时刻

的载荷进行静力分析是非常耗时耗力的。因此，这里使用单位载荷方法（即使用单位载荷取

代实际载荷值加载到有限元模型连接位置）进行静力分析（有限元模型没有受到约束，因此

分析过程中将用到惯性释放技术）。通过应力数据的线性叠加就可以获得载荷时间历程上各

时刻的应力状态。 
该方法仅在输入载荷时间历程的频率不等于结构的固有频率的场合有效。 
（1）有限元模型设置（Setup FE Model）。 
有限元模型设置过程如下： 
1）单击“文件浏览”按钮 选择目标零件有限元模型，Setup FE Model 面板如图 10-28

所示。 

 
图 10-28  Setup FE Model 面板 

2）单击 Load Model 按钮，载入有限元模型，如图 10-29 所示。在 Model Units 栏指定

有限元模型的单位制。 

 
图 10-29  有限元模型载入 

3）最后，单击 Apply 按钮进入 Unit Load Creation 面板。 
（2）创建单位载荷（Unit Load Creation）。 
在 Unit Load Creation 面板（见图 10-30）中可以将目标零件在多体动力学模型中的连接

位置信息以及分析得到的载荷历程关联到其有限元模型中。关联成功后，程序将自动在有限元

相应的连接位置处创建单位载荷以及包含单位载荷的载荷集，完成有限元模型的定义。 
面板各按钮功能解释如下： 
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图 10-30  Unit Load Creation 面板 

●  MBD Component 用于指定多体动力学分析模型中的目标零件。 
●  FE Model 用于指定有限元模型中的目标零件。 
●  Map Tolerance 用于定义模型关联时的搜索容差。 
●  MBD reference frame/marker 用于指定目标零件在多体动力学分析模型中的参考坐标系。 
●  FE reference frame 用于指定目标零件在有限元模型中的参考坐标系。 
●  Map Info 查看关联信息。单击 Map Info 按钮，在弹出的 Load Map Info 窗口中，Node 

Details 标签（见图 10-31）可查看相关联多体动力学模型硬点与有限元模型节点信

息。而新建的工况信息则显示在 Loadcases 标签，如图 10-32 所示。 

   

          图 10-31  载荷映射节点信息                      图 10-32  载荷映射工况信息 

在成功的关联操作中，软件将为每个连接点的每个自由度新建一个单位载荷工况。例

如，目标零件上有 6 个连接点，那么软件将为其建立 36 个单位载荷工况（6×6=36）。单位

载荷集使用以下命名规则： 
载荷集名称 = [节点号]_[多体系统中的物体名称]_F[多体系统中的物体编号][自由度] 
（3）有限元测试模型设置（Test FE Setup）。 
要求的输入设置完毕后即可进入 Test FE Setup 面板（见图 10-33）递交求解器求解。单

击“文件浏览器”按钮指定求解文件的名称及保存路径。Export Deck 按钮用于输出求解文

件，Run Analysis 按钮将激活求解器进行求解。 

 

图 10-33  Test FE Setup 面板 
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4.目标零件寿命评估（Estimate Life of Components） 

图 10-34 描述了耐久性分析流程。 

 

图 10-34  耐久性分析流程 

几何指目标零件的结构，在本流程特指目标零件的有限元模型与单位载荷工况下静力分

析获得的应力结果。材料疲劳数据指材料对循环载荷的响应。该响应可由 SN 或 EN 曲线定

义。结构载荷谱指目标零件承受的载荷谱，本流程特指由多体动力学分析获得的作用在目标

零件上的载荷历程。 
上述 3 项输入组合在耐久性分析中即可评估零件的寿命。这里必须指明的是，零件寿命

是一个统计量，不容易也不可能得到一个确定量。影响寿命评估的因素很多，如不合理的零

件模型简化、不准确的载荷历程、不恰当的材料数据等。根据经验，材料数据中 10%的应变

或应力误差可能导致 0.5～2 倍实际寿命的误差。 
通常，耐久性分析只考虑高应力区单元而忽略低应力区单元。这是因为零件的断裂常常

出现在切口或槽等高应力区域。这就意味着在耐久性分析时需要创建高应力单元集，同时高

应力单元集的使用也提高了疲劳分析的计算效率。 
（1）查看单位载荷工况分析结果（Visualize Unit Load）。 
Visualize Unit Load 面板（见图 10-35）用于查看 Generate Unit Load Response 模块中定

义的单位载荷工况分析结果。应用标准的后处理工具 HyperView 可以查看目标零件在单位载

荷作用下的位移和应力结果。该面板自动识别分析后的模型与结果，单击面板上的 Load 
result 按钮可以自动加载。 

 

图 10-35  Visualize Unit Load 面板 

（2）创建结果单元集（Create Result Subset）。 
Creat Entity Subset 面板（见图 10-36）用于选择进行耐久性分析的单元。 
（3）创建材料集（Create Material Subset）。 
在 Create Entity Subset 面板上选择的目标零件上应力最大的前 N 个单元将根据零件名称
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自动组织到单元集中。这一步将为这些单元集定义材料和机加工条件。 

 

图 10-36  Create Entity Subset 面板 

Analysis Type 列用于指定耐久性分析类型（SN 应力寿命或 EN 应变寿命）。Material 
properties 列用于定义材料的耐久性分析相关数据。该选项将根据选择的分析类型作出相应的

调整。Machine Conditions 列用于指定零件表面状态，如表面光洁度、表面处理方法以及疲

劳强度折减系数。零件的表面状态对分析结果影响很大，需要仔细选择。 
（4）创建载荷集（Create Load Subset）。 
Create Load Subset 面板将综合来自负载循环、多体动力学分析以及有限元分析的相关数

据，创建耐久性分析文件。在每一栏，单击“文件浏览”按钮 选择数据文件或使用方框

中的默认文件。耐久性分析求解器将使用线性叠加原理联合所有的载荷工况，确定每个计算

点的应力状态。 
该面板将多体动力学分析的多通道数据历程文件转换成单一的时间历程文件，转换过程

遵守表 10-4 的命名规则。 

表 10-4  多体动力学分析中多通道数据历程文件命名规则 

输入多体动力学分析结果文件类型 输出时间历程文件 

MotionSolve：*.PLT 
Adams：*.REQ [工况名称]F[多体模型中的物体编号] [自由度编号] 

输出的时间历程文件格式与Preference 面板指定的耐久性分析求解器有关，如表 10-5 所示。 

表 10-5  有限元分析中输出的时间历程文件格式命名规则 

求  解  器 文 件 格 式 备    注 

OptiStruct *.ASC 该文件用于创建 TABLEFAT、FATLOAD、FATSEQ、FATEVNT 卡片 

Fe-Fatigue R7 *.DAC 无 

多体动力学分析结果文件到有限元分析结果文件的自动转换也采用类似的命名规则，如

表 10-6 所示。 

表 10-6  结果转换命名规则 

有限元载荷集命名规则 [节点编号]_[多体系统物体名称]_F[多体系统物体编号][自由度] 

多体系统结果历程命名规则： 
MotionSolve ： *.PLT 

Adams： *.REQ 
[负载循环名称]F[多体系统物体编号][自由度] 
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（5）求解参数设置（Solver Parameters）。 
Solver Parameters 面板（见图 10-37）用于设置耐久性分析的求解参数。目前，该流程

支持 Stress-Life 和 Strain-Life 两类耐久性分析。 

 

图 10-37  Solver Parameters 面板 

面板上各参数介绍如下。 
Stress Combination Method：S-N 方法只能处理单轴应力，因此每个时刻的应力分量应在

计算点处合并为一个等效名义应力值，与 S-N 曲线相对应。该流程支持多种应力合并方法，

默认方法为 MAXPRINC（绝对最大主应力）。通常，MAXPRINC 用于脆性材料，而

VONMISES（米塞斯应力）用于韧性材料。 
FEA Stress Unit：通常，S-N 曲线使用 MPa 单位。因此耐久性分析之间需要将有限元分

析应力结果转换到与 S-N 曲线相一致的单位上。这里支持 MPA、PA、PSI 和 KSI 四种应力

单位。 
Gate：通过去除小循环（由定义的阈值决定）和中间点来节省求解时间，如图 10-38 所示， 

 

图 10-38  负载循环数据处理 

在去除小循环时，如果相邻数据点的差值小于相对阈值的最大限值，那么相邻数据点将

从每个通道中去除。但是，在不同时间不同通道下的波峰波谷的相位关系会保留下来。例
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如，当绝对阈值等于 1 时，第一个通道（上）数据点 4 和 5 将被去除，而第二通道（下）的

数据点 1 和 2 将被保留下来以保持通道间的相位关系。 
Mean Stress Correction：平均应力修正系数。通常，S-N 曲线由标准的全周循环加载试

验获得。事实上，真实的耐久性试验是不可能实现全周循环加载的。平均应力对零件的耐久

性能影响很大。在疲劳强度理论中，拉应力产生有害结果而压应力产生有利结果。平均应力

修正即是考虑非零平均应力对耐久性分析的影响。 
赫氏图用于描述给定次数的加载循环下的应力幅值和平均应力不同联合引起的失效。该

图中 Gerber 线和 Goodman 线常用于确定平均应力的影响。 
Gerber：Se = Sa /[1 − （ Sm / Su ）2] 
Goodman：Se = Sa / （1 − Sm / Su ） 
应力比：R = Smin / Smax = （ Sm − Sa ） / （ Sm + Sa ） 
应力幅值：Sa = SR / 2 
这里，Se 是全周循环加载条件下的疲劳极限，相当于平均应力 Sm 和应力范围 SR 的加

载工况。 
Certainty of Survival：生存率取决于 S-N 曲线的分布。高可靠性需要高的生存率。 
（6）耐久性分析设置（Test Fatigue Setup）。 
耐久性分析所需数据定义完毕后即可进入求解阶段。应用 Test Fatigue Setup 面板

（见图 10-39）可输出求解文件或直接提交求解。不同的求解器对求解文件的定义不同，如果

选择 FE-Fatigue R7 求解器，本流程将为定义在负载循环中的每一个工况创建一个独立的求解

文件；如果选择 RADIOSS 求解器，本流程将输出一个包含负载循环所有工况的求解文件。  

 

图 10-39  Test Fatigue Setup 面板 

5.查看损伤结果（Visualize Damage） 

Visualize Damage 模块进行以下工作： 
●  载入模型与分析结果。 
●  创建 HyperView 窗口显示零件损伤或寿命结果。 
●  提供描述损伤贡献量的饼状图。 
●  在 PowerPoint 中创建耐久性分析总结报告。 
（1）查看寿命图（Visualize Life Plots）。 
Visualize Life Plots 面板可以载入模型与分析结果。进入该面板后，模型文件路径和结果

文件路径已自动加载到相应的方框中。单击 Load Result 按钮载入文件，Set Result Type 按钮

用于转换损伤结果和寿命结果。在该面板上，HyperView 的全部功能（如截面图、视图控

制、标题编辑等）均可使用。此时，图形区显示 4 个窗口。 
（2）创建损伤图（Create Damage Plot）。 
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Create Damage Plot 面板（见图 10-40）用于创建损伤贡献量饼状图、各工况损伤效果总

结以及损伤表。单击 Display Damage Plot 按钮显示损伤

数据。 
单击 Display Damage Plot 按钮后将弹出一个包含若干

个标签的新窗口。第一个标签是 Damage_Fractions，如图

10-41 所示。这里将以饼状图的形式显示各工况的损伤贡献

量。第二个标签为 DutyCycle_Plots，如图 10-42 所示。该

标签对负载循环及产生的损伤进行了总结，各工况中应力最大的单元也将显示在该标签下。其

后是各工况的具体损伤结果，如图 10-43 所示。 

 
图 10-41  Display Damage for Events 面板中的 Damage_Fractions 标签 

 
图 10-42  Display Damage for Events 面板中的 DutyCycle_Plots 标签 

 

图 10-43  Display Damage for Events 面板中各工况的损伤结果 

 

图 10-40  Create Damage Plot 面板 
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（3）生成报告（Generate Report）。 
Generate Report 面板（见图 10-44）用于创建简洁的 PowerPoint 报告。单击 View Report

按钮可查看创建的报告。 

 
图 10-44  Generate Report 面板 

10. 3.2  流程二 

流程二（见图 10-45）假定已获取可用于激励多体动力学模型的测试载荷，目标零件以

柔性体的形式定义在多体模型中，通过一次或多次多体系统分析获得目标零件模态状态，然

后将模态信息加载到目标零件的有限元模型上，并对此模型进行疲劳分析，分析结果与后处

理在 HyperView 中完成。 

 
图 10-45  耐久性分析流程二 

接下来将介绍耐久性分析流程二中循环工况、多体动力学模型、虚拟测试台、有限元模

型以及不同模型间数据关联的建立方法。 

1.创建负载循环（Generate Duty Cycle） 

耐久性分析需要定义零件工作的负载循环。这里，可以使用载荷、位移、速度或加速度

数据创建负载循环。整个创建过程可在 Specify Duty Cycle 面板完成，与流程一相同。 

2.创建目标零件载荷（Generate Component Loads） 

该部分将打开一个包含目标零件的多体动力学模型，选择是否使用虚拟试验台模型。该

模型用于模拟实验室或其他试验环境，然后将循环工况通道（载荷、位移、速度或加速度）

加载到模型或虚拟试验台上。提交求解任务时可以选择本地计算机或通过 PBS 提交到计算

集群。指定目标零件可以将需要的载荷输出请求自动提交给求解器。另外，多体求解器求解

参数的设置也在本部分完成。 
本部分包括多体模型、测试台模型、激励通道、结果输出、多体动力学分析求解参数以

及多体动力学测试模型等内容的设置，设置方法与流程一相同。 

3.目标零件寿命评估（Estimate Life of Components） 

目标零件寿命评估模块包括单位载荷工况分析结果查看、结果单元集创建、材料集创
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建、载荷集创建、求解参数设置与耐久性分析设置等部分，设置方法与流程一相同。 

4.查看损伤结果（Visualize Damage） 

查看损伤结果模块包括载入模型与分析结果、创建 HyperView 窗口显示零件损伤或寿命

结果、提供描述损伤贡献量饼状图和在 PowerPoint 中创建耐久性分析总结报告等内容，各部

分设置方法与流程一相同。 

10. 3.3  流程三 

流程三（见图 10-46）假定具有可直接应用于有限元模型的载荷谱和完成单位载荷工况

定义的有限元模型。进行目标零件的单位载荷工况有限元分析，然后在此基础上使用载荷谱

进行目标零件的耐久性分析。分析结果及后处理在 HyperView 中完成。 

 
图 10-46  耐久性分析流程三 

接下来将介绍耐久性分析流程三中循环工况、多体动力学模型、虚拟测试台、有限元模

型以及不同模型间数据关联的建立方法。 

1.创建负载循环（Generate Duty Cycle） 

耐久性分析需要定义零件工作的负载循环。这里，可以使用载荷、位移、速度或加速度

数据创建负载循环。整个创建过程可在 Specify Duty Cycle 面板完成，与流程一相同。 

2.创建单位载荷响应（Generate Unit Load Response） 

该部分将定义在创建负载循环模块的输入数据（载荷或位移）映射到目标零件的有限元

模型上。该部分设置方法如下： 
（1）有限元模型设置（Setup FE Model）。 
在 Setup FE Model 面板中选择目标零件的有限元模型，单击 Load Model 按钮载入。 
上述载入的有限元模型应包含预定义的单位载荷工况，模型中每个载荷集中均包括独立

的单位载荷。单击 Apply 按钮进入 Unit Load Creation 面板。 
（2）创建单位载荷（Unit Load Creation）。 
Unit Load Creation 面板用于有限元模型及载荷工况的选择。上一部分载入的有限元模型

可能包含额外的载荷或用户希望只计算其中一部分的单位载荷，这种情况下，就可以使用该

面板快速选择。 
1）单击 FE MODEL 列的下拉按钮，选择待分析的有限元模型。 
2）单击 Select Fatigue Subcases 按钮，将弹出载荷选择窗口，如图 10-47 所示。 
3）在弹出的载荷选择窗口中选择待分析的、已在模型中预定义的单位载荷工况。工况

名称不能修改。 
（3）有限元测试模型设置（Test FE Setup）。 
输入设置完毕后即可进入 Test FE Setup 面板递交求解器求解。单击“文件浏览”按钮
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指定求解文件的名称及保存路径。Export Deck 按钮用于输出求解文件，Run Analysis 按钮

将激活求解器进行求解。 

 

图 10-47  载荷选择窗口 

3.目标零件寿命评估（Estimate Life of Components） 

目标零件寿命评估模块包括单位载荷工况分析结果查看、结果单元集创建、材料集创

建、载荷集创建、求解参数设置与耐久性分析设置等部分。除载荷集创建与流程一不同外，

本模型其他部分的设置方法均与流程一相同。 
载荷集创建方法如下： 
（1）Create Load Subset 面板（见图 10-48）用于关联单位载荷工况分析与负载循环数据

通道。面板上显示的负载循环与有限元分析数据文件分别来自于 Specify Duty Cycle 模块和

Test FE Setup 模块。如果这两栏数据不存在，则需要回到相应的面板重新创建。 

 

图 10-48  Create Load Subset 面板 

（2）单击 Synthesize 按钮进行数据关联，此时将弹出 Synthesize Fatigue Duty Cycle 窗口。

Map_Log_Details 标签显示了选择的有限元模型、负载循环名称及其数据通道的关联日志

（见图 10-49），以有限元模型名称命名的标签显示了各通道的关联状态（见图 10-50）。 

 

图 10-49  Map_Log_Details 标签 
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图 10-50  数据关联状态 

4.查看损伤结果（Visualize Damage） 

查看损伤结果模块包括载入模型与分析结果、创建 HyperView 窗口显示零件损伤或寿命

结果、提供描述损伤贡献量的饼状图和在 PowerPoint 中创建耐久性分析总结报告等内容，各

部分设置方法与流程一相同。 

10.4  实例 

10. 4.1  自行车架耐久性分析 

本练习将学习应用 Durability Director： 
●  设置分析流程。 
●  定义负载循环。 
●  载入多体动力学模型和测试台模型。 
●  指定负载循环通道。 
●  指定结果输出与更新求解参数。 
●  单位载荷工况分析与载荷历程关联。 
●  查看材料属性。 
●  更新和检查求解参数并进行耐久性分析。 
●  查看损伤结果并生成报告。 
在练习开始前，复制目录 chap10 的 Bike 文件夹到工作路径。 

初始化耐久性分析工作路径与设置项目首选项 

（1）新建一个 MotionView 会话。 
（2）从 Directors 菜单中选择 Durability Director，如

图 10-51 所示。 
此时，弹出 Durability Director 对话框，如图 10-52

所示。 

 STEP 

01 

 
图 10-51  激活耐久性分析向导 
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图 10-52  Durability Director 对话框 

（3）激活 Durability Director 标签。 
（4）单击 Create New 按钮，新建一个耐久性分析项目。 
（5）选择一个分析流程，本例选择 Flow 1（DUTY – MBD - FE – FATIGUE – POST），如

图 10-53 所示。 

 
图 10-53  耐久性分析流程一 

（6）单击 Next 按钮，进入下一界面。 

设置项目信息与默认选项 

（1）在 Project Name 文本框中输入项目名称 bike_demo。 

（2）在 Project Description 文本框中输入项目简介 Bike durability：Analysis of the bike 
frame。 

（3）在 Solution Directory 处单击“文件浏览”按钮  指定工作路径，如图 10-54 所示。 

 
图 10-54  Define Project 标签 

 STEP 

02 
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注：路径和文件夹名称中不允许包含空格。 
（4）单击 Next 按钮。 
（5）在 PRE-PROCESSOR PREFERENCE 栏下的 Duty Cycle 项处设置 PREFERENCE 为

CSV，如图 10-55 所示。 

 

图 10-55  设置 Duty Cycle 文件类型 

（6）在 Duty Cycle 项选择工作文件夹下的 Bike\dutvcvclefiles 目录。 

（7）在 MBD Preprocessor 项选择工作文件夹下的 Bike\mbdmodelfiles 目录。 
（8）在 FE Preprocessor 项选择工作文件夹下的 Bike\femodelfiles 目录。 
（9）路径设置完毕后，如图 10-56 所示。 

 

图 10-56  设置文件路径 

（10）单击 Launch 按钮，此时将在当前会话的浏览器区域加载 Process Manager 标签。 
（11）如图 10-57 所示，在 Project Setup 面板区域将显示上步定义的项目名称、项目简

介与工作路径信息。 

 

图 10-57  Project Setup 面板 

（12）单击 Apply 按钮进入下一面板。 
每进入 Durability Director 的一个面板，在流程管理浏览器的相应位置会用黄色勾号标记

出来。该步骤完成之后，勾号变为绿色。如果某一步骤未完成，则勾号变红色叉号。 

定义负载循环 

本步骤将创建驱动耐久性分析流程的负载循环。本例的输入数据构成 3 个工况：沙砾路

工况、高速路工况、坑洼路工况。 
（1）注意到黄色勾号显示在 Specify Duty Cycle 前。确认 Duty Cycle 面板设置为 Create 

New。 

 STEP 

03 



MotionView & MotionSolve 
应用技巧与实例分析 

 384 

（2）此时 Channel File Format 设置为 CSV。 
（3）在 Create New 处单击“文件浏览”按钮 ，输入 bike_sample_dutycycle，如图 10-58

所示。 

 
图 10-58  创建负载循环文件 

（4）单击“保存”按钮，保存新建的负载循环文件。 
（5）单击 Launch 按钮，启动负载循环创建面板。 
（6）单击两次 Next 按钮，进入 Create Duty Cycle 标签。 
（7）单击 Add Event 按钮，从下拉菜单中选择 Time Series，如图 10-59 所示。 
（8）在弹出的文件对话框中选择 gravelstop_01.csv。 
（9）单击 Open 按钮，载入数据。 
（10）在 Description 栏下输入 gravelstop。 
（11）单击 Add Event 按钮，选择 Time Series。 
（12）在弹出的文件对话框中选择 highway_01.csv。 
（13）单击 Open 按钮。 
（14）在 Description 栏下输入 highway。 
（15）单击 Add Event 按钮，选择 Time Series。 
（16）在弹出的文件对话框中选择 pothole_01.csv。 
（17）单击 Open 按钮。 
（18）在 Description 栏下输入 pothole。 
定义完毕后，负载循环创建面板如图 10-60 所示。 

 

图 10-60  定义负载循环 

 

图 10-59  指定负载循环类型 
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（19）单击 Create 按钮，弹出 Durability Director 对话框，提示用户是否进行负载循环数

据关联（Duty Cycle Synthesized）。 
（20）单击 OK 按钮。 
此时，对话框中显示 3 个 Time Series 表格。 
（21）单击 Close 按钮。 
（22）单击 Apply 按钮进入下一面板。 

载入多体动力学模型和测试台模型 

该步骤将载入自行车多体动力学模型和测试台模型。模型中的错误可由 Check Model 功
能检查。 

（1）如图 10-61 所示，在 Setup System Model 面板中单击“文件浏览器”按钮，选择自

行车模型 two_wheeler_bike_rel_path.mdl。 

 

图 10-61  Setup System Model 面板 

（2）单击 Load Model 按钮，将自行车模型载入当前 MotionView 会话中。 
（3）单击 Apply 按钮，进入下一面板。 
（4）单击“文件浏览器”按钮 ，选择测试台模型 two_wheeler_rig_bistop.mdl。 
（5）单击 Open 按钮。 
（6）单击 Load Test Rig 按钮，载入测试台模型，忽略所有提示信息。 
（7）单击 Close 按钮。 
（8）单击 Check Model 处的 Launch 按钮检查模型。 
（9）单击 Apply 按钮进入下一面板。 

指定负载循环数据通道 

本步骤将特定的负载循环工况加载到测试台，作为多体动力学模型的激励。 
（1）单击 按钮，选择 Assign Channels，如图 10-62 所示。 

 

图 10-62  指定数据通道类型 

 STEP 

05 

 STEP 

04 
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（2）单击 Launch 按钮，弹出 Assign Channels 窗口。 
（3）单击 motions 标签。 
（4）在 Select Master Event 下拉菜单中选择 gravelstop。 
（5）在第一行 Select channel 处选择 gravelstop_01.csv。 
（6）在第二行 Select channel 处选择 gravelstop_02.csv。 

数据通道定义完毕后应如图 10-63 所示。 

 

图 10-63  定义数据通道 

（7）单击 OK 按钮关闭 Assign Channels 窗口。 
（8）单击 Apply 按钮进入下一面板。 

指定结果输出，更新求解参数并进行多体动力学分析 

（1）在 BODY 列单击 Body 按钮。 
（2）如图 10-64 所示，在图形区单击自行车架（frame），指定该零件作为耐久性分析的

目标零件。 

 

图 10-64  指定结果输出 

（3）单击 REF MARKER（Default CM Marker）列下的 RefMarker 按钮，在图形区选择

全局坐标系（Global Frame）。 
（4）在 CREATE REQUEST 列单击 Create_Request，弹出“Request Output Created”信息

提示框。 
（5）单击 OK 按钮。 
（6）单击 Apply 按钮。 
（7）如图 10-65 所示，在 OTHER PARAMETERS 列的 Simulation Type 下拉列表中选择

 STEP 

06 



第 10 章 
耐久性分析 

 387 

Transient，在 End time 文本框中输入 1.2。 

 

图 10-65  设定仿真参数 

（8）在 Transient 列选择 VSTIFF 积分器。 
（9）单击 Apply 按钮。 
（10）单击 Run Analysis 按钮。 
此时，将进行沙砾路工况、高速路工况以及坑洼路工况的多体动力学分析。分析完毕

后，关闭命令窗口。 
（11）单击 Apply 按钮进入下一面板。 

单位载荷工况有限元分析 

本步骤将载入目标零件的有限元模型并将多体动力学分析获得的载荷映射到有限元模型上。 
（1）如图 10-66 所示，在 Setup FE model 面板上单击“文件浏览”按钮 ，选择自行

车架有限元模型 bike_frame.fem。 

 

图 10-66  Setup FE model 面板 

（2）单击 Open 按钮。 
（3）单击 Load Model 按钮载入模型，如图 10-67 所示。 

 

图 10-67  载入车架有限元模型 
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（4）单击 Apply 按钮，进入下一面板。 
（5）在 FE MODEL 处，单击下拉菜单选择 bike_frame.fem。 
（6）单击 Maps Loads 按钮，创建单位载荷和约束条件。 
（7）单击 Map info 按钮可以查看载荷映射信息，Node details 显示了载荷加载位置，

Loadcases 表示根据映射的载荷创建的工况。 
（8）单击 Apply 按钮进入有限元分析面板。 
（9）单击 Run Analysis 按钮进行单位载荷工况分析。求解结束后关闭命令窗口。 
（10）单击 Apply 按钮进入下一面板。 

关联载荷历程与单位载荷工况 

接下来，载入有限元分析结果，选择一定数量单元进行耐久性分析。 
（1）在 Visualize Unit Load 面板上单击 Load Result 按钮载入有限元分析结果，该结果将

显示在第三个窗口。 
（2）单击 Apply 按钮，进入下一面板。 
（3）在 Create Entity Subset 面板上确认 Result Type 为 vonMises，10 代表选择应力最大

的 10 个单元进行耐久性分析。 
（4）单击 Apply 按钮，窗口将显示模型的应力云图，如图 10-68 所示。 

 

图 10-68  车架有限元分析应力云图 

查看材料属性 

（1）在 MATERIAL PROPERTY 栏中单击 Material Database 按钮，弹出材料信息窗口，

如图 10-69 所示。 
（2）单击 Save 按钮，关闭该窗口，使用默认设置。 
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（3）在 Machining Conditions 栏中单击 Machining Conditions 按钮，弹出材料机加工信息

窗口，如图 10-70 所示。 

          

              图 10-69  材料信息窗口                      图 10-70  材料机加工信息窗口 

（4）单击 Save 按钮，关闭该窗口，使用默认设置。 
（5）单击 Apply 按钮进入下一面板。 

创建载荷集 

本步骤将为每个单位载荷工况关联合适的多体分析获得的载荷历程。 
（1）负载循环信息、多体动力学求解结果和有限元分析结果已经填入相应的位置。 
（2）单击 Synthesize 按钮，关联载荷历程到每个分析工况。此时，弹出 Synthesize 

Fatigue Duty Cycle 窗口，如图 10-71 所示。 

 

图 10-71  Synthesize Fatigue Duty Cycle 窗口 

（3）单击 bike_frame_fem 标签。 
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（4）查看与每个映射工况相关的文件。 
（5）单击 OK 按钮。 
（6）单击 Apply 按钮进入下一个面板。 

检查求解参数，进行耐久性分析设置 

（1）使用默认的耐久性分析参数。 
（2）单击 Apply 按钮进入下一面板。 
（3）单击 Run Analysis 按钮，进行耐久性分析。 
（4）求解结束后，关闭命令窗口。 
（5）单击 Apply 按钮进入下一面板。 

查看损伤结果 

本步骤将查看目标零件的耐久性分析结果。每个工况结果将显示在一张饼状图中，此外

还提供了结果报表，其中包括工况名称、最大应力单元编号以及损伤值等。 
（1）在 Visualize Life Plot 面板中单击 Load Result 按钮，弹出第四个窗口并自动加载分

析结果。 
（2）单击 Apply 按钮进入 Create Damage Plot 面板。 
（3）单击 Display Damage Plot 按钮，弹出 Display Damage for Events 窗口，如图 10-72

所示。每个工况的损伤程度将显示在饼状图上。 

 

图 10-72  Display Damage for Events 窗口（Damage_Fractions 标签） 

（4）从饼状图可以看出，坑洼路工况（gravelstop）对目标零件产生的损伤最大，沙砾路

工况其次，而高速路工况对其损伤没有影响。 
（5）单击 DutyCycle_Plots 标签，如图 10-73 所示。此时将以表格的形式显示损伤信
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息，这里可以看到坑洼路工况对车架的损伤影响。 

 

图 10-73  Display Damage for Events 窗口（DutyCycle_Plots 标签） 

（6）单击 OK 按钮。 
（7）单击 Apply 按钮，进入下一个面板。 

生成报告 

在 Generate Report item 面板单击 Create Report 按钮，将创建包含上述损伤结果的

PowerPoint 文件。 

查看结果 

（1）耐久性分析所有结果文件将写入工作路径文件夹。查看工作路径可在分析向导中单

击 Define Project 文件夹，选择 Project Setup 进入项目设置面板。 
（2）单击 Set Preference 按钮。 
（3）在弹出的窗口中选择 Set Preference 标签，工作路径将显示在 DATA MANAGEMENT 

PREFERENCE 栏。 
（4）根据上述工作路径，打开 bike_demo 文件夹，在 Master_Solution 文件夹下可以看到分

析过程中创建的 5 个子文件夹：Duty_cycle_result_files、FAT_analysis_result_files、FE_analysis_ 
Result_files、MBD_analysis_result_files 和 POST_analysis_result_files。 

（5）进入POST_analysis_result_files 文件夹，可以看到上述步骤中创建的PowerPoint 文件。 
（6）关闭文件夹。 

保存和关闭耐久性分析向导 

（1）单击耐久性分析流程树面板右下角的 Close 按钮，关闭耐久性分析流程。 
（2）在弹出的是否退出分析向导提示对话框中单击 Yes 按钮。 
（3）在弹出的是否保存分析流程窗口中单击 Save 按钮。该操作将分析流程相关信息以

PMI 文件保存到工作路径。 
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（4）此时将弹出一个新窗口，确认要保存的文件。 
（5）单击 Yes 按钮，关闭耐久性分析向导。 

10. 4.2  车门耐久性分析 

本练习将学习以下内容： 
●  设置分析流程。 
●  定义负载循环。 
●  设置多体动力学模型与指定负载循环通道。 
●  设置结果输出与更新求解参数。 
●  查看单位载荷。 
●  查看材料属性与创建载荷集。 
●  查看耐久性分析参数与求解。 
在练习开始前，复制目录 chap10 的 Door_Slam 文件夹到工作路径。 

初始化耐久性分析工作路径与设置项目首选项 

（1）新建一个 MotionView 会话。 
（2）从 Directors 菜单中选择 Durability Director，弹出 Durability Director 对话框。 
（3）激活 Durability Director 标签。 
（4）单击 Create New 按钮，新建一个耐久性分析项目。 
（5）选择一个分析流程，本例选择 Flow 2（DUTY – MDB – FATIGUE – POST），如图

10-74 所示。 

 

图 10-74  耐久性分析流程二 

（6）单击 Next 按钮，进入下一界面。 

设置项目信息与默认选项 

（1）在 Project Name 文本框中输入项目名称 door_slam_demo。 

（2）在 Project Description 文本框中输入项目简介 Durability Analysis of a door due to slam。 
（3）在 Solution Directory 处单击“文件浏览”按钮  指定工作路径，如图 10-75 所示。 
注：路径和文件夹名称中不允许包含空格。 
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图 10-75  项目信息 

（4）单击 Next 按钮。 
（5）在 PRE-PROCESSOR PREFERENCE 栏下的 Duty Cycle 项处设置 PREFERENCE 为

MBS，如图 10-76 所示。 

 

图 10-76  前处理首选项设置 

（6）在 Duty Cycle 项选择工作文件夹下的 Door_Slam 目录。 
（7）在 MBD Preprocessor 项选择工作文件夹下的 Door_Slam\mbdmodelfiles 目录。 
（8）在 PREFERENCE 栏选择 FE-Fatigue R7。 
（9）单击“文件浏览”按钮 ，找到 FE-Fatigue 的可执行文件。 
（10）单击 Launch 按钮，将在当前会话的浏览器区域加载 Process Manager 标签。 
（11）在图 10-77 所示的 Project Setup 面板区域，将显示上步定义的项目名称、项目简

介与工作路径信息。 

 

图 10-77  Project Setup 面板 

（12）单击 Apply 按钮进入下一面板。 

定义负载循环 

本步骤将创建驱动耐久性分析流程的负载循环。这里的负载循环来自于多体模型。 
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（1）注意到黄色勾号显示在Specify Duty Cycle 前。确认Duty Cycle 面板设置为Create New。 
（2）此时 Channel File Format 设置为 MBS。 
（3）在 Create New 处单击“文件浏览”按钮 ，输入 door_slam_dutycycle，如图 10-78

所示。 

 
图 10-78  负载循环创建窗口 

（4）单击“保存”按钮，保存新建的负载循环文件。 
（5）单击 Launch 按钮，启动负载循环创建面板。 
（6）单击两次 Next 按钮，进入 Create Duty Cycle 标签。 
（7）单击 Add Event 按钮，从下拉菜单中选择 MBS Events，如图 10-79 所示。 

 
图 10-79  指定负载循环类型 

（8）在弹出的文件对话框中选择 door_closure_from_B47.mdl。 
（9）单击 Open 按钮，载入数据。 
（10）在 Description 栏下输入 doorslamlow，如图 10-80 所示。 

 
图 10-80  定义负载循环 
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（11）单击 Create 按钮，弹出 Durability Director 对话框，提示用户是否进行负载循环数

据关联（Duty Cycle Synthesized）。 
（12）单击 OK 按钮。 
此时，MBS 工况显示在当前窗口中，如图 10-81 所示。 

 

图 10-81  负载循环信息 

（13）单击 Close 按钮，关闭 Durability Director 对话框。 
（14）单击 Apply 按钮进入下一面板。 

载入多体动力学模型和测试台模型 

本步骤将载入车门闭锁机构多体动力学模型。本例没有测试台模型，因此该步将跳过。

模型中的错误可由 Check Model 功能检查。 
（1）在 Setup System Model 面板中单击“文件浏览”按钮 ，选择车门闭锁机构模型 door_ 

closure_from_B47.mdl，如图 10-82 所示。 

 

图 10-82  Setup System Model 面板 

（2）单击 Load Model 按钮，将车门闭锁机构模型载入当前 MotionView 会话中。 
（3）单击 Apply 按钮，进入下一面板。 
（4）本例没有测试台模型，单击 Apply 按钮，弹出 Test rig has not been selected would 

like to continue 对话框，单击 Yes 按钮进入下一面板。 
（5）单击 Close 按钮，关闭模型检查信息对话框。 
（6）单击 Apply 按钮进入下一面板。 
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指定负载循环数据通道 

（1）单击 按钮选择 Assign Analysis，如图 10-83 所示。 

 

图 10-83  指定数据通道类型 

（2）单击 Launch 按钮，打开 Assign Events 窗口。 
（3）单击 Analysis 标签，这里只有一个工况 doorslamlow，如图 10-84 所示。 

 

图 10-84  Assign Events 窗口 

（4）在 Analysis Name 处选择 MODEL.ana 0。 
（5）单击 Ok 按钮关闭 Assign Events 窗口。 
（6）单击 Apply 按钮进入下一面板。 

指定结果输出，更新求解参数并进行多体动力学分析 

（1）在 BODY 列单击 Body 按钮。 
（2）如图 10-85 所示，在图形区单击车门（Car Door），指定该零件作为耐久性分析的

目标零件。 
（3）单击 REF MARKER（Default CM Marker）列下的 RefMarker 按钮，在图形区选择

全局坐标系（Global Fram）。 
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图 10-85  车门闭锁机构多体模型 

（4）在 CREATE REQUEST 列单击 Create_Request 按钮，弹出“Request Output 
Created”信息提示框。 

（5）单击 OK 按钮，关闭提示框。 
（6）单击 Apply 按钮，进入下一面板。 
（7）在面板左上角激活 Use Predefined Solver and Analysis Settings 选项。 
（8）单击 Apply 按钮，进入下一面板。 
（9）单击 Run Analysis 按钮，求解该模型。 
（10）求解完毕后，关闭命令窗口。 
（11）单击 Apply 按钮进入下一面板。 

查看单位载荷工况有限元分析结果 

本步将载入多体动力学分析结果，选择部分单元进行耐久性分析。 
（1）在 Visualize Unit Load 面板，单击 Load Result 按钮载入单位载荷工况有限元分析结

果。该结果将显示在第三个窗口，如图 10-86 所示。 

 

图 10-86  车门有限元分析结果 
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（2）单击 Apply 按钮进入下一个面板。 
（3）在 Create Entity Subset 面板，确认 Result Type 为 vonMises，10 表示选择应力最大

的 10 个单元进行耐久性分析。 
（4）单击 Apply 按钮，进入下一面板。 

查看材料属性 

（1）对于车门零件，在 MATERIAL PROPERTY 栏中单击 Material Database 按钮，此时

弹出材料信息窗口。 
（2）单击 Save 按钮，使用默认的设置并关闭窗口。 
（3）单击 Apply 按钮进入下一面板。 

创建载荷集 

本步骤将进行单位模态应力与相应的模态参与因子的关联操作。 
（1）单击CAE Duty Cycle 面板的Synthesize 按钮，弹出Synthesize Fatigue Duty Cycle 窗口。 
（2）单击 MODEL_b_1 标签，查看已关联的模态应力与单位载荷工况，如图 10-87 所示。 

 

图 10-87  模态应力与单位载荷工况关联信息 

（3）单击 OK 按钮，关闭该窗口。 
（4）单击 Apply 按钮进入下一面板。 

检查求解参数，进行耐久性分析设置 

（1）使用默认的耐久性分析参数。 
（2）单击 Apply 按钮进入下一面板。 
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（3）在 Test Fatigue Setup 面板，单击 Run Analysis 按钮，进行耐久性分析。 
（4）求解结束后，关闭命令窗口。 
（5）单击 Apply 按钮进入下一面板。 

生成报告 

在 Generate Report item 面板单击 Create Report 按钮，将创建包含上述损伤结果的

PowerPoint 文件。 

查看结果 

（1）耐久性分析所有结果文件将写入工作路径文件夹。查看工作路径可在分析向导中单

击 Define Project 文件夹，选择 Project Setup 进入项目设置面板。 
（2）单击 Set Preference 按钮。 
（3）在弹出的窗口中选择 Set Preference 标签，工作路径将显示在 DATA MANAGEMENT 

PREFERENCE 栏。 
（4）根据上述工作路径，打开 door_slam_demo 文件夹，在 Master_Solution 文件夹下可

以看到分析过程中创建的 4 个子文件夹：Duty_cycle_result_files、FAT_analysis_result_files、
MBD_analysis_result_files 和 POST_analysis_result_files。 

（5）进入POST_analysis_result_files 文件夹，可以看到上述步骤中创建的PowerPoint 文件。 
（6）关闭文件夹。 

保存和关闭耐久性分析向导 

（1）单击耐久性分析流程树面板右下角的 Close 按钮，关闭耐久性分析流程。 
（2）在弹出的是否退出分析向导提示对话框中单击 Yes 按钮。 
（3）在弹出的是否保存分析流程窗口中单击 Save 按钮。该操作将分析流程相关信息以

PMI 文件保存到工作路径。 
（4）此时将弹出一个新窗口，确认要保存的文件。 
（5）单击 Yes 按钮，关闭耐久性分析向导。 

10. 4.3  下控制臂耐久性分析 

本练习将学习以下内容： 
●  定义耐久性分析流程。 
●  定义负载循环。 
●  建立有限元模型并进行单位载荷工况分析。 
●  关联负载历程与单位载荷工况。 
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●  定义耐久性分析参数并进行耐久性分析。 
●  查看损伤结果并生成结果报告。 
在练习开始前，复制目录 chap10 的 Control_Arm 文件夹到工作路径。 

初始化耐久性分析工作路径与设置项目首选项 

（1）新建一个 MotionView 会话。 
（2）从 Directors 菜单中选择 Durability Director，弹出 Durability Director 对话框。 
（3）激活 Durability Director 标签。 
（4）单击 Create New 按钮，新建一个耐久性分析项目。 
（5）选择一个分析流程，本例选择 Flow 3（DUTY – FE – FATIGUE – POST），如图 10-88

所示。 

 

图 10-88  耐久性分析流程三 

（6）单击 Next 按钮，进入下一界面。 

设置项目信息与默认选项 

（1）在 Project Name 文本框中输入项目名称 control_arm_demo。 

（2）在 Project Description 文本框中输入项目简介 Durability Analysis of the control arm。 
（3）在 Solution Directory 处单击“文件浏览”按钮 指定工作路径，如图 10-89 所示。 

 

图 10-89  项目信息 

注：路径和文件夹名称中不允许包含空格。 
（4）单击 Next 按钮。 
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（5）在 PRE-PROCESSOR PREFERENCE 栏下的 Duty Cycle 项处设置 PREFERENCE 为

CSV。 
（6）在 Duty Cycle 项选择工作文件夹下的 Control_Arm\dutycyclefiles 目录。 

（7）在 FE Preprocessor 项选择工作文件夹下的 Control_Arm\femodelfiles 目录。 
（8）路径设置完毕后，如图 10-90 所示。 

 

图 10-90  前处理首选项设置 

（9）单击 Launch 按钮，将在当前会话的浏览器区域加载 Process Manager 标签。 
（10）如图 10-91 所示，在 Project Setup 面板区域将显示上步定义的项目名称、项目简

介与工作路径信息。 

 

图 10-91  Project Setup 面板 

（11）单击 Apply 按钮进入下一面板。 

定义负载循环 

（1）注意到黄色勾号显示在Specify Duty Cycle 前。确认Duty Cycle 面板设置为Create New。 
（2）此时 Channel File Format 设置为 CSV。 
（3）在 Create New 处单击“文件浏览”按钮 ，输入 sample_duty_cycle，如图 10-92

所示。 

 

图 10-92  负载循环创建窗口 
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（4）单击“保存”按钮，保存新建的负载循环文件。 
（5）单击 Launch 按钮，启动负载循环创建面板。 
（6）单击两次 Next 按钮，进入 Create Duty Cycle 标签。 
（7）单击 Add Event 按钮，从下拉菜单中选择 Time Series，如图 10-93 所示。 
（8）在弹出的文件对话框中选择 3g_01.csv。 
（9）单击 Open 按钮，载入数据。 
（10）在 Description 栏下输入 3gturnevent。 
（11）再次单击 Add Event 按钮，选择 Time Series。 
（12）在弹出的文件对话框中选择 1g_01.csv。 
（13）单击 Open 按钮。 
（14）在 Description 栏下输入 1gturnevent。 
定义完毕的负载循环如图 10-94 所示。 

 

图 10-94  定义负载循环 

（15）单击 Create 按钮，弹出 Durability Director 对话框，提示用户是否进行负载循环数

据关联（Duty Cycle Synthesized）。 
（16）单击 OK 按钮，对话框中显示两个 Time Series 表格。 
（17）单击 Close 按钮，关闭窗口。 
此时，HyperGraph 窗口中将显示 3gturnevent 曲线。 
（18）单击 Apply 按钮进入下一面板。 

设置有限元模型 

本步骤将载入目标零件的有限元模型，加载负载循环后进行单位载荷工况分析。模型在

载入前已经完成静态单位载荷工况定义。 
（1）单击图10-95所示面板上的“文件浏览”按钮 ，选择控制臂有限元模型 ctrlarm.fem。 

（2）单击 Open 按钮。 

 

图 10-93  指定负载循环类型 
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图 10-95  Setup FE Model 面板 

（3）单击 Load Model 按钮载入模型，如图 10-96 所示。 

 
图 10-96  下控制臂模型 

（4）单击 Apply 按钮，进入下一面板。 

创建单位载荷工况与设置有限元分析参数 

（1）如图 10-97 所示，在 FE MODEL 栏的下拉菜单中选择 Ctrlarm.fem。 

 

图 10-97  Unit load creation 面板 

（2）在 DEFINE LOADCOLS 栏单击 Select Fatigue Subcases 按钮。 
（3）此时弹出的窗口中将显示当前有限元模型的工况信息，确认两个工况均被激活，如

图 10-98 所示。 
（4）单击 OK 按钮。 
（5）单击 Apply 按钮，进入 Test FE Setup 面板。 
（6）单击 Run Analysis 按钮，进行单位载荷工况有限元分析。 
（7）分析完毕后关闭命令窗口。 
（8）单击 Apply 按钮进入下一面板。 
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图 10-98  工况选择窗口 

关联载荷历程与单位载荷工况 

接下来将载入有限元分析结果，选择单元集进行耐久性分析。 
（1）在 Visualize Unit Load 面板单击 Load Result 按钮载入单位载荷工况分析结果。 
此时，分析结果将显示在第三个窗口，如图 10-99 所示。 

 

图 10-99  单位载荷工况分析结果 

（2）单击 Apply 按钮进入下一面板。 
（3）如图 10-100 所示，在 Create Entity Subset 面板确认结果类型为 vonMises，并且指

定单元个数为 10。此值表示选择应力最大的 10 个单

元进行耐久性分析。 
（4）单击 Apply 按钮进入下一面板，显示模型应

力云图。 

定义材料属性 

（1）对于 PSOLID_2，在 MATERIAL PROPERTY 栏中单击 Material Database 按钮，弹

出材料信息窗口，如图 10-101 所示。 

 

图 10-100  Create Entity Subset 面板  STEP 

07 
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（2）将 Fatigue Limit（MPa）修改为 190。 
（3）将 Standard Error of log（N）修改为 0.05。 
（4）单击 Save 按钮，关闭该窗口并保存上述设置。 
（5）在 Machining Conditions 栏中单击 Machining Conditions 按钮，弹出材料机加工信息

窗口，如图 10-102 所示。 

       
            图 10-101  材料信息窗口                     图 10-102  材料机加工信息窗口 

（6）在 Surface finish 栏选择 FORGE（锻造）。 
（7）在 Surface treatment 栏选择 SHOTPEEN（喷丸）。 
（8）单击 Save 按钮，关闭该窗口并保存上述设置。 
（9）对于 PSOLID_5，重复上述设置。 
（10）单击 Apply 按钮进入下一面板。 

创建载荷集 

本步骤将负载循环与单位载荷工况进行关联。3g_01 和 1g_01 与 Subcase 1 关联，3g_02
和 1g_02 与 Subcase2 关联。 

（1）单击 Synthesize 按钮。 
（2）在弹出的 Synthesize Fatigue Duty Cycle 窗口中单击 Ctrlarm_fem 标签，如图 10-103

所示。 

 

图 10-103  3gturnevent 工况关联 
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（3）确认待映射的工况（Mapped Event）为 3gturnevent。 
（4）对于 SUBCASE1，在 Associated Channel 中选择 3g_01_csv.asc。 

（5）对于 SUBCASE2，在 Associated Channel 中选择 3g_02_csv.asc。 

（6）选择 1gturnevent 作为映射工况，如图 10-104 所示。 

 

图 10-104  1gturnevent 工况关联 

（7）对于 SUBCASE1，在 Associated Channel 中选择 1g_01_csv.asc。 

（8）对于 SUBCASE2，在 Associated Channel 中选择 1g_02_csv.asc。 

（9）单击 OK 按钮。 
（10）单击 Apply 按钮，进入下一面板。 

设置求解参数，进行耐久性分析设置 

（1）使用默认的耐久性分析参数，如图 10-105 所示。 

 

图 10-105  耐久性分析参数设置窗口 

（2）单击 Apply 按钮进入 Test Fatigue Setup 面板，如图 10-106 所示。 
（3）单击 Run Analysis 按钮，进行耐久性分析。 

 

图 10-106  Test Fatigue Setup 面板 

（4）求解结束后，关闭命令窗口。 
（5）单击 Apply 按钮进入下一面板。 
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查看损伤结果 

本步骤将查看目标零件的耐久性分析结果。每个工况结果将显示在一张饼状图中，此外

还提供了结果报表，其中包括工况名称、最大应力单元编号以及损伤值等。 
（1）如图 10-107 所示，在 Visualize Life Plot 面板单击 Load Result 按钮。 

 

图 10-107  Visualize Life Plot 面板 

此时，弹出第四个窗口并自动加载分析结果。 
（2）单击 Apply 按钮进入 Create Damage Plot 面板，如图 10-108 所示。 

 

图 10-108  Create Damage Plot 面板 

（3）单击 Display Damage Plot 按钮，弹出 Display Damage for Events 窗口，每个工况的

损伤程度将显示在饼状图上，如图 10-109 所示。 

 

图 10-109  Display Damage for Events 窗口 
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（4）从饼状图可以看出，所有的损伤效果均来自于 3gturnevent 工况。 
（5）单击 DutyCycle_Plots 标签，此时将以表格的形式显示损伤信息，如图 10-110

所示。 

 

图 10-110  DutyCycle_Plots 标签 

（6）单击 OK 按钮。 
（7）单击 Apply 按钮，进入下一个面板。 

生成报告 

在 Generate Report item 面板单击 Create Report 按钮，此时将创建包含上述损伤结果的

PowerPoint 文件。 

查看结果 

耐久性分析所有结果文件将写入工作路径文件夹。

查看工作路径可在分析向导中单击 Define Project 文件

夹，选择 Project Setup 进入项目设置面板，如图 10-111
所示。 

（1）单击 Set Preference 按钮，如图 10-112 所示。 

 

图 10-112  Project Setup 面板 

（2）在弹出的窗口中选择 Set Preference 标签，工作路径将显示在 DATA MANAGEMENT 

 

图 10-111  分析向导流程树 
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PREFERENCE 栏。 
（3）根据上述工作路径，打开 control_arm_demo 文件夹，在 Master_Solution 文件夹下

可以看到分析过程中创建的 4 个子文件夹：Duty_cycle_result_files、FAT_analysis_result_files、 
FE_analysis_Result_files 和 POST_analysis_result_files。 

（4）进入POST_analysis_result_files 文件夹，可以看到上述步骤中创建的PowerPoint 文件。 
（5）关闭文件夹。 

保存和关闭耐久性分析向导 

（1）单击耐久性分析流程树面板右下角的 Close 按钮，关闭耐久性分析流程。 
（2）在弹出的是否退出分析向导提示对话框中单击 Yes 按钮。 
（3）在弹出的是否保存分析流程窗口中单击 Save 按钮。该操作将分析流程相关信息以

PMI 文件保存到工作路径。 
（4）此时将弹出一个新窗口，确认要保存的文件。 
（5）单击 Yes 按钮，关闭耐久性分析向导。 

10.5  小结 

应用 CAE 技术进行结构耐久性分析时，加载到结构上的边界条件主要来源有两个：试

验测试和多体系统动力学仿真分析。对于一些工作环境恶劣、试验数据不容易获取的场合，

多体系统动力学仿真分析便成为耐久性分析工况数据的主要来源。耐久性分析的一般流程为

获取工况数据，加载有限元模型、耐久性计算和分析结果后处理。HyperWorks 开放的软件

架构，为这一流程的统一提供了可能。通过多体系统前处理环境 MotionView、有限元前处

理环境 HyperMesh、多体系统动力学求解器 MotionSolve（或其他）、耐久性分析求解器

RADIOSS（或其他）及结果后处理环境 HyperView & HyperGraph 的无缝集成，开发的耐久

性分析向导 Durability Director，实现了结构耐久性分析的流程化。该向导提供 3 种分析流

程，适用于不同的分析场合。本章通过功能介绍与应用结合的方式详细描述了 3 种分析流程

的使用方法，相信读者学习完本章后，会对耐久性分析有更加深入的认识，能够将耐久性设

计广泛地应用于实际工作中。 
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附录 A  MotionSolve 函数说明 

表 A-1  数学函数（Math Functions） 

函数及格式 函 数 功 能 

ABS（x） 返回表达式 x 的绝对值 

ACOS（x） 返回表达式 x 的反余弦值 

AINT（x） 返回表达式 x 向绝对值小的方向取整，如 AINT（-3.7）= -3，AINT（3.7）=3 

ANINT（x） 返回表达式 x 向绝对值大的方向取整，如 ANINT<-3.7>= -4，ANINT<3.7>=4 

ASIN（x） 返回表达式 x 的反正弦值 

ATAN（x） 返回表达式 x 的反正切值 

ATAN2（x，y） 返回表达式 x/y 的反正切值 

COS（x） 返回表达式 x 的余弦值 

COSH（x） 返回表达式 x 的双曲余弦值 

DIM（x，y） 返回表达式 x 和 y 的正差值，即 DIM（x， y）= max（0， x-y） 

EXP（x） 返回表达式 x 的指数函数 ex 

LOG（x） 返回表达式 x 的自然对数值 

LOG10（x） 返回表达式 x 的以 10 为底的对数值 

MOD（x，y） 返回表达式 x 整除 y 后的余数 

SIGN（x，y） 
符号函数 
SIGN（x，y）= ABS（x），y≥0 
SIGN（x，y）= −ABS（x），y< 0 

SIN（x） 返回表达式 x 的正弦值 

SINH（x） 返回表达式 x 的双曲正弦值 

SQRT（x） 返回非负表达式 x 的平方根 

TAN（x） 返回表达式 x 的正切值 

TANH（x） 返回表达式 x 的双曲正切值 

MAX（x，y） 
返回表达式 x 和 y 中数值最大的表达式 
MAX（x，y）= x， x≥y 
MAX（x，y）= y， x>y 

MIN（x，y） 
返回表达式 x 和 y 中数值最小的表达式 
MIN（x，y）= x，x≤y 
MIN（x，y）= y，x>y 

表 A-2  常值与变量函数（Constants and Variables） 

函数及格式 函 数 功 能 

TIME 返回当前的仿真时间 

MODE 

返回当前的仿真类型，常用于脚本仿真控制中。返回值约定如下： 
1 表示运动学分析（Kinematics） 
2 保留使用（Reserved） 
3 表示初始条件（Initial conditions） 
4 表示动力学分析（Dynamics） 
5 表示静力学分析（Statics） 
6 表示准静态分析（Quasi-Statics） 
7 表示线性分析（LinearAnalysis） 

PI 返回圆周率 π 值 

DTOR 将角度值转换为弧度值的乘积系数，等于 π /180 

RTOD 将弧度值转化为角度值的乘积系数，等于 180/ π 
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（续） 

函数及格式 函 数 功 能 

IF（EXPR1：EXPR2，EXPR3， 
EXPR4） 

IF 函数是一个判断函数，返回值根据如下约定： 
如果表达式 1<0，则返回表达式 2 的值 
如果表达式 1=0，则返回表达式 3 的值 
如果表达式 1>0，则返回表达式 4 的值 

表 A-3  位移函数（Displacement Functions） 

函数及格式 函 数 功 能 

DX（I， J， K） 返回标记点 I 相对标记点 J 的位移矢量在坐标系 K 的 X 轴方向的分量，其中标记点

I 必须指定，后两个参量为可选项，若未指定，则使用全局坐标系 

DY（I， J， K） 返回标记点 I 相对标记点 J 的位移矢量在坐标系 K 的 Y 轴方向的分量，其中标记点

I 必须指定，后两个参量为可选项，若未指定，则使用全局坐标系 

DZ（I， J， K） 返回标记点 I 相对标记点 J 的位移矢量在坐标系 K 的 Z 轴方向的分量，其中标记点

I 必须指定，后两个参量为可选项，若未指定，则使用全局坐标系 

DM（I， J） 返回标记点 I 与标记点 J 之间的相对距离 

AX（I， J） 返回标记点 I 相对标记点 J 的 X 轴旋转的角度，其中标记点 J 为可选项，若未指

定，则使用全局坐标系 

AY（I， J） 返回标记点 I 相对标记点 J 的 Y 轴旋转的角度，其中标记点 J 为可选项，若未指

定，则使用全局坐标系 

AZ（I， J） 返回标记点 I 相对标记点 J 的 Z 轴旋转的角度，其中标记点 J 为可选项，若未指

定，则使用全局坐标系 

AXU（I， J） 
返回标记点 I 相对标记点 J 的 X 轴旋转的角度，其中标记点 J 为可选项，若未指

定，则使用全局坐标系。其与 AX（I， J）函数区别在于：如果旋转角度大于一周，则

AX 连续计算旋转角度，而 AXU 从 0 开始计算 

AYU（I， J） 
返回标记点 I 相对标记点 J 的 Y 轴旋转的角度，其中标记点 J 为可选项，若未指

定，则使用全局坐标系。其与 AY（I， J）函数区别在于：如果旋转角度大于一周，则

AY 连续计算旋转角度，而 AYU 从 0 开始计算 

AZU（I， J） 
返回标记点 I 相对标记点 J 的 Z 轴旋转的角度，其中标记点 J 为可选项，若未指

定，则使用全局坐标系。其与 AZ（I， J）函数区别在于：如果旋转角度大于一周，AZ
连续计算旋转角度，而 AZU 从 0 开始计算 

YAW（I， J） 按照 321 旋转顺序，返回标记点 I 相对标记点 J 的第一个旋转角度，其中标记点 J
为可选项，若未指定，则使用全局坐标系 

PITCH（I， J） 按照 321 旋转顺序，返回标记点 I 相对标记点 J 的第二个旋转角度，其中标记点 J
为可选项，若未指定，则使用全局坐标系 

ROLL（I， J） 按照 321 旋转顺序，返回标记点 I 相对标记点 J 的第三个旋转角度，其中标记点 J
为可选项，若未指定，则使用全局坐标系 

PSI（I， J） 按照 313 旋转顺序，返回标记点 I 相对标记点 J 的第一个旋转角度，其中标记点 J
为可选项，若未指定，则使用全局坐标系 

THETA（I， J） 按照 313 旋转顺序，返回标记点 I 相对标记点 J 的第二个旋转角度，其中标记点 J
为可选项，若未指定，则使用全局坐标系 

PHI（I， J） 按照 313 旋转顺序，返回标记点 I 相对标记点 J 的第三个旋转角度，其中标记点 J
为可选项，若未指定，则使用全局坐标系 

PROXIMITY（id， comp） 

返回最近点传感器（Sensor_Proximity）感测值。id 表示最近点传感器单元编号；

comp 的取值范围为 1～8，各数值含义如下： 
1 返回界面状态（1 表示接触，0 表未接触） 
2 返回最小间距 
3 返回图形 1 中最近点的 X 坐标 
4 返回图形 1 中最近点的 Y 坐标 
5 返回图形 1 中最近点的 Z 坐标 
6 返回图形 2 中最近点的 X 坐标 
7 返回图形 2 中最近点的 Y 坐标 
8 返回图形 2 中最近点的 Z 坐标 

INCANG（I， J， K） 返回标记点 I 和标记点 J 的连线与标记点 J 和标记点 K 的连线之间的夹角 
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表 A-4  速度函数（Velocity Functions） 

函数及格式 函 数 功 能 

VX（I， J， K， L） 返回标记点 I 与标记点 J 相对于坐标系 L 的线速度矢量差在坐标系 K 的 X 轴方向的分

量，其中标记点 I 必须指定，后 3 个参量为可选项，若未指定，则使用全局坐标系 

VY（I， J， K， L） 返回标记点 I 与标记点 J 相对于坐标系 L 的线速度矢量差在坐标系 K 的 Y 轴方向的分

量，其中标记点 I 必须指定，后 3 个参量为可选项，若未指定，则使用全局坐标系 

VZ（I， J， K， L） 返回标记点 I 与标记点 J 相对于坐标系 L 的线速度矢量差在坐标系 K 的 Z 轴方向的分

量，其中标记点 I 必须指定，后 3 个参量为可选项，若未指定，则使用全局坐标系 

VM（I， J） 返回标记点 I 与标记点 J 之间的相对线速度 

WX（I， J， K） 返回标记点 I 相对标记点 J 的角速度矢量差在坐标系 K 的 X 轴方向的分量，其中标

记点 I 必须指定，后两个参量为可选项，若未指定，则使用全局坐标系 

WY（I， J， K） 返回标记点 I 相对标记点 J 的角速度矢量差在坐标系 K 的 Y 轴方向的分量，其中标

记点 I 必须指定，后两个参量为可选项，若未指定，则使用全局坐标系 

WZ（I， J， K） 返回标记点 I 相对标记点 J 的角速度矢量差在坐标系 K 的 Z 轴方向的分量，其中标

记点 I 必须指定，后两个参量为可选项，若未指定，则使用全局坐标系 

WM（I， J） 返回标记点 I 与标记点 J 之间的相对角速度 

VR（I， J， K） 返回标记点 I 与标记点 J 在坐标系 K 的相对速度 

表 A-5  加速度函数（Acceleration Functions） 

函数及格式 函 数 功 能 

ACCX（I， J， K， L） 返回标记点 I 与标记点 J 相对于坐标系 L 的线加速度矢量差在坐标系 K 的 X 轴方向的

分量，其中标记点 I 必须指定，后 3 个参量为可选项，若未指定，则使用全局坐标系 

ACCY（I， J， K， L） 返回标记点 I 与标记点 J 相对于坐标系 L 的线加速度矢量差在坐标系 K 的 Y 轴方向的

分量，其中标记点 I 必须指定，后 3 个参量为可选项，若未指定，则使用全局坐标系 

ACCZ（I， J， K， L） 返回标记点 I 与标记点 J 相对于坐标系 L 的线速度矢量差在坐标系 K 的 Z 轴方向的分

量，其中标记点 I 必须指定，后 3 个参量为可选项，若未指定，则使用全局坐标系 

ACCM（I， J） 返回标记点 I 与标记点 J 之间的相对线加速度 

WDTX（I， J， K） 返回标记点 I 相对标记点 J 的角加速度矢量差在坐标系 K 的 X 轴方向的分量，其中

标记点 I 必须指定，后两个参量为可选项，若未指定，则使用全局坐标系 

WDTY（I， J， K） 返回标记点 I 相对标记点 J 的角速度矢量差在坐标系 K 的 Y 轴方向的分量，其中标

记点 I 必须指定，后两个参量为可选项，若未指定，则使用全局坐标系 

WDTZ（I， J， K） 返回标记点 I 相对标记点 J 的角速度矢量差在坐标系 K 的 Z 轴方向的分量，其中标

记点 I 必须指定，后两个参量为可选项，若未指定，则使用全局坐标系 

WDTM（I， J） 返回标记点 I 与标记点 J 之间的相对角速度 

表 A-6  合成力函数（Generic Force Functions）  

函数及格式 函 数 功 能 

FX（I， J， K） 返回作用在标记点 I 上的标记点 I 和 J 之间的合力在坐标系 K 的 X 方向的分量，其

中第三个参量为可选项，若未指定，则使用全局坐标系 

FY（I， J， K） 返回作用在标记点 I 上的标记点 I 和 J 之间的合力在坐标系 K 的 Y 方向的分量，其

中第三个参量为可选项，若未指定，则使用全局坐标系 

FZ（I， J， K） 返回作用在标记点 I 上的标记点 I 和 J 之间的合力在坐标系 K 的 Z 方向的分量，其

中第三个参量为可选项，若未指定，则使用全局坐标系 

FM（I， J） 返回作用在标记点 I 上的标记点 I 和 J 之间的合力 

TX（I， J， K） 返回作用在标记点 I 上的标记点 I 和 J 之间的合力矩在坐标系 K 的 X 方向的分量，

其中第三个参量为可选项，若未指定，则使用全局坐标系 

TY（I， J， K） 返回作用在标记点 I 上的标记点 I 和 J 之间的合力矩在坐标系 K 的 Y 方向的分量，

其中第三个参量为可选项，若未指定，则使用全局坐标系 

TZ（I， J， K） 返回作用在标记点 I 上的标记点 I 和 J 之间合力矩在坐标系 K 的 Z 方向的分量，其

中第三个参量为可选项，若未指定，则使用全局坐标系 

TM（I， J） 返回作用在标记点 I 上的标记点 I 和 J 之间的合力矩 
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表 A-7  力元函数（Element-Specific Reaction Force Functions）  

函数及格式 函 数 功 能 

BEAM（id， jflag， comp， RM） 

返回梁单元作用在构件上引起的力或力矩。id 表示梁单元编号；jflag 表示载荷作用

位置（0 表示标记点 I，1 表示标记点 J）；RM 表示参考的坐标系，如未指定，则使

用全局坐标系；comp 的取值范围为 1～8，各数值的含义如下： 
1 返回合力 
2 返回合力在参考系 RM 的 X 轴上的分量 
3 返回合力在参考系 RM 的 X 轴上的分量 
4 返回合力在参考系 RM 的 X 轴上的分量 
5 返回合力矩 
6 返回合力矩在参考系 RM 的 X 轴上的分量 
7 返回合力矩在参考系 RM 的 X 轴上的分量 
8 返回合力矩在参考系 RM 的 X 轴上的分量 

BUSH（id， jflag， comp， RM） 返回衬套单元作用在构件上引起的力或力矩，使用方法与 BEAM 类似 

FIELD（id， jflag， comp， RM） 返回场力单元作用在构件上引起的力或力矩，使用方法与 BEAM 类似 

FRICTION（id， comp） 

返回摩擦力。id 表示摩擦力单元编号；comp 的取值范围为 1～18，各数值的

含义如下： 
1～3 分别返回摩擦力在约束副标记点 J 的 X、Y、Z 三个轴向方向上的分量 
4～6 分别返回摩擦力矩在约束副标记点 J 的 X、Y、Z 三个轴向方向上的分量 
7～9 分别返回平动摩擦系数在约束副标记点 J 的X、Y、Z 三个轴向方向上的分量 
10～12 分别返回转动摩擦系数在约束副标记点 J 的X、Y、Z 三个轴向方向上的分量 
13～15 分别返回滑动线速度在约束副标记点 J 的 X、Y、Z 三个轴向方向上的分量 
16～18 分别返回滑动角速度在约束副标记点 J 的 X、Y、Z 三个轴向方向上的分量 

GFORCE（id， jflag， comp， RM） 返回 3 个方向组合力和 3 个方向组合力矩作用在构件上引起的力或力矩，使用方法

与 BEAM 类似 

NFORCE（id， jflag， comp， RM） 返回一个多点作用力施加在构件上引起的力或力矩，使用方法与 BEAM 类似 

SFORCE（id， jflag， comp， RM） 返回单个作用力施加在构件上引起的力或力矩，使用方法与 BEAM 类似 

SPDP（id， jflag， comp， RM） 返回弹簧阻尼力作用在构件上引起的力或力矩，使用方法与 BEAM 类似 

VFORCE（id， jflag， comp， RM） 返回 3 个方向组合力作用在构件上引起的力或力矩，使用方法与 BEAM 类似 

VTORQ（id， jflag， comp， RM） 返回 3 个方向组合力矩作用在构件上引起的力或力矩，使用方法与 BEAM 类似 

表 A-8  约束力函数（Element-Specific Reaction Force Functions）  

函数及格式 函 数 功 能 

JOINT（id，jflag， comp， RM） 

返回约束副上的连接力或力矩。id 表示约束副编号；jflag 表示载荷作用位置（0 表

示标记点 I，1 表示标记点 J）；RM 表示参考的坐标系，如未指定，则使用全局坐标

系；comp 的取值范围为 1～8，各数值含义如下： 
1 返回合力 
2 返回合力在参考系 RM 的 X 轴上的分量 
3 返回合力在参考系 RM 的 Y 轴上的分量 
4 返回合力在参考系 RM 的 Z 轴上的分量 
5 返回合力矩 
6 返回合力矩在参考系 RM 的 X 轴上的分量 
7 返回合力矩在参考系 RM 的 Y 轴上的分量 
8 返回合力矩在参考系 RM 的 Z 轴上的分量 

JPRIM（id，jflag， comp， RM） 返回基本约束副上的连接力或力矩，使用方法与 JOINT 类似 

MOTION（id，jflag， comp， RM） 返回驱动产生的力或力矩，使用方法与 JOINT 类似 

PTCV（id，jflag， comp， RM） 返回点−线副上的连接力或力矩，使用方法与 JOINT 类似 

CVCV（id，jflag， comp， RM） 返回线−线副上的连接力或力矩，使用方法与 JOINT 类似 

PTSF（id，jflag， comp， RM） 返回点−面副上的连接力或力矩，使用方法与 JOINT 类似 

CVSF（id，jflag， comp， RM） 返回线−面副上的连接力或力矩，使用方法与 JOINT 类似 

SFSF（id，jflag， comp， RM） 返回面−面副上的连接力或力矩，使用方法与 JOINT 类似 
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（续） 

函数及格式 函 数 功 能 

COUPLER（id，jflag， comp， RM） 

返回耦合副上的连接力或力矩，耦合副可以定义两个约束副 4 个标记点或 3 个约束

副 6 个标记点之间的运动关系，因此 jflag 的取值范围为 0～5。其中，0 和 1 分别代表

第一个约束副上的标记点 I 和 J；2 和 3 分别代表第二个约束副上的标记点 I 和 J；4
和 5 分别代表第三个约束副上的标记点 I 和 J。表达式中的其他参量与 JOINT 类似 

CONTACT（id，jflag， comp， RM） 返回接触约束产生的接触力或力矩，使用方法与 JOINT 类似 

表 A-9  数据元素函数（Data Elements）  

函数及格式 函 数 功 能 

VARVAL（id） 返回状态变量的当前值，id 表示状态变量编号 

ARYVAL（id， comp） 返回矢量单元指定的分量值，id 表示矢量单元编号，comp 表示分量编号 

DIF（id） 返回微分方程变量的积分值，id 表示微分方程编号 

DIFI（id） 返回微分方程变量的值，id 表示微分方程编号 

SENVAL（id） 返回传感器的监测值，id 表示传感器编号 

PINVAL（id， comp） 返回输入控制信号中指定的分量值，id 表示输入控制单元编号，comp 表示分量编号 

POUVAL（id， comp） 返回输出控制信号中指定的分量值，id 表示输出控制单元编号，comp 分量编号 

表 A-10  插值函数（Interpolation Functions） 

函数及格式 函 数 功 能 

CUBSPL（x，z，id）或（x，0，id， n） 
标准三次样条函数插值。x 表示曲线的第一个独立变量；z 表示第二个独立变量（可

选），两者组成一个曲面；id 表示样条数据单元编号；n 为微分阶数，可选 0、1 或 2，
分别表示不微分、一次微分和二次微分，第二个独立变量存在时，该参量不可用 

CURVE（alpha， iord， comp， id） 
B 样条插值或用户定义插值。其中，alpha 为独立变量；iord 为微分阶数，可选 0、1

或 2，分别表示不微分、一次微分和二次微分；comp 表示返回的 X、Y 或 Z 轴分量；

id 表示样条数据单元编号 

AKISPL（x，z，id）或（x，0，id， n） 根据 Akima 拟合算法插值，使用方法与 CUBSPL 类似 

LINSPL（x，z，id）或（x，0，id， n） 线性插值，使用方法与 CUBSPL 类似 

QUISPL（x，z，id）或（x，0，id， n） 五次样条函数插值，使用方法与 CUBSPL 类似 

表 A-11  通用函数（General Functions） 

函数及格式 函 数 功 能 

1 ma xBISTOP（ ， ， ， ， e， ， ）x x x k c d  
模拟双侧碰撞产生的碰撞力 

1 maxIMPACT（ ， ， ， ， e， ， ）x x x k c d  
模拟单侧碰撞产生的碰撞力 

0 0 1 30CHEBY（ ， ， ， ， ...， ）x x c c c  返回 Chebyshev 多项式在指定点 x 处的值。其中，x 为独立变量， 0x 为独立变量偏

置量， 0 1 30， ，...，c c c 为多项式系数 

0 0 1 30FORCOS（ ， ， ， ， ，...， ）x x c c cω  返回傅里叶余弦级数在指定点 x 处的值。其中，x 是独立变量， 0x 是独立变量偏置

量，ω 是角频率， 0 1 30， ，...，c c c 是级数的系数 

0 0 1 30FORSIN（ ， ， ， ， ， ...， ）x x c c cω  返回傅里叶正弦级数在指定点 x 处的值。其中，x 是独立变量， 0x 是独立变量偏置

量，ω 是角频率， 0 1 30， ，...，c c c 是级数的系数 

0 0 1 1HAVSIN（ ， ， ， ， ）x x y x x  返回 HAVSIN 函数在指定点 x 处的 y 值。其中，x 是独立变量， 0 0（ ， ）x y 为起始值，

1 1（ ， ）x y 为终止值 

0 0 1 30POLY（ ， ， ， ， ...， ）x x c c c  返回标准多项式在指定点 x 处的值。其中，x 为独立变量， 0x 为独立变量偏置量，

0 1 30， ，...，c c c 为多项式系数 

0SHF（ ， ， ， ， ， ）x x A yω ϕ  
返回简谐函数在指定点 x 处的值。其中，x 是独立变量， 0x 是独立变量的偏置量，

A 是幅值，ω 是角频率，ϕ 是初始相位，y 是简谐函数平均值，函数定义为 

0SHF = sin （ （ ） ）+A x x yω ϕ− −  
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（续） 

函数及格式 函 数 功 能 

0 0 1 1STEP（ ， ， ， ， ）x x y x y  
用一个 3 次多项式构造一个阶跃函数。其中，x 是独立变量， 0 0（ ， ）x y 决定起始点，

1 1（ ， ）x y 决定终止点，其值在 0～ 0x 时刻为 0y ，在 1x 时刻增加（或减小）到 1y ，然

后保持不变 

0 0 1 1STEP5（ ， ， ， ， ）x x y x y  用一个 5 次多项式构造一个阶跃函数。其中，x 是独立变量， 0 0（ ， ）x y 决定起始点，

1 1（ ， ）x y 决定终止点 

0 0 1 1SWEEP（ ， ， ， ， ， ， dx）x A x f x f  
构造一个常幅值且频率线性递增的正弦函数 

KE（id） 返回刚性体或柔性体动能，id 表示物体编号 

表 A-12  柔性体常数（Flexible Body Constants） 

函数及格式 函 数 功 能 

FXFREQ 返回柔性体当前模态频率值，用于定义阻尼比表达式 

FXMODE 返回柔性体当前模态阶数，用于定义阻尼比表达式 

附录 B  常见问题与解答 

1.常见求解报错信息及解决方案 

（1）对象参数设置不完整产生的报错，如铰未定义约束方向、驱动约束未定义施加对

象、力没有定义加载点等，报错信息如图 B-1 所示。 

 

图 B-1  常见报错信息 

此类问题的解决方法是根据报错信息中对象的简称，找到对应的面板，将缺失信息补充

完整。例如，对于 Error 1，错误信息为未定义载荷加载点，进入 force 面板，如图 B-2 所

示，可以看到 Apply force at 处显示为 Unresolved。单击 Point 按钮，在图形区选择需要的加

载点即可。MotionView 错误信息及缺失项如表 B-1 所示。 

 
图 B-2  force 面板 
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表 B-1  MotionView 错误信息及缺失项 

错 误 信 息 面    板 工具栏按钮 缺  失  项 

MODEL.m_0.origin 标记点原点 

MODEL.m_0.body 
标记点（Marker）  

标记点从属几何体 

MODEL.gra_0.body 图形从属几何体 

MODEL.gra_0.origin 图形原点 

MODEL.gra_0.align_pt1 

图形（Graphic）  

图形方向 

MODEL.j_0.origin 铰约束原点 

MODEL.j_0.b1 铰关联几何体 1 

MODEL.j_0.b2 铰关联几何体 2 

MODEL.j_0.align_pt1 

铰（Joint）  

铰约束方向 

MODEL.mot_0.jt 驱动（Motion）  驱动关联铰 

MODEL.c_0.j1 耦合副关联铰 1 

MODEL.c_0.j2 
耦合副（Coupler）  

耦合副关联铰 2 

MODEL.gear_0.j1 齿轮副关联铰 1 

MODEL.gear_0.j2 齿轮副关联铰 2 

MODEL.gear_0.origin 齿轮副原点 

MODEL.gear_0.align_pt1 

齿轮副（Gear）  

齿轮副方向 

MODEL.aj_0.crv 高副曲线对象 

MODEL.aj_0.b1 高副关联几何体 

MODEL.aj_0.origin 

高副 
（Advanced Joint）  

高副原点 

MODEL.frc_0.origin 载荷作用点 

MODEL.frc_0.b1 
载荷（Force）  

载荷作用的几何体 

MODEL.bsh_0.origin 衬套原点 

MODEL.bsh_0.b1 衬套关联几何体 1 

MODEL.bsh_0.b2 

衬套（Bushing）  

衬套关联几何体 2 

MODEL.fld_0.b1 场力关联几何体 1 

MODEL.fld_0.b2 场力关联几何体 2 

MODEL.fld_0.origin 

场力（Field）  

场力原点 

MODEL.sd_0.p1 弹簧阻尼单元端点 1 

MODEL.sd_0.p2 弹簧阻尼单元端点 2 

MODEL.sd_0.b1 弹簧阻尼单元关联几何体 1 

MODEL.sd_0.b2 弹簧阻尼单元关联几何体 2 

MODEL.sd_0.len 

弹簧阻尼单元 
（Spring Damper）  

弹簧阻尼单元原长 

MODEL.bm_0.origin1 梁端点 1 

MODEL.bm_0.origin2 梁端点 2 

MODEL.bm_0.b1 梁关联几何体 1 

MODEL.bm_0.b2 

梁 
（Beam）  

梁关联几何体 2 

MODEL.pbm_0.pt0 多段梁端点 1 

MODEL.pbm_0.pt1 
多段梁 

（Polybeam）  
多段梁端点 2 
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（续） 

错 误 信 息 面    板 工具栏按钮 缺  失  项 

MODEL.con_0.b1 接触几何体 1 

MODEL.con_0.b2 
接触（Contact）  

接触几何体 2 

（2）仿真脚本中出现中文字符，会出现如图 B-3 所示的错误。 

 

图 B-3  中文字符错误提示 

此类问题的解决方法是根据报错信息找到.xml 文件的出错行（见图 B-4），检查该行出

现中文字符的位置，并在 MotionView 面板中修正（见图 B-5）。 

 

图 B-4  .xml 文件的出错行 

 
图 B-5  出错信息位置 

（3）使用表达式编辑器创建表达式时，出现 Error Evaluating 的问题，如图 B-6 所示。 
此类问题的解决方法是在表达式的两侧加入

“`”符号。该符号是通过单击英文输入法的 键

输入的。另外，MotionView 使用简称来表示对

象，如使用 the_model.b_0.cm.idstring 表示几何

体 b_0 质心处的标记点，此类表达式需要 Templex
工具解释，因此在调用时需要在语句的两侧加入

“{}”符号。完整的表达式如下所示：`DX（{the_model.b_0.cm.idstring}）` 
（4）求解过程中，积分失效报错信息如图 B-7 所示。 
导致积分器失效的原因有很多，求解器在报错的同时，也给出了几种可能原因及解决方法。 
●  积分过程不稳定。收紧瞬态分析中积分容差、最大步长等参数设置有助于保证积分

过程的稳定性。 
●  求解过程中，仿真步长变小以致小于设定的最小仿真步长 h_min，使得求解中断。此

时，收紧 h_min，可强制求解过程继续进行。 

 

图 B-6  所示表达式错误信息 
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图 B-7  积分失效报错信息 

●  使用不切实际的惯性参数（如使用 mass=100kg，IXX=IYY=IZZ=1kg ⋅mm2
）或在自由体

上定义了一个非常小的惯量参数。测试模型时，推荐的默认值为 

2

1000 0 0
=1kg， = 0 1000 0 kg mm

0 0 1000
mass Inertia

⎛ ⎞
⎜ ⎟ ⋅⎜ ⎟
⎜ ⎟
⎝ ⎠

 

模型中可以使用点质量单元以减小系统自由度，该类单元有 3 个平动自由度。此外，可以

使用哑物体（即质量为 0 的物体），但该物体必须使用固定副与其他的刚性体或柔性体连接起来。 
●  模型中使用的梁或柔性体超出了其线性范围、衬套在两个或两个以上的轴线上出现

大转动（大于 10°）、曲线超出了插值边界以及高副约束中曲线或曲面超出了端点等。 
●  使用 LINSPL、AKISPL 函数或模型状态 DX、VX 等定义的位移驱动以及参考其他载

荷定义的载荷均有可能造成收敛困难及积分失效。 

2.约束建模问题 
（1）约束建模时应注意以下几点： 
●  建模时，应逐步施加各种约束，并经常对施加的约束进行试验，检查是否有约束错

误，通过这种方法可以较容易地发现约束错误。 
●  微分将放大输入信号中的噪声，因而保证所有的表达式和提供的试验数据尽可能平

顺且二阶连续是非常重要的。进行曲线插值时，尽量使用 CUBSPL 算法，避免使用

AKIMA 算法，因为该算法得到的曲线一阶和二阶导数质量较差。 
●  积分将降低输入信号中的噪声，因而定义驱动时最好使用速度数据。 
●  确保驱动的初始速度与其作用的物体的初始速度一致。例如，机械系统仿真起始于

一个静止状态，那么需要保证驱动的初始速度为 0。如果两者不一致，驱动速度将抑

制物体初速。 
●  如果使用速度驱动，求解得到的位置结果中将存在积分误差（由 PARAM_TRANSIENT

定义）。类似地，使用加速度驱动，求解得到的位置和速度结果都会存在积分误差。这

是所有基于数值积分算法的代码的局限性。 
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●  进行系统动力学分析前，应先进行运动学分析。通过运动学分析可以确定系统的各

种约束是否正确。有时，为了进行运动学分析，需要添加一些临时约束。 
●  去除模型中多余的约束，因为即使在含有多余约束的情况下，求解过程仍可顺利进行。 
●  注意约束的方向是否正确。错误的约束方向，可能导致某些自由度没有约束或约束

了不应该约束的方向。 
●  如果定义位移驱动，表达式不应为常数，而应是时间的函数，如`5*time`。 
●  通过 MotionView 提供的模型检查功能（默认情况下，不检查模型自由度，可单击菜

单 Tools→Options→check model→Degrees of Freedom 命令进行设置）可对模型的自

由度进行检查。 
（2）过约束问题及其处理方法。 
机械系统在创建过程中，如果部件间的约束类型设置不合理将产生过约束的问题，这在

MotionView 建模过程中是较为常见的现象。在现实生活中，房门即是一个典型的过约束系

统。从强度和安全的角度考虑，人们常常用两个合页将门与门框连接起来。而在 MotionView
中，一个旋转副限制了 5 个自由度，如果用两个旋转副限制两个构件，显然是过约束了，因

为第二个旋转副不会给这个系统加入新的约束信息。从数学意义上讲，第二个合页形成的约

束方程与第一个合页形成的约束方程是相关的。 
这种冗余表现为系统控制方程矩阵的不满秩，也就意味着系统控制方程没有特定解。在

这种情况下，MotionSolve 根据自身机制的判断，对过约束的系统进行相关约束自由度的释

放，从而保证系统可以正常运转。但这种自动释放自由度的处理方法并不总是有效的，如果

某个约束被移除，那么被移除约束处的约束反力将置为 0，此时系统中其他约束处可能会产

生不切实际的较大的反力或力矩。因此，如果希望获得较为实际的约束反力，则可通过以下

方式处理过约束问题： 
●  合理选择约束类型以保证系统不产生过约束。例如，可以使用约束较少的基本副来

代替约束副。 
●  使用柔性力对象（如衬套、梁等）取代理想铰约束。 
●  将铰连接的几何体替换成柔性体。柔性体将引入较多的自由度，可消除冗余铰带来

的过约束。 

3.模型导入时无法计算构件质量问题及其处理方法 
MotionView 进行模型导入时，支持 CATIA、HyperMesh、JT、NASTRAN、RadiossBulk、 

Parasolid、Pro/E、SolidWorks、STEP、UG 格式模型文件的质量和转动惯量信息的自动计

算，而对于 Abaqus、ACIS、Ansys、DXF、DXF、HyperMeshAscii、Ideas、IGES/IGS、LS-
Dyna、Madymo、Marc、Pamcrash2G、PDGS、Permas、RadiossBulk、VDAFS 格式模型文件

只能输入而不能计算其质量与转动惯量信息。 
如果用户在模型导入时希望获得后一类模型的质量等信息，可通过以下办法间接实现： 
●  对于几何模型，先导入 HyperMesh 并将其转换为实体，然后保存为 HyperMesh 的

HM 格式文件，再输入 MotionView。 
●  对于有限元模型，进入对应的求解器模板将模型导入 HyperMesh，然后使用 Tools→

Convert，将模型转换为 RadiossBulk 格式文件并保存为 HyperMesh 的 HM 格式文

件，再输入 MotionView。 
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模型导入时，可以使用 HyperMesh 将没有相对位移的构件移动到一个组件中，模型转

换过程中，处于同一组件的构件将在 MotionView 中形成一个构件。这样，既可以使得模

型简化，又可以减少固定副的使用。HyperMesh 与 MotionView 中模型组件对应关系如

图 B-8 所示。 

 
图 B-8  模型组件对应关系 

a） HyperMesh 模型浏览树  b） MotionView 模型浏览树 

4.接触问题及其处理方法 

模型中使用接触约束可以更加真实地反映多体系统的运动状态。然而，如果接触参数设

置不当，此类约束的使用常常会造成求解器积分困难，从而导致求解失败或产生物体穿透。

此问题的处理方法如表 B-2 所示。表 B-3 列出了常用材料恢复系数参考值，表 B-4 列出了

常用材料不同接触条件下的摩擦系数参考值。 

表 B-2  接触问题及接触方案 

现    象 解 决 方 案 

物体穿透 
减小最大仿真步长 H_MAX 
减小积分容差 
增大惩罚系数 

积分失效 

减小最大仿真步长 H_MAX 
减小惩罚系数 
增大积分容差 
减小摩擦系数 
增大滑移速度 
为刚性无阻尼构件施加阻尼 
使用 ABAM 积分器 

计算起始时刻积分困难 检查模型初始装配位置是否有穿透 

接触时产生引力而不是斥力 确保接触面法向指向物体表面，接触面法线方向可使用 HyperMesh 的 normals
工具查看 
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表 B-3  常用材料恢复系数参考值 

材    料 恢 复 系 数 材    料 恢 复 系 数 

Brass 0.30 Iron 0.67 

Bronze 0.52 Ivory 0.78 

Copper 0.22 Lead 0.16 

Cork 0.60 Maple 0.65 

Elm 0.48 Rubber 0.75 

Glass 0.96 Steel 0.90 

表 B-4  常用材料不同接触条件下的摩擦系数参考值 

摩 擦 系 数 

干  摩  擦 润 滑 摩 擦 材  料  1 材  料  2 

静摩擦 滑动摩擦 静摩擦 滑动摩擦 

Aluminum Aluminum 1.05～1.35 1.4 0.3  

Aluminum Mild Steel 0.61 0.47   

Brake Material Cast Iron 0.4    

Brake Material Cast Iron（Wet） 0.2    

Brass Cast Iron  0.3   

Brick Wood 0.6    

Bronze Cast Iron  0.22   

Bronze Steel   0.16  

Cadmium Cadmium 0.5  0.05  

Cadmium Mild Steel  0.46   

Cast Iron Cast Iron 1.1 0.15  0.07 

Cast Iron Oak  0.49  0.075 

Chromium Chromium 0.41  0.34  

Copper Cast Iron 1.05 0.29   

Copper Copper 1.0  0.08  

Copper Mild Steel 0.53 0.36  0.18 

Copper Steel  0.8   

Copper Steel（304 stainless） 0.23 0.21   

Copper-Lead Alloy Steel 0.22    

Diamond Diamond 0.1  0.05～0.1  

Diamond Metal 0.1～0.15  0.1  

Glass Glass 0.9～1.0 0.4 0.1～0.6 0.09～0.12 

Glass Metal 0.5～0.7  0.2～0.3  

Glass Nickel 0.78 0.56   

Graphite Graphite 0.1  0.1  

Graphite Steel 0.1  0.1  
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（续） 

摩 擦 系 数 

干  摩  擦 润 滑 摩 擦 材  料  1 材  料  2 

静摩擦 滑动摩擦 静摩擦 滑动摩擦 

Graphite（In vacuum） Graphite（In vacuum） 0.5～0.8    

Hard Carbon Hard Carbon 0.16  0.12～0.14  

Hard Carbon Steel 0.14  0.11～0.14  

Iron Iron 1.0  0.15～0.2  

Lead Cast Iron  0.43   

Lead Steel  1.4   

Leather Wood 0.3～0.4    

Leather Metal（Clean） 0.6  0.2  

Leather Metal（Wet） 0.4    

Leather Oak（Parallel grain） 0.61 0.52   

Magnesium Magnesium 0.6  0.08  

Nickel Nickel 0.7～1.1 0.53 0.28 0.12 

Nickel Mild Steel  0.64；  0.178 

Nylon Nylon 0.15～0.25    

Oak Oak（parallel grain） 0.62 0.48   

Oak Oak（cross grain） 0.54 0.32  0.072 

Platinum Platinum 1.2  0.25  

Plexiglas Plexiglas 0.8  0.8  

Plexiglas Steel 0.4～0.5  0.4～0.5  

Polystyrene Polystyrene 0.5  0.5  

Polystyrene Steel 0.3～0.35  0.3～0.35  

Polythene Steel 0.2  0.2  

Rubber Asphalt（Dry）  0.5～0.8   

Rubber Asphalt（Wet）  0.25～0.75   

Rubber Concrete（Dry）  0.6～0.85   

Rubber Concrete（Wet）  0.45～0.75   

Sapphire Sapphire 0.2  0.2  

Silver Silver 1.4  0.55  

Sintered Bronze Steel   0.13  

Solids Rubber 1.0～4.0    

Steel Aluminum Bros 0.45    

Steel Brass 0.35  0.19  

Steel（Mild） Brass 0.51 0.44   

Steel（Mild） Cast Iron  0.23 0.183 0.133 
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（续） 

摩 擦 系 数 

干  摩  擦 润 滑 摩 擦 材  料  1 材  料  2 

静摩擦 滑动摩擦 静摩擦 滑动摩擦 

Steel Cast Iron 0.4  0.21  

Steel Copper Lead Alloy 0.22  0.16 0.145 

Steel（Hard） Graphite 0.21  0.09  

Steel Graphite 0.1  0.1  

Steel（Mild） Lead 0.95 0.95 0.5 0.3 

Steel（Mild） Phos. Bros  0.34  0.173 

Steel Phos Bros 0.35    

Steel（Hard） Polythened 0.2  0.2  

Steel（Hard） Polystyrene 0.3～0.35  0.3～0.35  

Steel（Mild） Steel（Mild） 0.74 0.57  0.09～0.19 

Steel（Mild） Steel（Mild）  0.62   

Steel（Hard） Steel（Hard） 0.78 0.42 0.05～0.11 0.029～0.12 

Steel Zinc（Plated on steel） 0.5 0.45  - 

Teflon Steel 0.04  0.04 0.04 

Teflon Teflon 0.04  0.04 0.04 

Tin Cast Iron  0.32   

Titanium Alloy Ti-6Al-4V（Grade 5） Aluminum Alloy 6061-T6 0.41 0.38   

Titanium Alloy Ti-6Al-4V（Grade 5） Titanium Alloy Ti-6Al-4V
（Grade 5） 0.36 0.30   

Titanium Alloy Ti-6Al-4V（Grade 5） Bronze 0.36 0.27   

Tungsten Carbide Tungsten Carbide 0.2～0.25  0.12  

Tungsten Carbide Steel 0.4～0.6  0.08～0.2  

Tungsten Carbide Copper 0.35    

Tungsten Carbide Iron 0.8    

Wood Wood（clean） 0.25～0.5    

Wood Wood（Wet） 0.2    

Wood Metals（Clean） 0.2～0.6    

Wood Metals（Wet） 0.2    

Wood Brick 0.6    

Wood Concrete 0.62    

Zinc Zinc 0.6  0.04  

Zinc Cast Iron 0.85 0.21   

5.柔性体问题及其处理方法 

关于柔性体使用的一些有益的提示如下： 



附录 
 

 425 

（1）创建柔性体时，指定的界面点不应距离太近，否则将造成计算的模态线性相关，使

得求解失效。 
（2）对于模态综合法来说，高质量的结构网格通常是不需要的。 
（3）使用柔性体之前需验证是否选择了合适的界面点约束模态。 
（4）在多体动力学分析时，应使用全部的模态。因为抑制部分模态虽然可以提高求解效

率，但容易产生积分失效。用户可在创建柔性体时，根据构件的实际工作状态，释放界面点

的自由度以减少模态数量。 
（5）为减小柔性体的规模，创建柔性体时可以考虑使用指定应力/应变集、指定模态

集、释放界面点自由度、使用 PLOTEL 单元以及超单元的方法。 
（6）创建柔性体时，要确保材料卡片中材料的单位与单位制卡片指定的单位一致，

如图 B-9 所示。 

 
图 B-9  单位制对应 

a） KG-N-MM-S  b） MMG-N-MM-S 

6.高副问题及其处理方法 

MotionView 提供了两类高副约束：点-线副（PTCV）与线-线副（CVCV）。两类约束都

需要用户提供曲线数据，这里的曲线一般为构件的轮廓曲线。关于构件的轮廓曲线，用户可

通过测绘、三维建模软件轮廓点坐标输出等方式获得，这里推荐一种较为方便的方法。下面

以凸轮（见图 B-10）为例说明该方法具体的操作流程。 
（1）将几何模型导入 HyperMesh，找到待提取点坐标的轮廓边界。使用 Geom→line edit

→compine 命令，将轮廓上的所有曲线合并为一条曲线。隐藏三维实体，合并后的轮廓曲线

如图 B-11 所示。 

                 
          图 B-10  凸轮三维模型图                            图 B-11  凸轮轮廓曲线 
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（2）使用 Geom→nodes→Extract on line 命令，在轮廓曲线上创建 100 个节点，如图 B-12
所示。设定的节点数量越多，拟合出来的曲线越接近原始轮廓。 

 

图 B-12  凸轮轮廓曲线节点 

（3）单击 Export Solver deck 按钮 ，指定文件类型为 OptiStruct、模板为 Standard 
format，并指定文件保存路径将其保存为 cam.fem 文件。 

（4）使用文本编辑器打开上步保存的 cam.fem 文件，如图 B-13 所示。将点坐标数据以

列为单位复制到 Excel 表格中，如图 B-14 所示。 

       

              图 B-13  cam.fem 文件点坐标                     图 B-14  Excel 表格点坐标 

（5）将其保存为 cam.csv 文件。 
（6）打开 MotionView，单击 Curve 按钮 。 
（7）在 Curve 面板中指定曲线类型为 2D Cartesian，单击“文件浏览”按钮 ，选择

cam.csv 文件，指定 x 轴 compent 为 Column1，指定 y 轴 compent 为 Column2。 
（8）单击 Show Curve 按钮，拟合的凸轮轮廓如图 B-15 所示。 
高副使用时需注意以下事项： 
●  尽可能使用封闭曲线，创建曲线时指定曲线为 Closed curve。如果曲线不封闭，如模

拟滑槽的曲线，则需要延长曲线并定义高副工作范围以避免超出曲线端点而报错。 
●  使用曲线中某个点的坐标定义接触点初始位置。 
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图 B-15  拟合的凸轮轮廓 

●  使用 MotionView 创建高副时，需要定义正确的标记点。这里，标记点一方面提供曲

线所关联的几何体，另一方面定义曲线的偏置。 

7.载荷创建问题及解决方案 

（1）避免使用无阻尼的衬套和弹簧单元。这类单元将促使求解器缩小仿真步长以捕捉仿

真中的微小变化量。另外，无阻尼振荡常常不会自行消散。可以考虑为模型中所有衬套和弹

簧添加小的阻尼，如刚度值的 1%，这样的阻尼足以提高求解效率。 
（2）避免使用无阻尼的冲击函数。 
（3）避免使用带 if 条件的非连续载荷，因为不连续的载荷将导致积分失效。如果必须使

用此类单元，可减小最大仿真步长以帮助积分过程的顺利实现。 
（4）衬套单元允许在一个轴线上产生较大的角位移。如果在大于一个轴线上出现较大位

移时，则由此产生的结果将是错误的。 

8.进行 HyperStudy 优化分析时，保存的 XML 文件无法正常打开 

使用通过 MotionView Applications 下拉菜单打开的 HyperStudy 保存的模型，需要使用相

同的方式打开 HyperStudy，然后选择 File→Open study 命令即可打开已保存的 XML 模型。 

9.联合仿真时，MotionSolve 不会自动创建 H3D、PLT 以及 ABF 结果文件，如何才能

获得这些文件 

联合仿真求解后，可调用 mspost.exe 工具获得上述结果文件。操作过程如下： 
（1）启动 DOS 窗口，使用 cd 命令进入工作文件夹。 
（2）输入以下命令求解模型： 

<installdirectory>\hwsolvers\bin\win64\mspost.exe A.xmlA.mrfA.h3d 

关于 MotionSolve 输出文件以及求解执行模块请参看 MotionSolve 在线帮助： 

User's Guide >MotionSolve> Running MotionSolve 
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10.如何顺利完成联合仿真 

（1）确定各系统正常工作。联合仿真前，应分别求解各个系统以保证各个分系统能够顺

利求解并可获得预期的仿真结果。 
（2）精确的输入输出量。联合仿真时，应保证各求解器提供数据的精确性，否则仿真将

获得错误的结果或求解中断。例如，如果 MotionSolve 提供速度信号作为 Sinmulink 的输入

信号（常用速度信号计算控制力），则需要保证来自 MotionSolve 的速度量是精确的。动力学

分析中，MotionSolve 默认使用 DSTIFF I3（Index 3）算法求解模型，该算法不执行速度误差

控制，因此无法保存速度结果的精确性。相反，DSTIFF SI2 算法进行速度误差控制，将提供

更加准确的速度量。 
（3）稳定的仿真过程。如果联合仿真过程中断，则可尝试降低求解器最大积分步长，这

将降低求解效率，有助于获得精确/稳定的求解结果；如果仍不能顺利求解，则可查看每个求

解器的输入量，确保这些数据充分光滑且合理，通常，不连续的输入是求解失效的主要原因。 
（4）输入输出量插值功能。在联合仿真过程中，MotionSolve 将根据模型中 Control_ 

PlantInput 和 Control_PlantOutput 的 hold_order 参数确定进行结果外插值还是内插值。

hold_order 可取值为 0、1 和 2。通常，选择一个非零的、用于内插计算的 hold_order 有助于

提高结果精度，因为在起始时刻与终止时刻，插值端点均是确定值；而选择非零的、用于外

插计算的 hold_order 常常会对结果精度及系统稳定性产生一定影响，因为外插算法需要根据

求解获得的确定值计算预测值。如果选择 1 或 2 作为外插算法的 hold_order 时发现系统响应

较差，则可尝试降低该值为 0 或 1，以提高系统稳定性。 
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